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Preface

Welcome to the Opsware Server Automation System (SAS) — an enterprise-class
software solution that enables customers to get all the benefits of the Opsware data
center automation platform and support services. Opsware SAS provides a core
foundation for automating formerly manual tasks associated with the deployment,
support, and growth of server and server application infrastructure.

This guide describes how to use Opsware SAS, starting with an introduction to the system
and how to navigate the user interface. It provides information about managing servers,
operating system provisioning, managing software packages, provisioning applications,
managing patches, reconciling servers, script execution, configuration tracking, and
deploying and rolling back code. This guide is intended for system administrators who are
responsible for all aspects of managing and provisioning the servers in an operational
environment.

Contents of this Guide
This guide contains the following chapters and appendices:

Chapter 1: Introduction to Opsware SAS: Provides a high-level overview of Opsware
SAS, including the system features, Web Service APIs, and multimaster.

Chapter 2: Getting Started with the Opsware SAS Web Client: Includes information
about supported operating systems and browsers, navigation of the user interface, and an
explanation of each of the features found on the Opsware SAS Web Client Home page.

Chapter 3: Getting Started with SAS Client: Includes information about how to get
started using the SAS Client, the user interface, the client installation and launch, and SAS
Client main features.

Chapter 4: Opsware Agent Management: Includes information about Opsware Agents
on managed servers, the Opsware Discovery and Agent Deployment feature, and
Opsware Agent reachability communication test.
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Chapter 5: Exploring Servers and Jobs in SAS Client: Provides information browsing
servers, server groups, and jobs, also includes information about copying files on a
managed server's file system.

Chapter 6: Server Tracking in the SAS Web Client: Provides information about server
asset tracking, server lists, server search, server histories and reports.

Chapter 7: Server Management in SAS Web Client: Provides information about all
aspects of server management including server groups, server life cycle, server locking,
and service levels.

Chapter 8: Integration with NAS: Provides information about how you can monitor
managed servers and network devices that are connected to them by using Opsware
Server Automation System (SAS), Opsware Network Automation System (NAS), Opsware
Global Shell, and Opsware Visual Application Manager.

Chapter 9: Global Shell: Provides information about the Global Shell, the Opsware
Global File System, setting user and group permissions with the Global Shell, accessing
the Global Shell and remote terminals on servers, and explains Global Shell commands.

Chapter 10: Distributed Script Execution: Describes script types, permissions required
for scripting tasks, script version history, and how to create, edit, and delete scripts. It also
discusses script execution for all script types, script execution results, and scripting error
resolution.

Chapter 11: Code Deployment and Rollback: Provides information about uploading
code and content to staging, and performing services, synchronizations, and sequences
to deploy code and content to managed servers.

Chapter 12: Configuration Tracking: Provides information about configuration tracking
policies, the supported types of configuration files and databases, how changes are
detected, and the tracking policies for a specific server. It also discusses reconciling
customized tracking policies, performing manual backups, viewing backup history,
restoring backed up files, and enabling and disabling configuration tracking.

Appendix A: Communication Test Troubleshooting: Provides troubleshooting
information to diagnose Opsware Agent unreachability problems.

Appendix B: Opsware Agent CLI Utilities: Provides information about installing
Opsware Agent using the Opsware Command Line Interface and the Agent Upgrade Tool.

Appendix C: Global Shell Utilities: Describes the syntax and usage rules for the aaa,
rosh, and swenc commands.
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Appendix D: OGFS Directories: Provides an overview of the directories under /opsw,
which can be accessed from within a Global Shell session.

Appendix E: Glossary: Defines terminology and acronyms that are unique to Opsware
SAS.

Conventions in this Guide

This guide uses the following typographical and formatting conventions.

Bold Identifies field menu names, menu items, button names, and
inline terms that begin with a bullet.

Courier Identifies text that is entered or displayed at the
command-line prompt, such as Unix commands, Opsware
SAS commands, file names, paths, directories, environment
variable names, contents of text files that are viewed or edited
with a text editor, source code in a programming language,
and SQL (database) commands.

ltalics Identifies document titles, DVD titles, web site addresses.
Used to introduce new terms when they are first defined in a
document and for emphasis.
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Icons in this Guide

This guide uses the following iconographic conventions.

This icon represents a note. It identifies especially important
concepts that warrant added emphasis.

[

This icon represents a requirement. It identifies a task that
must be performed before an action under discussion can be
performed.

<

This icon represents a tip. It identifies information that can
help simplify or clarify tasks.

)

This icon represents a warning. It is used to identify significant
information that must be read before proceeding.

=
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Guides in the Documentation Set and Associated Users

- The Opsware® SAS User’s Guide: Server Automation is intended to be read by
systems administrators and describes how to use Opsware SAS, starting with an
introduction to the system and how to navigate the user interface. It provides
information about managing servers, remediating servers, script execution,
configuration tracking, deploying and rolling back code, agent deployment, and using
the Opsware Global Shell and opening a Remote Terminal on managed servers. This
guide is intended for system administrators who are responsible for all aspects of
managing the servers in an operational environment.

. Opsware® SAS User’'s Guide: Application Automation is intended to be read by the
system administrator who is responsible for performing the day-to-day functions of
managing servers, such as auditing and compliance, software packaging, visual
application management, application configuration, and installing software and
operating systems on managed servers.

+ The Opsware® SAS Administration Guide is intended to be read by Opsware
administrators who will be responsible for monitoring and diagnosing the health of the
Opsware SAS components.

* The Opsware® SAS Deployment and Installation Guide is intended to be used by
advanced system administrators who are responsible for planning all facets of an
Opsware SAS installation and for the installation of Opsware SAS in a facility. It
documents all the main features of Opsware SAS, scopes out the planning tasks
necessary to successfully install Opsware SAS, how to run the Opsware Installer, and
how to configure each of the components. It also includes information on system sizing
and checklists for installation.

« The Opsware® SAS Policy Setter’'s Guide is intended to be used by system
administrators who are responsible for all facets of configuring the Opsware SAS Web
Client. It documents how to set up users and groups, how to configure Opsware server
management, and how to set up the main Opsware SAS features, such as patch
management, configuration tracking, code deployment, and software management.

Opsware, Inc. Contact Information

The main web site and phone number for Opsware, Inc. are as follows:

* http://www.opsware.com/index.htm

* +1 (408) 744-7300
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For links to the latest product documentation and software downloads, see the Opsware
Customer Support site:

* https://download.opsware.com/opsw/main.htm

For troubleshooting information, you can search the Opsware Knowledge Base at:
* https://download.opsware.com/kb/kbindex.jspa

The Opsware Customer Support email address and phone number follow:
* support@opsware.com

* +1(877) 677-9273
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Chapter 1: Introduction to Opsware SAS

This section discusses the following topics:
+ Overview of Opsware SAS

« Opsware SAS Interfaces and Tools

» Opsware SAS Features

+ Opsware SAS Terms and Concepts

Overview of Opsware SAS

Opsware SAS provides a core set of features that automate critical areas of server and
application operations — including the provisioning, deployment, patching, and change
management of servers — across major operating systems and a wide range of software
infrastructure and application products.

Opsware SAS does not just automate your operations, it also allows you to make changes
more safely and consistently, because you can model and validate changes before you
actually commit the changes to a server. Opsware SAS helps ensure that modifications to
your servers work on your first attempt, thereby reducing the risk of downtime.

Using Opsware SAS, you can coordinate many operations tasks, across many IT groups
with everyone working with the same understanding of the state of servers, applications,
and configurations. This coordination ensures that all IT administrators have full
knowledge of the current state of the environment before further changes are made.

Opsware SAS allows you to incorporate and maintain operational knowledge gained
through long hours of trial-and-error processes. After an administrator has found and
tested a procedure or configuration, that knowledge can be translated into a model that is
stored in a central repository. This allows you to continue to benefit from the operational
knowledge gained by your system administrators, even if they are no longer working in
your organization.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

33



Opsware® SAS 6.0.1 User’s Guide: Application Automation

The following figure provides an overview of how Opsware SAS automates server and
application operations across all major platforms and a wide range of applications. Each
feature that is shown in the diagram is discussed in the following sections.

Figure 1-1: Overview of Opsware SAS Features
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Types of Opsware Users

The following table identifies the types of Opsware users and their responsibilities.

Table 1-1: Types of Opsware Users

Data Center and Operations | After manually racking and stacking servers, manage
Personnel customer facilities and boot bare-metal servers over the
network or from an Opsware boot image.

System Administrators Install operating systems and applications (for example,
Solaris 5.7 or WebLogic 6.0 Web Server), upgrade
servers, create operating system definitions, and set up
software management policies.

Site Engineers and Deploy custom code on servers.
Customer Project Managers

In addition to the Opsware users listed above, this guide describes the following three
types of users:

« End Users are responsible for all aspects of managing and provisioning the servers in
an operational environment. In the Opsware SAS documentation, these users are
referred to as Opsware users or system administrators. These users log into the
Opsware SAS Web Client and SAS Client and use these interfaces to manage servers
in their IT environment.

- Opsware Administrators are the users, with special training and information, who are
responsible for installing and maintaining Opsware SAS. In the Opsware SAS
documentation, these users are referred to as Opsware administrators. They use the
Administration features in the SAS Web Client to manage Opsware SAS and Opsware
users (by adding user accounts and assigning permissions for different levels of
operation and access), to add customers and facilities, and to change Opsware SAS
configurations. They monitor and diagnose the health of Opsware SAS components.
Opsware administrators need to understand how Opsware SAS features operate to
support users and Opsware SAS.

« Policy Setters are the power users who are responsible for architecting what Opsware
SAS will do in the managed environment; for example, they determine which operating
systems can be installed on your managed servers and how those operating systems
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will be configured during installation. Policy setters, for example, prepare specific
features in Opsware SAS by defining the Software Policies, preparing Operating System
Definitions, and acting as Patch Administrators to approve patches for installation in the
operational environment.

Opsware SAS Interfaces and Tools

Depending on the type of operation you need to perform with Opsware SAS, you select
the appropriate user interface, as Figure 1-2 shows.

Figure 1-2: Interfaces in Opsware SAS
USER INTERFACES & TOOLS

( SAS Client occ
ﬁ Discovery & Agent ﬁ OS Provisioning

Deplqyment . . Software Provisioning
Application Configuration Application Installation
Audit & Remediation Patch Management

Global Shell Script Execution

Remote Terminal Code Deployment & Rollback

Server Explorer .
Visual Packager Data Center Intelligence

[Opsware Command Line Interface ] [ISM Development Kit ]

[DCML Exchange Tool (DET) ] [Opsware APIls ]

+ Opsware SAS Web Client: The web-based user interface to Opsware SAS through
which users can manage servers, provision applications and operation systems onto
servers, run distributed scripts on servers, and deploy code and content to servers,
among other things.

+ SAS Client: A Java Web-Start application that extends the SAS Web Client features
and provides the following new features:

— Discovery and Agent Deployment

Device Explorer

Visual Application Manager

Audit and Remediation

Compliance Dashboard
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- Reports

- Software Management

— Patch Management for Windows

— Patch Management for Unix

- Visual Packager

— Visual Packager

— Application Configuration Management
- Global Shell

— NAS Integration

« Opsware Command Line Interface (OCLI): A command line interface that users can
use to upload packages to the Opsware Software Repository (version 1), and perform
many other Opsware SAS operations (version 2).

+ DCML Exchange Tool (DET): A utility that enables users to export almost all server
management content from any Opsware core — standalone or multimaster mesh — and
import it into any other Opsware core. Opsware SAS can also provide pre-packaged
server management content appropriate for new installations that can be imported into
a core after initial setup. See the Opsware® SAS Content Utilities Guide for information
about using this utility.

+ ISM Development Kit: A development kit that consists of command-line tools and
libraries for creating, building, and uploading ISMs. An ISM is a set of files and
directories that include application bits, installation scripts, and control scripts. See the
Opsware® SAS Content Utilities Guide for information about using the ISM
Development Kit.

+ Opsware APIs: A set of APIs and a command-line interface (CLI) that facilitate the
integration and extension of Opsware SAS. This platform allows other IT systems —
such as existing monitoring, trouble ticketing, billing, and virtualization technology — to
exchange information with Opsware SAS. This broadens the scope of how IT can use
Opsware SAS to achieve operational goals.

Opsware SAS Features

Opsware SAS is made up of a set of Opsware SAS features. Opsware SAS features are
the components that automate particular IT processes.
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The features are designed to replace ad hoc, error-prone, manual processes. For example,
by using the OS Provisioning feature, users can set standards for different types of servers
and automatically provision the servers, saving time and ensuring that operating system
builds are consistent. By using the Patch Management feature, users can establish
polices about how patches are installed. Opsware SAS uniformly enforces those polices.

The following features are currently available as part of Opsware SAS:
+ Operating System Provisioning

» Code Deployment & Rollback

» Configuration Tracking

+ Script Execution

+ Discovery and Agent Deployment

» Device Explorer

 Visual Application Manager

* Audit and Remediation

+ Compliance Dashboard

» Reports

« Software Management

« Patch Management for Windows

« Patch Management for Unix

» OS Provisioning

+ Visual Packager

+ Application Configuration Management
+ Global Shell

* NAS Integration

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 1: Introduction to Opsware SAS

All Opsware SAS features support cross-platform environments and are designed to
automate both new and existing data center environments. See the following figure
Figure 1-3: Opsware SAS Features
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Operating System Provisioning

The OS Provisioning feature gives administrators the ability to provision operating system
baselines onto bare metal servers quickly, consistently, and with minimal manual
intervention. Bare metal OS provisioning is a key part of the overall process of getting a
server into production.

Benefits of the OS Provisioning feature include the following items:
 Integration with the other features of Opsware SAS

Because the OS Provisioning feature is integrated with the suite of Opsware SAS
automation capabilities, including patch management, software management, and
distributed script execution, handoffs between IT groups are seamless. Opsware SAS
ensures that all IT groups are working with a shared understanding of the current state
of the environment, which is an essential element of delivering high-quality operations
and reliable change management.

* The ability to easily update server baselines without re-imaging servers

Unlike many other OS provisioning solutions, systems provisioned with Opsware SAS
can be easily changed after provisioning to adapt to new requirements. The key to this
benefit is the Opsware SAS use of templates and its installation-based approach to
provisioning.

¢ Flexible architecture designed to work in many environments

Opsware engineers carefully designed the OS Provisioning feature to handle many
different types of servers, networks, security architectures, and operational processes.
Opsware SAS works well in floppy (Windows provisioning), CD (Linux provisioning), or
network-boot environments, with scheduled or on-demand workflows, and across a
large variety of hardware models. This flexibility ensures that you can provision
operating systems to suit your organization’s needs.

Opsware SAS automates the entire process of provisioning a comprehensive server
baseline, which typically consists of the following tasks:

+ Preparing the hardware for OS installation using an OS installation profile

« Creating OS sequences that define a server build policy, including application policies,
patch policies, device groups, and remediation policies

+ Installing a base operating system and default OS configuration using an OS sequence
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« Applying the latest set of OS patches, the exact list depends on the applications
running on the server

+ Installing system agents and utilities such as SSH, PC Anywhere, backup agents,
monitoring agents, or anti-virus software

+ Installing widely-shared system software such as Java Virtual Machines

« Executing pre-installation or post-installation scripts that configure the system with
values such as a root password

Code Deployment & Rollback

Opsware SAS automates code and content deployment to reduce the risk and time
requirements associated with pushing new code to production. The Code Deployment &
Rollback (CDR) feature provides an automated system for deploying code (such as, ASP,
JSP, JAR, Java, C++, and Perl files) and content (such as, HTML, JPEG, GIF, and PDF
files).

Specifically, CDR enables you to perform the following actions:
* Push code from staging or development environments to production environments.

» Synchronize code and content across multiple servers and locations.

.

Automatically rollback to the previous version of code or content.
» Sequence multiple, complex deployment steps into repeatable workflows.

+ Manage changes across heterogeneous operating systems.

Configuration Tracking

The Configuration Tracking feature tracks, backs up, and recovers critical software and
system configuration information across Unix and Windows servers.

System administrators set up policies that describe the configuration files and databases
to track, and the actions to take when a change in configuration is detected. Policies can
be assigned to software, individual servers, groups of servers, and customers, and
applied either locally or globally across data centers.

When Opsware SAS notices a server configuration change, it can log the change, notify
administrators about the change with email, or back up the configuration, depending on
the policy set by the administrator.
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When a bad configuration change forces administrators to rollback to a previous version,
they can use Opsware SAS to restore the configuration file to the saved version of the
configuration. By notifying users about configuration changes — and maintaining a version
history of those changes — organizations can quickly diagnose problems related to
configuration errors and rollback to a known good state. In addition, this capability helps
teams plug security holes inadvertently created by bad server configurations.

Typically, system administrators define configuration-tracking policies on a per-application
basis. So for example, a policy for BEA WeblLogic might specify, “Monitor the
weblogic.conf file, notify app-server-admins@company.com of any changes, and
maintain a version history of any changes that occur for 30 days.” After a policy is defined
in this fashion, administrators can apply the policy to all the Weblogic servers running in
their environment or to specific servers.

Script Execution

The Script Execution feature enables you to share and run ad-hoc or custom scripts
across an entire farm of Opsware-managed servers.

By executing scripts with Opsware SAS instead of manually, administrators benefit by
using the following features:

« Parallel script execution across many Unix and/or Windows servers, saving time and
ensuring consistency.

» Role-based access control, ensuring only authorized administrators can execute scripts
on hosts to which they have access.

« The ability to control access to scripts by storing them in private or in public libraries.

+ The ability to see and download script output one server at a time or in a consolidated
report, which captures output from all servers in a single place.

« The ability for scripts to be mass-customized. Administrators can access information in
Opsware SAS about the environment and the state of servers. This is critical to ensuring
that the right scripts are executed on the right servers.

« A comprehensive audit trail that reports who, what, when, and where a particular script
was executed.

» The ability to rollback changes (when used in conjunction with the Configuration
Tracking feature).
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« Automatic backup of all private and shared scripts to all other Opsware-managed data
centers (when used in conjunction with an Opsware Multimaster Mesh).

Because the Script Execution feature is an integrated part of Opsware SAS, administrators
enjoy unique benefits when compared to standalone script execution tools:

+ Using known system state and configuration information to customize script execution,
users can tailor each script by referencing and accessing the rich store of information in
Opsware SAS, such as the customer or business that owns the server, whether the
server is a staging or production server, which facility the server is located in, and
custom name-value pairs.

« By sharing scripts without compromised security, users can share scripts with each
other without compromising security because Opsware SAS maintains strict controls on
who can execute scripts on which servers and generates a comprehensive audit trail of
script execution.

Discovery and Agent Deployment

The Opsware Discovery and Agent Deployment (ODAD) feature allows you to deploy
Opsware Agents to a large number of servers in your facility and place them under
Opsware management.

Using the ODAD features, you can perform the following tasks:
« Scan your network for servers.
+ Select servers for Opsware Agent installation.
« Select a communication tool and provide user/password combinations.

+ Choose agent installation options and deploy agents.

Device Explorer

The Device Explorer lets you view information about servers in your managed
environment.

From the Server Explorer, you can perform the following tasks:

» Create a server snapshot, perform a server audit, audit application configurations,
create a package, and open a remote terminal session on a remote server.

+ Browse a server's file system, registry, hardware inventory, software and patch lists,
and services.
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» Browse Opsware information such as properties, configurable applications, and even
server history.

From the Groups Browser, you can perform the following tasks:
+ Audit system information, take a server snapshot, and configure applications.
» View and access group members (servers and other groups).

» View group summary and history information.

Visual Application Manager

The Visual Application Manager feature is designed to help you optimally understand and
manage the operational architecture and behavior of distributed business applications in
your IT environment. Since these applications are complex collections of services that
typically run across many servers and network devices, it can become increasingly
difficult to understand (or remember) what is connected to what, where performance
problems originate, how to troubleshoot and resolve problems, and what result would
occur if you make a change in your environment.

Visual Application Manager helps you see (visualize) this type of information in physical
and logical drawings
Audit and Remediation

The Opsware Audit and Remediation feature allows you to define server configuration
policies and make sure that servers in your facilities meet those policy standards. When
servers are found to be ‘out of compliance’ (not configured the way you want them to be),
you can remediate the differing server configurations.

With Audit and Remediation, you can audit a server configuration values based upon a
live server (or server snapshot), or based upon your own custom values, perform server
comparisons against a baseline, and create custom audit policies that define company or
industry server configuration compliance standards, and which can be used inside of
audits, snapshot specifications, and audit policies.

Using Audit and Remediation, you can perform the following tasks:
» Compare servers or snapshots to reference servers or snapshots
» Create audits for repeated use

+ Create audit policies that define compliance and security standards for your
organization
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« Associate audits with individual servers or dynamic server groups

+ Remediate problems at multiple levels, including files, directories, patches, registry
keys, and packages

Compliance Dashboard

The Compliance Dashboard allows you to view at a glance the overall compliance levels
for all the devices in you facility and helps you to remediate compliance problems. The
Compliance Dashboard displays compliance tests for software policies, application
configurations, audits, patches, and duplex status. Each of these compliance tests is
based upon an Opsware Server Automation System (SAS) “policy” (user or system
defined) which define a unique set up server or device configuration settings or values
that help ensure your IT environment is configured the way you want it to be.

Reports

The Reports feature provides comprehensive, real-time information about managed
servers, network devices, software, patches, customers, facilities, operating systems,
compliance policies, and users and security in your environment. These reports are
presented in graphical and tabular format, and are actionable—where you can perform
appropriate actions on objects, such as a policy or an audit, within the report. These
reports are also exportable to your local file system (in .html and .xIs formats) to facilitate
use within your organization.

Software Management

The Software Management feature in Opsware SAS provides a powerful mechanism to
model software by using software policies and to automate the process of deploying
software and configuring applications on a server in a single step. In addition, the
Software Management feature provides a structure to organize your software resources in
folders and define security permissions around them. This feature allows you to verify the
compliance status of a server and remediate non-compliant servers.

The Software Management feature in SAS Client provides the following functions:

» Create an organizational structure for software

+ Define security boundaries for folders

« Define a model-based approach to manage the IT environment in your organization

» Enable sharing of software resources among user groups
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» Deploy and configure applications simultaneously

» Deploy multiple application instances on one server

+ Establish a software deployment process

« Verify compliance status of servers to software policies
» Generate reports

« Comprehensively search for software resources and servers

Patch Management for Windows

The Patch Management for Windows feature enables you to identify, install, and remove
Microsoft® Windows patches and maintain a high level of security across managed
servers in your organization. With SAS Client user interface, you can identify and install
patches that support security vulnerabilities for the Windows 2000, Windows 2003, and
Windows NT4.0 operating systems. These patches include Service Packs, Update
Rollups, and hotfixes.

Patch Management for Unix

The Patch Management for Unix feature enables you to identify, install, and remove Unix
patches to maintain a high level of security across managed servers in your organization.
With the Opsware SAS Client, you can identify and install patches that support security
vulnerabilities for the AIX, HP-UX, and Solaris operating systems.

OS Provisioning

OS Provisioning in the SAS Client allows you to install an operating system, applications,
and packages and packages on unprovisioned servers by creating OS Installation Profiles
and OS Sequences. From the Devices list, you can view all unprovisioned servers in your
facility and provision those servers by running an OS Sequence.

OS Sequences allow you to set up a complete server build (policy) that represents the
ideal manner in which a particular OS should be installed, which includes the proper OS
Installation Profile that should be used, as well as Application and Patch policies, the
servers to install the OS on, and how these policies should be remediate either before or
after the OS is installed.
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Visual Packager

The Create Package feature allows you to create an installable software package from a
managed server and from server compliance information, such as server snapshots and
audit results. File system objects that are recorded in snapshots and compliance
information produced by audits help you define the content of a package. In turn, you can
use that package to update a server with new or missing server objects.

Create Package enables you to selectively package server objects according to the
operating system of the servers that you want to distribute the package to, supporting
both Unix and Windows operating systems.

It allows packages to contain the following objects:

« A Unix package can contain files (including attributes), directories, packages, patches,
and patch clusters.

+ A Windows package can contain files (including attributes), directories, packages,
patches, Windows registry, and Windows services.
Application Configuration Management

Opsware Application Configuration Management (ACM) allows you to create templates so
you can modify and manage application configurations associated with server
applications. ACM enables you to manage, update, and modify those configurations from
a central location, ensuring that applications in your facility are accurately and consistently
configured.

Using ACM, you can perform the following tasks:

+ Manage configurations based on files and objects, such as Windows registry, IIS
metabase, WebSphere, COM+, and more.

» Preview configuration changes before applying them.

« Edit and push configuration changes to individual servers or server groups.

+ Use information in the Opsware data model to set configuration values.

+ Manage configurations of any application by building configuration templates.

+ Audit the Application Configurations on a server to determine if any of the
configuration files on the server are out of sync with the values stored in your
templates.
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Global Shell

The Opsware Global Shell feature enables you to manage servers by using a command-
line interface. You can remotely perform the following tasks:

+ Complete routine maintenance tasks on managed servers.
« Troubleshoot, identify, and remediate problems on managed servers.

Global Shell consists of a file system and a command-line interface to that file system for
managing servers in Opsware SAS. The file system is known as the Opsware Global File
System (OGFS). All object types in the OGFS (such as servers, customers, and facilities)
are represented as directory structures in this file system.

The Global Shell feature also manages user permissions for accessing the file system,
Windows Registry, and Windows Services objects on managed servers.
NAS Integration

The NAS Integration feature enables you to closely examine detailed information about
managed servers and the network devices connected to them so that you can determine
how they are related and then, subsequently, coordinate and implement those changes.
This feature supports an integrated approach to using NAS and SAS so that you can
perform actions on device groups, such as combine event history, determine compliance,
and identify duplex mismatches across servers and network devices in your environment.
Opsware SAS Terms and Concepts

This section discusses the following topics:

« Agent-Server Architecture of Opsware Technology

« Server Management in Multiple Facilities

* Multimaster Support
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Agent-Server Architecture of Opsware Technology

The agent-server architecture of Opsware SAS enables server management. The server

portion of Opsware SAS consists of multiple, integrated components, each with a unique
purpose. Each server managed by Opsware SAS runs an intelligent agent (the Opsware

Agent).

Figure 1-4: Opsware SAS Agent-Server Architecture
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See the Opsware® SAS Administration Guide for a detailed description of the
components that make up the Opsware SAS server portion of the architecture.

The Opsware Agent is the agent of change on a server. Whenever Opsware SAS needs to
make changes to servers, it does so by sending requests to the Opsware Agents.
Depending on the request, the Opsware Agent on a server might use global Opsware
SAS services in order to fulfill the request. For example, the Opsware Agent might often
make requests to the Model Repository, the central database for all Opsware SAS
components, and the Software Repository, the central repository for all software that
Opsware SAS manages.
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Some functions that the Opsware Agent supports are:
+ Software installation and removal

+ Configuration of software and hardware

« Periodically reporting server status

+ Auditing of the server

An Opsware Agent is idle unless Opsware SAS is trying to perform some change on the
server. In addition, each Opsware Agent periodically contacts the Data Access Engine
and registers itself. The Data Access Engine is an XML-RPC interface to the model
repository. The Data Access Engine sends this data to the Model Repository, which allows
the Model Repository to keep track of server status, and know when particular servers are
disconnected from or reconnected to the network.

After you install an Opsware Agent on a server, users can manage the server by installing
or upgrading software, patching the OS software, removing software, changing server
properties, or decommissioning the server.

See “Agent Reachability Communication Tests” on page 114 in Appendix for information
about how to install an Opsware Agent on a server so that Opsware SAS can manage it.
Server Management in Multiple Facilities

The managed environment might span several facilities. A facility refers to the collection of
servers that a single Opsware Model Repository manages, and the database that stores
information about the managed environment. For example, one facility might be
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dedicated to an organization’s Intranet, while another facility might be dedicated to the
web services offered to the public. Your Opsware SAS can contain facilities (a full
Opsware SAS is installed) and Satellite facilities. See Figure 1-5.

Figure 1-5: Server Management in Multiple Facilities
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See the Opsware® SAS Planning and Installation Guide for more information about the
types of installations that Opsware SAS supports.

Users can manage servers in any facility from an SAS Web Client in any facility. When a
user updates data in a facility, the Model Repository for that facility is synchronized with
the Model Repositories located in all remote facilities.

When using Opsware technology in multiple facilities, users should follow these work
process rules to reduce the chance of data conflicts between facilities:

« Users should not change data in one facility and then make the same change in
another facility.

« More than one user should not change the same object in different facilities at the
same time. For example, two users should not manage the same server from different
facilities.
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Multimaster Support

With the Opsware Model Repository Multimaster Component, customers can store and
maintain a blueprint of software and environment characteristics of each data center
(referred to as a facility in the Opsware SAS Web Client) in multiple locations so the
infrastructure can be easily rebuilt in the event of a disaster. The Multimaster Replication
Engine not only provides the ability to replicate an environment in case of a disaster, but
can also assist in facility migration activities as well as knowledge sharing across the
enterprise.

Through the Model Repository Multimaster Component, Opsware SAS provides the ability
to easily rebuild server and application environments, provision additional capacity,
distribute updates, and share software builds, templates and dependencies — across
multiple facilities and from one user interface. See Figure 1-6.

Figure 1-6: Multimaster Support
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Web Client

This section provides an overview of the SAS Web Client and discusses the following
topics:

+ Getting Started with the SAS Web Client
« Access to Features in the SAS Web Client

» User Interface

Getting Started with the SAS Web Client

The following section describes Supported Browsers for the SAS Web Client (a web
application) and Browser Configuration Requirements.

Supported Browsers for the SAS Web Client
The following table lists the supported browsers for the SAS Web Client.

Table 2-1: Supported Browsers for the SAS Web Client

Microsoft

Internet X
Explorer

55

Microsoft

Internet X X X
Explorer

6.0

Mozilla 1.6 X X X
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Table 2-1: Supported Browsers for the SAS Web Client

Firefox 1.0 X X X

Browser Configuration Requirements

To use the SAS Web Client, your browser must be configured in the following manner:

« The browser must accept cookies and be able to use Java.

« The browser must support SSL and should provide 128-bit encryption (recommended).

» Using a pop-up blocker might prevent some functions from working correctly. Either
disable the pop-up blocker completely or use the supported browser’s native pop-up
blocking function instead of a third-party product.

Access to Features in the SAS Web Client

This section explains how to configure your user profile to access features within the
Opsware System. This section contains the following topics:

+ System Management of Opsware User Information
» Best Practices for Selecting Passwords

» Updating User Profiles and Passwords

System Management of Opsware User Information

An Opsware administrator creates additional users who can use the SAS Web Client, and
the Opsware administrator assigns them temporary passwords. Once added to the
system, an Opsware user can update their personal information, password, and time zone
and date display preferences by using the My Profile link.

An Opsware user cannot change their access permissions by using the My Profile link. If
an Opsware user needs additional access permissions, they contact their Opsware
administrator.
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Best Practices for Selecting Passwords

Th
au

e Opsware Server Automation System (SAS) enforces a security policy that allows only
thorized users to log into the SAS Web Client. Opsware users are advised to select a

password based on the following guidelines:

.

Change your password frequently to ensure that your account information is secure.
Select a password that is easy to remember so that you don't have to write it down.

Use a mixture of upper and lower case letters, numbers, and punctuation in your
password.

Do not share your password.

Do use a password that you can type quickly, without having to look at the keyboard.

Updating User Profiles and Passwords

As

an Opsware user you can change your name, contact information, password, and

preferences such as time zone and date display. You cannot change your access
permissions. Contact your Opsware administrator to change your access permissions.

Perform the following steps to change your profile and password.

< o

Log into the SAS Web Client. The SAS Web Client Home Page appears.
Click the My Profile link located at the top of the page. The My Profile Page appears.

To change your profile information, enter new information on the User Identification
tab of the My Profile Page.

Click Save.

To change your password, click the Change Password Link. The Password Change
page appears.

Enter your old password.
Enter your new password.
Confirm your new password in the Confirm Password field.

Click Save. A confirmation page appears indicating that your password was
successfully changed.

KK Click Okay. The Profile page appears.
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User Interface

The following section discusses getting started with the Opsware System and contains
the following topics:

» Requirements for Logging In

+ Overview of the SAS Web Client User Interface
« My Profile

+ Search

* My Servers

» Mouseover Icon Tooltips

Requirements for Logging In

In order to log in and access SAS Web Client features, your Opsware administrator must
have created a user name and password for you, and assigned user permissions that
control the features you can access, the actions you can perform, and the resources you
can access.

Overview of the SAS Web Client User Interface

The SAS Web Client user interface consists of the five following sections:

+ Home Page

» Tasks

+ My Jobs

+ My Customers

« Navigation Panel
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Home Page

Figure 2-1 shows the Home page as it appears when you log in or when you click the
Home link in the navigation bar.

Figure 2-1: Opsware System Home Page
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The time zone that appears in the upper right corner of the Home page is taken from the

time zone preference that was defined for you when your profile was created.

Consequently, the date and time information that displays throughout the SAS Web Client
is for that time zone. The occasional exceptions however are always labeled GMT.
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Tasks

The Tasks area of the Home page displays links to the wizards that you have permissions
to access, a link to the Code Deployment page if you have that permission. If you do not
have permissions to a task in this area, the task name still displays, but it is italicized and
it is not an active link. Figure 2-2 shows the Tasks area with all permissions enabled.

Figure 2-2: Tasks Area of the Home Page
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My Jobs

The My Jobs area of the Home page is populated with details of the jobs that you have
run, jobs that are currently in progress, or jobs that you have scheduled to run, including
the name of the job, the start time, the number of servers affected by the job, and the
status of the job. If there are more than six jobs, you can see the rest of them by clicking
the See All link, which also shows the total number of jobs in parentheses, as Figure 2-3
shows.

If the job was run in the SAS Client, then there will be a link next to the job that (when
clicked) will launch the SAS Client. You can view the more detailed information about the
job in the SAS Client.

Figure 2-3: My Jobs Area of the Home Page
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58 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 2: Getting Started with the SAS Web Client

My Customers

The My Customers area of the Home page is populated with customer information,
including unreachable servers associated with a customer and the total number of
servers associated with that customer. To select the customers to display in the My
Customers area of the Home page, click Edit and select the check box next to the
customer name. See Figure 2-4.

Figure 2-4: My Customers Area of the Home Page

My Customers Euiit
Customer Unreachable Servers Total Servers

o amold 0 0
? Industrial Machines 0 ]
| masTERCUST 106 110
? Opsware 13 23
o opswiNC 0 0
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Navigation Panel

The navigation panel on the left side of the SAS Web Client shows all possible features,
as shown in Figure 2-5. The features you can access and the actions you can perform
depend upon your user profile, as defined by the Opsware administrator.

Figure 2-5: Navigation Panel, All Permissions View
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The items that appear in the navigation panel depend on the permissions the user has.
Clicking an item on the navigation panel displays that feature in the main part of the
Home page. For a user with all permissions, the following links appear:

60 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 2: Getting Started with the SAS Web Client

Home: Displays the top level of the SAS Web Client. The Home page is described in this
section of the guide. Wizards are documented in their respective functional areas of the
system.

My Jobs: Displays the My Jobs page, showing jobs completed during the previous 30
days, jobs currently in progress, and currently scheduled jobs. This page is an expanded
view of the contents of the My Jobs area of the Home page and has the same effect as
clicking Show All in the My Jobs area of the Home page.

Servers: Expands to display these selections:

+ My Servers: Use to add any server or server group to your own personal view of
servers. My Servers provides an efficient way to manage servers when your
operational environment contains hundreds or thousands of servers.

+ Manage Servers: Use filters to display a list of servers and perform operations on
them such as edit server values, assign, run scripts, and add servers to My Servers.
See “Server Management in SAS Web Client” on page 199 in Chapter 7 for more
information.

» Search: Find specific servers using default criteria or user-defined criteria. See
“Server Search” on page 168 in Chapter 6 for more information.

» Server Pool: Use filters to display a list of servers, install operating systems on the
servers, and delete the servers. See Opsware® SAS User’s Guide: Application
Automation for more information.

Software expands to display these selections:

+ Operating Systems: Prepare operating systems for installation and delete existing
operating systems. See Opsware® SAS User’s Guide: Application Automation for
more information.

» Scripts: Run scripts, upload scripts, and create new scripts. See “Distributed Script
Execution” on page 323 in Chapter 10 for more information.

Environment expands to display these selections:

« Customers: Create new customers and edit or delete existing customers. See the
Opsware® SAS Administration Guide.

+ Facilities: Create new facilities, edit facility properties, and assign and edit custom
attributes for facilities. See the Opsware® SAS Planning and Installation Guide.
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Hardware: A read-only view of servers categorized by the hardware manufacturer
and model, and their related information. See “Hardware Information for Managed
Servers” on page 196 in Chapter 6 for more information.

Service Levels: Define service levels and custom attributes. See “Service Levels” on
page 263 in Chapter 7 for more information.

IP Ranges: Identify and create IP ranges and IP range types. See the Opsware® SAS
Policy Setter’s Guide for more information.

IP Range Groups: Create IP Range Groups. See the Opsware® SAS Policy Setter’s
Guide for more information.

Code Deployment expands to display these selections:

.

Deployment Home: The exact CDR links that you see in the Code Deployment area
are based on the permissions that you have for the customer you want to work with.

Service Management: Create, modify, and delete service definitions. Services
define the location and commands to manipulate applications on hosts.

Run Service: Perform service operations on one or more hosts, or request that a
service operation be performed on your behalf. Service operations include starting or
stopping applications, cutting over or rolling back code, and backing up or restoring
code.

Sync Management: Create, modify, and delete synchronization definitions.
Synchronizations define the path for pushing code from a source host to one or more
destination hosts.

Synchronize: Perform a synchronization to one or more hosts, or request that a
synchronization be performed on your behalf.

Sequence Management: Create, modify, and delete sequence definitions.
Sequences allow the grouping of service operations and synchronization operations
to define higher level code deployment operations.

Run Sequence: Perform a pre-defined sequence of service operations and
synchronizations on one or more hosts, or request that a sequence be performed on
your behalf.

View History: Get information about previously run Code Deployment operations.
See “Code Deployment and Rollback” on page 359 in Chapter 11 for more
information.
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Administration: Expands to display the following features. For more information about
these features, see the Opsware® SAS Administration Guide and Opsware® SAS Policy
Setter's Guide.

Users & Groups: Administrators use this feature to create user groups, define
permissions for those groups, create new administrators, and add users to groups.

Server Attributes: Define and edit server use attributes, enable them for code
deployment, and define deployment stages. Also define and edit server deployment
stage attributes.

System Configuration: Contains the configuration parameters that define how the
Opsware System works in your environment. This selection is only used at the
direction of Opsware Inc.

System Diagnosis: Runs a series of tests on Opsware components to make sure
that they are functioning correctly.

Gateway: Allows you to connect Satellites with this or other cores.

Opsware Software: Provides a view of the properties, custom attributes, installation
order, and history of the software attached to the Opsware SAS in the system.

The Administration set of features is only available if you are logged in as an Opsware

administrator.

Navigation

Top-level navigation from the Home page is simple. To access any of the features in the
navigation panel, click the feature name. To access any of the wizards or other features in
the Tasks area of the Home page, click the name of the task.

After you select a task or a feature, other pages appear, which might have one or more of
the following means of navigation:

+ Clicking a hyperlinked name to display a page

For example, if you select Software » Scripts (assuming that you have the correct
permissions), the page that appears shows all of the scripts that have been uploaded
so far.

+ Selecting a tab to display a page
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For example, when you select Manage Servers and click one of the hyperlinked server
names, the resulting page shows a row of tabs, like Figure 2-6 shows.

Figure 2-6: Example of Tabs

Each tab displays a page, each with its own buttons and functionality.
+ Clicking a button to display a page

For example, when you select the Custom Attributes tab, a page appears with several
buttons: Add, Delete, and Copy, which are common to each page called by these tabs,
and Add Custom Attribute, which is unique to this particular tab. You will find similar
functionality on all tabbed pages in the Opsware System.

My Profile

You can update your own personal user information without the assistance of the
Opsware administrator with the My Profile link. You can change your first and last name,
your contact information, your password, and your time zone and date display
preferences.

Search
At the top of the Home page open the dialog box as Figure 2-7 shows.

Figure 2-7: Search Function
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You can search for servers, jobs, and server groups, by making the selection from the
drop-down list, and then entering an identifying string in the text box.

My Servers

The My Servers feature provides a convenient place to store a set of servers that have
been selected and stored using the Add to My Servers function in Manage Servers. You
might use it as a shortcut to the servers you work with most often, or as a way to gather a
group of servers when you want to apply the same changes to all of them. All functions
that are available in the Manage Servers page are also available from within My Servers.
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Mouseover Icon Tooltips

When an icon appears on a page in the SAS Web Client, a tooltip displays information
about the icon when your mouse pointer hovers over it. For example, server icons display
messages such as “Available or Build Failed” to describe the state of the server. Packages
and patches display messages such as Available, Managed, Unmanaged, and so forth.
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This section discusses the following topics:

Overview of the SAS Client
Requirements for Running the SAS Client
Installing and Launching the SAS Client
SAS Client User Interface

SAS Client Search

Accessing SAS Client Options

Overview of the SAS Client

The SAS Client is a powerful Java client for the Opsware Server Automation System. It
provides the look-and-feel of a Microsoft Windows desktop application with the cross-
platform flexibility of Java. Over time, more and more of the Opsware Server Automation
System's features will be available via the SAS Client.

The SAS Client provides the following features:

Discovery and Agent Deployment
Server Explorer

Audit and Remediation

Visual Application Manager
Software Management

Patch Management for Windows
Patch Management for Unix
Visual Packager

Application Configuration Management

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

67



Opsware® SAS 6.0.1 User’s Guide: Application Automation

+ Global Shell
* Integration with NAS

For descriptions of all the SAS Client features, see “Opsware SAS Features” on page 37.

Requirements for Running the SAS Client

Java J2SE v 1.4.2 - 1.4.2 10 JRE must be installed on the system that runs the SAS Client.
To download this version of Java, go to http://java.sun.com/j2se/1.4.2/download.html. The
SAS Client is supported on the following operating systems:

* Windows 2003
* Windows 2000

* Windows XP

When using Internet Explorer, if you try to launch the SAS Client without installing Java
J2SE v 1.4.2 - 1.4.2_10 JRE, you are prompted to install JRE and run the SAS Client in one
step. When you select this option, Java v 1.4.2 JRE is installed and you get the following
error message: Java Web Start -unexpected Error. Unable to launch
SAS Client. To launch the SAS Client, ignore the error message and click Retry.

Installing and Launching the SAS Client

To access the SAS Client for the first time, you must launch the SAS Client installer from
the SAS Web Client. You only need to install the SAS Client once.

Once you have downloaded and installed the SAS Client, you can start it from the
following locations:

* In the Power Tools section of the SAS Web Client home page

+ On your desktop (an SAS Client program icon is installed to your desktop if you
choose to install one on your desktop)

+ From the Start menu, select » All Programs » Opsware SAS Client.
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By default, the core that you log into is the core of the SAS Web Client where you
launched the SAS Client download. You can change the default core by configuring your
general options. See “Accessing SAS Client Options” on page 83 in this chapter for more
information.

To install and launch the SAS Client, perform the following steps:
H Launch the Opsware SAS Web Client and log in.

H From the Home page of the SAS Web Client, in the Power Tools section, click the
Launch SAS Client link.

B If you are a Firefox user, you will be able to open the JSP file to launch the SAS Client
installation. (Internet Explorer users should go to the next step.)

Bl After the SAS Client has been downloaded to your computer, the Login window
displays, as seen in Figure 3-1.

Figure 3-1: Login theSAS Client Window.

¥ please login... |Z||E|rz|

PSWAREFE

SERVER AUTOMATION
User Marne: |
Password:
Core Server: occ,c03, dev.opsware, com

| Login _” Zancel
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Enter your user name and password, and click Login. The user name is not case
sensitive. If you have access to more than one core server, you can enter the core
server's IP address or name in the core server field. If you don't specify a port with
the host:port notation, port 443 is used.

B f you are asked to accept the certificate from the core server, click Yes. The SAS
Client now appears.
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SAS Client User Interface

The SAS Client user interface provides easy access to all of the SAS Client features and
functionality. The SAS Client user interface has six main areas:

* Menus

» Navigation Pane

+ Search

» Content Pane

» Details Pane

» Status Bar

Figure 3-2: SAS Client User Interface
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Menus
SAS Client menus include the following menus:

« File: This allows you to open a new SAS Client window, or close the current window,
or exit all open SAS Client windows.

« Edit: This allows you to cut, copy, paste, and delete text.

» View: This refreshes the current view and shows the latest information from the core
that you are currently logged into (such as compliance test information for the
compliance dashboard). You can also access SAS Client features in the Navigation
pane, such as Devices (groups of devices, managed and unmanaged servers),
Reports (Compliance Dashboard, Reports) Software Library (application
configuration, server compliance, patch management), OS sequences and OS
installation profiles, Jobs and Sessions (job logs and shell sessions), and Opsware
Administration (patch settings and patch compliance rules). This also allows you to
show or hide the Action pane and the Preview pane.

» Tools: This allows you to open a Global Shell session, open the Visual Application
Manager, or access the SAS Client options.

+ Actions: Depending upon the feature that you have selected in the Navigation panel,
this menu allows you to perform numerous functions related to all main SAS Client
features.

» Window: This allows you to access multiple instances of SAS Client windows, if more
than one window is open.

+ Help: This menu provides help for the SAS Client. Help F1 provides context-sensitive
help relevant to the current feature window or dialog box selected or opened (same
as F1). The contents and index will open the SAS Client help system to the main table
of contents. (The About SAS Client menu provides version and system information.)

72 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Navigation Pane

To access SAS Client features, select a feature in the Navigation pane, as shown in
Figure 3-3. When you select a feature, the contents of it appear in the Contents pane. You
can access functions related to it through the Actions menu.

Figure 3-3: Navigation Pane

Servers
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Patches

N Patch Paolicies

= [ windows

[ windowes MT 4.0 (18]

(" incowes 2003 (23)
[ windowes 2000 (13)

Jobs and Sessions

Opsware Administration

Search

The Search feature allows you to search for any information in Opsware SAS, such as SAS
Client Server, Device Group, Folder, Job, Software, Patch, Application Configuration,
Software Policy, Patch Policy, Audit, and Snapshot Result. For more information on how to
use the search tool, see “SAS Client Search” on page 78.

Figure 3-4: Search in theSAS Client
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Content Pane

Depending on the selection in the Navigation pane (Devices, Library, Reports, Jobs and
Sessions, Opsware Administration), the Content pane lists the following information:

All managed servers and device groups, including unmanaged servers
Agent deployment information

Application Configurations and Application Configuration Templates
Software Policies

Audit and Remediation audits, audit policies, and snapshots
Patches and patch policies

OS installation profiles and OS sequences

Packages

Reports and the Compliance Dashboard

Custom attributes

Jobs that the user has run

Access to the Global Shell sessions

Patch configuration and patch compliance rules
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Figure 3-5 is an example of the content pane for managed servers. You can perform
actions on features in the Content area using the Action Menu or Action Pane, or you can
right-click to perform various actions or double-click to open.

Figure 3-5: Feature Content Window Showing the Managed Server
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Content Pane Tools
From inside the Content pane, you can perform the following actions:

+ With the View drop-down list, you can change the view of a selected feature. For
example, you can select a server from the Contents pane, and then from the View
drop-down list, choose Installed Packages. This shows all packages installed on the

server, as shown in Figure 3-6.

Figure 3-6: View Drop-down List
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+ In the column headings of the Content pane, you can sort data about a feature. For
example, for a managed server, you can sort by server Patch Compliance, IP address,
OS, and so on.

« With the search tool, you can search the Content pane by feature attribute, as shown

in Figure 3-7.

Figure 3-7: Search Tool

S ppdoress v [1o21889] |

Details Pane

The Details pane allows you to preview information about servers, device groups, patches,
and patch policies selected in the Content pane without having to open a new window.

You can use the Details pane to perform the following actions:

+ Preview information about a server, device group, patch, or patch policy by selecting
it in the Content pane.
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area, by choosing a view from the View drop-down list.

To deactivate the Details pane, from the View menu, select Details Pane » Minimize.

For example, if you are viewing Windows 2003 patched from the Library, you can select a
patch in the Contents pane and see information about the patch in the Details pane. This

is shown in Figure 3-8.

Figure 3-8: Main Application Windows Showing Patch Properties Information in the Preview Pane
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If you would like to view other types of information about the selected patch, from the
View drop-down list, choose a view.

Details Pane Show Filter

Some features displayed in the Details pane allow you to further filter the feature. Using

the Show drop-down list, you can
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For example, if you are viewing all of the servers that the patch policy is attached to, in the
Details pane, you can select to filter either Servers with Policies Attached or Servers with
Policies Not Attached, as shown in Figure 3-9.

Figure 3-9: Details Pane Show Drop-down List

&/ Windows 2003 MLOS

Status Bar

At the bottom of the SAS Client Application window, the status bar provides the following
information:

+ Informational text (left hand side) about the selected object

+ A progress bar that shows progress on retrieving information from the core
* The user ID

+ The current Opsware SAS time

Figure 3-10: SAS Client Status Bar
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SAS Client Search

In the SAS Client, you can search for any information about your operational environment
that is available in Opsware SAS using the SAS Client Search feature. The Search feature
enables you to search for Application Configuration, Application Configuration Template,
Audit, Device Group, Folder, Job, Patch, Patch Policy, Server, Snapshot Result, Software,
and Software Policy.

The SAS Client Search feature enables you to perform the following actions:
« Perform a simple search by using keywords.
+ Perform an advanced search by creating search queries.

« Save a search query.

78 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 3: Getting Started with SAS Client

» Perform actions on search results.

« Email search results by exporting the search results to .csv/.html and then attaching the
exported file to the email.

+ Print search results by exporting the search results to .csv/.html and then printing from
an application that supports .csv/.html.

+ Customize search results formatting.

You cannot search for Custom Fields on servers using the SAS Client Search feature. To
search for Custom Fields on servers, use Server Search in the SAS Web Client. See
“Server Search” in Opsware® SAS User’'s Guide: Server Automationfor more information.

Performing a Simple Search

In the SAS Client, a simple search enables you to search for items by entering a keyword
in the search text field. When you enter a keyword or text, simple search carries out a
“contains” operator search on the entered text.

The search operation returns only items on which you have at least read permissions. To
perform an action on an item, you must have write permission on that item.

Perform the following steps to carry out a simple search:

El From the Navigation pane, select Search.

B To display Search in the navigation pane, select Search Pane from the View menu.
From the drop-down list, select the item you want to search as shown in Figure 3-11.

Figure 3-11: Simple Search in the SAS Client
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Bl Enter the search text in the text field. The SAS Client search feature does not support
a wildcard search and the search is not case sensitive.

Click to search. The search results appear in the Content pane.

(Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

(Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search and click Save. The name of the saved search cannot
be more than 64 characters.

E (Optional) Click Export to export search results. The Export Results window appears.
Enter the location, file name and file type and then click Export Results.

El (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html files.

EIJ (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Performing an Advanced Search

In the SAS Client, an Advanced search enables you to create complex queries on search
items. In a search query you can specify up to five rules and combine each rule with a
logical “And” or “Or” operator. You cannot use both the “And” and “Or” operator in a single
search query. Each rule is a combination of an attribute/operator/value that enables you
to search for a specific attribute value for the selected search item. Depending on the
attribute that you select, the options for the operator and value are displayed. You can
specify the attribute values by entering text or a numerical value in the text field, by
selecting a value from the drop-down list, or by selecting multiple values from a list of
values in the Select Values window.

The Select Values window appears when you need to specify multiple values for a rule
containing an “equals” or “not equals” operator. In this window, you can select multiple
values from the list or add values to the Available field.

The search operation returns only items on which you have at least read permissions. To
perform an action on an item, you must have write permission on that item.
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Perform the following steps to carry out an advanced search:

El From the Navigation pane, select Search. To display Search in the navigation pane,
select Search Pane from the View menu.

H Click Advanced Search. The Advanced Search page appears in the Content pane.
By default, the search item Server is selected in the first drop-down list and one
search rule is added to the search.

B From the first drop-down list, select the item you want to search.

Figure 3-12: SAS Client Search
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Bl Create a rule by selecting the attribute from the second drop-down list. Depending
on the attribute that you select, options available for the operator and values for the
rule will change.

B Select the operator from the third drop-down list. The operator selected defines how

the search text is treated.

B Enter a value in the field or select a value from the drop-down list or click [ to
select multiple values from the Select Values window.

Click to add additional rules and repeat steps 4 to 6. Click E] to delete any
rules.

B Select the logic (And/Or) to be applied for every rule in the query.

El Click Search to run the search query. The search results appear in the Content pane.

K (Optional) Click Reset to clear the search query rules or click Cancel to cancel the
search operation.
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EEl (Optional) Click on any column heading to sort the search results. You can also
change the order of the columns by dragging the column heading and dropping it
into the desired location.

EH (Optional) Click Save to save your search query. The Save Search window appears.
Enter the name of the search query and click Save. The name of the saved search
cannot be more than 64 characters. The saved search query appears in the Saved
Searches.

EEl (Optional) Click Export to export search results. The Export Results window appears.
Enter the location, file name and file type (.csv or .html) and then click Export
Results.

K3 (Optional) After you export the search results, you can email the search results by
attaching the exported file to the email. You can also print the search results by
printing the exported file from an application that supports .csv or .html.

EE (Optional) To perform an action on the search results, select an item from the
Content pane and then from the Actions menu, select the appropriate action.

Running a Saved Search Query
Perform the following steps to run a saved search query:
E From the Navigation pane, select Search.

H From the Saved Searches drop-down list, select a search query. The query appears
in the content pane.

Click Search to run the query. The search results will appear in the content pane.

Deleting a Saved Search
Perform the following steps to delete a saved search query:
El From the Navigation pane, select Search.

H From the Saved Searches drop-down list, select a saved search query. The saved
search appears in the Content pane.

Click Save. The Save Search window appears.

Select the saved search and click Delete. Click Delete on the confirmation window
to delete a saved search.
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Accessing SAS Client Options

You can configure the following options for the SAS Client:

.

General Options: This enables you to set options such as choosing the core you want
to log into by default, how to handle caching, and so on.

Unmanaged Servers: This enables you to set options for the Opsware Agent
Discovery and Deployment (ODAD) feature.

Packaging Servers: This enables you to view and specify packaging servers available
on the core.

Terminal and Shell: This enables you to configure your Terminal (UNIX) and RDP
(Windows) client for the Global Shell and Remote Terminal connections.

Patch Policies: This enables you to specify that a confirmation message will display
when you try to remove a patch policy or a patch policy exception from a managed
server.

Opsware NAS: This enables you to reset the name of the NAS host that you log into,
restore the previously saved (default) host name, and launch the NAS login window.

Accessing SAS Client Options

To set SAS Client options, perform the following steps:

E From the Tools menu, select Options.

H From the left side of the Set Options dialog box, choose an option.

General Options

The following general options enable you to select your default core:

Core Server Defaults

This option allows you to configure the core that you log into from the SAS Client. Options
include:

.

Host: The name or IP address of the SAS Web Client host that you log into by default.

Port: The port number of the SAS Web Client host that you log into by default; 443 is
the default.
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Cache

This option enables you to configure the caching of data displayed inside the SAS Client.
You can configure the following cache settings:

« Check for updates every X minute(s): Enter a value for how many minutes will pass
before the cache is refreshed.

« Update Cache: Click to check instantly for new information from the core.
* Reload the Cache: Click to immediately reload (refresh) the cache.

Progress Information
This option shows the progress of a job. When a job finishes, the Progress window closes.

Equals Operator Limit in Search and Reports

This setting limits the number of available value selections in the Select Values | Available
selection in the Advanced Search and Reports interfaces. To prevent delays and
excessive system load, the list of available values is not populated when the number of
values exceeds this setting. Values are added by entering them in a text box.

Unmanaged Servers

These options allow you to control the operation of the ODAD. You can set the following
ODAD options:

« Installer Options
» Protocols
» Advanced

See Chapter 4, “Opsware Agent Management” on page 91 of this guide for more
information.

Installer Options

From the Installer Options window, you can set the Installer options and control the
installation of an Opsware Agent on a server. The Installer Options window enables you to
perform the following actions:

- Start the Opsware Agent after Installation: This option starts the Opsware Agent
after installing it on the server. By default, the Opsware Agent Installer does not start the
Opsware Agent.
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Remove existing machine IDs and cryptographic material: This option removes any
existing machine specific identifying materials, such as Machine ID file (MID), and all
machine-specific cryptographic material from the server.

Ignore prerequisite check failures: This option ignores prerequisite check failures and
forces Opsware Agent installation.

Set the server’s time from the Opsware core: This option synchronizes the time on
the server in which the Opsware Agent is installed with the Opsware core.

Install Windows Installer (MSI) if required: This option installs MSI along with the
Opsware Agent. If MSl is already installed, this option has no effect.

Install Windows Management Instrumentation (WMI) if required: This option
installs WMI along with the Opsware Agent. If WMI is already installed, this option has
no effect.

Reboot Windows servers after agent installation: This option reboots Windows
servers after Opsware Agent installation is complete.

Install Red Hat Package Manager (RPM) on AIX and Solaris: This option installs the
RPM handler with the Opsware Agent. Opsware recommends that you always include
this option when you install Opsware Agents on Solaris and AlX servers.

Reset Opsware Agent configuration, if present: This option replaces the existing
Opsware Agent configuration.

Delete gateway address list, if present: This option deletes the Opsware Gateway
address list, if present and is no longer required.

Overwrite staged Opsware Agent installer: This option overwrites the existing
Opsware Agent Installer.

Log Level: This option sets the log level for log messages. With this option, you can
specify levels for error, warning, info, and trace.

Protocols

The Protocol window allows you to specify the standard port to connect to the servers for
deployment. The following protocols are used:

+ SSH: This is the standard port to connect to the servers for deployment using the SSH

protocol.

* Rlogin: This is the standard port to connect to the servers for deployment using the

Rlogin protocol.
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Telnet: This is the standard port to connect to the servers for deployment using the
Telnet protocol.

NetBIOS: This is the standard port to connect to the servers for deployment using the
NetBios protocol.

WTS: This is the standard port to connect to the servers for deployment using the WTS
protocol.

Advanced

The Advanced Installer Options window allows you to set the following options:

Immediately do a full hardware registration: This option forces the Opsware Agent
Installer to report full hardware information to the core.

Immediately do software registration: This option forces the Opsware Agent Installer
to report full software information to the core.

Suppress Opsware Agent reachability check: This option disables this check during
installation. By default, the installer triggers the core to check if the server is reachable.

Disallow anonymous SSL connections if Opsware Agent is dormant: This option
configures the Opsware Agent so that browsers cannot connect without a valid
certificate.

Force creation of new device record if conflict found: This option suppresses this
functionality. During registration, the Data Access Engine creates a new device record.

Fail if initial hardware registration fails (do not go dormant): This option does not
allow the Opsware Agent to become dormant, if it fails to report hardware information.

Do not open Windows Firewall for core-agent communications: By default, the
Opsware Agent Installer will modify the Windows Firewall configuration on Windows XP
and Windows 2003 (r2) servers to allow the Opsware core to contact the managed
server on port 1002. If you select this option, the firewall configuration will not be
modified. The server may not be manageable by Opsware in this case.

Remediate software policies: Remediates the server against any software policies
attached to the server.

Attach to software Policy ID: Attaches server to the software policy <ID>.

Reconcile Type: This option reconciles the server against any nodes assigned to the
server. The reconcile type can be Full or Add only.

86 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 3: Getting Started with SAS Client

« Attach to template ID: This option assigns the nodes contained in the template to the
server.

+ Install directory (UNIX): Allows you to specify the directory where the Opsware
Agent will be installed. By default, the Agent is installed in /opt/opsware/agent
on UNIX, and $ProgramFiles%\Opsware\agent on Windows.

« Extra Installer options: This option allows you to specify any other installer options.

* nmap parameters: This option allows you to specify parameters used when scanning
for unmanaged servers. If you find that the Opsware Discovery and Agent Deployment
is unable to correctly locate and identify unmanaged servers due to the network firewall
configuration, you can specify a different set of scan parameters. See the nmap
documentation for more information.

Packaging Servers

In order to create packages with the SAS Client, you need to configure a managed server
in your Opsware core as a packaging server.

The Set Options window lists all configured packaging servers on the core. To sort the list
alphabetically by operating system, click the OS column heading. To sort this list of
servers by existing configured packaging servers, click the Default Server column
heading. For servers that are already configured as packaging servers, the IP address is
displayed in this column. For servers that are not configured as packaging servers, Not
Configured is displayed in this column.

To configure a packaging server, perform the following steps:
H In the right pane, select a managed server and click Edit.

H In the Select Server window, select the managed server that you want to configure
as the packaging server and then click Select. In the Set Options window, the
Default Server column will now display the IP address of the server. (Before you
configured this as the packaging server, the Default Server column displayed Not
Configured.)

HE nthe Set Options window, click Save to save your changes or click Cancel to close
this window without saving your changes.
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Terminal and Shell

These settings define the command that the SAS Client invokes on your PC to open a
Global Shell or Remote Terminal session. (For instructions on using an ssh client instead
of the SAS Client, see “Opening a Global Shell Session” on page 310.)

Terminal Client: This setting specifies the terminal client that the SAS Client uses for
Remote Terminal sessions on Unix managed servers and for Global Shell sessions. The
default value is:

cmd /c start /w cmd /c "telnet %h %p && echo %m && pause > nul"

The telnet program emulates a command-line terminal session. The $h represents the
host and the %p is for the port. (See Table 3-1.)

If you change the Terminal Client setting from the default value, make sure that the
command blocks until the terminal application terminates. The terminal application must
not run in the background. If you specify cmd /c start, include the /w switch to make
cmd block until the underlying command (such as telnet) completes.

You are not required to use telnet as the terminal application. For example, to use a PuTTY
client, specify the following command:

"C:\\Program Files\\putty\\putty.exe" -telnet %h %p

RDP Client: This setting specifies the remote desktop protocol (RDP) client that the SAS
Client uses for Remote Terminal sessions on Windows managed servers. The default
value is the Microsoft Terminal Services Client:

mstsc "%r"

The SAS Client supports the Windows XP version of the Remote Desktop Connection
Software, which can be downloaded from the following URL
. http://www.microsoft.com/windowsxp/downloads/tools/rdclientdl.mspx

The specified terminal client must be installed on your PC. To verify the existence of the
terminal client, click Test.
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The command can include variables such as $h and %p. When the terminal client is
launched, these variables are replaced with the values shown in Table 3-1. To override a
replacement value, specify a constant instead of a variable. For example, you might
specify 435 for the port instead of %p.

Table 3-1: Variables for the Terminal and RDP Client Options
The character encoding. | For Remote Terminal sessions, the encoding of the managed

server. For Global Shell sessions, the value of the Encoding
field.

o\°
(]

o\°
a3

The host name that the | The value of the 1ocalhost of the managed server.
telnet client connects
to.

A locale-specific For English locales, Click the Enter key to close this window.

o\
3

message on how to
close the window.

The port that the telnet | A randomly chosen port.
client connects to.

o\°
e}

The name of the A temporary RDP file generated at runtime by the SAS Client.
Remote Desktop (RDP)

connection file. This

variable is used only for

the Microsoft Terminal

Services Client

o\°
R

(mstsc).

The title displayed in the | For Remote Terminal sessions, the name of the managed
terminal window. server. For Global Shell sessions, the string “Global Shell.”

o\
pa

Encoding: This setting sets the encoding for Global Shell and the Remote Terminal
sessions. This option is the replacement value of the %e variable in the command
specified by the Terminal Client field. The default value of the Encoding option is UTF-8.

Patch Policies

This option allows you to specify that a confirmation message will display when you try to
remove a patch policy or a patch policy exception from a managed server.
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Opsware NAS

This options allows you to reset the name of the NAS host that you log into, restore the
previously saved (default) NAS host name, and test whether SAS can communicate with
NAS by using the new host name.

« Host: This option specifies the name of a server that is acting as a proxy for the NAS
host. Only the format of the host name is verified.

* Restore Default: This option restores the previously saved NAS host name.

» Test: This options opens the Opsware NAS login window to verify whether the host
name is valid.
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This section discusses the following topics:

+ Opsware Agent on Managed Servers

+ Opsware Discovery and Agent Deployment
« Opsware Agent Installation Using ODAD

« Viewing Unmanaged Server Information

+ Agent Reachability Communication Tests

Opsware Agent on Managed Servers

This section provides information about the Opsware Agent on managed servers and
contains the following topics:

« Overview of the Opsware Agent on Managed Servers
+ Security for Opsware Agents Running on Managed Servers
« Opsware Agent Functionality on Managed Servers

« Server Information that the Opsware Agent Tracks

Overview of the Opsware Agent on Managed Servers
The Opsware Agent regularly performs management tasks on each server autonomously:

On a regular interval, the Opsware Agent gathers a hardware and software inventory of
each managed server. It opens a secure communication channel to the Opsware core,
presenting its IP address and public-key certificate for authentication purposes. If properly
authenticated, the Opsware Agent is permitted to write its updates about the server to the
Opsware Model Repository.
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Every 12 hours, the Opsware Agent submits hardware information for the managed server
on which it is running. Hardware registration also occurs during Opsware Agent
installation or software installation. Every 24 hours, the Opsware Agent submits software
information for the managed server to the Opsware core. See Figure 4-1.

Figure 4-1: Server Management Tasks Performed by Opsware Agent

Every 12 hours the Opsware Agent inventories the managed servers it runs on,
registering hardware information in the Opsware System Core.

Managed Servers OPSWARE STANDALONE CORE

Servers with the - N -
Opsware Agent The Model Repository \

' Gateway | | Registered Hardware:
A A e memory
v v b o disk drives

® network cards
| e CPUs

The Reporting field indicates the status of the Opsware Agent's reporting capability and
tells you whether or not the Opsware Agent is reporting regularly and successfully. The
four possible reporting states for the Opsware Agent are as follows:

OK: The Opsware Agent is reporting properly.

* Registration in progress: The Opsware Agent is currently registering server
hardware information.

* Reporting error: The Opsware Agent encountered an error while trying to report
hardware information.

+ Last reported days ago: This indicates when the Opsware Agent last reported.

You can access Opsware Agent reporting information in Server Properties by using
advanced search, and by viewing managed servers by Communication status. When
viewing by Communication status, the SAS Web Client user interface displays this
information in the registration column.

If the Opsware Agent experiences an error in reporting, or has not reported within 24
hours, you can run a Communication Test to troubleshoot the problem.

If you modify the server hardware, it could take up to 12 hours for the change to appear in
the SAS Web Client user interface, depending on the time that the Opsware Agent for that
server contacted the Opsware core.
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If you install or uninstall software on a managed server outside of Opsware SAS, it could
take up to 24 hours for the change to appear in the SAS Web Client user interface. For
example, if you update the Microsoft Patch Database, it could take up to 24 hours for all
managed servers to display whether they need new patches based on the updated
Microsoft Patch Database.

In some cases, not all of a server's hardware information is reported. For example, if the
Opsware Agent was installed with its default settings, not all hardware information is
reported to the SAS Web Client until an hour after the agent is installed. There also might
be a problem retrieving certain hardware information, such as a disk failure, that could
prevent some hardware information from being reported. In these cases, the server’s
property page lists unreported information as not set.

If configuration tracking is enabled for a server, the Opsware Agent sweeps through the
managed server on a regular interval to see if any of the configurations being tracked are
changed. If a tracked configuration is changed, the Opsware Agent performs the action
specified by the tracking policy, namely, writing the information to a log file, generating a
backup, or sending an email message through SMTP to the email address specified in
the tracking policy.

Security for Opsware Agents Running on Managed Servers

Opsware Agents act as both clients and servers when they communicate with Opsware
SAS. All communication is encrypted, integrity-checked, and authenticated using X.509v3
client certificates using SSL/TLS.

A small number of Opsware core components can issue commands to the Opsware
Agent over a well-defined TCP/IP port. The Opsware Agent can also call back to Opsware
core components, each with its own well-defined port.

The Code Deployment & Rollback (CDR) feature uses agent-to-agent communication for
performance reasons. In particular, CDR synchronizations (the process of copying
changed files and directories from one server to another) happen when an Opsware
Agent connects to another Opsware Agent and sends across the network files that have
changed since the last time the two Opsware Agents connected.

To further safeguard the SSL/TLS-based communication channel, the two Opsware
Agents participating in the code deployment also need to have a common shared secret
provided by the Command Engine. Before one Opsware Agent can begin a file transfer to
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another Opsware Agent, the two agents must verify that they have a common shared
secret provided on a per-session basis by the Command Engine. This safeguard prevents
unauthorized users from copying files from one managed server to another.

Opsware Agent Functionality on Managed Servers
The Opsware Agent is designed such that:
« |t can only discover information about its own managed server (and no others).

+ It cannot make changes on a server unless explicitly instructed to do so by an Opsware
core component.

Opsware SAS runs with administrator privileges (root on UNIX servers and Local System
on Windows servers), because it performs tasks that require administrator privileges,
such as installing patches and rebooting servers.

The Opsware core performs client authentication and, checks to see if the presenting
certificate belongs to that particular server. Opsware SAS does this by comparing the
certificate to the server's IP address that is generated when the Opsware Agent is initially
installed. If the certificate is not valid or the originating IP address does not match the IP
address stored in the Opsware Model Repository, authentication fails and the Opsware
Agent cannot continue communication with Opsware SAS.

If an unauthorized user were able to log on to a managed server with administrator
privileges and compromise a server's security, the user would have only limited access to
the following information in the Opsware Model Repository:

« The server's own hardware inventory (already available to someone logged on with
administrator privileges)

+ The server's own software inventory (already available to someone logged on with
administrator privileges)

* The custom attribute information
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Server Information that the Opsware Agent Tracks

For each managed server, the Opsware Agent reports software, networking, and hardware
information, as shown in Figure 4-2 and Figure 4-3. By communicating with the Opsware
core and reporting the installed hardware and software for the server, Opsware SAS
determines what software should be installed on a server.

Figure 4-2: Manager Servers: Properties Page-Server Information

Manage Servers: Properties | core tr3. opsware.com

Return to Manage Servers

Properties

MANAGEMENT INFORMATION

Name: |core.tr3.0psware.com |

MNotes:

IP Address: 172.16.36.18
05 Version: Red Hat Enterprise Linux AS 3
Customer:
Facility: DATACENTER1
Server Lse:
Deployment Stage:
Config Tracking:

Console: {notsef
Opsware Lifecycle: Managed
Server ID: 10003

Status: ot Reachable as of Tue May 17 13:11:28 2005
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Figure 4-3: Server Properties-Hardware and Additional Information

REPORTED INFORMATION (as of Tue May 17 19:05:47 2005)

96

Reporting:
Agent Version:
Hostname:
Reported 0S:
MAC Address:
Serial Number:
Chassis ID:
Manufacturer:
Model:

CPUs:

Memony:

Storage:

Metwork:

Ok

3002102

coreird.opsware.com

Linuz 3AS

00:11:43:07:2F:4F

2YLLPE1

2LLPA1

DELL COMPUTER CORPORATION
FPOVWEREDGE 18250

Model Cache Size

VYendor Speed

GEMUINEIMTEL
GEMUIMEIMTEL
GEMUIMEIMTEL
GEMUINEIMTEL

IrteliR) Heon(Th) CPL 2.506Hz
IrteliR) ¥eon(Thi) CPU 2.80GHz
IrteliR) ¥eoniThi) CPU 2.50GHz
IrteliR) ¥eon(Th) CPU 2.506Hz

2793 MHz
2793 MHz
2793 MHz
2793 MHz

1 MB
1 MB
1 MB
1 MB

Capacity
3.8GH
185GB

Type
e
SYNAP

Drive Media Capacity Bus Tvpe Model

hda
zda

CDROM - IDE SAMSEUNG CD-ROM Sh-124
SCSIDISK B8.24 GB  SCE| MegaRalD LD 0 RAIDD 653G

See the Metwork tab

Cancel

Software Information

The software that should be installed is recorded in the Opsware Model Repository. To
access that information, click the Install List or Installed Packages tabs. This shows the
software that should be installed on the server or all software that is installed on the

server.

To display the list of what software packages should be installed on that server, select
the Install List tab from the Manage Servers: Server Properties page.

To display the list of software that is reportedly installed on the server, select the Installed
Packages tab from the Managed Servers: Server Properties page.

Partially-installed Solaris packages do not show up in the Installed Packages list, even
though the package was partially installed.
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Opsware SAS tracks hardware information in a variety of manners. Table 4-1 shows how
the Opsware Agent obtains the server and hardware information about each managed

server.

Table 4-1: Hardware Information that the Opsware Agent Reports for Servers

Name

Reported OS

OS Version

Serial
Number

Manufacturer

The user-configurable
name for the server.
By default, Opsware
SAS uses the
configured host name
of the server until a
user edits it.

The version number
of the server's
operating system.

The OS version
specified for the OS
definition.

The serial number of
the system. Opsware
SAS attempts to
report a chassis ID, if
possible.

The manufacturer of
the server if available.

Windows: Uses the fully qualified DNS name of
the server.

Linux, Solaris, AIX, HP-UX: Uses the current
host name of the server that the hostname
command returns.

Windows: Uses the Windows version number as
reported by the operating system. This information
includes the major version number, the minor
version number, the Windows build number, and
the Service Pack level.

Linux, Solaris, AIX, HP-UX: Uses the operating
system version that the uname command returns.

Specified by the user who prepared the OS with
the Prepare Operating System Wizard.

See the Opsware® SAS Policy Setter’s Guide for
more information.

Windows, Linux: Obtained from the system BIOS.

Solaris, AlX, HP-UX: Obtained from the system
ROM.

Windows, Linux: Obtained from the system BIOS.

Solaris, AlIX, HP: Obtained from the system ROM.
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Table 4-1: Hardware Information that the Opsware Agent Reports for Servers (continued)

Model The model of the Windows, Linux: Obtained from the system BIOS.

server if available. Solaris, AIX: Obtained from the system ROM.

HP-UX: Output of model command (which is read
from the system ROM).

Memory The amount of Windows: Uses the Windows 2000 API
physical RAM and the | GlobalMemoryStatus ().
total amount of virtual
memory paging
space configured.

Linux: Obtained from information in the file

/proc/meminfo.

Solaris: Obtained from the sysconf and
swapctl APIs.

AIX: Uses the 1sattr command for memory
information and the 1sps command for paging
space.

HP-UX: Uses the pstat system call.

Processors | Information about Windows: If WMI is available, iterates over all
each of the instances of Win32 Processor. If WMI is not
processors in the available, parses the registry key
system. HARDWARE\DESCRIPTION\System

\CentralProcessor. There is one sub-key for
each processor.

Linux: Obtained from information in the file

/proc/meminfo.

Solaris, HP-UX: Uses system APIs to enumerate
the processors in the system.

AIX: Uses the 1scfg command.

Storage Information about All Platforms: Uses system APIs to discover and
each installed disk probe disk drives and RAID arrays.
drive or RAID array.
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Table 4-1: Hardware Information that the Opsware Agent Reports for Servers (continued)

Server ID The internal ID that
Opsware SAS uses to
identify the server.

MID The MID (Machine ID)
iS a unigue number
that Opsware SAS
assigns when the
server first registers.
The server stores the
MID and reports it
each time the server
registers.

In most cases, the server ID is the same as the
MID.

Windows: The MID is stored in the file
$ProgramFiles%\Common

Files\Loudcloud\cogbot\mid if present.

Linux, Solaris, AIX, HP-UX: The MID is stored in
the file /var/lc/cogbot/mid.

In addition to hardware and software reporting, the Opsware Agent reports networking
information. See “Network Configuration” on page 280 in Chapter 7 for descriptions of the
networking information reported and how you can modify that information using the

Network tab in the SAS Web Client.

Opsware Discovery and Agent Deployment

The Opsware Discovery and Agent Deployment (ODAD) feature helps to deploy Opsware
Agents to a large number of servers through the Opsware SAS Client (SAS Client). This
feature helps to identify servers on which to install an Opsware Agent, specify the
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deployment actions to be carried out on each server, select the login protocols to connect
to each server, specify the Opsware Agent Installer options for installing an Opsware
Agent, and generate reports on Opsware Agent installation status. See Figure 4-4.

Figure 4-4: Agent Deployment Process

AGENT DEPLOYMENT PROCESS

SAS Client SAS Client SAS Client SAS Client
- Unmanaged Managed
8 i?gé%giﬁﬁ@ (0] Server% (0] Servgrs
A ~1Ra@a@ IR
D IP Range A ‘ ‘ ‘ A Password/Login A “‘
172.34.65.30 - 70 D | root/@mb3r

STEP 1 STEP 2 STEP 3 STEP 4
User launches Scan results User selects one or Server list is updated
the ODAD in the (unmanaged servers) more servers, provides to show agent
SAS Client , selects are displayed password/login, sets installation status.
scan location in the SAS install options, and
and range of IP Client. clicks install.
address.

This overview section contains the following topics:

» Discovering Servers for Installing an Opsware Agent

« Setting Deployment Actions for Each Server

» Specifying Login Settings

» Opsware Agent Installer Options

» Reports on Server Status

See “Installing Opsware Agents Using ODAD” on page 107 in this chapter for information
about how to install an Opsware Agent.

Discovering Servers for Installing an Opsware Agent

Using the Opsware Discovery and Agent Deployment feature, you can select a location to
scan for servers. After selecting a location, you can specify the IP addresses or IP address
ranges to perform a network scan to identify servers in which to install an Opsware Agent.
Instead of performing a network scan, you can also import a file containing a list of IP
addresses or IP address ranges. When the scan is complete, a list of scanned servers is
shown.
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For each server, this feature determines the status of the server, its IP address, its host
name, detected operating system, and open ports used to connect to the server.

Setting Deployment Actions for Each Server

Once you have identified the servers, you can select the servers and perform the
following deployment actions:

« Verify installation prerequisites.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server. The verification checks include:

+ Checking for sufficient disk space for Opsware Agent installation on the server
 Verifying that no other application is using port 1002
+ Verifying if ports to the Opsware Gateway are accessible

« Verify prerequisites, and copy the Opsware Agent Installer to servers.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server and the Opsware Agent Installer
is copied to the server.

« Verify prerequisites, copy installer, and install Opsware Agent.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server, the Opsware Agent Installer is
copied to the server, and the Opsware Agent is installed on the server.

Specifying Login Settings

After selecting the deployment action, you can select the network protocols to connect to
the server and specify the user name and password to login to each server. The Opsware
Agent needs administrator-level privileges (root on Unix servers and administrator on
Windows servers) to manage a server. Therefore, Opsware Agent installation is performed
as root on Unix operating systems and as administrator on Windows operating systems.
ODAD tries to log into each of the selected servers with the specified user name and
password and performs the specified deployment actions.
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Opsware Agent Installer Options

The Opsware Discovery and Agent Deployment feature allows you to specify the installer

options listed in Table 4-2.

Table 4-2: Opsware Agent Installer Options

Start the Opsware Agent after Installation

Remove existing machine IDs and
cryptographic material

Ignore prerequisite check failures

Set the server’s time from the Opsware
core

Install Windows Installer (MSI) if required

Install Windows Management
Instrumentation (WMI) if required

Reboot Windows servers after agent
installation

Install Red Hat Package Manager (RPM) on
AlIX and Solaris

Reset Opsware Agent configuration, if
present

Starts the Opsware Agent after installing it
on the server. By default, the Opsware
Agent Installer does not start the Opsware
Agent.

Removes any existing machine specific
identifying material such as Machine ID file
(MID), and all machine-specific
cryptographic material from the server.

Ignores the prerequisite check failures and
forces Opsware Agent installation.

Synchronizes the time on the server in
which the Opsware Agent is installed to the
Opsware core.

Installs MSI along with the Opsware Agent.
If MSI is already installed, this option has
no effect.

Installs WMI along with the Opsware Agent.
If WMI is already installed, this option has
no effect.

Reboots windows servers after Opsware
Agent installation is complete.

Installs the RPM handler with the Opsware
Agent. Always include this option when you
install Opsware Agents on Solaris and AIX
servers.

Replaces the existing Opsware Agent
configuration.
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Table 4-2: Opsware Agent Installer Options (continued)

Delete gateway address list, if present

Overwrite staged Opsware Agent installer

Log Level

Use Opsware Gateways

Immediately do a full hardware registration

Immediately do software registration

Suppress Opsware Agent reachability
check

Disallow anonymous SSL connections if
Opsware Agent is dormant

Force creation of new device record if
conflict found

Fail if initial hardware registration fails (do
not go dormant)
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Deletes the Opsware Gateway address list
if present and is no longer required.

Overwrites the existing Opsware Agent
Installer.

Sets the log level for log messages. With
this option, you can specify the log levels
of error, warning, info, and trace.

Specifies the Opsware Gateways used
during Opsware Agent installation.

Forces the Opsware Agent Installer to
report full hardware information to the
Opsware core.

Forces the Opsware Agent Installer to
report full software information to the
Opsware core.

By default, the installer triggers the core to
check if the server is reachable. This option
disables this check during installation.

Configures the Opsware Agent so that
browsers cannot connect without a valid
certificate.

During registration, the Data Access Engine
creates a new device record. This option
suppresses this functionality.

Does not allow the Opsware Agent to
become dormant, if it fails to report
hardware information.
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Table 4-2: Opsware Agent Installer Options (continued)

Do not open Windows Firewall for core- By default, the Opsware Agent Installer will

agent communications modify the Windows Firewall configuration
on Windows XP and Windows 2003 (r2)
servers to allow the Opsware core to
contact the managed server on port 1002.
If you select this option, the firewall
configuration will not be modified. The
server may not be manageable by
Opsware in this case.

Remediate software policies Remediates the server against any
software policies attached to the server.

Attach to software Policy ID Attaches server to the software policy
<ID>,

Extra Installer options Allows you to specify any other installer
options.

Install directory (UNIX) Allows you to specify the directory where

the Opsware Agent will be installed. By
default, the Agent is installed in /opt/
opsware/agent on UNIX, and
$ProgramFiles%\Opsware\agent on

Windows.

Reports on Server Status

After the deployment action is complete, the SAS Client displays the results and updates
the status icons for the servers as shown in Table 4-3.

Table 4-3: Server Status

The server is unmanaged.

5
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Table 4-3: Server Status (continued)

The server is managed by Opsware.

The server failed prerequisite checks.
The server passed prerequisite checks.

The server passed prerequisite checks and
-f-l the Opsware Agent Installer was copied to
|:|;‘JJ the server.

The Opsware Agent was successfully
‘ deployed.

The Opsware Agent was not successfully
deployed.

A server is considered to be managed by Opsware when the ODAD determines that the
Opsware Agent is listening for TCP connections on port 1002.

For a failed deployment action, you can view the errors on each server. You can also log
into the server from this feature and correct the errors.

Using this feature, you can create the following reports:

» All the servers in the current network scan
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+ Selected servers in the current network scan
« All the servers in the current network scan with successful deployments
« Servers in the current network scan with failed deployments

You can save and export the reports to a CSV, HTML, or text format file.

Opsware Agent Installation Using ODAD

The Opsware Discovery and Agent Deployment (ODAD) feature helps you to deploy
Opsware Agents to a large number of servers through the SAS Client. This section
contains the following topics:

» Prerequisite Setup for Opsware Discovery and Agent Deployment
+ Permissions Required for Opsware Discovery and Agent Deployment

« Installing Opsware Agents Using ODAD

Prerequisite Setup for Opsware Discovery and Agent Deployment

Before you can install Opsware Agents using ODAD, you must install the Windows Agent
Deployment Helper package (required for installing Opsware Agents on Windows server
only) and install JRE version 1.4.2_10 for running the SAS Client.

See the Opsware® SAS Planning and Installation Guide for more information about
installing the Windows Agent Deployment Helper Package.

See “Requirements for Running the SAS Client” on page 68 in Chapter 3 for information
about installing JRE.
Permissions Required for Opsware Discovery and Agent Deployment

To use the Opsware Discovery and Agent Deployment feature you must have certain
permissions. See Opsware® SAS Administration Guide for more information about the
permissions required to use the ODAD feature.

To obtain the required permissions for scanning and deploying Opsware Agents, contact
your Opsware administrator.
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Installing Opsware Agents Using ODAD

To install Opsware Agents using ODAD, launch the SAS Client from the Opsware SAS
Web Client. See “Installing and Launching the SAS Client” on page 68 in Chapter 3 for
more information.

Perform the following steps to install an Opsware Agent:
H Log into the SAS Client. The SAS Client Page appears.
From the navigation pane, select Devices and then select Unmanaged Servers.

Select a location to scan for servers from the Scan in drop-down list.

Select Supply IP Address Ranges from the drop-down list to specify a set of IP
address ranges to scan. Enter the IP address range in the From and To field. Click the
plus (+) button (next to the To field) to add another IP address range. You can add a
maximum of five IP address ranges. Click the minus (-) button to delete the IP
address range field.

Or

Select Explicit list of IPs from the drop down list to specify the list of IP addresses to
scan. Click the ellipsis (...) button as shown in Table 4-5 to display a text editor that
allows you to load and scan a file with IP ranges to scan.

Figure 4-5: Loading a File with IP Addresses

Scan in |C03 '| IP Addresses | |LJ

|Explicit List of 1Ps -|

B Click Scan to scan for servers. When the scan is complete, the list of scanned
servers is shown. For each server, ODAD determines the status of the server, its IP
address, its host name, the detected operating system, the actual operating system,
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and open ports that can be used to connect to the server. See Figure 4-6. The actual
operating system of the server can be only determined if ODAD is able to
successfully log into the server.

Figure 4-6: Scan Results

Scanin |C12 M from [192.168.193.1 | to [192.168.195.20 | =
|Supplv IP Address Fanges V| | Scan |
| Hostname |IP Address  |Detected 035 |actual 05 [55H  [rlogin [ Telnet  [Metbios
5l 192.168,193.1 Cisco [03 12.%
51'| admin3-eth0-110.dev, opsware,com  192,168,193.2 Linux Linux 2.4,%/2.5.5/2.6,% v
@“ ml23, dev,opsware,com 192,168,193.4 Linux Linux 2,4.%/2,5.% v
Elﬂ 185 dev. opsware, com 192,168,193.5 Linux Linux 2,4.%/2.5.% v v

@ Click on any of the column headings to sort the server list by that column. If you want
to hide managed servers, select Hide Opsware-managed Servers from the View
menu.

Select servers on which you want to deploy the Opsware Agent. The SAS Client
supports hot keys to make multiple selections.

H From the Actions menu, select Deploy Agent. The Deploy Agent dialog box appears
as shown in Figure 4-7.

Figure 4-7: Deploy Agents

Actions

() Merify installation prerequisites

| Merify prerequisites and copy agent inskaller to servers
() Verify prerequisites, copy installer, and install agent

Login Settings

Protocal |Select Automatically vl

Usernarne

Passward
[] Become rook (UNIX)

Installer Options
Advanced

(] (]9 J | Cancel
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El Select one of the following deployment actions:
 Verify installation prerequisites.
« Verify prerequisites and copy agent installer to servers.
 Verify prerequisites, copy installer, and install agent.

See “Setting Deployment Actions for Each Server” on page 101 in this chapter for
more information.

EJ Select a network protocol to log in and connect to the server from the drop-down list.
Or

Choose Select Automatically to allow ODAD to select an appropriate protocol for
each server.

EEl Enter the user name to log into the server. For Windows, log in as administrator. For
Unix, log in as root.

EH If root logging is not allowed, select the Become root (UNIX) checkbox. Select
“Supply root password” and enter the password or select Use sudo, if sudo access is
enabled for that account.

See “Specifying Login Settings” on page 101 in this chapter for more information.

EEl Specify the Opsware Agent Installer options to control the way the Opsware Agent is
installed on a server. See “Opsware Agent Installer Options” on page 102 in this
chapter for more information.

EH Click OK to deploy Opsware Agents to selected servers.

EH After the deployment action is completed, the SAS Client displays the results and
updates the status icons for the servers. You can view information on an unmanaged
server and generate reports on Opsware Agent Installation status. See “Reports on
Opsware Agent Installation” on page 113 in this chapter for more information.

Viewing Unmanaged Server Information

After the deployment action is completed, you can review the results and generate
reports. You can view the summary and history information for an unmanaged server. For
a failed deployment action, you can view the errors on each server. You can also log into
the server from ODAD and correct the errors.

This section discusses the following topics:
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Summary Information for an Unmanaged Server
History Information for an Unmanaged Server
Remote Terminal Sessions on Unmanaged Servers

Reports on Opsware Agent Installation

Summary Information for an Unmanaged Server

The Unmanaged Server Summary browser shows the following information about the
unmanaged server:

Host Name: The host name of the unmanaged server, if defined in the Domain Name
System (DNS).

IP Address: The IP address of the unmanaged server.

Detected OS: The operating system detected on the server after performing the
network scan.

Actual OS: The actual operating system detected on the server after the deployment
action.

MAC Address: The Media Access Control (MAC) address, which is the network
interface card’s unique hardware number of the unmanaged server. The MAC is used
as the server's physical address on the network. The MAC address is only detected if
the server is on the same physical network as the Opsware Gateway.

NIC Vendor: The vendor name for the Network Interface Card (NIC) driver. The NIC
vendor is only detected if the server is on the same physical network as the Opsware
Gateway.

Open Ports: The available open ports on an unmanaged server.

Number of Deployment Attempts: The number of deployment attempts on an
unmanaged server.

Last Deployment Attempt Date/Time): The Date/Time of the last deployment
attempt.

Last Deployment Attempt Message: The message stating the possible cause for the
failure of the last deployment attempt.

Viewing Summary Information of an Unmanaged Server

Perform the following steps to view the summary of an unmanaged server.
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Log into the SAS Client. The SAS Client Page appears.

From the navigation pane, select Devices and then select Unmanaged Servers.

H From the Unmanaged Servers page, select the unmanaged server. From the Actions

menu, select Open.

The Unmanaged Server Browser page appears.

Bl Click Summary on the left side navigation panel of the Unmanaged Server Browser
page to view the summary on the unmanaged server. See Figure 4-8.

Figure 4-8: Unmanaged Server Summary Page

Feature Edit  Yiew Ackions Help

Discovered Information

Hostrname:

IP Address:
Detected 05!
Actual 05
MaC Address:
MIC Yendor:
% Open Parts:
Murber of Deplayment Atkempts:
Last Deployment Attempt Date|Time:
Last Deployment Atkermpt Massage:

192,165.195.93
Microsaft Windows 2003) METMNT/2K =P

139 3589

3

Thu, 7 Apr 2005 15:17:08

The credentials supplied conflict with an existing set of credentials.

| ssunderrajan | Thu Apr 07 23:15 2005

History Information for an Unmanaged Server

The Unmanaged Server History Browser shows a history of all actions executed on

unmanaged servers such as:

+ A summary of the actions performed on the unmanaged server
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» Details of all the actions performed on the unmanaged server

* Log information

The history is read-only.

Viewing History Information of an Unmanaged Server

Perform the following steps to view the history of an unmanaged server:

E Log into the SAS Client. The SAS Client Page appears.

H From the navigation pane, select Devices and then select Unmanaged Servers.

E From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select Open.

The Unmanaged Server Browser page appears.
Bl Click History on the left side navigation panel of the Unmanaged Server Browser
page to view the history of all actions executed on unmanaged servers.
Remote Terminal Sessions on Unmanaged Servers

Using the ODAD feature, you can open terminal sessions on an unmanaged server. You
can log into the server using the appropriate protocol to correct the errors on the server or
perform any other operations.

You can use the SAS Client Remote Terminal and Shell preferences to configure the
Terminal (UNIX) and RDP (Windows) clients used to launch terminal sessions. See
“Overview of the Global Shell” on page 299 in Chapter 9 for more information.

Opening Remote Terminal Sessions on an Unmanaged Servers

Perform the following steps to open remote terminal sessions on a server:

H Log into the SAS Client. The SAS Client Page appears.

H From the navigation pane, select Devices and then select Unmanaged Servers.

H From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select the appropriate log in with protocol.
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Reports on Opsware Agent Installation

Using the Opsware Discovery and Agent Deployment feature, you can create the
following reports:

» All the servers in the current network scan
« Selected servers in the current network scan
« Servers in the current network scan with successful deployments

« Servers in the current network scan with failed deployments

You can also save and export the reports to a CSV, HTML, or text file format.
Creating Reports on Opsware Agent Installation

Perform the following steps to create reports:

H Log into the SAS Client. The SAS Client Page appears.

H From the navigation pane, select Devices and then select Unmanaged Servers.

E From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select Export to the desired report format. The Save Report dialog box
appears.

Bl From the drop-down list, select the type of report as shown in Figure 4-9.

Figure 4-9: Generating Reports

Save In: |0 Desktop '| 53] |E| |§| |ﬁlg_:
£3 My Dacuments |servers with Errors |
3 My Computer 4l Servers

3 My Metwork Places Successful Deployrments
] log.t=t Servers \With Errors

Selected Servers

File Marne: | |

Files of Type: |Text File - |

Save || Cancel |
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B Enter the location and file name to save the report.

Example Report

The following example shows a report of servers with failed deployments.
Servers which the Opsware Agent could not be deployed to:
Hostname : Unknown

IP Address : 192.168.198.93

Detected Operating System : Microsoft Windows 2003 Server or XP
SP2

Open Ports : 139 3389
MAC Address : Unknown
NIC Vendor : Unknown
# of Deployment Attempts : 2

Last Deployment Message : The credentials supplied conflict with

an existing set of credentials.

Last Deployment Attempt Date/Time : "Wed, 6 Apr 2005 16:18:46"
Failed Phase : Check

Return Code : 2013

Suggested Resolution : The Agent Deployment Helper was unable to

log in to the unmanaged server.

An incorrect login name or password was specified. Try a

different login name and/or password.

Agent Reachability Communication Tests

This section provides information on agent reachability Communication Tests within
Opsware SAS and contains the following topics:

+ Overview of Communication Tests
« Communication Tests and Unreachable Opsware Agents

« Communication Test Types
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« Communication Test Errors

+ Additional Information on Communication Tests

* Running a Communication Test on an Individual Server
* Running a Communication Test on Multiple Servers

+ Viewing Servers by Communication Status

« Searching for Unreachable Servers

» Creating Communication Test DCI Reports

» Viewing My Jobs Communication Tests

« Exporting the Unreachable Server Status List to CSV

Overview of Communication Tests

Sometimes an Opsware Agent can become unreachable, which means that the SAS Web
Client has difficulty communicating with the Opsware Agent. When an Opsware Agent is
unreachable, the server it is installed on is considered unmanaged. This section explains
how to use the Communication Test to find unreachable Opsware Agents and suggests

ways that you can resolve these problems.

To help identify those managed servers that have unreachable agents, the SAS Web
Client runs periodic Communication Tests to verify that Opsware SAS can communicate
with all servers under its management. You can always check the reachability of Opsware
Agents by looking at the server’s properties, or by viewing the current agent reachability
status for all managed servers since the last Communication Test was run by choosing
the Communication view from the Manage Servers list.

To determine the current reachability of a specific Opsware Agent, you can run a
Communication Test to find those servers that have unreachable agents by using the
Communication Test feature located in the Server menu of the Manage Server list. A
Communication Test lists all servers with unreachable agents, returns specific errors
associated with each unreachable Opsware Agent, and provides troubleshooting
information to help you get the Opsware Agent back in working order.

You have the ability to check Opsware Agent reachability for individual servers, selected
servers, or all servers under management of Opsware SAS. Each time that you run a
Communication Test, this test is saved in the My Jobs panel, which allows you to view a
history of all the Communication Tests that you have run. You can even export the current
reachability status of all managed servers to a CSV file.
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Communication Tests and Unreachable Opsware Agents

The Communication Test works by testing communication and data exchange between
the specific components of the Opsware core and each managed server. The Opsware
core is the entire collection of servers and services that provide Opsware services. In
order to successfully manage servers, the Opsware core needs to be able to
communicate with each Opsware Agent on all servers under Opsware SAS management.

Communication Test Types

The Communication Test performs the following diagnostics to determine if an Opsware
Agent is reachable:

+ Command Engine to Agent Communication (AGT): Determines if the Command
Engine can communicate with the agent. The Command Engine is the Opsware SAS
component that enables distributed programs to run across many servers. The
Command Engine handles the entry of scripts into the Opsware Model Repository (the
script storage location in Opsware SAS) and the versioning of stored scripts.

+ Crypto Match (CRP): Checks that the SSL cryptographic files that the agent uses are
valid.

+ Agent to Command Engine Communication (CE): Verifies that the agent can
connect to the Command Engine and retrieve a command for execution.

- Agent to Data Access Engine (DAE). Checks whether or not the agent can connect
to the Data Access Engine and retrieve its device record. The Data Access Engine
provides an XML-RPC interface to the Model Repository that simplifies interaction with
various clients such as the SAS Web Client, system data collection, and monitoring
agents on servers.

+ Agent to Software Repository Communication (SWR): Determines if the agent can
establish an SSL connection to the Software Repository. The Software Repository is the
central repository for all software that Opsware SAS manages. It contains software
packages for operating systems, applications, databases, customer code, and software
configuration information.

+ Machine ID Mismatch (MID): Checks that the Machine ID (MID) on the server
matches the MID registered in the Model Repository for the agent.
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When the test finishes, it returns results that show either success or failure for each test
run on each server. For each failed test, the nature of the failure is indicated in the Test
Summary column of the Communication Test results page. In some cases, the failure of
one test might prevent other tests from being executed.

See “Opsware Agent Functionality on Managed Servers” on page 94 in this chapter for
information about the Opsware Agent and its relationship to managed servers.

Communication Test Errors

After you run a Communication Test, three icons indicate the success or failure of agent
reachability as Table 4-4 shows.

Table 4-4: Agent Unreachability Status Icons

Communication Test passed. Agent is reachable.

@

Communication Test unable to be executed.
=

Communication Test failed. Agent is unreachable.
™
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Table 4-5 describes each type of Communication Test and all possible errors for each

test.

Table 4-5: Communication Test Types with Possible Results

Command Engine to Agent | Determines if the

Communication (AGT)

Crypto Match (CRP)

Command Engine can
communicate with the
agent

Checks that the agent’s

SSL cryptographic files are

valid

OK

Untested

BN R

Unexpected error
Connection refused
Connection time-out

Request time-out

~ o I o

Server never registered

Realm is unreachable
El Tunnel setup error
Gateway denied access
EEB Internal gateway error

Gateway could not
connect to server

Gateway time-out
B oK

Untested

BN

Unexpected error

Agent certificate
mismatch

SSL negotiation failure
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Table 4-5: Communication Test Types with Possible Results (continued)

Agent to Command Engine | Verifies that the agent can | H

Communication (CE) connect to the Command 2]
Engine and retrieve a
command for execution

4]
5]
6]
8]
9]

OK

Untested

Unexpected error
Connection refused
Connection time-out
DNS does not resolve
Old agent version
Realm is unreachable

No gateway defined

Tunnel setup error

EEl Gateway denied access

Gateway name resolution

error

Internal gateway error

EE Gateway could not

connect to server

EH Gateway time-out

No callback from agent
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Table 4-5: Communication Test Types with Possible Results (continued)

Agent to Data Access Checks whether or notthe ||l OK
Engine (DAE) agent can connect to the Untested
Data Access Engine and
retrieve its device record Unexpected error
B Connection refused
H Connection time-out
@ DNS does not resolve
Old agent version
B Realm is unreachable

Bl No gateway defined
Tunnel setup error
EEl Gateway denied access

Gateway name resolution
error

Internal gateway error

EE Gateway could not
connect to server

EH Gateway time-out
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Table 4-5: Communication Test Types with Possible Results (continued)

Agent to Software Determines if the agent OK
Repository Communication | can establish an SSL
(SWR) connection to the Software

Repository

Untested

BN a

Unexpected error
Connection refused
Connection time-out

DNS does not resolve

~ o I o

Old agent version

Server identification error
El Realm is unreachable
No gateway defined

EEl Tunnel setup error
Gateway denied access

EEl Gateway name resolution
error

KK Internal gateway error

Gateway could not
connect to server

Gateway time-out

MID Match Checks that the Machine |l OK
ID (MID) on the server 2]
matches the MID
registered in the Model Unexpected error
4]

Repository for the agent

Untested

MID Mismatch

See “Communication Test Troubleshooting” in Opsware® SAS User’s Guide: Server
Automation for information about how to troubleshoot Communication Test Errors.
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Additional Information on Communication Tests

In the case that the Communication Test cannot be performed on a server, you see an
error named Unexpected Error with a small plus (+) button next to it. Click the plus (+)
button to see the Additional Information window, which provides traceback information
regarding the error. You can send this information to Opsware Customer Support to solve
a problem of this nature. See Figure 4-10.

Figure 4-10: Additional Information on an Unexpected Error

2 Opsware Command Center - Microsoft Internet Explorer,

Additional Information

@ reach0000.opsware.com

Tracehack (innermost last):
File " fbasefdeliverance.py”, line 1230, in poke_handler
File " femirpeimirpelib.py’, line 730, in __call_
File " milrpellcsmirpelib.py®, line 106, in __request
File " milrpelmirpelib.m, line 818, in __request
File"/85LTransport.my, line 61, in request
File " fasyncsslpy', line 113, in connect
File " fasyncsslpy', line 182, in _blocking_connect
errar: host not found

Running a Communication Test on an Individual Server

Perform the following steps to run a Communication Test on an individual server to find
out if the Opsware Agent on that server is reachable:

E From the navigation panel, click Servers » Manage Servers.

H From the Manage Servers list, click the display name of the server that you want to
perform a Communication Test on.

On the Server Property page, look in the Status field and notice that the server is
either listed as Reachable or Not reachable. If listed as Not Reachable, a date
indicates when the last regularly scheduled Communication Test was performed.
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To see the results of the last Communication Test for this server, click Details. The
Communication Test window for the server appears, as Figure 4-11 shows.

Figure 4-11: Communication Test Results on an Individual Server

< Communication Test - 172.16.1.34 - Microsoft Internet Explorer |:||E|r5__(|

Communication Test

W 172.16.1.34

Last Tested: 07/26/04 08:41:20 Run Test Again ]
Total Errors: 4

AGT B Connection timeout [7]

CREP O Untested

CE B Internal gateway arror [7]

DAE ﬂ Gateway couldn't connectto server [7]
swR B Gateway denied access [7]

MID O Untested

The results listed in this window show details from when the last regularly scheduled
Communication Test was run.

Bl To view troubleshooting information for any of the test errors, move your mouse over
the error name (for example SWR). When your mouse cursor changes to a question
mark, click the question mark to view the troubleshooting help.

B To rerun the Communication Test, click Run Test Again. The new results display in
the same window when the test finishes.
Running a Communication Test on Multiple Servers

Perform the following steps to run a Communication Test on multiple servers and to find
out which managed servers are not reachable:

E From the navigation panel, click Servers » Manage Servers.
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In the Manage Servers Summary View page, select the servers for which you want a
Communication Test.

Choose Tasks » Run » Communication Test. The Communication Test window
opens and the test is initiated. The top of the test window shows the status report for
the Communication Test, which indicates the time of the test, how many servers in
the test were reachable, which servers were not reachable, and a progress bar. This
summary information is shown in Figure 4-12.

Figure 4-12: Communication Test Summary

%" May 20, 2004 - Testing 5 Servers

Started: 11:33 PM UTC Comm Test in progress...1 of 5 completed
Servers: 0 with Errars [ z0%
ot 203 |
Tsummary: & new results available.

® Semvers can report more than one errar

Display: [THide servers that are QK
[ Refresh Results

Date: Provides the date of the test.

Statistics: Shows start and finish time, total servers OK, total servers with
unreachable agents, and a summary of errors.

Progress Bar: Provides live feedback of Communication Test progress. Progress
data includes the number of servers completed, the total number of servers to be
completed, and the list of servers completed so far.

Refresh Results Button: Refreshes the results screen with new results.
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Below the summary section is a list of all Opsware Agents that were not reachable
and their details, as Figure 4-13 shows.

Figure 4-13: Communication Test Results on an Unreachable Agent

Communication Test - Job 1D: 260003 Close
@ May 17, 2005 - Testing 2 Servers
Started: 8:46 PM UTC Completed Job ID: 260003
Servers: 0 with Errars
00K
“EER 0 new result avallable.
® Senvers can report more than one emor . .
Display. [JHide servers that are OK
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» The results section shows a table of all unreachable servers, detailing server name,
host name/IP address, OS, Opsware Agent version, registration (when the Opsware
Agent last reported to Opsware SAS), and the time the test was completed.

+ Click the title of each column to sort the test information by specific categories.

» The Test Summary section shows a list of all Communication Test types that were
run, and which errors were returned. For information about each type of error and how
to troubleshoot Opsware Agent reachability problems, click the link on each error to
view online help.

Viewing Servers by Communication Status

Perform the following steps to view all manage servers with the most recent
Communication Test results for each manage server:

E From the navigation panel, click Servers » Manage Servers.

H From the View menu, choose Communication. A list of the most recent
Communication Test that was run on all managed servers appears. All servers listed
in this view are listed as unreachable or reachable since the last regularly scheduled
Communication Test was run.
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E To sort the information in this view, click any of the column headings. For example,
you might want to view the servers by number of errors. Click the Error column title
by name, by OS version, and so on.

Bl To export this view to the CSV file format, choose Export to CSV from the Resource
menu.

H To run a new Communication Test for some or all of the servers in this view, select
the servers that you want to run a Communication Test on and then choose Run »
Communication Test from the Tasks menu.

Searching for Unreachable Servers

Another way you can discover unmanaged servers (those with unreachable agents) is to
search for all servers that have a status of unreachable. See “Using the Search Feature”
on page 171 in Opsware® SAS User’s Guide: Server Automation for more information.

Perform the following steps to search for unreachable agents:

E From the navigation panel, click Servers » Server Search. The Server Search page
appears.
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H From the Server Search page, choose the Agent Reporting attribute from the first list,

Figure 4-14: Agent Reporting Server Search Attribute

as Figure 4-14 shows.
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More criteria displays for the search parameters.

From the far right list of search attributes, select Not Reporting. Your search

parameters are Agent Status is Not Reporting.

Click Search. Wait a few moments for the results (the speed of the search results
depends on how many managed servers are being searched). If any of your
managed servers are not reachable, these servers will be listed in the search results.

To run a new Communication Test on these servers, select the server (check box
next to the server), and choose Run » Communication Test from the Tasks menu.
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Creating Communication Test DCI Reports

To view a Communication Test in a report format, you can use the Data Center
Intelligence (DCI) Reporting feature. It enables you to create a printable report of the
Communication Test results. After you make a report of the test results, you can export the
report to HTML, CSV, Microsoft Word, and other file formats, so that you can exchange the
report with others.

For information on how to create a DCI Communication Test report, view the DCI online
help by clicking Help in the SAS Web Client.
Viewing My Jobs Communication Tests

Each time that you run a Communication Test, the information is saved as a My Job. This
feature automatically saves a history of all tests that you run. To view saved
Communication Tests, perform the following steps:

EH From the navigation panel, click My Job.
H From the My Job list, click the Communication Test job that you want to view.

In the Communication Test window, wait a few moments for the Communication Test
information to load, then click View Details. You see the Communication Test
window.

Exporting the Unreachable Server Status List to CSV

Perform the following steps to export the list of all servers that have a status of
unreachable to the CSV file format:

E From the navigation panel, click Servers » Manage Servers.

H From the View menu, choose Communication. You see a list of all servers that are
in an unreachable or reachable state.

To export a list of these servers to the CSV file format, select the check box next to each
server that you want to include in the report, then from the Resource menu choose
Export to CSV.
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SAS Client

Th

is section discusses the following topics:
Device Explorer and Device Group Explorer
Accessing the Device Explorer

Server Information

Device Group Explorer

Browsing Job Logs

Device Explorer and Device Group Explorer

The Device Explorer feature of the Opsware SAS Client allows you to browse and manage
servers, devices, and groups of servers in your facility. Using the Device Explorer you can
perform the following actions on individual servers:

Browse Opsware information such as properties, configurable applications, and
server history.

Browse the file system, registry, hardware inventory, software and patch lists, and
services.

Drag-and-drop files between your desktop and servers.

Perform an audit of the server or view where the server is being used in an audit.
Take a snapshot of the server.

View packages and patches installed on the server.

Configure applications on the server.

View attached software policies.

Add and delete custom attributes.
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+ View summary and history information.

You can also browse groups of servers and perform the following operations for groups of
servers:

» Browse groups of servers and access servers inside of groups.
« Perform an audit of servers in the group.
» Take a snapshot of servers in the group.

» View software and patch policies associated with the group of servers.

When you perform an action on a group of servers, the action applies to all members of

the group, including other groups and their members. However, changes applied to an
Application Configuration at the group level only apply to members of the group that are
servers, but do not apply to sub groups of the parent group.

Accessing the Device Explorer

Open the Device Explorer to view server information or perform operations on a server. To
access the Device Explorer, perform the following steps:

E Launch the SAS Client and from the Navigation pane, select Devices » All
Managed Servers.

H A list of servers will display in the Content pane.

=
If the list of servers is long, use the search tool J"J to locate a server (upper right
corner) by name, IP address, OS, customer, facility, or description. If you search by
user name, the text entry is case insensitive.

You can also sort the list by clicking a column heading, such as name, IP address,
OS, customer, and so on. To reverse sort, click the column heading a second time.

E Open a server from the Contents pane. This opens the Device Explorer. From the
Actions menu, you can perform the following operations:

— View more detailed information about the selected server in the SAS Web Client.

— Access the Visual Application Manager.

Audit or configure application configurations.

Perform an audit.
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Create a snapshot.

Create a package.

Attach a software policy.

Install a patch, export patch information to .csv.
Run a compliance scan.

Add or delete custom attributes.

Open a remote terminal.
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Device Explorer Interface

The Device Explorer consists of two main components: The Views pane and the Content
pane. The Views pane lists server objects from the managed server, and the Content

pane displays content for each of the server's objects. When you select a server object in
the Views pane, its corresponding content appears in the Content pane. See Figure 5-1.

Figure 5-1: Device Explorer Interface
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Actions Menu in the Device Explorer

To access features from the Device Explorer, select a server object in the Views pane and
select an item from the Actions menu. Action menu items change according to the server
object selected.

For example, if you select the Configured Applications object from the server object tree,
then from the Actions menu, you can add a configuration, remove a configuration, create
a package, and so on.
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Opening a Remote Terminal

You can open a remote terminal for any managed server, but not a group of servers. To do
so, perform the following steps:

E Launch the SAS Client. From the Navigation pane, select Devices » All Managed
Servers.

A Select a managed server and open it.

H In the Device Explorer window, from the Actions menu, select Launch Remote
Terminal.

H Log into the remote terminal.

See “Opening a Remote Terminal” on page 321 in Chapter 9 for more information.

Server Information

The Device Explorer allows you to review the following server information:
+ Summary

* Properties

* Hardware

* File System

+ Configured Applications

+ Software Policies

+ Services

+ Patches

+ Patch Policies - Windows Only
+ Windows Registry

+ Windows IIS Metabase

* Windows COM+ Objects

* Audit and Remediation

+ Custom Attributes

+ Server History
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« Compliance

Summary

The Summary view lists the following information:

.

System: This displays operating system information.
Manufacturer: This displays server manufacturer, hardware, and system details.

Opsware Registration: This displays communication status, when the server was
last registered, how many applications and patches are registered with Opsware SAS,
and so on.

Properties

The Properties view lists the following property information for the server that you are
browsing:

Management Information

.

Name: This displays the name of the managed server.
Notes: This displays any notes listed.
IP Address: This displays the IP address of the managed server.

OS Version: This displays the operating system (platform) that the managed server
is running on.

Customer: This displays an account within Opsware SAS that has access to
designated resources, such as servers and software.

Facility: This displays the location of the server. Users can manage servers in any
facility from an SAS Web Client.

Realm (link speed): This displays the minimum bandwidth limit between the
Opsware Agent and the core (if the agent is going through gateways).

Server Use: This displays how an organization is using the managed server; for
example, a server could be a staging server, a production server, a development
server, and so on.

Deployment Stage: This displays the stages of deployment for a server; for example,
a server could be live or offline.

Opsware Lifecycle: This displays the server's stage in the Opswatre Lifecycle; for
example, unprovisioned, available, managed, or deactivated.
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+ Server ID: This displays the internal ID that Opsware SAS uses to identify the server.

+ Status: This displays whether or not the server is reachable and thus managed by
Opsware SAS. “OK” means that the server (its Opsware agent) is reachable;
unreachable means that there is a communication problem and Opsware SAS cannot
communicate with the server.

« Encoding: This displays the character encoding of the managed server, such as

Shift_JIS (Japanese) or Windows 1252 (Western).

Reported Information
* Reporting: This displays information about the ability of the server's agent to
communicate with the core. Statuses include Has not reported, OK, Registration in
progress, and Reporting error.

» Agent Version: This displays the version number of the agent.
+ Name: This displays the name of the managed server.

* Reported OS: This displays the operating system (platform) that the managed server
is running on.

+ MAC Address: This displays the Media Access Control (MAC) address. This is the
network interface card’s unique hardware number. The MAC address is used as the
server's physical address on the network.

+ Serial Number: This displays the serial number of the system. Opsware SAS
attempts to report a chassis ID if possible.

« Chassis ID: This displays a unique hardware-based identifier that the Opsware Agent
discovers, typically derived from some property of the server's chassis. As a common
source for this ID, Opsware SAS uses an interface's MAC address or the host ID on
Solaris servers, or the serial number for one of the interfaces.

From this window, you can also open a remote terminal on the selected server.

Hardware

The Hardware view lists all the reported hardware on the selected managed server. This
includes the following information:

» CPUs: This lists CPU information for all CPUs on the managed server.

« Memory: This lists the total amount and the types of memory on the managed
server.
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» Storage: This lists all storage devices on the managed server.

File System

The File System view enables you to browse the file system of a managed server. The File
System has two main sections (similar to the Windows file system explorer): the server's
directories and the contents of the selected directory.

The left side navigation panel of the Device Explorer shows all the directories of the
selected server, and the right side of the Device Explorer lists the contents of the selected
directory.

For each file, the SAS Client lists the file’s name, size, type, and date modified. To sort the
files by any of these categories, click on the top of the column.

Depending upon your user permissions, you might not have access to a particular

server's file system. In such a case, you cannot select and view the server's file system in
the Device Explorer. If you have access to a server's file system, then you will see user
names, such as Administrator, root, and Local System. These are user names used to
access that server's file system.

Viewing File Contents
To view file contents, perform the following steps:

E Launch the SAS Client. From the Navigation pane, select Devices » All Managed
Servers.

H Alist of servers will display in the Content pane. Select a server and open it. This
opens the Device Explorer.

From the left side of the Device Explorer, select a File System object.

You are prompted to select a user name to log into the computer, such as
Administrator, LocalSystem, or root. Select a user.

To view the contents of disk drives or folders, expand the icon. Select a directory.

B From the Actions Menu, select View Contents. The file content view pane appears
at the bottom of the window.

To change the character encoding, select an item from the Encoding drop-down list.
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Ways to Copy Files

You can copy files from a server to another directory on the same server, to a directory on
another Opsware-managed server, or to your local computer (where the SAS Client is
running). You can also copy a file from your local computer to a directory on the managed
server. A few restrictions apply when copying files on a managed server’s file system
using the Device Explorer:

+ You cannot copy folders/directories.
« You can only copy to servers that you have permissions to write to and to view.
+ You can only copy one file at a time.
+ You cannot undo a deletion — once you delete a file, it's gone.
Copying Files Between Managed Servers
To copy files between managed servers, perform the following steps:

EF Launch the SAS Client. From the Navigation pane, select the Devices » All
Managed Servers.

H To launch the Device Explorer, open a server from the server list.

E From the left side of the Device Explorer, select a File System object. To view the
contents of disk drives or folders, expand the icon.

Navigate to the directory that contains the file that you want to copy and select it.

H From the Actions Menu, select Copy To.

In the Copy To dialog box, select from the following locations in the drop-down list:
» Managed Servers (other managed servers in the core)

+ This Server

+ Local File System

Navigate to the desired directory.

B Click Select.

Copying Files from Your Computer to a Managed Server

To copy files from your computer to a managed server, perform the following steps:

E Launch the SAS Client. From the Navigation pane, select Devices » All Managed
Servers.
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To launch the Device Explorer, open a server from the server list.
From the left side of the Device Explorer, select a File System object.
Navigate to the target directory where you want to copy the file.

Use your system’s file system explorer to select the file that you want to copy, then
drag the file to the desired location in the Device Explorer.

Deleting Files

Once you delete a file, it cannot be recovered. (However, before you delete, you are
prompted with a confirmation dialog box.)

To delete a file, perform the following steps:

B N

Launch the SAS Client. From the Navigation pane, select the Devices » All
Managed Servers.

To launch the Device Explorer, open a server from the server list.
From the left side of the Device Explorer, select a File System object.
Select a file to delete from the Content pane.

From the Actions menu, select Delete.

Click Yes in the confirmation dialog box.

Renaming Files

To rename a file, perform the following steps:

Launch the SAS Client. From the Navigation pane, select the Devices > All
Managed Servers.

To launch the Device Explorer, open a server from the server list.

From the left side of the Device Explorer, select the File System object. To view the
contents of a folder, expand the folder.

Select the file that you want to rename, and from the Actions menu, select Rename.

Enter a new name for the file, then press ENTER. Pressing the ESC key on your
keyboard will cancel the rename operation.

Creating a Configuration Template from a File

For any file on a managed server, you can create an Application Configuration Template.
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To create an Application Configuration Template from a file, select the file. From the
Actions Menu, select Create Configuration Template. See Opsware® SAS User’s
Guide: Application Automation for more information.

Creating a Package from a File

For any file on a managed server, you can create an installable software package. For
each package, you can specify the customer assignment, the reboot requirements, and
the pre/post install and pre/post uninstall scripts.

To create a package from a file on the managed server file system, select the file. From
the Actions Menu, select Create Package. See Opsware® SAS Policy Setter’'s Guide on
how to create a package.

Installed Packages

The Installed Packages view enables you to view any installed packages on the selected
managed server. For each package, you can view name, type, size, last modified, and
description. To sort the list by these categories, click the title of each column. See the
Opsware® SAS Policy Setter’s Guide on how to create a package.

Configured Applications

The Application Configurations view in the Device Explorer gives you access to
application configurations and configuration templates, and shows you configuration files
on the selected managed server being managed by Opsware.

Installed Configurations

In the Content pane, the Installed Configurations tab of the Configured Applications
window allows you to browse and edit all Application Configurations attached to the
managed server.

In the Views pane, expand the Configured Application icon to display all applications
being managed by the Application Configuration Management System. (If you cannot
expand the Application Configurations folder, then no Application Configurations have
been attached to the server)

Each application can contain one or more instances of a managed application on the
server. You can expand each application to view and edit values sets for each managed
application. For more information about setting values for an Application Configuration,
see the Opsware® SAS User’s Guide: Application Automation.
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Configuration History

The Backup Configurations tab of the Configured Applications window provides a history
of all changes made to the selected application configuration template, and allows you to
revert to a previous version of the configuration. Thus, you can rollback the current state of
an application configuration to any previous state in this list.

To rollback the configuration to a previous state, select an item in the list and click Revert.

Software Policies

The Software Policies view displays all software policies associated with the selected
server (or group of servers).

Show Options
You can use the Show drop-down list to filter the following types of software policies:

» Policies Attached Servers: This displays all policies attached to the server, or
policies attached to a group of servers to which the selected managed server
belongs.

+ Non-Compliant Policies: This displays the software policies attached to the selected
server which are non-compliant with the actual server configuration.

+ Policies which Require Scan: This displays the software policies for which the
software compliance information is not yet calculated.

+ Policies Currently Scanning: This displays the software policies for which software
compliance information is being calculated.

From the Actions menu, you can perform actions such as attaching a policy, detaching a
policy, remediating a server, and scanning software compliance.

Services

The Services window shows you a list of all running services on the selected managed
server. Depending on the installed operating system, you can perform different operations
on the services:

« For Windows services, you can start, stop, pause, resume, and restart a service. You
can also set the service to start manually, to start automatically when the system is
rebooted, or to be disabled altogether.

« For Linux servers (supported by Red Hat and SuSE versions), you can perform any
action that a particular service supports. Supported actions may vary from service to
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service, for example, start, stop, restart, condrestart, or status. You can also specify the
run levels that you want a service to run under.

To perform an operation on a service, select the service and right-click.

Patches

This window displays all patches associated with the selected managed server.

Show Options - Windows

You can use the Show drop-down list to filter the following types of patch information:

Patches Installed: This option displays all patches that have been installed on the
server.

Patches Recommended By Vendor: This option displays all application and operating
system patches that have been recommended by Microsoft (MBSA 2.0) for the selected
server. If multiple patches have the same QNumber, Patch Management detects the
application files that are already installed on a managed server and, subsequently,
recommends the correct patch to install.

Patches with Policies or Exceptions: This option displays patches in policies
attached to the selected server, or patches that have always install exceptions, and
have one of the following conditions:

» The patches are not currently installed and are recommended by the vendor.
« The patches are currently installed.

Patches Needed: This option displays all patches that should be installed on the
selected server but are not. These include patches that are in policies attached to that
server, or patches that have always install exceptions, and are recommended by the
vendor.

Patches with Exceptions: This option displays all patches that have exceptions (such
as always install or never install) and have one of the following conditions:

* The patches are not currently installed and are recommended by the vendor.
« The patches are currently installed.

All Patches: This option displays all patches that are associated with the operating
system of the server.
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Show Options - UNIX
The Show options for UNIX patches display the following information:

« All Patches: This option displays all patches that are associated with the operating
system of the server.

« Patches Installed: This option displays all patches that have been installed on the
server.

Patch Contents — Windows
The Show options for Windows patches display the following information:

+ lcon: A dimmed icon means that the patch has not yet been uploaded to the Software
Library.

+ Name: This is the QNumber of a patch that is a hotfix or an update rollup. Service pack
patches do not have a QNumber.

+ Compliance: This shows one of the following three levels of patch compliance, as
defined by a patch administrator:

* Non-Compliant (red): This indicates that the patch is installed on the server, but is
not in the policy, or that the patch is not installed on the server but is in the policy.

« Partial (yellow): This indicates that the policy and exception do not agree, and the
exception does not have data in the Reason field.

+ Compliant (green): This indicates one of the following conditions:

— A patch is installed on the server and is in a policy, or a patch is not installed on
the server and is not in a policy.

- A patch is installed on the server and there are additional patches with the same
QNumber in a patch policy or exception. In this case, all patches with the same
QNumber are considered installed when Patch Management calculates patch
compliance.

— A patch is not installed on the server and is in a patch policy or has an always
install exception, and is not recommended by the vendor. In this case, the patch
has a never install exception, because it is not recommended by the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column
to view patch compliance information about a server.

« Type: This shows the type of patch, such as Windows Hotfix or Windows Update
Rollup.
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+ Bulletin (Optional): This shows the Microsoft Security Bulletin ID number for this patch.

+ Severity (Optional): This shows one of the following three Microsoft severity ratings for
this patch:

« Critical: This indicates a patch whose exploitation could allow the propagation of an
internet worm, without user action.

« Important: This indicates a patch whose exploitation could result in a compromise of
the confidentiality, integrity, availability of user data, or of the integrity or availability of
processing resources.

* Moderate: This indicates a patch whose exploitability is mitigated to a significant
degree by certain factors, such as default configuration, auditing, or difficulty of
exploitation.

» Low: This indicates a patch whose exploitation is extremely difficult, or whose impact
is minimal.

* Release Date: This displays the date that Microsoft released this patch.
+ Exception: This displays the type of patch policy exception set for the selected server.
« Installed: This shows if the patch is installed on the selected server.

+ Recommended: A check mark indicates that this patch was recommended by the
vendor (MBSA 2.0) during the last software registration.

« Description: This displays a description of the server.

+ Opsware ID (Optional): This displays a unique Opsware ID that identifies the patch
object.

» Locale (Optional): This displays encoding of the patch contents.

+ OS (Optional): This displays operating system version of the server.

Patch Contents — UNIX

The show options for UNIX patches display the following patch content information:

+ Icon: A dimmed icon means that the patch has not yet been uploaded to the Software
Library.

« Type: This shows the type of patch, such as Solaris Patch, HP-UX Patch Fileset, and so
on.

+ Installed: This shows if the patch is installed on the selected server.
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« Description: This displays a description of the server.
« Install Date: This displays the date the patch was installed on the server.

+ Opsware ID (Optional): This displays the unique Opsware ID that identifies the patch
object.

+ OS (Optional): This displays the operating system version of the server

Patch Policies - Windows Only

This window displays all patch policies associated with the selected Windows managed
server (or server group).

Show Options

The Show drop-down list displays the following patch policy information:

+ Policies Attached to the Server: This displays all policies attached to the Windows
server, or policies attached to a server group to which the selected Windows managed
server belongs.

+ Policies Not Attached to the Server: This displays a list of all patch policies relevant
to the selected server that are not attached to the server.

Patch Contents

This section displays the following patch policy content information:

« Name: This displays the name of the patch policy.

+ OS: This displays the operating system associated with the patch policy.

» Description: This shows a description of the patch policy.

Windows Registry

This window displays a read-only view of the Windows registry on the selected Windows
managed server. You can navigate to this registry much like the regedit tool on the
Windows operating system.

Folders on the left side of the window represent keys in the registry. Clicking a folder on
the left displays entries in a key in the right window.
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To view Windows Registry items, select the top-level Windows Registry icon in the Server
Explorer and select a user from the menu. Your user must have proper permissions to
view Windows Registry keys. If your user is unable to access the Windows Registry for
the selected managed server, contact your Opsware administrator.

The HKEY_CLASSES ROQOT might have thousands of entries and can take time to load.

Windows IIS Metabase

This window displays a read-only view of the IIS Metabase on the selected Windows
managed server. You can browse the IIS Metabase much like one of the metabase
browsing tools such as metaedit or the IIS Metabase Browser.

The left side of the Metabase window displays the hierarchical layout of the metabase
tree. Selecting an item in the tree on the left shows the data items associated with the
selected key in the right hand view. Clicking the (+) symbol to the left of a key item will
expand the item's child keys.

To view Windows IIS Metabase items, select the top-level Windows Metabase icon in the
Server Explorer, right-click, and select a user. Your user must have permissions to view
Windows Metabase items. If your user is unable to access the Windows Registry, contact
your Opsware administrator.

Windows COM+ Objects

This window displays a read-only view of all the COM+ objects on the selected managed
server. In the Server Explorer window, the Views pane displays the following two folders
for browsing COM+ objects:

« All Objects: This is a flat list of all the COM+ objects on the managed server.

+ Component Categories: This contains an alphabetical list of all COM component
categories.

To view the contents of a COM+ object, perform the following steps:

H Select the All Objects or the Component Categories folder. In the Content pane,
expand the folder until you reach an object.

H To view the contents of a COM+ object, from the Actions Menu, select View
Contents. The contents will then display.
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HE If the content of the COM+ object uses a different encoding, choose the appropriate
encoding type from the Encoding drop-down list.

You must have specific user permissions to view Windows COM+ objects. If you are
unable to access the Windows Registry, contact your Opsware administrator.

Audit and Remediation

The Audit and Remediation view shows the following information for the selected server:

» Audit - Server is Source: Shows all audits where the selected server is used as
the source of the audit.

« Audit - Server is Target: Shows all audits where the selected server is the target
of the audit.

+ Audit Results - Server is Source: Shows the results of all audits where the
selected server was used as the source of the audit.

+ Audit Results - Server is Target: Shows the results of all audits where the
selected server was used as the target of the audit.

« Snapshot - Specifications: Shows all snapshot specifications that are using this
server as one of its targets.

« Snapshots: Shows all snapshot results that used this server as a target.

Custom Attributes

This window displays the custom attributes set to a server or group of servers. You can
add, edit or remove custom attributes from this window.

Custom attributes can be one of the following two types:

* Inherited ® from another source, such as a customer, a software policy, group of
servers, ISM control, and so on.

+ Attached directly to the server.

To override inherited custom attribute values, click the inherited arrow icon ® once, and

enter a new value in the value field. Press ENTER. The inherited arrow changes ] to
indicate that the custom attribute value has been overridden.
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Server History

The Server History view shows changes made to the selected server. For example, it
displays who modified a server, what change was made, when it was modified, and so
on. Server history specifically shows when a user has performed one of the following
actions:

» Added the server to a node
* Removed the server from a node
» Reassigned the server from one node to another

Entries are generated when actions are performed for managed servers in the SAS Web
Client. The History is read-only. Each entry shows the following information:

» Description: A description of the change.
« Last Modified: The date when the last change occurred.
* Modified By: The user who made the change.

Use the View drop-down list to sort the server history list according to a range of time,
such as last week, the last two months, and so on.

Compliance

The Compliance view of the Device Explorer displays the compliance levels for the
selected server and allows you to determine if your server is in compliance with the
following categories:

+ Software: Software compliance indicates whether or not all software policies attached
to the selected server are compliant with the actual server configuration. A software
policy includes installed packages and patches, application configurations, and other
software policies. If the actual server configuration does not match the software policy
definitions, then the server's software policies are considered out of compliance.

« App Config: An Application Configuration defines how specific application
configurations files should be configured on a managed server. Application
Configuration compliance indicates whether or not all of the Application Configurations
attached to a server are compliant with the actual application configuration files on the
server. If the actual server configuration does not match the Application Configuration
definitions, then the server’s Application Configurations are out of compliance.

« Patch: Patch Compliance determines whether all patches in a patch policy and a patch
policy exception were installed successfully. To test patch compliance, servers are

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved. 147



Opswezre® SAS 6.0.1 User’s Guide: Server Automation

scanned to determine whether they conform to their attached policies and exceptions,
based on compliance status and rules. If any of the patches defined in the patch policy
do not match what is actually installed on the server, then the server's patch policies
are out of compliance.

+ Audit: The Compliance Dashboard displays these two types of compliance for audits:

« All roll up of scheduled audits will appear by default in the Compliance Dashboard in
a single column named audit. This status enables you to view the total compliance
status of all audits scheduled to run on a regular basis on the selected server. A
server at any given time can be the target for several audits. This compliance test
provides a roll up of compliance status for all audits being run against the server.

« Individual audits that have been scheduled to run on the selected server can be
displayed on a per-audit basis. These audits will not appear by default and must be
activated to be displayed in the Compliance Dashboard. In order to view an individual
audit for a specific server in the Compliance Dashboard, you must have access to
view that server where the audit is running.

Device Group Explorer

The Device Groups Explorer provides access to all groups of servers and other devices in
the core. From the Device Groups Browser, you can perform the following actions:

Browse groups of servers and access servers inside of groups:

View patches, patch policies and software policies associated with the servers in the
group.

Create an audit.

Take a snapshot.

View and create custom attributes.

View server history.

Dynamic and Static Groups

When you view groups or servers in the Device Groups Browser, you are viewing all
public groups and groups your user has access to. There are two kinds of device group
types, static and dynamic:

Static Device Groups tﬁ . A static device group contains servers that are added to
and removed from the group manually (as opposed to being added based upon user-
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defined rules). When using static groups, you first create the group, and then select the
servers to populate it.

« Dynamic Device Groups ‘t—j' : A dynamic device group contains servers added to or
removed from the group based on a set of user-defined rules. If the rules are changed
or the servers in the environment change, servers will be added to or removed from the
group automatically. Rules apply only to the group being created or modified, not to any
subgroups.

Accessing the Device Groups Browser
To access the Device Groups Browser, perform the following steps:
El Launch the SAS Client and select Devices » Device Groups.

H Select a device group and open it. (You can expand a group to find sub groups.)

HE I the list of device groups is long, sort the list by clicking a column name, such as
name, IP address, OS, customer, or facility.

Bl For each device group, you can also perform an audit, take a snapshot, or configure
applications.

Device Group Members

From inside each device group, you can view all members — managed servers and other
groups of servers and other devices — that belong to the group. For each server that
belongs to the group, the system displays its name, IP address, OS, customer, facility, and
any description.

Configured Applications for Device Groups

If the device group is public, then you can add an Application Configuration to the group.
The Application Configuration applies to all servers and groups in this group.

» The Installed Configurations tab allows you to browse and edit all Application
Configurations attached to the device group.

» The Backup Configurations tab provides a history of all changes made to the selected
application configuration template, and allows you to revert to a previous version of the
configuration.

See Opsware® SAS User’s Guide: Application Automation for more information.
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Patches for Device Groups

This window displays all patches associated with the selected server group.

Show Options

You can use the Show drop-down list to filter the following types of patch information
displayed in the Device Groups Explorer.

+ Patches with Exceptions (Windows Only): This option displays all patches that have
exceptions for Windows servers (such as always install or never install) and have one
of the following conditions:

« The patches are not currently installed and are recommended by the vendor.
» The patches are currently installed.

« Al Patches: This displays all patches that are associated with the operating system of
a server.

Patch Contents
This section displays the following patch contents information.

+ lcon: This displays a dimmed patch icon when the patch has not yet been uploaded to
the Software Library.

+ Name: This indicates the QNumber of a patch that is a hotfix or an update rollup.
Service pack patches do not have a QNumber.

« Compliance: This shows one of the following three levels of patch compliance, as
defined by a patch administrator:

* Non-compliant (red): This indicates that the patch is installed on the server, but that
it is not in the policy, or the patch is not installed on the server but is in the policy.

+ Partial (yellow): This indicates that the policy and exception do not agree, and that
the exception does not have data in the Reason field.

« Compliant (green): This indicates any of the following conditions:

— A patch is installed on the server and is in a policy, or a patch is not installed on
the server and is not in a policy.

— A patch is installed on the server and there are additional patches with the same
QNumber in a patch policy or exception. In this case, all patches with the same
QNumber are considered installed when Patch Management calculates patch
compliance.
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— A patch is not installed on the server and is in a patch policy or has an always
install exception, and is not recommended by the vendor. In this case, the patch
has a never install exception because it is not recommended by the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column
to view patch compliance information about a server.

« Type: This indicates the type of patch, such as Windows Hotfix or Windows Update
Rollup.

+ Bulletin (Optional): This indicates the Microsoft Security Bulletin ID number for this
patch.

+ Severity (Optional): This displays one of following Microsoft severity ratings for this
patch:

« Critical: This indicates a patch whose exploitation could allow the propagation of an
internet worm, without user action.

« Important: This indicates a patch whose exploitation could result in a compromise of
the confidentiality, integrity, or availability of user data, or of the integrity or availability
of processing resources.

* Moderate: This indicates a patch whose exploitability is mitigated to a significant
degree by factors, such as default configuration, auditing, or difficulty of exploitation.

« Low: This indicates a patch whose exploitation is extremely difficult, or whose impact
is minimal.

+ Release Date: This shows the date that Microsoft released this patch.
« Exception: This indicates the type of patch policy exception set for the selected server.
« Installed: This indicates if the patch is installed on the selected server.

+ Recommended: A check mark indicates that this patch was recommended by the
vendor (MBSA 2.0) during the last software registration.

« Description: This shows a description of the server.

Patch Policies for Device Groups

This window displays all patch policies associated with the selected device group. You
can use the Show drop-down list to filter the type of patch policies to display in the Server
Explorer.
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Show Options
This section displays the following patch information:

+ Policies Attached to Device Group: This displays all policies attached to the device
group, or policies attached to a server group to which the selected managed server
belongs.

« Policies Not Attached to the Server: This displays a list of all patch policies relevant
to the selected server group that are not attached to the group.

Patch Contents

This section displays the following patch content information:

+ Name: This displays the name of the patch policy.

+ 0OS: This displays the operating system associated with the patch policy.

« Description: This shows a description of the patch policy.

Software Policies for Device Groups

This Software Policies view displays all software policies associated with the selected
server (or group of servers). You can perform actions such as attaching a policy,
detaching a policy, remediating a server, and scanning software compliance from the
Actions menu.

Custom Attributes for Device Groups

This window displays the custom attributes set to a server or device group. You also can
add, edit or remove custom attributes from this window.

Custom attributes can be one of the following two types:

* Inherited ® from another source, such as a customer, a software policy, group of
servers, ISM control, and so on.

« Attached directly to the server.

To override inherited custom attribute values, click the inherited arrow icon ® once, and

enter a new value in the value field. Press ENTER. The inherited arrow changes © to
indicate that the custom attribute value has been overridden.
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History Properties for Device Groups

The Device Groups Explorer shows the following information for each group:
« Type: This indicates if the group is dynamic (rule-based) or static.

* Rules: If the group is dynamic, this displays all of the group’s rules.

« Status: This displays the group’s status. Active means that the group is accessible. “In
use by access control” means that an administrator has set access control boundaries
(security permissions) for the group.

» Accessibility: This indicates if the group is public or private.

+ Servers (this level): This indicates the number of servers that belong to this group at
this level in the group hierarchy.

» Groups (this level): This indicates the number of groups that belong to this group at
this level in the group hierarchy.

* Unique Servers (all levels): This shows the number of servers for the current group
and all the servers in its subgroups, recursively. For example, if the group has one
server, ServerA, and a sub-group, Group, containing two servers, then this group will
contain a total of three unique servers.

- Date last used (by a job): This displays the most recent job run on the group.

Browsing Job Logs

A job is any major process run by the Opsware SAS Web Client or the SAS Client, such as
a communication test, a software installation, an OS installation, audit results remediation,
an Application Configuration push, a server compliance audit, and so on.

The Job Logs window shows the details of all jobs run under the currently logged in user
name and jobs that are currently in progress. It also displays jobs scheduled to run,
including the name of the job, the start time, the number of servers affected by the job,
and the status of the job.

The display of a job’s start time and finish time is determined by original user preferences
set in the SAS Web Client, which may be different than those of the current user. If a user
is working in multiple times zones, it is a good idea to make sure that these preferences
are set to display the time zone in the date.
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To see details of a finished job, open a job. If the job is recurring (scheduled to be run),
then opening the job will cause the Schedule Job window to display. You will only be able
to modify the scheduled job if you created the job, or have Edit All Jobs permissions. To
obtain these permissions, contact your Opsware administrator. See the Opsware® SAS
Configuration Guide for more information.

You can search the job list by selecting the following criteria (located at the top of the Job
Logs window):

* Job ID: Enter the job ID.
+ Job Type: Choose a type of job from this list.

« Time Restrictions: Limit the search for a job by a time restriction such as the last
week, last two weeks, or last month.

« Ticket ID: Enter a ticket ID here if one was given for the job.

« Job Status: Choose a job status, such as job completed, completed with errors,
cancelled, and so on.

« User name: Enter your user name to see only those jobs you have run, or enter nothing
here to to show all jobs. Click on the column header to sort the list. Only users with the
View All Jobs or Edit All Jobs permissions will be able to view all jobs in the core. If you
do not have these permissions, you will not be able to see all jobs.

To view a job, select it, right-click, and select Open.
To stop a job that is currently running, select it, right-click, and select Stop.

Recurring Schedules

The recurring schedules window shows all jobs that are scheduled to run on a recurring
basis. You can choose to view all recurring jobs, or filter the list of recurring jobs by the
following methods:

« Any ID: Enter the job ID.
+ Any Type: Choose a type of job from this list.
« Any Ticket: Enter a ticket ID here if one was given for the job.

« Any User: Enter your user name to see only those jobs you have scheduled to run on a
recurring basis, or enter nothing here to show all recurring jobs. Click on the column
header to sort the list. Only users with View All Jobs or Edit All Jobs permissions will be
able to view all jobs in the core. If you do not have these permissions, you will not be
able to see all jobs.
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To view a recurring job schedule, select it, right-click, and select Open.

To delete a recurring job, select it, right-click, and select Stop.
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Client

This section discusses the following topics:
« Server Tracking

+ Server Lists

+ My Servers

+ Server Search

+ Server Identification

+ Server Histories and Reports

+ Hardware Information for Managed Servers

Server Tracking

This section discusses the following topics:
» Ways to Locate, List, and Display Servers
» Tracked Server Properties

» Supported Operating Systems for Managed Servers.

Ways to Locate, List, and Display Servers
You can locate, list, and display servers in the SAS Web Client in the following four ways:

» By searching when you know the name, host name, or IP address of the server you
want to provision or manage.

+ By viewing the Manage Servers list and Server Pool list when you want to see a
complete list of all your servers. You can refine the lists by using filters.
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.

By viewing servers sorted by hardware category. (Click Environment » Hardware in the
navigation panel.) The Servers tab in the Hardware pages shows each manufacturer
and model that you have running in the operational environment. See “Hardware
Information for Managed Servers” on page 196 in this chapter for more information.

You can also browse managed servers and server groups using the SAS Client.

Tracked Server Properties

Every server that Opsware SAS manages has the following properties:

|P addresses, host name, and the server ID

All software that is installed on the server. Select the Installed Packages tab from the
Manage Servers: Server Properties page to display the list of software that is reportedly
installed on the server.

Opsware SAS is able to determine what software is installed on a server because the
Opsware Agent communicates with the Opsware core and reports the installed
hardware and software for the server.

In some cases, Solaris packages might only be partially installed. In these cases, the
partially installed Solaris package does not show up in the installed list.

See “Server Information that the Opsware Agent Tracks” on page 95 in Chapter 4 for
information about a complete list of all the hardware and software information that

Opsware SAS tracks for managed servers.

Supported Operating Systems for Managed Servers

This section lists the supported operating systems for Opsware Agents, the SAS Web
Client, and the SAS Client.
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The following table lists the supported operating systems for Opsware Agents, which run
on the servers managed by Opsware SAS.

Table 6-1: Opsware Agent Supported Operating Systems

AIX

HP-UX

Sun Solaris

Fujitsu Solaris

Windows
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AlX 4.3
AIX 51
AIX 5.2
AIX 5.3

HP-UX 10.20
HP-UX 11.00
HP-UX 11.11

HP-UX 11i v2

Solaris 6
Solaris 7
Solaris 8
Solaris 9
Solaris 10

Solaris 8
Solaris 9
Solaris 10

Windows NT 4.0

Windows 2000 Server Family
Windows Server 2003
Windows Server 2003 x64
Windows XP Professional

POWER
POWER
POWER
POWER

PA-RISC
PA-RISC
PA-RISC

PA-RISC and Itanium

Sun SPARC
Sun SPARC
Sun SPARC
Sun SPARC

Sun SPARC, 64 bit x86 and

Niagara

Fujitsu SPARC
Fujitsu SPARC
Fujitsu SPARC

32 bit x86
32 bit x86
32 bit x86
64 bit x86
64 bit x86
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Table 6-1: Opsware Agent Supported Operating Systems

SUPPORTED
OPERATING SYSTEMS

FOR OPSWARE AGENT

VERSIONS

ARCHITECTURE

Red Hat Linux

Red Hat Linux 7.3

Red Hat Linux 8.0

Red Hat Enterprise Linux 2.1 AS
Red Hat Enterprise Linux 2.1 ES
Red Hat Enterprise Linux 2.1 WS
Red Hat Enterprise Linux 3 AS

Red Hat Enterprise Linux 3 ES
Red Hat Enterprise Linux 3 WS
Red Hat Enterprise Linux 4 AS

Red Hat Enterprise Linux 4 ES
Red Hat Enterprise Linux 4WS

32 bit x86

32 bit x86

32 bit x86

32 bit x86

32 bit x86

32 bit x86 and 64 bit x86
and Itanium

32 bit x86 and 64 bit x86
and Itanium

32 bit x86 and 64 bit x86
and Itanium

32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86

SUSE Linux

SUSE Linux Enterprise Server 8
SUSE Linux Standard Server 8
SUSE Linux Enterprise Server 9

32 bit x86
32 bit x86
32 bit x86 and 64 bit x86

The following table lists the operating systems supported for the SAS Client.

Table 6-2: SAS Client Supported Operating Systems

SUPPORTED

OPERATING SYSTEMS

FOR SAS CLIENT

VERSIONS

ARCHITECTURE

Windows

Windows XP
Windows 2003
Windows 2000

32 bit x86
32 bit x86
32 bit x86

download.html

Java J2SE v 1.4.2 - 1.4.2-10 JRE must be installed on the system that runs on the SAS
Client. To download this version of Java, go to http://java.sun.com/j2se/1.4.2/
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Server Lists

This section discusses the following topics:
« Types of Server Lists

+ Server Pool

+ Manage Servers List

« Filters on the Manage Servers List

Types of Server Lists
The SAS Web Client displays lists for two types of servers, as Figure 6-1 shows.

Figure 6-1: Servers Section in the Navigation Panel

=l Servers
= hly Senvers
*hlanage Servars
»Search
*Senver Fool

Server Pool: Servers in the Server Pool have registered their presence with Opsware SAS
but do not have the target OS installed. An OS Build Agent is running on each server so
that they can communicate with Opsware SAS.

See Opsware® SAS User’s Guide: Application Automation on how to use the Server Pool
when you install the target OS on a server.

Manage Servers: The Manage Servers list contains servers on which Opsware SAS can
perform management tasks, because Opsware Agents are installed on them. However,
Opsware SAS might not have provisioned all software running on the servers.

You begin the OS provisioning process by reviewing the servers in the Server Pool list.
From the Server Pool, you can install a target OS by selecting a server and clicking Install
0S.

Server Pool

The Server Pool provides the following information about each server waiting to be
provisioned with the target OS:

+ The host name set by booting the server for the first time over the network or by using
an Opsware Boot Floppy

* The MAC address
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* The manufacturer and model

» The OS that the OS Build Agent is running — DOS (Windows operating systems), Linux,
or Solaris

You use this information to select the target OS for servers. If the server is in the
process of installing an OS, this value might change.

» The last date and time that the Opsware Agent on the server communicated with
Opsware SAS (by submitting the server's hardware and software information)

If the server is in an unreachable state (that is, if the server icon has a red “x” on it), you
can run a Communication Test to help you troubleshoot why that server is unreachable.
See “Agent Reachability Communication Tests” on page 114 in Chapter 4 for more
information.

+ The life cycle value, such as whether the server is available to have a target OS
installed on it

» The facility in which the server is located

» The customer association

+ Additional hardware information (Click the server name to open a window that displays
specific hardware information.)

Manage Servers List

The Manage Servers list contains servers on which Opsware SAS can perform
management tasks because Opsware Agents are installed on them. When an existing
operational server has an Opsware Agent installed successfully, it appears in the Manage
Servers list and the server icon indicates that it is fully manageable, as Figure 6-2 shows.

Figure 6-2: The Manage Servers List in the SAS Web Client

Manage Servers (Summary iew) 2
Al Statuses * || Red Hat Enterprise Linux A5 2.1 w || Al Stages || &ll Uzes b

All Facilties % || &ll Customers || All Manufacturers v Update EJ'
Al Models || All Lifecycles -

FResource  Edit  “iew  Tazks  Configuration Tracking

| Host Mame §IP Address  ©S Yersion Stage Uze Facilty Customer

Public Groups
&)

0O [E || m022 dev.opsware.com  m022.dev.opsware.com | Red Hat Erterprise  Nat Mot CO3 Mt
- 192168197 31 Linuzx &5 2.1 Specified  Specified Azzigned
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See “Opsware Agent on Managed Servers” on page 91 in Chapter 4 for more information.
By default, servers in the Manage Servers list are sorted by the Name column. However,

you can re-sort the list based on any of the column headings. For example, you can click
the Hostname / IP Address column heading to re-sort the list by host name or IP address.

If you have many servers that Opsware SAS manages, the list of servers is grouped by
pages. Click the page number links or the left arrow at the bottom of the list.

The Manage Servers list provides the following information about each server:
» The name of the server

By default, the server's host name appears in this field. However, you can edit it so that
it is more descriptive or useful.

+ The host name of the server determined by the Opsware Agent

« The IP address configured for the server, which users can edit by using the network
configuration feature in the

» The reported OS, which is obtained by the Opsware Agent that is running on the server

« The stage of the server, which specifies the stages of deployment for servers

* The server's use

« The facility in which the server is located

* The customer association

+ Additional hardware information (Click the server name to open a window that displays
specific hardware information.)

Filters on the Manage Servers List

The Manage Servers list displays the following filters that you can specify to qualify the
servers that the SAS Web Client displays, as Figure 6-3 shows.

Figure 6-3: Filters in the Manage Servers List

Manage Servers (Summary “iew)

Al Statuses v || &l Operating Systems || Al Stages » || Al Uses || &l Facilties + || &l Customers w

Al Manufacturers || &l Maddels hall} 2N Litecycles

+ Status: Specifies the ability of Opsware SAS to manage servers. Opsware SAS
automatically detects the status of servers; a server’s status is OK or Not Reachable.
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+ 0OS: Specifies the operating system on the server, which is obtained by the Opsware
Agent that is running on the server.

+ Stages: Specifies the stages of deployment for servers; for example, a server is live or
offline. Users set this property for servers. The values in this list are customizable by the
Opsware administrator.

« Uses: Specifies how an organization is utilizing servers; for example, a server is a
staging server. Users set this property for servers. The Opsware administrator can
customize the values in this list.

+ Facilities: Specifies the location of servers. From an SAS Web Client, users can
manage servers located in any facility. For example, a user could log in to the SAS Web
Client running in facility A and manage the server located in facility B.

+ Customers: Specifies the customer associated with each server. Your Opsware
administrator defines the options for customer selections by using the Administration
pages.

+ Manufacturers: Specifies the manufacturer for the server as reported by the OS Build
Agent running on the server.

* Models: Specifies the model of the server as reported by the OS Build Agent running
on the server.

 Life cycles: Specifies the various Opsware server life cycle values which include
Managed, Available, Build Failed, Installing OS, and Deactivated.

You can change the filters displayed in the Manage Servers page. To change the filters
Q you want to be displayed on the Manage Servers page, click on the icon as shown in
Figure 6-4 and specify the filters from the Edit Filters Menu.

Figure 6-4: Edit Icon

Figure 6-5 shows the filters that are in the Server Pool list.

Figure 6-5: Filters in the Server Pool List

Al Manufacturers || Al Models || &)l Facilities » || Update
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+ Manufacturers: Specifies the manufacturer for the server as reported by the OS Build
Agent running on the server.

* Models: Specifies the model of the server as reported by the OS Build Agent running
on the server.

+ Facilities: Specifies the location of the server. Users can manage servers in any facility
from an SAS Web Client in any facility.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved. 165



Opswezre® SAS 6.0.1 User’s Guide: Application Automation

My Servers

This section contains the following topics:
+ Overview of My Servers
+ Adding Servers to My Servers

+ Removing Servers from My Servers

Overview of My Servers

The My Servers feature provides an efficient way to manage servers when your
operational environment contains hundreds or thousands of servers.

When you search for servers or browse the server lists, you can add servers to My
Servers (similar to a shopping cart on an e-commerce site). Using My Servers allows you
to view and perform actions on selected servers.

When you use the same browser and login to the SAS Web Client running in the same
facility, servers stay in My Servers for one year or until you explicitly remove them. Each
time that you login to the SAS Web Client, you see the servers that were in My Servers the
last time that you logged in.

The My Servers feature is available only on a per-user basis. You cannot log in as an
Opsware administrator to see the servers in the My Servers area of other Opsware users.
Adding Servers to My Servers

Perform the following steps to add a server to My Servers:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the servers that you want to add to the My
Servers.

Or
Search for the servers that you want to add to My Servers.

See “Using the Search Feature” on page 169 in this chapter for more information.
See “Server Searching by IP Address” on page 184 in this chapter for more
information.

A Select the servers that you want to add to My Servers.
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E Choose Resource » Add to My Servers from the menu above the Manage
Servers list. The Add To My Servers window appears, which indicates that you added
the chosen number of servers to My Servers.

B Click Close to close the window.

B Next select the My Servers link at the top of the page. You see the selected servers
added to My Servers, as Figure 6-6 shows.

Figure 6-6: Servers in My Servers
My Servers (Summary “iew) 2

Resource  Edit  “iew  Tasks  Configuration Tracking |

D_m Host Mame /P Address OS5 Wersion  Stage Uze Facilty Customer

O EFH mO3E dev.opsware .com mO3s dev opsyware.com SunoS 58 Mot Specified  Production 03 Opsware
- 192168192 67

You can perform the same server management tasks on servers in My Servers as on the
servers in the Manage Servers list.

Removing Servers from My Servers

Perform the following steps to remove servers from My Servers:

H Click the My Servers link in the navigation panel of the SAS Web Client. The My
Servers page appears that shows the servers currently added to it.

H Select the servers that you want to remove from My Servers and choose Edit »
Remove from My Servers from the menu above the Server list.

The My Servers page refreshes and displays the remaining servers in My Servers.
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Server Search

This section provides information about Server Search and contains the following topics:
« Searching for a Server By Using the Search Box

+ Ways to Use Search

» Using the Search Feature

* Rules for Server Search and for Creating Dynamic Groups

+ Line Break Workaround for Server Search

+ Conditions for Searching with Multiple Rules

« Server Searching by IP Address

» Example: Server Search

« Searching for a Server Group

Searching for a Server By Using the Search Box
Perform the following steps to search for a server using the Search box:

E On the Home page, click the down arrow in the top navigation panel to open the
Search box, as Figure 6-7 shows.

Figure 6-7: Search Text Box on the SAS Web Client Home Page

Servers w Nl =Enter search text here=

H Jobs
OME |corver Groups

A Verify that the Servers option is selected in the list.

B Type the server's IP address, host name, or name in the Search box and then click
Go.

The search text that you enter can include an asterisk (*) wildcard character.
However, the search feature automatically prepends and appends an asterisk to the
text.

For example, you can type any of the following search queries:

192.168.68.6
host02.coredev-val.sample.com
192.168.*.19
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hostl*.xyz.samplecompany.com

The resulting page contains one or more servers, depending on the type of search
query that you specified. If no servers are found, the SAS Web Client displays a
message that indicates that no servers were found that matched your query.

See “Using the Search Feature” on page 169 in this chapter for information about
how to formulate complex, multiple rule search queries.

Ways to Use Search

By using the SAS Web Client, you can perform searches in the following ways:

» From Opsware wizards

While using the Opsware wizards from the Tasks panel, you are prompted to select (by
browsing or searching) servers or server groups, and operating systems, at specific
points in the process.

What you can search for in the Opsware wizards is context sensitive to the type of
operation that you are performing.

« From the navigation panel, click Servers » Search.
The Search page allows you to search for managed servers that match specified rules.
+ While adding or modifying rules for a dynamic group (By clicking Search on the Rules
tab for a group).
Using the Search Feature

In the Opsware wizards, you can browse for servers, operating systems, or use the Search
feature to search for these items.
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Perform the following steps to search by using the Search feature:

El n an Opsware wizard, select the Search tab. The following Search page appears.
See Figure 6-8.

Figure 6-8: Search Tab in the Select Servers Step of an Opsware Wizard

Select Software

Select the software application(s) you wish to install.

Browse Search | (0) Software Selected

Match: if all rules are met

|Name V||is V|| | =]

You can also use the Search tab at other steps in the wizards to search for operating
systems, patches, applications, and templates.

Or

From the navigation panel, click Servers » Search. The Search page appears, as
Figure 6-9 shows.

Figure 6-9: Search Page
Search 2

¥ Rules

WMatch: | if all rules are met | % |

Search for servers whose:

Agent Discovery Date V| | Is after v | | May V| |23 V| | 2005 V| =

[ Search ” Save. ][Reset ]

By default, one search rule is added to the search.
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H Specify the rule that you want to search for by selecting it from the first list, as
Figure 6-10 shows.

Figure 6-10: Search Rules List in the Search Page

Agent Discovery Date w
Properties ~
. Agent Discove
Agent Reporting
Agent Status
Agent Version
Custom Attribute {any)
Custom Attribute {local)
Customer
Deployment Stage
Facility
Group Membership
Hostname
Mame (any)
Motes
Opsware Display Name
Server Use
Senice Level
Opsware Properties
Application Caonfiguration
Code Deployment
Configuration Tracking
Lifecycle
Server D
Software
Attached Software
Installed Patches

~assmstalled Software oo es
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Depending on the rule that you select, a popup window might appear in the page.
For example, if you selected Deployment Stage, a popup window showing the
stages appears in the page as Figure 6-11 shows:

Figure 6-11: Search Popup Window with Values
Search 2

¥ Rules

Match: | if all rules are met | v

Search for servers whose:

Deployment Stage v| | Is

Choose any number of deployment stages:

(0) selected

0| ==

[ Buiding

[ FALED

[0 In Deployment

O Live

[ Mot Specified B

[ Mot Specified

Offli

F ine 2
[ Clear All Selections Apply
&] Dane S @ Internet

You cannot search in Notes that contain line breaks. See “Line Break Workaround for
Server Search” on page 183 in this chapter for more information and a workaround.

If you are searching while using an Opsware wizard, the first search rule list might not
have all the options. The list only includes the options that are relevant for the
Opsware wizard that is being used. For example, the Install OS Wizard does not
include options to search for installed patches on the servers.

In the second list, specify how you want Opsware SAS to search by selecting a value.
The operator selected defines how the search text is treated. Negative operators
might not be available in all cases.

See “Rules for Server Search and for Creating Dynamic Groups” on page 174 in this
chapter for more information about the operator for each search rule.
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Bl Enter the text that you want to search for in the text box or choose a value from the
list or popup window. The search text that you enter can include an asterisk (*)
wildcard character. The search text is case insensitive. You can also use the SHIFT or
CTRL key to select multiple values from the list or popup window.

B (Optional) To add additional rules, click the plus (+) button as Figure 6-12 shows and
repeat Steps 2 through 4.

Figure 6-12: Multiple Rules in a Search
Search 2

¥ Rules

Match: | if all rules are met | %

Search for servers whose:

|Depl0yment Stage V| | Is V| |Ir1 Deployment |E =
|Op9ware Display Name V| | Contains V| |marketing| |E =

Search Save .. || Reset

@ If you specified multiple rules for the search, select whether you want search results
only if all rules are met or if any of the rules are met, as Figure 6-13 shows.

Figure 6-13: Operator Controlling Search Results

Match: | if allrules are met | %

if all rules are met |
if anv rules are met

By default, search results appear for servers that match all the search rules. If you are
searching from an Opsware wizard, this field is set to the value if all rules are met;
you can change the value when searching for servers, but you cannot change it
when searching for patches, software, operating systems, and so on.
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Click Search. The list of servers that match your search rules appears in the page, as
Figure 6-14 shows.

Figure 6-14: Displayed Search Results

Results
FResource  Edit Tasks  Configuration Tracking

e i | ||

O @” cazela.znvl.corp.opsware.com cazela.znv].corp.opsware.com 152.1868.9.191  SunO055% c12 Opsware
- Web Services test box

O @ chamarel.znv1.corp.opswars.com chamarel.znvi. corp.opswars.com 192168959146 | Red Hat c12 Opaware
~ Web Services test box Linux 7.3

The search results include columns for Name, IP Address, OS Version, Facility, and

Customer.

When you search for installed software or patches and include an asterisk in the

search text, Opsware SAS might take several minutes to display the search results.
Rules for Server Search and for Creating Dynamic Groups

The following table describes the rules that you can use to search for servers or to create
dynamic server groups.

Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden
your results.

Table 6-3: Rules for Server Search and for Creating Dynamic Groups

PROPERTIES
Agent Discovery Date: The + |s after Drop-down lists with the day,
date that the Opsware Agent | Is before month, and year
was installed.
* Is within the last User-entered text
+ Is today N/A
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Agent Reporting: Whether e Is + Has not reported
the Opsware Agent is
reporting to Opsware SAS.

+ Is not + OK
« Registration in progress

* Reporting error

Agent Status: \Whether the e Is * Not reachable
Opsware Agent is reachable | Is not . OK
by Opsware SAS.
Agent Version: The version of | « Contains User-entered text
the Opsware Agent — such as | Does not contain
14.2.3b.
« s
* Is not
Custom Attribute (any): The « Contains User-entered text
name of a custom attribute s
that is associated with the
server through attachment or
inheritance.
Custom Attribute (local): The | < Contains User-entered text
name of a custom attribute s
that is locally attached to the
server,
Customer: The customer or + s Popup window of customers
account that the server is
* Is not

associated with.
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Deployment Stage: The e Is * In Deployment
stage the server performs
within a lifecycle environment.

Is not « Live
» Not Specified
« Offline

The values that appear in this
list are customizable; in
addition to the values above,
values specific to your
environment might appear.

Facility: The collection of * s Popup window of facilities
servers managed by a.n . Is not
Opsware SAS installation. When Opsware SAS is running

multimaster mode, the list can
contain many facilities.

Group Membership: Whether |« Is Popup window of groups
the server belongs to a group.

Host name: The host name of | < Contains User-entered text
the server — such as

* Does not contain
mO04.company.com.

e s
* Is not

Name (any): This enables + Contains User-entered text
searching for any name or IP
address associated with a

* Does not contain

server. Is

* Is not
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Notes: The contents of the » Contains User-entered text
Notes field from the Properties
tab for a server.

* Does not contain

. Is
* Is not
Opsware Display Name: The + Contains User-entered text
user-configurable name for the .
+ Does not contain
server. By default, Opsware SAS uses
s the configured host name of
+ Is not the server until a user edits it.
Server Use: How the serveris |« Is + Development
being used — such as - Is not - Not Specified
Development, Staging,
Production. * Production
« Staging
You can customize values that
appear in this list. In addition
to the values above, values
specific to your environment
might appear.
Service Level: The user- * s Popup window of service
defined category that can be | Is attached here or levels

used as an organizational tool.
below

Servers can be associated
with multiple service levels.

OPSWARE PROPERTIES
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Application Configuration:
Whether the server uses the
Application Configuration
feature.

Code Deployment: Whether
the server uses the Code
Deployment feature.

Configuration Tracking:
Whether the Configuration
Tracking feature is monitoring
or backing up specific files or
configurations on a server.

Lifecycle: The server states
that are part of bringing a
server into Opsware SAS.

Server ID: The internal ID
Opsware SAS uses to identify
the server.

SOFTWARE

Attached Software: The
software that is assigned or
modeled through the Opsware
installation process.

Is not used

Is used

Is not used

Is used

Is off

Is on

Is not

Is not

Is

Is attached here or
below

N/A

N/A

N/A

+ Available

+ Build Failed
* Deactivated
+ Installing OS
+ Managed

User-entered text

In most cases, the Server ID is
the same as the MID.

Popup window of software
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Attached Software Policies:
The software policies that is
assigned or modeled through
the Opsware installation
process.

Installed Patches: \Whether a
patch is installed on the
server.

Installed Software: The
package reported installed on
the server.

OS Version: The OS version
defined by OS definitions in
the OS Provisioning feature.

Reported OS: For Windows —
the version reported by the
OS, for Unix — the version
returned by the uname
command.

Windows Service: The names
of the Windows services that
are reported to Opsware SAS.

NETWORK
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Contains

» Does not contain

Is
Is not

Contains

» Does not contain

Is

Is not

Is

* Is not

Contains

» Does not contain

Is
Is not

Contains

» Does not contain

Is

Is not

Popup window of software
policies

User-entered text

User-entered text

A package does not have to

be installed by Opsware SAS
to be reported as installed on
a server.

Popup window of operating
systems

User-entered text

User-entered text
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

DNS Search Domains: The « Contains User-entered text
domains configured to be
searched in the server's

* Does not contain

network settings. < Is
* Is not
DNS Servers: The IP + Contains User-entered text

addresses of the DNS servers
configured in the server's

* Does not contain

network settings. < Is
* Is not
Default Gateway: The IP + Contains User-entered text

address of the default router. .
* Does not contain

« Is

+ Is not
IP Address: Any Internet + Contains User-entered text
Protocol address for the server. .

+ Does not contain

e Is

* |s not

MAC Address: Any Media + Contains User-entered text
Access Control address, which
is the network interface card's

* Does not contain

unigue hardware number. * s
* |s not
WINS Servers: The Windows |« Contains User-entered text

Internet Naming Servers
configured in the server's
network settings. . ls

» Does not contain

* Is not

HARDWARE
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

CPU Make and Model: The
vendor name and CPU model
for the server — such as
GENUINEINTEL Intel(R)
Pentium(R) 4 CPU 2.60GHz.

CPU Speed: The Central
Processing Unit speed in
gigahertz [GHZz].

Make and Model: The vendor
name and server model for the
server — such as Compagq -
DL360.

Number of CPUs: The
number of CPUs on the server.

RAM: The amount of RAM on
the server in megabytes [MB].

Serial Number: The serial
number of the server.

* Is not

Does not equal

* Equals

Is greater than
Is less than

Is

* Is not

Does not equal

* Equals

Is greater than
Is less than

Does not equal

* Equals

Is greater than

Is less than
Contains

Does not contain
Is

Is not

Popup window of CPU makes
and models

User-entered text

A 600 Mhz machine should be
entered as 0. 6.

Popup window of server
makes and models

User-entered text

User-entered text

To enter 1 Gigabyte, type
1024.

User-entered text
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Table 6-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Storage Make and Model: e Is

The vendor name and storage
* Is not

model for the server — such as

WDC - WD800BB-75DKAO.

CUSTOM FIELDS

A Numeric field * Does not equal
* Equals

 |s greater than
* Is less than
A String field « Contains
* Does not contain
s Is
* Is not
A URI field + Contains
+ Does not contain
s Is
* Is not
A File field + Contains
+ Does not contain
+ s
+ Is not
A Date field * Is after
* |Is before
* |s within the last

+ |s today

Popup window of storage
makes and models

User-entered text

User-entered text

User-entered text

User-entered text

Drop-down lists with the day,
month, and year

User-entered text

N/A
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Line Break Workaround for Server Search

You cannot search in notes that contain line breaks. For example, you cannot search for
text in a note when it is this type of text:

linel <line break>

line2

For example, the following query does not return any results:
Any/all notes contain linel <line break> line2
However, the following query does return all servers that have notes:
Any/all notes is not linel <line breaks> line2

To work around this limitation, include an asterisk (*) where the line break occurs, as
Figure 6-15 shows. For example:

Any/all notes is linel*line2

Figure 6-15: Line Break Workaround in the Server Search Feature

Search 3)

¥ Rules

Watch: | if allrules are met | v |

Search for 2ervers whose:

Motes V||Is V||Iine1*lin92| | =

[% l Search ” Save .. ][Reset ]

Conditions for Searching with Multiple Rules

When you perform a search with multiple rules, the following conditions apply to the way
Opsware SAS provides search results:

+ When it evaluates rules, the Search feature considers each rule individually, finding
servers (or operating systems, patches, and so forth) that match the individual rule, and
then the results of each rule are combined.

* You must select at least one rule, and it must have a value. Default filter rules count as
rules with a value.
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« Empty rules are ignored in searches. Users do not have to manually remove them for
the search to proceed.

» You cannot search for empty values. For example, you cannot search for all servers
where the Notes field is empty.

At certain steps in the Opsware wizards, the Search feature provides default values based
on previous selections in the wizard.

The wizards are flexible; for example, when you select multiple servers and applications,
Opsware SAS will install the correct applications on the servers, even if you selected

different OS versions for the servers and applications in the respective steps. Opsware

SAS also matches the customer association for applications, operating systems, and

templates with the customer association of servers.

If Opsware SAS cannot find a match, an error message appears at the end of the wizard;

therefore, use caution when modifying these default values.

Server Searching by IP Address

Users can search for servers by entering a specific IP address in the Search box in the top
navigation or in the Search feature.

Opsware SAS includes support for static Network Address Translation (NAT). This feature
introduces the concept of a management IP, which might be different from any of the
local IP addresses that the Opsware Agent reported for a server.

When searching for a server based on its IP address, the Search feature searches based
on the server's primary IP address and based on the IP address for any interface that
server has, including its management IP address. In the search results, an extra column is
shown that lists all matching IP addresses for all interfaces. The management IP address
is included if the server's networking is configured for static NAT.

See “Communication Between Managed Servers and Opsware SAS” on page 201 in
Chapter 7 for information about how Opsware SAS handles servers that are affected by
static NAT.

Example: Server Search

Using the Search feature, a user creates a query with the following conditions:

+ Installed Software contains ga
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 Installed Software contains man
« If all rules are met is selected

The results of this search will be all servers that have at least one installed package with
ga somewhere in its name and at least one installed package (not necessarily the same
one) with man in its name.

The search results are not limited to packages that contain both ga and man in the
package name.

Find all servers that have some version of Apache or some version of Java installed:
+ Installed Package contains apache
« Installed Package contains java

« If any rules are met is selected

Searching for a Server Group

E From the navigation panel, click Servers » Search. The Search page appears. By
default, the Servers tab is selected.

Select the Groups tab. The rules for server group search appear as Figure 6-16
shows. By default, one search rule is added to the search.

Figure 6-16: Rules for Server Group Search
Search D

¥ Rules

Watch: | if all rules are met v |

Search for groups whose:

Group Mame v | Contains v | | | =]

|Properties

H nthe second list, specify how you want Opsware SAS to search by selecting either
“Contains” or “Is”. The operator selected defines how the search text is treated.

Enter the text that you want to search for in the text box. The search text that you
enter can include an asterisk (*) wildcard character. (The search text is case
sensitive. Search is not enabled until you enter text in the text box.)
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When searching for a server group, you can only specify one rule for Group Name. The

AN
plus (+) button is disabled.

Bl Click Search. The search results appear as Figure 6-17 shows.

Figure 6-17: Server Group Search Results
Search 2

¥ Rules

Match: | if all rules are met | »

Search for groups whoze:

Group Mame hd | | Contains Vl |test | D B

Results

Resource  Edit  Tasks  Configuration Tracking |

LENTEE Total Madsl Custom
| Location Serverz Subgroups Serverz Type Aftachments Atftributez  Last Use

o atestgroup Public Groups 0 0 0  Dynamic 3 0 03-22-0%
I
g 15:00:00

Server Identification

This section provides information on server identification within Opsware SAS and
contains the following topics:

» Overview of Server Identification

Ways that Servers are Identified by Opsware SAS
» Customer Accounts in Opsware SAS

» Associating Servers with Customers

Overview of Server Identification
Opsware SAS uses the following IDs to track managed servers:

+ MID: Machine ID. The unigue identifier that Opsware SAS uses to identify the server.
The MID is usually equal to the server ID.
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The MID is stored in a file on a server's disk so that the MID can persist and be read by
the Opsware Agent.

The MID follows the hard disk, not the chassis, so system administrators can swap
chassis for servers without affecting how Opsware SAS tracks those servers.

See “Example: Opsware SAS Swaps a Server's Hard Disk” on page 188 in this chapter
for information about swapping hard disks.

Server ID: The primary key in the Opsware Model Repository (database) that
represents a given server. The Server ID is used internally in Opsware SAS. Generally,
users do not need this value for servers to manage them in Opsware SAS.

MAC Address: Media Access Control address, which is the network interface card’s
unigue hardware number. The MAC is used as the server's physical address on the
network.

Chassis ID: A unique hardware-based identifier that the Opsware Agent discovers,
typically derived from some property of the server's chassis. As a common source for
this ID, Opsware SAS uses an interface's MAC address or the host ID on Solaris
servers, or the serial number for one of the interfaces.

Ways that Servers are Identified by Opsware SAS

Servers in the Manage Servers list are identified in the following ways when they register

their hardware and software with Opsware SAS:

+ Opsware SAS identifies each server by using the MID first.

+ If the MID cannot be determined, the chassis ID is used to identify the server.

« If the server cannot be identified with the chassis ID, the MAC addresses are used to

identify the server.

In the Server Pool, the MAC Address column displays values by which Opsware SAS

tracks the servers. The value used varies by platform:

« Intel x86 processor-based servers are identified by the MAC address of the server.
+ Sun SPARC processor servers are identified by the host ID of the server.

The host ID for Sun SPARC processor servers appears in the MAC Address column in
the Server Pool list.
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To determine the value in the MAC Address column, Opsware SAS uses the hardware
address by which the server contacted the Opsware Build Manager (a component of
the OS Provisioning feature).

Example: Opsware SAS Swaps a Server’s Hard Disk

The following steps show how Opsware SAS handles swapping a hard disk for a server:

A system administrator swaps the hard disk of Server A (MID 1230001, chassis ID
AB: 08) with the hard disk of Server B (MID 98730001, chassis ID XY: 96).

The Opsware Agent on Server A registers its hardware with Opsware SAS. The MID
for Server A equals 1230001 and the chassis ID equals XY : 96.

Opsware SAS locates Server A by using the MID.

Opsware SAS updates the data it has for Server A in the Model Repository. It sets the
chassis ID equal to XY : 96.

The Opsware Agent on Server B registers its hardware with Opsware SAS. The MID
for Server B equals 98730001 and the chassis ID equals AB: 08.

Opsware SAS locates Server B by using the MID.

Opsware SAS updates the data it has for Server B in the Model Repository. It sets the
chassis ID equal to AB: 08.

Customer Accounts in Opsware SAS

Many enterprise customers have consolidated disparate IT operations into a single
operation, yet they still need separate reporting, billing, and management for different
business units or groups (for example, West Coast Office, East Coast Office, and London
Office).

Opsware SAS accommodates these requirements with customer accounts created by
your Opsware administrator.
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When your Opsware administrator creates a customer in Opsware SAS, a value for that
customer is automatically added to the customer filter in the Manage Servers list, as
Figure 6-18 shows.

Figure 6-18: Customer Filter in the Manage Servers List

Manage Servers (Summary View) 2
All Statuses w || Al Operating Systems || Al Stages hd
All Uzes w | Al Customers v | &l Manufacturers A Update Ejl'

Al Models bactivated v

Rezource Configuration Tracking

[} Mame [P Address  OS Version Stage Uze Customer
@di Public Groups
&
O Ei coretr3opsware.com  corgtr3opsware.com  Red Hat Mot it Opswware
- 172163618 Enterprize Linux  Specified  Specified
AS S
El E’ OPEWARE-STROCOZ  OPSWARE-STROCOZ  Windows 2000 hat Mat Mot
-~ 172163643 Specified  Specified  Assigned

By using customer accounts in the SAS Web Client, you can segregate servers that
belong to different business units. By segregating servers, you can have separate
accounting for each customer or different levels of security for different customers. You
might want to segregate the servers based on the department or business unit.

By default, Opsware SAS is shipped with the following two customers:

+ Customer Independent: A global customer in Opsware SAS. Resources that are
associated with “Customer Independent” can be installed on any managed server, no
matter what customer it is associated with.

* Not Assigned: The servers are not associated with a customer. You can install
resources that are Customer Independent on Not Assigned servers. However, you
cannot install or use any resources associated with a customer on a server that is not
assigned to a customer.

When you install an Opsware Agent in a server, the server is associated with the Not
Assigned customer if IP ranges were not created to automatically associate Opsware SAS
managed servers with customers. See Figure 6-19.
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Opsware, Inc. recommends that you associate servers with customers, if necessary, by
Iz using the Server Properties pages.

Figure 6-19: Customers List Under Environment in the SAS Web Client

Customers
Mame Matne
ﬁ'ﬂiu 12204 ;'-')‘u Corp Test
ﬁ'ﬂiu Bigy Cor "-"'u Big Corp2
i"u Test Cust ;‘-"'u Customer Independert
ﬁ"u E-Cammerce ;'-ﬁ'u Rt Assigned

Associating Servers with Customers

An Opsware user or an Opsware administrator can set up an IP range group so that
servers are automatically associated with customers when users perform the following
server management tasks:

+ Install Opsware Agents on the servers.

See “Agent Reachability Communication Tests” on page 114 in Chapter 4 for more
information.

« Use the OS Provisioning feature to install operating systems on bare-metal servers.
See Opsware® SAS User’s Guide: Application Automation for more information.

To set up this automatic customer association, you must create IP range groups for
customers and specify the ranges of IP addresses that the groups contain.

In the SAS Web Client, an IP range group is both a physical and logical list — an
accounting way to group ranges of IP address and assign them to a particular customer.
An IP range identifies a range of IP addresses within an IP range group.

1 90 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 6: Server Tracking in the SAS Web Client

When you set this up, IP addresses get their customer association through the IP range,
which, in turn, gets its customer association from the IP range group.

Customer
IP Address > IP Range > IP Range Group

Facility (data center
or server room)

See the Opsware® SAS Policy Setter’'s Guide for more information.

The loose relationship between server and IP address means that you can associate a
server with a different customer from its IP address.

Even when IP range groups are set up for a customer, a server's IP address does not
necessarily determine the customer to which the server is associated because a user can
change the customer association in the Server Properties page.

See “Editing the Properties of a Server” on page 244 in Chapter 7 for information about
how to change the customer association for a server.

The customer association for a server is based on the management IP address of the
server and not the primary IP address.

See “Communication Between Managed Servers and Opsware SAS” on page 201 in
Chapter 7 for information about how Opsware SAS uses management IP addresses for
servers.
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However, a server always belongs to the same facility (data center or server room) as its
primary IP address. Opsware SAS enforces the relationship between server and facility at
hardware registration. See Figure 6-20.

Figure 6-20: Primary IP Addresses in Opsware SAS

Primary IP Address

"Loopback Network"
10.200.0.0/24

"Core Network"

Loopback Address
= 10.200.0.1

10.2.21

Router

¥

"Network B"
10.2.2.0/24

Switch B

"Network A"
10.1.2.0/24

Switch A

Customer A Customer B

10.2.2.20

o —@
Server 2

10.1.2.11 10.2.2.21
Primary IP
Address

In this illustration, the following conditions apply:

» Server 1 belongs to Customer A.

« Server 2 belongs to Customer A but has IP addresses in Network A and Network B.
» Server 3 belongs to Customer B.

» The Router belongs to the Core Network but has IP addresses in Network A and
Network B.
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Server Histories and Reports
This section provides information on server histories and reporting with Opsware SAS and

contains the following topics:
« Overview of Server History
+ Viewing Server History

+ Time Stamp for Server Operations

Overview of Server History

By using the SAS Web Client, you can view the history of changes made to a server. Each
action performed on a managed server is logged in the history with the associated user
who performed the action and the time of the action. You can view the history at any time,
but you cannot change it. History is read-only.
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Each History entry contains three pieces of information, as Table 6-4 shows.

Table 6-4: ‘Description of the Entries in the Server History Tab

Event Description Description of the operation performed, for example:

Run ISM Control: ad-hoc script (Job ID:
26190040) executed successfully.

Modified By The name of the Opsware user who made the change.

Date Modified The date and time the change was made, for example:
Mon Aug 06 18:14:41 GMT+00:00 2001)

Time Stamps used in History
Data is maintained for servers in Opsware SAS for the following periods of time:

« The SAS Web Client maintains the history of changes for the last three-month interval.

+ Command Engine session logs are retained for 30 days, except for the last remediate
session for a server, which is retained indefinitely.

The Command Engine is the Opsware SAS component that enables distributed
programs to run across many servers.

« Server history is retained for 6 months.

If longer periods of time are required, Opsware, Inc. recommends regular backups to
Q enable offline storage of Opsware SAS data.

Opsware SAS deletes old data from the Opsware Model Repository, and does not copy
the data before it removes it, but you can retain information for longer periods of time, by
using Oracle commands to manipulate scheduled jobs. Contact your Opsware, Inc.
support representative for assistance in changing these retention periods.

Viewing Server History

Perform the following steps to view the server history:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose history you want to view.

Or
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Search for the server whose history you want to view.

See “Using the Search Feature” on page 169 in this chapter for more information.
See “Server Searching by IP Address” on page 184 in this chapter for more
information.

H Click the name of the server whose information you want to see. The Manage
Servers: Properties page appears for that server.

E Select the History tab.

By default, the view shows changes made within the past week.

Time Stamp for Server Operations

Opsware SAS maintains a comprehensive audit trail of the software that the Opsware
users install, configure, and remove from a server. By using the SAS Web Client, you can
view the history of the changes made to a server. Entries are generated when actions are
performed for managed servers in the SAS Web Client. The history is read-only. See
“Server Histories and Reports” on page 193 in this chapter for more information.

The time stamps for system events are determined based on the system clocks of the
servers running the Opsware core components. To obtain accurate time stamps in server
histories (displayed in the SAS Web Client) and Opsware component logs, you must:

+ Synchronize the system clocks on all servers running Opsware components so that all
the servers are running with a common time.

+ Set the time zone for all servers running Opsware components to Coordinated
Universal Time (UTC).

See the Opsware® SAS Planning and Installation Guide for more information on facility
time requirements.

Additionally, Opsware, Inc. recommends that after installing an Opsware Agent on the
server (so that it becomes managed by Opsware SAS), you should synchronize the
system clock on the server with the system clocks of the servers running the Opsware
core components.

The time stamps appearing in the SAS Web Client server History tab and the Opsware

Agent logs are obtained from the Opsware core; however, you might need to review the
server's logs (such as, stdout). Having a consistent time stamp in the server's logs and

Opsware SAS is essential for effective troubleshooting.
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Hardware Information for Managed Servers

The Hardware link of the SAS Web Client provides a read-only view of all servers in your
managed environment categorized by hardware manufacturer and model. The Hardware
link provides hardware related information for each server, such as:

+ Manufacturer

* Model number

« MACID

+ Serial number

+ CPUs used on the server

+ Memory

+ Storage capacity

See “Server Information that the Opsware Agent Tracks” on page 95 in Chapter 4 for
more information.

Viewing Managed Server Hardware Information

Viewing hardware information allows you to see all the servers in your managed
environment by hardware vendor, and view such information as MAC ID, CPUs, memory,
and so on.

To view hardware of managed servers:

E From the navigation panel, click Environment » Hardware. You see the top level of
the Hardware category in the managed environment, as shown in Figure 6-21.

Figure 6-21: Top level hardware

Hardware /)
Details
O varaware
Mame OF Yersion tdaodified Customer
[} sERVER O Incependent 03-28-2005  Customer Independent

H To view the servers in your managed environment, click the Servers link.
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El Drill down to the type of server you want to look at. For example, you might want to
look at all Dell POWEREDGE 650s, as shown in Figure 6-22.

Figure 6-22: Hardware home page for Dell POWEREDGE 650s

Hardware = SERVER * DELL COMPUTER CORPORATION = POWEREDGE 650

[ u POWEREDGE 650

Mo Sub-Modes

Zannot edit or delete this Mode. This Mode is auto-generated. This Mode is special and cannot be modified.

Name: POWEREDGE 650
Customer: Custamer Independent
Operating Systermn: 05 Independent
Locked: Mo
Allow Servers: ‘Yes

ID: 1360003

B Next, select the Members tab. You will see a list of all the Dell POWEREDGE 650s in
your managed environment.

B To view specific hardware information, from the View menu, choose Hardware. You
now see more detailed information about all the Dell POWEREDGE 650s computers
being managed by Opsware SAS.
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This section discusses the following topics:

Overview of Server Management

Communication Between Managed Servers and Opsware SAS
Server Groups

Server Life Cycle

Server Management Jobs

Custom Fields for Servers

Custom Attributes for Servers

Network Configuration

This section does not document how to install operating systems, patches, or applications
on servers. However, it does discuss how those tasks fit into the overall server life cycle,
and it does provide cross-references to the appropriate topics in other sections.

Overview of Server Management

Opsware SAS manages servers in an operational environment in the following ways:

Provisioning servers with Microsoft Windows, Red Hat Linux, and Sun Solaris operating
systems by using vendor-provided operating system bootstrapping technologies.
Additionally, Opsware SAS integrates with AIX NIM and HP-UX Ignite installation
technologies to provide a uniform method for OS provisioning across a heterogeneous
environment.
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See Opsware® SAS User’s Guide: Application Automation for information about how
Opsware SAS provisions Microsoft Windows, Red Hat Linux, and Sun Solaris operating
systems on managed servers.

See the Opsware® SAS Administration Guide for information about how Opsware SAS
integrates with AIX NIM and HP-UX Ignite installation technologies.

» Providing configuration tracking, which allows users to monitor selected configuration
files and databases and to take certain actions when change is detected.

See “Configuration Tracking” on page 387 in Chapter 12 for more information.
« Automating the management and execution of server scripts.

See See “Distributed Script Execution” on page 323 in Chapter 10 for more information.

To manage servers with Opsware SAS, you do not need root access on Unix or

IZ administrator access on Windows. However, you will need permissions to use specific
Opsware SAS features, as well as permissions for customers and facilities associated with
servers. To obtain these permissions, contact your Opsware administrator. For more
information, see the Permissions Reference appendix in the Opsware® SAS
Administration Guide.
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Communication Between Managed Servers and Opsware
SAS

This section provides information about communication between managed servers and
Opsware SAS and contains the following topics:

» Network Address Translation (NAT) for Managed Servers

+ Key Terms of Opsware SAS Managed Server Communication
» Locating the Management IP Address of a Managed Server
» Code Deployment and Static NAT

+ Setting the Primary IP Address of a Server

* NAT Table Mapping and Managed Servers

Network Address Translation (NAT) for Managed Servers

To manage a server, Opsware SAS requires that the server have a unique IP address that
is routable from Opsware SAS. However, in a large operational environment, all servers
might not have unique IP addresses. In this case, Opsware SAS supports static Network
Address Translation (NAT) for managed servers.

Static NAT maps public IP addresses to hosts inside the internal network, which allows
Opsware SAS to manage all servers in the environment.

Unlike dynamic NAT, the mapping between Opsware SAS and the servers under
management is set ahead of time, not dynamically at runtime.

Key Terms of Opsware SAS Managed Server Communication

To understand how Opsware SAS communicates with managed servers, you must
understand these three terms:

+ Management IP: The IP address that Opsware SAS uses to communicate with the
Opsware Agent on the server.

During hardware registration for a server, the Opsware Agent opens a TCP/IP
connection to Opsware SAS. The connection contains the source IP (called peer IP)
address of the server. By default, Opsware SAS uses this peer IP address as the
management IP for the server.

+ Management Interface: \When a server has more than one network interface, you can
designate one of them as the management interface.
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« Primary IP: The IP address of the management interface. When you change the
management interface, the primary IP changes to the IP address of that interface. The
primary IP address is a locally-configured IP address.

During synchronizations, the Code Deployment & Rollback feature uses the primary IP
address to communicate with the server. See “Code Deployment and Static NAT” on
page 204 in this chapter for more information.

The Opsware Agents on servers communicate with each other by using the primary IP
addresses, even though Opsware SAS uses management IP addresses to
communicate with the servers.

Opsware SAS does not support managed servers that have IPv6 addresses.

When static NAT is being used, the management IP address for a server will not be the
same as the primary IP address. When static NAT is being used, the management IP is
the NAT-translated IP address for the server. When static NAT is not being used, the
management IP address is always the same as the primary IP address.

Locating the Management IP Address of a Managed Server

In the SAS Web Client, you can find the management IP address of a server and check
whether it is using static NAT. You might need this information for troubleshooting any
servers marked Not Reachable and to determine whether your NAT configuration is
correct. The SAS Web Client displays the management IP address of a managed server in
the following two places:

» The Network tab of the Server Details page

« The Hardware view of the Manage Servers list
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The Network tab shows (and allows the user to set) the management interface for the
server by selecting it from a drop-down list, as Figure 7-1 shows.

Figure 7-1: Management IP Address Information in the Network Tab

NETWORK INFORMATION |

Hostname: |core.tr3.0psware.com

Management IP: 17216.36.18
Facility: DATACEMTER1

Management Interface:

Gateway: |17 15.36.17

DNS Servers: |gf 54 32 78
66.54.0.75

Search Domains: tr3.0psware.com

opsware.com

CONFIGURATION FOR: ethn
Use DHCP Settings:

IP Address: 1173 15.36.18 |

MAC Address: 00:11:43:D7:2F:5F
Interface Type: ETHERMET
Interface Speed: {nhot sef)

SubnetMask: |5c5, o5 265,248 |

CONFIGURATION FOR: eth1
Use DHCP Settings:

IP Address: | |

MAC Address: 00:11:43:D7:2F:60
Interface Type: ETHERMET
Interface Speed: {nhot sef)

Subnet Mask: |
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Figure 7-2 shows the Hardware view in the Manage Servers list, which displays the
management interface for the server in the Network Info column. (To access the
Hardware view, choose Hardware from the View menu.)

Figure 7-2: Hardware Tab in the Manage Servers List

Al Statuzes w Al Operating Systems Al Stages v Al ses w &) Customers v Al Manufacturers Al Models v

Upilate
Managed & Deactivated v D

Resource  Edit  “Wiew  Tasks  Configuration Tracking

o Host Mame /P Address Redqistration  Metwork Info Hardwvare Info Hardheeare Components
'{g’ Public Groups
O Ej corelriopswarecom  coredrdopsware com O 17216 36.18 (eth) Mar:  DELL COMPUTER CORPORATION CPUs:  Intel(R) Xeon(TM) CPU 2.80GHz, 2793 MHZ, 1 MB
17216.36.18 i et ) Mok POWEREDGE 1850 Intel(R) ¥eon(TH) CPU 2 80GHz, 2783 MHz, 1 MB
Mac: 00:11:43:D7:2F:5F Intel(R) ¥ean(Th) CPU 2 80GHZ, 2793 MHZ, 1 MB
Ser: 2YLLPE1 Intel(R) ¥eon(Th) CPU 2.80GHz, 2793 MHZ, 1 MB

Memory: 3.9 GB RAM
1.85 GB SWAP
Stor. hda (CDROM)
sda (SCSI DISKES 24 GA)

The Network Info column shows the IP addresses and interfaces configured for each
server in the list. If a server is using static NAT, the management IP is the first entry in this
list and (NAT) appears after the IP address. If it is not using static NAT, the management IP
is the same as the management interface, so it is already shown.

Code Deployment and Static NAT

Code Deployment and Rollback (CDR) synchronizations can only occur between
Opsware Agents in the same NAT domain. Synchronizations cannot be performed
between Opsware Agents in different NAT domains.

Opsware SAS uses the primary IP address (instead of the management IP address)
during synchronization because it is assumed that static NAT is not occurring between
the servers in the synchronization. During CDR synchronizations, two Opsware Agents
must communicate directly. Users can override the IP address that Opsware SAS
determined and designate a specific network interface as the management interface.

See “Code Deployment and Rollback” on page 359 in Chapter 11 for information about
how to use CDR.
Setting the Primary IP Address of a Server

When a server has more than one network interface, users can specify one of them as
the management interface and the IP address for this interface is designated the primary
IP address. The primary IP address is used for Opsware Agent-to-Opsware Agent
communication.
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If static NAT is not being used, the management and primary IP addresses are the same.
If static NAT is being used, the management IP is unaffected when a user changes the
management interface.

Perform the following steps to set the primary IP address of a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose management IP address you
want to view.

Or

Search for the server whose management IP address you want to view.

Click the server name. The Manage Servers: Properties page appears.
E Select the Network tab. The network information for the server appears.
The Network tab shows (and allows you to set) the server's management interface.

Bl Set the management interface by selecting it from the Management Interface field.
The IP address for this interface is designated the primary IP address.

B Click Update.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

NAT Table Mapping and Managed Servers

Static, one-to-one NAT tables map routable IP addresses between Opsware SAS and
managed servers. Network administrators configure and maintain these NAT tables. After
the static NAT tables are configured, you do not have to perform any additional setup for
Opsware SAS.

Opsware SAS does not control these NAT tables and errors can occur if they are modified
after Opsware-managed servers register their hardware information. The following errors
can occur if the IP address mapping of a server changes:

+ If the IP address on the Opsware SAS side of the NAT mapping is modified, the server
becomes unmanageable and might be marked Not Reachable on the Manage Servers:
Status page. It stays in this state until the Opsware Agent requests another hardware
registration and the server's management IP is updated.

« If an IP address mapped to a particular server is mapped to a different server, both
servers become unmanageable and might be marked Not Reachable on the Manage
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Servers: Status page. This problem is resolved when one of the two servers reports its
IP address during hardware registration. The other server remains unmanageable until
the server registers with the Opsware Agent. Both servers eventually become
manageable.

Server Groups

This section provides information on server groups within Opsware SAS and discusses
the following topics:

« Overview of Server Groups

+ Types of Server Groups

* Public Group Modeling

+ Ways to Create Server Groups

« Adding a Server to Static Groups, Both Public and Private

» Removing Servers from Static Groups, Both Public and Private
» Duplicating Server Groups

» Rules for Deleting Server Groups

Overview of Server Groups

The Server Groups feature is useful for gathering servers into collections. These groups
can be used as a shortcut for performing the same action on all of the servers
simultaneously, instead of performing the action on each individual server, one at a time.
Server groups can also be used to simply organize groups of servers.

Server groups can be comprised of individual servers as well as other server groups.

The My Servers feature can also be used to gather servers and server groups, but it has

Q different functionality than the Server Groups feature. You can add individual servers,
server groups, and nested groups that you access frequently to My Servers. See “My
Servers” on page 166 in Chapter 6 for information about using this feature.
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Uses for Server Groups
Some recommended uses for server groups include:

+ Grouping servers by OS version

« @Grouping servers by customer

+ Grouping servers by facility

« Grouping servers by deployment stage

+ Grouping servers by use (Server Use in the Server Properties page)

« @Grouping servers by operational boundaries, for example, grouping together all servers
that require identical application configuration

« @Grouping servers by access control boundaries, for example, creating server groups
that are associated with a specific User Group

Permissions Required for Working with Server Groups
Users must have the permissions shown in Table 7-1 in order to perform specific tasks
related to server groups. Only administrators can set permissions.

Table 7-1: Permissions Required for Working with Server Groups
Manage Servers Create, edit, and delete pri-

vate server groups, both
static and dynamic.

Manage Public Server The Manage Servers Per- Create, edit, and delete pub-
Groups missions section on the lic server groups, both static
Other tab in Users and and dynamic.
Groups

Model Public Server Groups | The Manage Servers Per- Model public server groups.

missions section on the See “Public Group Model-

Other tab in Users and ing” on page 210 in this

Groups chapter for more
information.
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Table 7-1: Permissions Required for Working with Server Groups (continued)

Allow Run Refresh Jobs The Manage Servers Per- Add or remove servers from
missions section on the groups before a scheduled
Other tab in Users and job is run. This permission
Groups gives you the option to

refresh group membership
before a job is run so that it
is only run on the servers
that belong to the group
when the job is actually run.

Characteristics of Server Groups
When using server groups, groups have the following characteristics:

 Individual servers can be included in as many groups as you want, or not included in
any groups.

« Adding servers to a group does not remove those servers from the list of all servers
that appears when you click Servers » Manage Servers in the navigation panel.

+ Groups can contain servers and subgroups.
« Server groups are hierarchical (they can be nested) with these caveats:

« Private and public groups cannot be mixed in a hierarchy, but static and dynamic
groups can.

See “Types of Server Groups” on page 209 in this chapter for more information about
private and public groups.

» The rules for a dynamic group are not inherited from a parent dynamic group to a
dynamic subgroup.

See “Dynamic Groups” on page 210 in this chapter for more information about the
characteristics of dynamic groups.

» Groups do not inherit modeling data from their parents, including custom attributes.

« When you run an operation on a group that contains nested groups, the operation
also applies to all the servers in the nested groups below the current group.
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* When an Application Configuration operation within the SAS Client is applied to
groups, and those groups contain subgroups, the operation does not apply to all the
servers in the subgroups. It only applies to the group upon which the operation was
directly applied.

Types of Server Groups

There are private groups and public groups, and each can be either static or dynamic.

Private Groups

If you belong to a user group that has access to the Manage Servers list, you can create
groups that you alone can see and work with. Only you see your private groups — other
Opsware users cannot see them. Private groups behave the same way as public groups,
with the exception that modeling is not available for private groups. See “Public Group
Modeling” on page 210 in Chapter 7 for information about how the Opsware model
affects groups.

When you create your first group, the default type will be Private Static, which can be
changed to Private Dynamic, Public Static, or Public Dynamic. When you create a sub-
group, the type of group is private if you are in a private group when you create the new
group, and the type is public if you are in a public group when you create the new group.
Public and private groups cannot be mixed in a hierarchy. In other words, if the parent
group is public, the subgroups must be public, and if the parent group is private, the sub-
groups are also private.

Public Groups

Public groups can be created, edited, or deleted by anybody who has Manage Public
Server Groups permissions. Public groups are visible to all users, and can be used by
anybody, regardless of who created them, but only users with the Manage Public Server
Groups permissions can change the rules that govern dynamic groups.

A link called Public Groups appears at the top of server lists. Clicking that link displays a
list of available public groups.

Only public groups can be used for modeling.

Static Groups

Static groups can be either public or private, and no specific permissions are required for
static groups. A static group has servers that are added to and removed from the group
manually. When using static groups, you first create the group, and then select the
servers to populate it.
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Dynamic Groups

Dynamic groups contain servers that are added to or removed from the group based on a
set of user-defined rules. If the rules are changed or the servers in the environment
change, servers will be added to or removed from the group automatically. Rules apply
only to the group being created or modified, not to any subgroups.

Once the rules have been created, Opsware SAS will search for servers that match the
criteria of that specific group, and add them to the group. When the rules are changed,
Opsware SAS will search again, and the resulting group members reflect the changed
criteria. Consequently, as servers are added to or removed from management using
Opsware SAS, the members of the group will change automatically.

Opsware SAS calculates server group membership each time any of the following actions
occur:

+ After users add, delete, or change the rules for dynamic server groups.

* When attributes of servers change such that dynamic group membership could
change.

Additionally, Opsware SAS automatically recalculates dynamic group membership every
hour.

When a user schedules a job to run, dynamic group membership can be determined in
either of the following ways:

« Based on the servers in the dynamic group when the job was scheduled.

+ Based on the set of servers in the dynamic group when the job actually runs. The
membership is recalculated at that time.

Public Group Modeling

With Opsware modeling, the desired state of a server is defined and then applied to
servers. In the case of public server groups — static and dynamic — you can define a
model consisting of applications, patches, service levels, and custom attributes, which will
be applied to all servers in the group. The modeling information is attached to the group,
but not to any subgroups.

If the modeling information changes, the servers in the group are not affected until the
remediate operation runs on those servers. If the model has already been remediated on
that server when it is removed from the group, the installed material will be removed at
the next remediate process.
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Manage Servers Display for Public and Private Groups

As Figure 7-3 shows, server groups appear at the top of the Manage Server list. Public
Groups appear as a link at the top of the list. Private groups, if any have been created,
appear next, followed by the list of individual servers.

Figure 7-3: Manage Servers Displaying Public and Private Groups — Servers and Group View
Resource  Edit  “iew  Tasks  Configuration Tracking _L@ |

D__ Host Name / [P Address 0S Version Stage S Facility Customer e’

4] Public Groups

O @ barbar, 0 Servers (Static)

O barfoo, 0 Servers (Dynamic)
sl

O \J dhcp-8-071.corp.opsware.com :EEp1-B—U1
dL

.corp.opsware.com | Red Hat Enterprise Not Not c29 Opsware
faizals desktop do not touch

ES.S?.H Linux AS 3 Specified Specified
Manage Servers List - Groups Only

When you select View » Groups Only from the menu, information about the number of
servers in a group, the number of groups in a group, and whether the group is static or
dynamic appears in the list of groups, as Figure 7-4 shows.

Figure 7-4: Manage Servers List — Group Only View

Manage Servers (Surnmary View - Groups Only)

| oK || All Operating Systems v || update

Resource  Edit  “Yiew  Tasks  Configuration Tracking

o sE Total Model Custom
] Servers Subgroupz Servers Type Attachments Aftributes  Last Uze

§oai Public Groups 0 113 222 0 0
s
0 Eij A Group 0 1 0 Static 0 0

You can modify your views of servers and server groups by selecting Summary,
Hardware, Software, and Communications from the View menu. You can also elect to
further modify your view by selecting Servers and Groups, Servers Only, or Groups Only.

Operations on Server Groups

Any operation that can be done to a server can be done to a server group, because the
group acts as a container for a collection of servers, and so provides a shortcut to avoid
having to repeat the same operation on each individual server.
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When any of the following operations are performed on a group, they are actually
performed on the servers within the group, not on the group itself.

* Run
« Script
+ Custom Extension
+ Communication Test
+ Customer
+ Usage
» SAS Client operations

+ Configure Application

.

Audit Application Configurations

Perform Server Audit

» Create Server Snapshot

Install Patch

Install software

Also, some operations allow users to refresh the list of servers in the group (if the user
has the Allow Run Refresh Jobs permissions). Users with the correct permissions
schedule a job, and before the job is run, Opsware SAS will update the members of the
server groups upon which the operation is performed. The following actions allow refresh
when scheduling a job:

* Run Script

* Run Custom Extension

Using Server Groups Tabs

When you view group properties, the information for the group appears in the page, as
Figure 7-5 shows.

You can view group properties in either of the following ways:

+ By clicking the This Group link at the top of each server group list.
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+ By selecting a group in the list and choosing Resource » Properties from the menu.

Figure 7-5: Tabs Available for Server Groups

tanage Servers / Public 7 All Windows Servers / Properties »

Properties 0 0

The following properies describe ar restrict use of the current group.

Name: All'Windows Semvers
Description:
Type: Dwnamic
Status: Active
Accessibiliy:  Fublic
Servers (at this level): 7
Groups {at this level): 0
Unigue servers for all levels: 7
Date last used (by a job):
Device Group ID: 2530039

You can use these tabs to perform the following actions for a server group.

To perform any of these actions, you must have the correct Opsware SAS permissions.
See “Permissions Required for Working with Server Groups” on page 207 in this chapter
for more information.

« Properties: This displays information about the group, such as the type of group, the
number of servers in the group, and the status of the group. Clicking Edit allows you to
change the group name and description, and to convert a dynamic group to a static
group.

A created static group without servers added yet — an empty static group — can be
AS
converted to a dynamic group. Conversely, a static group that has servers cannot be
converted to a dynamic group.

» Rules: This appears when you are viewing a dynamic group. The rules tab displays the
rules used by the dynamic group to determine group membership. The rules apply to
the current group only and do not apply to subgroups. Click Edit to change the rules for
the group.
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.

See “Creating Groups by Using Search” on page 219 in this chapter for more
information about specifying rules for a dynamic group.

Custom Attributes: This allows you to set custom attributes for a server group. Click
New to add an attribute and then click Edit to change existing attributes. Custom
attributes are not inherited by subgroups within a group hierarchy.

See “Custom Attributes for Servers” on page 259 in this chapter for more information
about how custom attributes affect Opsware-managed servers.

Service Levels: This allows you to attach service levels to a group.
See “Service Levels” on page 263 in this chapter for more information.

History: This allows you to view the changes to groups. For each action on the group
(but not group members), the history displays a description, the date the action
occurred, and the user who performed the action (if the group is public).

Ways to Create Server Groups

Server Groups can be created by:

.

Using the New Group option from the Resource pull down menu on the Manage
Servers page

Clicking the Create Server Groups icon in the upper right corner of the Copy to Group
dialog

Performing a server search, and saving the resulting list of servers or the rules as a
group

Creating Static Groups by Using the New Group Option
Static server groups require servers to be added to them manually. The servers in a static

group also must be removed manually.

A created static group without servers added yet — an empty static group — can be

converted to a dynamic group. Conversely, a static group that has servers cannot be

converted to a dynamic group.
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To create static server groups, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H From the Resource menu, choose New Group. The New Private Static Group dialog
appears, as shown in Figure 7-6.

Figure 7-6: Default New Private Static Group Dialog

New Private Static Group

Save In: |Manage Servers = {ﬂ|
Marne Type 1=
& Public Groups Dynamic
I3 Content Groups, Dynarnic Dynamic |
B Content Managernent Servers Cynamic
@ Dynamic Content Servers Dynamic =

Save As: |Dan's Private Static Group|

Options: & Static
T Dynamic

S ave Cancel

To create a Private Static group in the top level of Manage Servers, perform the
following steps:

1. Enter the name of the group in the Save As text box.
2. Click Save.
Bl To create a Private Static group below another group, perform the following steps:
1. Navigate to the group below which you want to create a new group.
2. Enter the name of the group in the Save As text box.

3. Click Save.
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To create a Public Static Group, perform the following steps:

1. Click the Public Groups link in the Name and Type window, and navigate to the
location in the group hierarchy where you want to create the group.

2. Enter the name of the group in the Save As text box.

3. Click Save.

The Save In drop down list is populated according to the location you drill down to in order
A
to create your group. You can use the Save In drop down list to verify that you are in the
correct location in the group hierarchy, and you can move to a different location in the

hierarchy by selecting it from the Save In list.

Creating Static Groups by Using the Copy to Group Dialog

To create new server groups by copying existing server groups, perform the following
actions:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

Navigate to the servers and groups that you want to copy and click the check boxes
next to the servers and groups you want to copy.

From the Edit menu, choose Copy to Group. The Copy to Group dialog box appears.

Navigate to the place in the group hierarchy where you want to copy the servers and
group then by clicking the group links displayed in the Name and Type field.

In the Options field, select either of the following options:

+ Maintain Hierarchy: Select this option to copy any server groups exactly as they
are.

« Expand to a Flat List: Select this option to copy only the servers within the group
to the new group.

Each of those options displays the result of choosing that option by showing the
numbers of servers and groups in the new group’s hierarchy, or the number of
unigue servers in the flat list.
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If you select the Expand to a Flat List option, and a server is a member of more than one
group, that server will only appear in the list once.

@ (Optional) You can also create an entirely new group for the copied servers and
groups by clicking the Create New Group icon in the upper right corner of the dialog.

A new dialog appears, prompting you to name your new group.
Enter the name of your newly-created group.
B Click OK. The name dialog closes, and the Copy to Group dialog reappears.
El Click OK on the Copy to Group dialog.
Creating Dynamic Groups by Using the New Group Option

Dynamic Server Groups are rule-based, and the servers in dynamic groups will be added
or removed automatically based on the rules that you define.

The method for creating dynamic server groups is the same as for creating static server
groups. The difference is that when dynamic is selected, you are presented with a page
that allows you to define the rules for the group.

Dynamic groups can be converted to static groups, and all servers remain in the group,
but all rules will be lost when they are converted.

To create dynamic groups using the New Groups Option, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H From the Resource menu, choose New Group. The New Private Static Group dialog
appears.

E To create a private dynamic group, navigate to the place in the group hierarchy where
you want to create the group by clicking the group links displayed in the Name and
Type field.

Or

To create a public dynamic group, click the Public Groups link in the Name and Type
field, and navigate to the location in the group hierarchy where you want to create the

group.
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The Save In drop down list is populated according to the location you drill down to in order
to create your group. You can use the Save In drop-down list to verify that you are in the
correct location in the group hierarchy, and you can move to a different location in the
hierarchy by selecting it from the Save In list.

Bl Enter the name of the group in the Save As text box.
B In the Options field, select Dynamic.

@ Click Create Rules. The Manage Servers Properties page appears, with the Rules
tab selected, as Figure 7-7 shows.

Figure 7-7: Manage Servers Properties Page with Rules Tab Selected

MWanage Servers / Dynamic Content Servers / Properties 2

¥ Rules
The follovwing rules describe the server members of this group and do not apply to subgroups. Match: Im
Search for servers whose:
Agent Reporting j ||S j Minimal
git Reporting =!
Partial

Search |
Savel Cancel |

Select the criteria that apply to the servers you would like the group to include. See
“From the navigation panel, click Servers %o Search. The Search Rules page
appears with the Servers tab displayed.” on page 219 in this chapter for more
information.

Create as many lines of criteria as required to adequately describe your server group rules
by clicking the plus button to add a new line. Conversely, to remove lines of criteria, click
the minus button next to the line you want to remove.

B From the Match drop down list select either “If all rules are met” or “If any rules are
met.”

El (Optional) Click Search to apply the rules to a server search to validate the resuilts.
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KK Click Save to save the rules that apply to your group.
Creating Groups by Using Search
To create groups by using search, perform the following steps:

El From the navigation panel, click Servers » Search. The Search Rules page appears
with the Servers tab displayed.

To search for servers, use this tab. To search for groups, select the Groups tab.

H Use the criteria to create the rules used for a server search and to identify servers for
dynamic groups. The options in the user interface for specifying dynamic group rules
and for using Search are the same. See “Criteria for Search and Dynamic Group
Rules” on page 219 in this chapter for more information.

Create as many lines of criteria as required to adequately describe your server search or
your server group rules by clicking the plus button to add a new line. Conversely, to
remove lines of criteria, click minus button next to the line you want to remove.

B If you are defining dynamic server group rules, click Save to save your rules. You can
also click Search to use your rules to perform a server search.

Or

If you are doing a server search, click Search to perform the server search, or click
Save to save the search as the rules for a dynamic group.

The New Dynamic Group dialog appears.

Criteria for Search and Dynamic Group Rules
The following table describes the rules that you can use to search for servers or to create
dynamic server groups.

Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden
your results.

Table 7-2: Rules for Server Search and for Creating Dynamic Groups

PROPERTIES
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Agent Discovery Date: The .
date that the Opsware Agent
was installed.

Is after

* |s before

Is within the last

+ |s today
Agent Reporting: Whether * s
the Opsware Agent is . Is not
reporting to Opsware SAS.
Agent Status: Whether the « s
Opsware Agent is reachable | Is not
by Opsware SAS.
Agent Version: The version of | « Contains

the Opsware Agent — such as

» Does not contain

14.2.3b.

e Is

* Is not
Custom Attribute (any): The « Contains
name of a custom attribute s
that is associated with the
server through attachment or
inheritance.
Custom Attribute (local): The  + Contains
name of a custom attribute s
that is locally attached to the
server,
Customer: The customer or e Is
account that the server is

* Is not

associated with.

Drop-down lists with the day,
month, and year

User-entered text

N/A

Has not reported

OK

Registration in progress
Reporting error

Not reachable

OK

User-entered text

User-entered text

User-entered text

Popup window of customers
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Deployment Stage: The e Is * In Deployment
stage the server performs
within a lifecycle environment.

Is not + Live
» Not Specified
« Offline

The values that appear in this
list are customizable; in
addition to the values above,
values specific to your
environment might appear.

Facility: The collection of * s Popup window of facilities
servers managed by a.n . Is not
Opsware SAS installation. When Opsware SAS is running

multimaster mode, the list can
contain many facilities.

Group Membership: Whether |« Is Popup window of groups
the server belongs to a group.

Host name: The host name of | < Contains User-entered text
the server — such as

* Does not contain
mO04.company.com.

e s
* Is not

Name (any): This enables + Contains User-entered text
searching for any name or IP
address associated with a

* Does not contain

server. Is

* Is not
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Notes: The contents of the » Contains User-entered text
Notes field from the Properties
tab for a server.

* Does not contain

« Is
* Is not
Opsware Display Name: The + Contains User-entered text
user-configurable name for the .
+ Does not contain
server. By default, Opsware SAS uses
s the configured host name of
+ Is not the server until a user edits it.
Server Use: How the serveris |« Is + Development
being used — such as - Is not - Not Specified
Development, Staging,
Production. * Production
« Staging
You can customize values that
appear in this list. In addition
to the values above, values
specific to your environment
might appear.
Service Level: The user- * s Popup window of service
defined category that can be | Is attached here or levels

used as an organizational tool.
below

Servers can be associated
with multiple service levels.

OPSWARE PROPERTIES
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Application Configuration:
Whether the server uses the
Application Configuration
feature.

Code Deployment: Whether
the server uses the Code
Deployment feature.

Configuration Tracking:
Whether the Configuration
Tracking feature is monitoring
or backing up specific files or
configurations on a server.

Lifecycle: The server states
that are part of bringing a
server into Opsware SAS.

Server ID: The internal ID
Opsware SAS uses to identify
the server.

SOFTWARE

Attached Software: The
software that is assigned or
modeled through the Opsware
remediate operation — the
installation process.
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Is not used

Is used

Is not used

Is used

Is off

Is on

Is not

Is not

Is

Is attached here or
below

N/A

N/A

N/A

+ Available

+ Build Failed
* Deactivated
+ Installing OS
+ Managed

User-entered text

In most cases, the Server ID is
the same as the MID.

Popup window of software
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Attached Software Policies:
The software policies that is
assigned or modeled through
the Opsware installation
process.

Installed Patches: \Whether a
patch is installed on the
server.

Installed Software: The
package reported installed on
the server.

OS Version: The OS version
defined by OS definitions in
the OS Provisioning feature.

Reported OS: For Windows —
the version reported by the
OS, for Unix — the version
returned by the uname
command.

Windows Service: The names
of the Windows services that
are reported to Opsware SAS.

NETWORK

Contains

» Does not contain

Is
Is not

Contains

» Does not contain

Is

Is not

Is

* Is not

Contains

» Does not contain

Is
Is not

Contains

» Does not contain

Is

Is not

Popup window of software
policies

User-entered text

User-entered text

A package does not have to

be installed by Opsware SAS
to be reported as installed on
a server.

Popup window of operating
systems

User-entered text

User-entered text
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

DNS Search Domains: The
domains configured to be
searched in the server's

network settings.

DNS Servers: The IP
addresses of the DNS servers
configured in the server's

network settings.

Default Gateway: The IP
address of the default router.

IP Address: Any Internet

Protocol address for the server. .
* Does not contain

MAC Address: Any Media
Access Control address, which
is the network interface card's
unigue hardware number.

WINS Servers: The Windows
Internet Naming Servers
configured in the server's

network settings.

HARDWARE
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Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

» Does not contain

Is

Is not

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

CPU Make and Model: The e s Popup window of CPU makes
vendor name and CPU model . Is not and models
for the server — such as
GENUINEINTEL Intel(R)
Pentium(R) 4 CPU 2.60GHz.
CPU Speed: The Central » Does not equal User-entered text
P.rocessmg Unit speed in . Equals
gigahertz [GHz]. A 600 Mhz machine should be
* Is greater than entered as 0. 6.
* Is less than
Make and Model: The vendor |« Is Popup window of server
name and server model forthe | | Is not makes and models
server — such as Compagq -
DL360.
Number of CPUs: The * Does not equal User-entered text
number of CPUs on the server.
* Equals

 |s greater than
* |Is less than

RAM: The amount of RAM on |« Does not equal User-entered text
the server in megabytes [MB].

* Equals
To enter 1 Gigabyte, type
 |s greater than 1024,
* Is less than
Serial Number: The serial + Contains User-entered text

number of the server. .
* Does not contain

e Is

* |s not
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Storage Make and Model: + s Popup window of storage
The vendor name and storage | | Is not makes and models
model for the server — such as
WDC - WD800BB-75DKAO.
CUSTOM FIELDS
A Numeric field + Does not equal User-entered text

* Equals

 |s greater than
* Is less than
A String field + Contains User-entered text
+ Does not contain
o Is
* Is not
A URI field + Contains User-entered text
+ Does not contain
s Is
* Is not
A File field + Contains User-entered text

* Does not contain

s s
+ Is not
A Date field + |s after Drop-down lists with the day,
. Is before month, and year
* Is within the last User-entered text
+ |s today N/A
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Adding a Server to Static Groups, Both Public and Private
To add a server or a server group to a static group, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the static group that you want to add servers and server groups to.

Click the check box next to the group and select Edit » Add Servers. The Select
Servers and Groups to Add to [group name] window opens. The window is populated
with the same servers and groups visible on the Manage Servers page. You can use
the Status, OS, and Customer filters to change the servers and groups that appear
on the list.

When you select Edit » Add Servers and then select a group, the servers in the group
A
are added. The group itself is not added. If you want to add a group to a group, select Edit
>» Copy to Group from the menu.

Bl Click the check box next to the servers and groups you want to add, and click Add at
the bottom of the window.

Adding a Server to Dynamic Groups, Both Public and Private

Servers are added to dynamic server groups automatically, based on the rules created for
the group. To change the membership of a dynamic group, add, delete, or update the
dynamic group rules.

To update the rules for a dynamic group, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the Properties page of the dynamic group that you want to update rules
for; navigate by clicking the group links in Manage Server list.

Select the Rules tab.

Click Edit.
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To add criteria to the existing rules, click the plus (+) button next to existing criteria.
The fields for the criteria appear. Enter the values for the rule. See “From the

navigation panel, click Servers %o Search. The Search Rules page appears with the
Servers tab displayed.” on page 219 in this chapter for descriptions of these values.

To delete criteria, click the minus (-) button next to the criteria you want to delete from
the rules. The criteria are removed from the page.

Click Save.

Groups can be added manually to a dynamic group, in either of the following two ways:

Click the check box next to the name of the server group to which you want to add a
server group, and select Edit » Copy to Group. Then follow the steps for creating a
new group, either static or dynamic. See “Ways to Create Server Groups” on

page 214 in this chapter for more information.

Or
Navigate to the server group that you want to add a server group to.

Click the check box next to “This Group” and select Resource » New Group. Then
follow the steps for creating a new group, either static or dynamic. See “Ways to
Create Server Groups” on page 214 in this chapter for more information.

Removing Servers from Static Groups, Both Public and Private

To remove a server from a static server group, perform the following steps:

A server does not need to be deactivated to be removed from a group. You can remove a

server from a Static group at any time. The Membership tab for a server displays all the

server groups of which the server is a member.

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

Navigate to the static server group that you want to remove servers from until you
reach the level where the servers in question are located.
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Servers can belong to more than one group, so if you want to remove a server from each
AN
group it belongs to, you must locate and remove each instance of the server from all
groups.

HE Click the check box next to the servers you want to remove and select Edit »
Remove from Group.

As soon as you select that menu option, the server is removed and the screen
refreshes to display the current members of the group.

Removing Servers from Dynamic Groups, Both Public and Private

Servers are removed from dynamic server groups automatically, based on the rules
created for the group. To remove servers, you can create or update rules. To add rules to
an existing server group, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the Properties page of the dynamic group that you want to add rules to,
by drilling down into the group and clicking the “This Group” link.

El Select the Rules tab.
B Click Edit.
H Add one or more lines of criteria to the existing rules by following the procedure

described in the “Creating Dynamic Server Groups by Using the New Group Option’
topic, step 3 on page 219 or see “From the navigation panel, click Servers %o
Search. The Search Rules page appears with the Servers tab displayed.” on page
219 in this chapter for more information.

Moving Servers from One Static Group to Another

The process of moving servers from one group to another is similar to copying servers
from one group to another with the exception that with a move, the servers do not remain
in the original group.

The Edit » Move menu option is disabled when you select servers in a dynamic group.
A
To move servers in a dynamic group, chose the Edit » Copy to Group menu command.
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This menu command is also disabled for public groups when you do not have permission

to manage public groups.

To move servers from one group to another, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

Navigate to the group containing the servers you want to move and select those
servers.

From the Edit menu, choose Move. The Move [group name] Group dialog box
appears.

Navigate to the place in the group hierarchy where you want to create the group by
clicking the group links displayed in the Name and Type field.

Click Move.

Duplicating Server Groups

Duplicating a group is similar to copying a group. To duplicate an existing group, perform
the following steps:

Navigate to the group that you want to duplicate.

Click the check box next to the group name.

You can only select one group at a time to duplicate.
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From the Edit menu, choose Duplicate Group. The Duplicate [group name] Group
dialog appears as shown in Figure 7-8.

Figure 7-8: Duplicate Group Dialog Box

‘A Duplicate Group -- Web Page Dialog

Duplicate 'test2' Group

Duplicate to: | Marketing Servers V| 5P {:ﬂ|
Mame Type
Ep East Coast Static

Group Name: |test2 |

Options: & Maintain Static group and 1 subgroups

(O Convert group and 1 subgroups to a static flat list (0
unigue servers)

v Show Details

[ Duplicate ] [Cancel]

https: /{192, 168. 196. 245/com. opsware.occ. serversfmer | 8 Internet

Bl Select the location for the newly-duplicated group using the Duplicate In drop down
list.

The Duplicate In drop down list’s default location is the location of the group you select to
AN
duplicate. Navigate through the hierarchy of groups to find the location where you want
the newly-duplicated group to reside.

H Enter the name of the new group.

@ The values on the Options field will vary depending on whether the group duplicated
is static or dynamic.
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If the group is static, select one of the following options:

+ Maintain Static group and <number> subgroups: Selecting this option copies
the group and its hierarchy as is.

+ Convert group and <number> subgroups to a static flat list: Selecting this
option copies the group and flattens the hierarchy.

B If the group is dynamic, select one of the following options:

« Maintain rules & group hierarchy: Selecting this option copies the group and
leaves it as a dynamic group, it also copies any subgroups.

« Convert to static group, maintain hierarchy: Selecting this option copies the
group, but turns it into a static group with the current servers defined by the rules
and also copies any subgroups.

« Convert group and <number> subgroups to a static flat list: Selecting this
option copies the group, and turns it into a static group and flattens any hierarchy.

El Click Duplicate. The newly-duplicated group appears in the selected destination.

Rules for Deleting Server Groups

It's important to note the distinction between removing servers from a group, deleting a
server, and deleting a group.

Removing servers from a group only removes the server from the selected static group,
but the server itself remains in the global list of servers and is still managed by Opsware
SAS.

Deleting a server can only be performed on a server whose status is deactivated.
Selecting the Delete Server option completely removes the server from within Opsware
SAS, although its history remains.

Deleting a server group removes the group, but the servers in the group still remain in the
list of servers and in any other groups for which they are members.

A group cannot be deleted when any of the following conditions apply:
« Software is attached to the group or a subgroup of the group.
» Access control boundaries are attached to the groups or a subgroup of the group.

« Servers and groups are selected together for deletion.
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Deleting a Server Group
To delete a server group, perform the following steps:

H Click the check box next to the server group you want to delete.

H From the Edit menu, choose Delete Group. A confirmation message appears,
detailing the number of servers and server groups in the server group that you want
to delete.

E Click OK to complete the deletion of the server group.

The screen refreshes, showing the list of servers and groups without the deleted
server group.

Server Life Cycle

This section provides information on the server life cycle within Opsware SAS and
contains the following topics:

« OS Provisioning and the Server Life Cycle

» Server Properties

« Server Management Tasks Related to the Server Life Cycle
+ Changing the Use and Stage Values for Servers

+ Editing the Properties of a Server

» Tasks Associated with Deactivating a Server

» Deactivating a Server

» Deleting a Server from Opsware SAS

« Server Management Jobs

OS Provisioning and the Server Life Cycle

Opsware SAS is designed to enable multiple teams to work together to provision servers.
The OS Provisioning feature allows IT teams to separate the tasks of readying servers for
provisioning (such as mounting servers in racks and connecting them to a network) from
provisioning the servers with operating systems and applications.
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For example, someone mounts a new server in a rack and connects it to the Opsware
build network. Next, they boot the server for the first time by using an Opsware Boot
Floppy or CD or by using the network.

At a later time, a different system administrator can select the available server from the
Server Pool list and provision it with an OS. In the available state, servers do not have the
target OS installed and might not have access to disk resources.

During OS provisioning, servers progress through the Opsware SAS life cycle state
changes:

Unprovisioned (No OS Build Agent) » Available » Installing OS » Managed
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Table 7-3 describes the Opsware SAS server life cycle values.

Table 7-3: Opsware SAS Life Cycle Values for Servers

Server Pool Values

Available Indicates a server on which the OS Build Agent was installed and is
running, but the target OS has not been installed on the server.

The OS Build Agent is a small agent that can run in the memory of the
bare-metal server.

See Opsware® SAS User’s Guide: Application Automation for more
information about Operating System Provisioning.

Installing OS | Indicates that a user is installing the target OS on the server.

The server stays in the Server Pool list until the installation process
finishes successfully. Then the server moves to the Manage Servers list.

See Opsware® SAS User’'s Guide: Application Automation for more
information about installing OS.

Build Failed Indicates a server on which the OS Build Agent was installed and is
running, but the installation of the target OS failed.

The server remains in the Server Pool list with this status for 7 days
before Opsware SAS deletes the entry.

See Opsware® SAS User’s Guide: Application Automation for more
information about Operating System Provisioning.
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Table 7-3: Opsware SAS Life Cycle Values for Servers (continued)

Managed Server Values

Managed

Deactivated

Indicates a server that Opsware SAS is managing. Opsware SAS
performs periodic reachability checks on managed servers.

After a server reaches this life cycle state, the entry for the server moves
from the Server Pool list to the Manage Servers list. On managed
servers, you can use Opsware SAS to install applications and patches.

Indicates an Opsware-managed server that was removed from service.
However, the server’s history still exists in Opsware SAS. Deactivated
servers are not reachable.

Table 7-4 shows which server icons appear in Opsware SAS and explains what each icon

indicates in regard to the server life cycle.

Table 7-4: Server Icons in Opsware SAS

Indicates a server that is available to have a target OS installed on it
and on which an Opsware OS Build Agent is installed.

Appears in the Server Pool list.

Indicates a server on which the OS Provisioning feature is in the
process of installing the target OS.

Appears in the Server Pool list.

Indicates an available server on which an error occurred while the OS
Provisioning Subsystem was installing a target OS.

Appears in the My Jobs panel in the home page, in the list in the My
Jobs page, and in the Server Pool list.
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Table 7-4: Server Icons in Opsware SAS

0

Indicates a server that the SAS Web Client is managing and that
Opsware SAS can communicate with. An Opsware Agent is running on
the server.

Appears in the My Jobs panel in the home page, in the list in the My
Jobs page, in the Manage Servers list, and in the server lists in the
Opsware wizards.

Indicates a server that is scheduled for an operation (install software,
uninstall software, and so forth).

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a managed server that Opsware SAS cannot communicate
with (it is Not Reachable) because the Opsware Agent on the server
cannot connect to Opsware SAS.

If you want to discover reasons why the managed server is
unreachable, you can run a Communication Test. See “Agent
Reachability Communication Tests” on page 114 in Chapter 4 for more
information.

Appears in the Manage Servers list.

Indicates a managed server on which an error occurred while Opsware
SAS was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a managed server on which a warning occurred while
Opsware SAS was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a server that was deactivated in Opsware SAS so that it is

currently not managed and not reachable.

Appears in the Manage Servers list and in the server lists in the
Opsware wizards (however, it is not selectable in the wizards).
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Table 7-4: Server Icons in Opsware SAS

Indicates a managed server on which the configuration file on the
@\” server is out of sync with the Application Configuration Template
(Opsware model).

Appears only in the Application Configuration feature and the server list
in the SAS Client.

Indicates a static server group. The same states that apply to single
servers apply to groups.

=/

See “Server Groups” on page 206 in this chapter for information about
the different types of server groups.

Indicates a dynamic server group. The same states that apply to single
servers apply to groups.

N

Indicates a public and static server group. The same states that apply to
single servers apply to groups.

@

Indicates a public and dynamic server group. The same states that
apply to single servers apply to groups.

)
N
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Server Properties

Figure 7-9 shows the Server Properties columns. Table 7-5, Table 7-6, and Table 7-7
describe the Status, Stage, and Use properties for managed servers.

Figure 7-9: Server Properties Columns in the Manage Servers List

Manage Servers (Summary “iew) 7]
All Statuses W || All Operating Systems W || Al Stages W || Al Uses v
Al Customers w || &l Manufacturers || Al Mocels A Update Ei'

Managed & Deactivated

Resowrce Edit  Wiew  Tagks  Configuration Tracking |

D_m Host Mame ! P Address  OF Version Staoe

Use Customer
Public Groups
F] Eﬂ| coretr3opsveare com  coretr3opswarecom  Red Hat Erterprise Mot Mot Opswware
-~ 172163618 Linuz &% 3 Specified Specified
O EFH m201 tr3.opsweare.com | mhi3 Windows 2000 Pt Pt Pt
-~ 17216.36.534 Specified Specified Aszzigned

The Status property is represented by an icon in the first column in the Manage Servers
list.

Status (short for Agent Status) is set automatically by Opsware SAS.

Opsware SAS toggles each server between OK and Not Reachable by reachability
checks.

The Status value specifies the ability of Opsware SAS to manage servers. Opsware SAS
automatically detects the status of servers. To verify the current status of a server, click
Update in the Server Properties page for that server.

Table 7-5: Values for the Status Property for Managed Servers

OK Server is manageable by Opsware SAS. Represented as text (OK) in
the properties page for a server. Represented as an icon in the
Manage Servers and Server Pool lists:

0
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Table 7-5: Values for the Status Property for Managed Servers (continued)

Not Reachable | Server is unreachable by Opsware SAS due to an error (for example, it
cannot connect to the Opsware core); automatically set by Opsware
SAS. Represented as text (Not Reachable) in the properties page for a
server. Represented as an icon in the Manage Servers list:

If you want to discover reasons why the managed server is
unreachable, you can run a Communication Test. See “Agent
Reachability Communication Tests” on page 114 in Chapter 4 for more
information.

Stage (short for Deployment Stage) is set by a user.

The Stage value specifies the stages of deployment for servers; for example, a server is
live or offline.

Your Opsware administrator can change the values for the Stage property. By default,
Opsware SAS is installed with the following Stage values.

Table 7-6: Values for the Stage Property for Managed Servers

In Deployment Initial stage after being fully initialized.
Live Your organization defines the meaning of this stage.
Not Specified The default value for a server. Cannot be changed by the Opsware

administrator.
Offline Your organization defines the meaning of this stage.

Ops Ready Your organization defines the meaning of this stage.

Use (short for Server Use) is set by a user.

The Use value specifies how an organization is utilizing servers. For example, a serveris a
staging server. Users set this property for servers.
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By default, Opsware SAS is installed with the following Use values. Except for the Staging,
Production, and Not Specified values, an Opsware administrator can change the default
values. The CDR feature depends on the Staging and Production values. Therefore, these
default values cannot be changed or deleted.

Table 7-7: Values for the Use Property for Managed Servers

Development A server that is not being used in production.

Not Specified The default value.

Production Fully live in-use servers (includes Opsware core servers).
Staging A staging server for production.

Server Management Tasks Related to the Server Life Cycle

Managing servers in Opsware SAS involves the following standard tasks:

.

Bringing a new server into Opsware SAS so that it appears in the Server Pool

See Opsware® SAS User’s Guide: Application Automation for more information about
OS Provisioning.

Installing an operating system on a server

See Opsware® SAS User’s Guide: Application Automation for more information about
OS Provisioning.

Installing a patch

See Opsware® SAS User’s Guide: Application Automation for more information on
installing patches.

Installing a software

See Opsware® SAS User’s Guide: Application Automation for more information on
installing software.

Reprovisioning a server with a new OS

See Opsware® SAS User’s Guide: Application Automation for more information about
OS Provisioning.

You can reprovision Solaris and Linux servers so that they are running another version
of the same OS so long as the hardware supports that new version of the OS.
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You can reprovision servers built by Opsware SAS and Opsware-managed servers by
using this feature.

You cannot reprovision a Linux server so that it runs a Windows OS.

+ Deactivating a managed server so that Opsware SAS no longer manages it.

See “Tasks Associated with Deactivating a Server” on page 245 in this chapter for more

information.

You accomplish server management tasks by using the following menus in the Manage
Servers list:

.

Resource: Allows to create new server groups, view properties of servers.

Edit: Allows you to add servers to a group, delete server groups, remove servers from
a group, deactivate servers.

View: Allows you to view the summary, hardware, and software information of servers
and server groups.

Tasks: Allows you perform tasks such as running scripts, custom extensions and
running communication tests.

Configuration Tracking: Allows you to edit, and reconcile tracking policies.

Changing the Use and Stage Values for Servers

Perform the following steps to change the Use and Stage values for multiple servers
simultaneously:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to deactivate.

Or
Search for the server that you want to deactivate.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

Select the servers that you want different Use or Stage values for.
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Choose Edit » Usage from the menu above the Manage Servers list. A window
prompts you to select different values, as Figure 7-10 shows.

Figure 7-10: Edit Server Popup Window

Edit Servers

Select the new values

Server Facility Stage Use
172.16.36.18 - core.tr3.opsware.com DATACENTERL current: Mot Specified current: Mot Specified
Mot Specified  » Mot Specified +
[ Save Changes ][ Cancel ]

Bl Select the Use and Stage values from the lists.
H Click Save Changes. The window closes and the Manage Servers list refreshes with

the updated values.

Editing the Properties of a Server

You can edit a server only if you have permission in the SAS Web Client to access the

N
customer to whom the server is associated.

When you edit the properties of a server, the server itself does not change; how Opsware
SAS views it changes. Perform the following steps to edit the properties of a server:

H From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose properties you want to edit.

Or
Search for the server that you want to edit.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

Click the Server Display name. The Properties page for the server appears.
Change any of the following properties for the server:

» To change the name that appears in the SAS Web Client, edit the text in the Name
field.

» To change the description of the server, edit the Notes field.
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» To change the customer associated with the server, select a different customer
from the list. Your Opsware administrator defines the options for customer
selections. Contact your Opsware administrator if the list does not contain the
customer that you want to associate with this server.

You cannot change the customer associated with a server when the server is part of a
A
CDR service, synchronization, or sequence. See the Opsware® SAS Policy Setter’'s Guide
for more information.

» To change the Use or Stage of the server, make your changes in either of those
lists.

See “Server Properties” on page 240 in this chapter for more information.

» To change whether configuration tracking is enabled or disabled for the server,
select a value from the list.

See “Configuration Tracking” on page 387 in Chapter 12 for more information.

Bl To save your changes, click Save.

To change the custom attributes of the server, select the Custom Attributes tab. The
Q Manage Servers: Custom Attributes page appears. See “Managing Custom Attributes” on
page 260 in this chapter for more information.

Tasks Associated with Deactivating a Server

You will want to deactivate a server when Opsware SAS removes the server from
management. For example, you are moving the server to a warehouse for storage.
Additionally, you might choose to deactivate a server when you need to rebuild it from
scratch, without using the OS Provisioning feature.

When you deactivate a server, information about the server remains in the Opsware
Model Repository for auditing purposes.

After you deactivate a server, you can reactivate it by re-installing an Opsware Agent with
the Opsware Agent Installer and the - -clean command line option.

See “Agent Reachability Communication Tests” on page 114 in Chapter 4 for more
information.
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When you deactivate a server, you accomplish the following tasks:
+ Remove custom attributes from the server.

+ Delete any configuration tracking policies from the server that are associated with
backups.

« Set the server life cycle value to Deactivated.

You cannot deactivate a server when it is part of a CDR service, synchronization, or
AS
sequence. See the Opsware® SAS Policy Setter’s Guide for more information.

Deactivating a Server
Perform the following steps to deactivate a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to deactivate.

Or
Search for the server that you want to deactivate.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

Select the servers that you want to deactivate.

Choose Edit » Deactivate Server from the menu above the Manage Servers list. A
confirmation dialog box prompts you to confirm the deactivation.

Bl Click OK. The Manage Servers list refreshes and the server appears with a
deactivated icon.

Deleting a Server from Opsware SAS

When you want to remove all record of a server from Opsware SAS, you can delete it.

You must deactivate a server before you can delete it from Opsware SAS.

4

When you delete a server from Opsware SAS, it has these effects:
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+ Deletes all job information in the My Jobs feature
» Deletes the server from the Model Repository
Perform the following steps to delete a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to delete.

Or
Search for the server that you want to delete.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

Select the servers that you want to delete.

Choose Edit » Delete Server from the menu above the Manage Servers list. A
confirmation dialog box prompts you to confirm the deletion.

Bl Click OK. The Manage Servers list refreshes and the server disappears from the list.

Server Management Jobs

This section provides information about server management jobs within Opsware SAS
and contains the following topics:

* My Jobs

+ My Jobs Display Information

* My Jobs in the Opsware SAS Web Client

+ Jobs in SAS Client

+ Viewing Job Details in the Opsware SAS Web Client

+ Viewing My Job Details from inside the SAS Client

My Jobs

The My Jobs information is available only on a per-user basis. You cannot log in as an
Opsware administrator to see the jobs that other Opsware users have run. The My Jobs
information appears in two places in the SAS Web Client:

+ A panel on the SAS Web Client home page that lists your most recent six jobs
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+ A page (accessed by clicking My Jobs in the navigation panel) that lists all the jobs that
you have run

Opsware SAS maintains information about the server operations that you have run for
the last 30 days in the My Jobs list. By default, the jobs are deleted from the Opsware
Model Repository after 30 days. (The bottom of the My Jobs page indicates how long
this interval is set for the Opsware SAS installation at your organization.)

My Jobs Display Information

For each job, the My Jobs lists display the following information:

« The name of the job, which is a link to a page that displays more detailed information
about the job

+ The date and time the job started or is scheduled to start (using your preference for
time display)

« The number of servers that the job affects

« The status of the job:

.

Scheduled
* In Progress

+ Completed

Completed with errors
« Completed with warnings

+ You can search for an existing Job by the Job’s ID. On the Home page, select Job from
the drop-down list and enter a Job ID and click Go.
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My Jobs in the Opsware SAS Web Client

The My Jobs feature in the Opsware SAS Web Client provides information about the
following Command Engine scripts:

.

.

OS provisioning
CDR requests
Distributed script execution

Custom Extensions

Jobs in SAS Client

Jobs feature in the SAS Client displays job logs about the following SAS Client jobs:

Creating snapshots

Pushing or Auditing an Application Configuration
Auditing Servers

Creating Server Snapshots

Remediating policies

Running OS Sequence

Any jobs scheduled to be run at a future date

Jobs in the SAS Client appears in the Jobs Logs feature window.
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Viewing Job Details in the Opsware SAS Web Client

Perform the following steps to view the job details:

E From the SAS Web Client home page, click the link in the My Jobs panel for the job

that you want to view, as Figure 7-11 shows.

My Jobs

MName

E Run Custom Extension

[ Run Script

£

A Run Script

Audit Servers [Launch OCC Client]

<<l

Create Snapshot  [Launch OCC Client]

&l

#4 Audit Servers  [Launch QCC Client]

Or

Figure 7-11: My Jobs Panel in the SAS Web Client Home Page

Start Time
{not sef)

VWed Oct 31 21:45:00 2007
Tue May 31 21:22:06 2005
Tue May 31 21:00:48 2005
Tue May 31 20:57:05 2005
Tue May 31 20:50:09 2005

Servers
4

4
3

Groups
0

0
0
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From the navigation panel, click My Jobs and then click the link for the job to open a
window that shows the details of the job, as Figure 7-12 shows.

Chapter 7: Server Management in SAS Web Client

Figure 7-12: My Jobs Page Accessed from the Navigation Panel

* || Mo Time Restrictions % || All Job Status

[ Launch QCC Client ]

[ Launch Qo Client ]
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Tue May 31 221918 2005

Tue hlay 31 22:16:50 2005

Tue May 31 22:12:26 2005

Tue May 31 22:04:27 2005

Tue May 31 2200017 2005
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Tue May 31 20:57: 05 2005
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Servers
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The My Jobs page displays the operations that you performed.
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Click View Details to see detailed information about the job. The My Jobs
information contains a build log for the job. This build log contains any error
messages that Opsware SAS generates. See Figure 7-13.

Figure 7-13: Communication Test Details Page in the My Job Window

Communication Test - Job ID: 2590666

gi:” m119.qa.epsware.com

Last Tested:Wed Jun 01 01:24:51 2005 [ Run Test Again ]
Total Errors: 0

AGT @ oK
CRP @ OK
CE @ oK
DAE @ OK
sk @ OK
MD @ OK

Viewing My Job Details from inside the SAS Client

You can also view job details from inside the SAS Client. If the job was run from
inside the SAS Client, you will see a link next to the job named Launch SAS Client, as
shown in Figure 7-14.

Figure 7-14: My Jobs with link to SAS Client

My Jobs

MHame

Audit

Servers [ Launch Opsware 545 Client]
. Create
{jl Snapshot  [Launch Opsware SAS Client]

P-.leit
P [Serers  [Launch Opsware SAS Client ]
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To launch the SAS Client and view the job details, click the link.

Server Management Scheduling and Notification
This section contains the following topics:

+ Scheduling a Job

+ Sending Email Notification

The time used for the scheduled job is specified in the user's preferred time zone (which
can be modified in My Profile). If the user does not have a preferred time zone set, the
time zone is derived from the Opsware SAS core server (usually UTC).

Scheduling a Job
Perform the following steps to schedule server management tasks:

H Inthe Schedule and Notify page of an Opsware Wizard, choose the Run Now option
to execute the operation immediately or choose the Specify Time Option to schedule
the operation at a later date and time. See Figure 7-15

The time used for the scheduled job is specified in your preferred time zone which can be
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

H \When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

+ Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of the
servers that the job will run on.
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« Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

Figure 7-15: Scheduling a Job in an Opsware Wizard

Run Custom Extension 0

Select Schedule and Notify

Extension
| Select the time and date for this job to run. ¥You can choose to be notified after the job runs.
Select
Servers Schedule: & oo ow
Specify I
Settings O specify Time
Confirm
Settings
< Schedule i
and Notify Notify: @ pone
Run O condition Recipients
Extension

Options: Run the job on the servers from the Groups based on the time of Confirm
Selections.

Af the scheduled time, update the list of servers from the groups (0) selected prior
to running the job.

Cancel = Previous

E Additionally, you can view a scheduled job in the My Jobs page and change the date
and time for the job to run, or cancel the job entirely. (Click the name of a scheduled
job to open a window to change the date or time that the job will run or cancel it.)

Sending Email Notification

The email notification feature provides you with an option to receive an email
summarizing the job details when a job is over, and to notify others at the address they
have registered with Opsware SAS.

You have the option of sending the notification
+ On the job success only
* On the job failure only

* On any result
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You can also send notification to various people based on the condition of the job. For
example, you can select to send the notification to your manager only on the job success,
select to send the notification to yourself on any result of the job, and select to send the
notification to support only on the job failure.

To send an email about the job details, choose the Condition option on the Schedule and
Notify page and set the parameters to send an email when the operation is completed.
You can choose to have an email sent on any result, if the operation fails, or if the
operation is successful. To add another email recipient, click the plus (+) button next to
the Recipients field. See Figure 7-16.

Figure 7-16: Notifying about a Job in the SAS Web Client

2 Install Template - Microsoft Internet Explorer

Select Schedule and Notify
I Select the time and date for this job to riﬁn. You can choose to be notified after the job runs.
Select
Si .
EMVers Schedule: @ ¢ o vow
Canfirm o
Selections O specify Time
@ Previgw
= Schedule .
and Notify Notify: O yone
Install @ condition Recipients
| on any result V| |ssunderrajan@opsware.com‘ ‘ =
€| Cone é O Inkernet

Install Template
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Time-Outs for Server Management Jobs

Table 7-8 describes the time-out values that apply to the server management operations
in Opsware SAS.

Table 7-8: Time-Quts in Opsware SAS

420 Reconciling software (installation and uninstallation).
(7 hours)
2 Starting Command Engine sessions in response to a command. If the

Opsware Agent does not start executing the command within this time, the
command will time out and the Command Engine script will continue.

30 Responding to a command (for example, after a reboot, the maximum time
to wait until a server responds) or sending a message to the Command
Engine from the Opsware Agent.

If the Opsware Agent does not respond to the Command Engine at least
once during this interval, the command will time out and the Command
Engine script will continue.

Opsware SAS polls the Opsware Agent every 15 minutes and if the
Opsware Agent fails to respond two consecutive times, the command will
time out.

Customizing the Monitor Time-Out Duration

If you would like to set a different monitor time-out duration, you can create a custom
attribute named OPSW_reconcile monitor_ timeout and change the number of
minutes before a time out occurs. For each type of hardware running in your operational
environment, you can set a custom attribute with the time-out duration that you want. To
set a time-out duration for a type of hardware, click Environment » Hardware in the
navigation panel. Then, navigate to the type of hardware that you want to add a custom
attribute for.

During remediate, a periodic heartbeat occurs between the Opsware Agent and the
Command Engine to ensure that the agent is still responsive. This setting controls the
maximum amount of time that can pass between these heartbeat messages. Typically,
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you only need to increase this setting if you install software that reboots the server, and
the time that it takes for the server to reboot and for the agent to restart exceeds the
default value.

Custom Fields for Servers

This section provides information on custom fields for servers within Opsware SAS and
discusses the following topics:

» Overview of Custom Fields for Servers

« Changing the Value for a Custom Field

Overview of Custom Fields for Servers

In Opsware SAS, you can store custom server data that is specific to your operational
environment. These fields were created specifically for your Opsware SAS installation — all
servers in an Opsware SAS installation contain the same number and type of custom
fields. Custom fields can contain files, URLs, text strings, numbers, and dates.

In addition to adding files, URLs, text strings, numbers, and dates, you can use custom
fields to search for servers based on a value stored in a custom field. You can also use a
custom field as criteria to create a dynamic server group.

In order for the custom fields to appear in the Manage Server: Properties page, you will
have to initially create a custom field. To create a custom field, you will need to install the
custFields.py Custom Extension which is available only from the Content Starter Pack.
Contact your Opsware Technical Support for assistance in installing the custFields.py
Custom Extension in Opsware SAS.

Typed Data Supported for Custom Fields

The custom fields designated for your operational environment will vary. However, the
custom fields created for your environment support values with the following data types:

* Number: The value provided must be a long integer.
+ Short String: A text string that must be less than or equal to 4000 characters.

« Long String: A text string with no length restrictions. Custom fields with this type
cannot be used in search or in the rules for dynamic server groups.
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+ Date: The value will be verified for correctness.
» File: Indicates a file attachment.
« URI: A Uniform Resource Identifier string, which is validated as a URI.

Opsware SAS validates the value you enter in a custom field based on the data type
specified for the field.

Uses of Custom Fields

The custom fields designated for your operational environment will vary. However, you can
use custom fields to accomplish any of the following goals:

» To store the date of patch installation
« To assign a severity rating between 1 and 10 to a Hotfix
« To store an ID from an internal bug tracking system with its associated patch

+ To store a JPEG image of the back of a server and have that JPEG associated with that
server

+ To store a Microsoft Word document describing the disaster recovery steps for a server
or group of servers

» To search for a server based on the value of a custom field

Changing the Value for a Custom Field

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose custom fields you want to
change.

Or

Search for the server whose custom fields you want to change.
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H Click the server name. The Manage Servers: Properties page appears. Scroll to the
Custom Fields section of the page. The custom fields that appear in the properties
page are specific to your operational environment. Figure 7-17 shows an example of
the types of custom fields that can appear for a server.

Figure 7-17: Custom Fields That Appear for a Server

CUSTOM FIELDS

Date to be installed |04 v || October v | 2004 v | [0 (v|[o0 w|TVT
External OS5 system ID |CQ12345 ||1| Enter up to 4000 characters in this field
Microsoft bulletin  http:/fwww.microsoft. com/bulletinfhotfixes/Q23909 html @7
Severity |4 | Pleaze enter an integer with a maximum of 18 digitz
Support document 'Sl':g?sot:: s:ppurl document for this patch.

o]

To change a value in a field requires a number or text, enter the value in the field.

Bl To add a file, click Browse and select the file from the dialog box.

B To remove a file, click Remove.

@ To specify a URL, enter the URL in the field or click Edit to change an existing URL.

To add or change a date, click the icon and select the date or enter the date in
the field by selecting the appropriate day, month, and year from the drop-down lists.

B Click Save.

Custom Attributes for Servers

This section provides information on custom attributes for servers within Opsware SAS
and contains the following topics:

+ Overview of Custom Attributes for Servers
+ Managing Custom Attributes

+ Adding Server Custom Attributes

+ Editing Server Custom Attributes

+ Deleting Server Custom Attributes
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Overview of Custom Attributes for Servers

Users often need to store specific miscellaneous information in the Opsware Model
Repository to facilitate server or application installation and configuration, scripting, or
other purposes.

The SAS Web Client provides a data management function by allowing users to set
custom attributes for servers. These custom attributes include setting miscellaneous
parameters and named data values. Users can write scripts that use these parameters
and values when performing a variety of functions, including network and server
configuration, natifications, and CRON script configuration.

Custom attributes can be accessed by software packages at installation time to configure
settings that might be unique to the installation.

For information about how to set custom attributes required by the software running on a
specific server, contact the group responsible for packaging your applications, as
Figure 7-18 shows.

Figure 7-18: Custom Attributes Set for a Server

Return to Manage Servers

Custom Attributes

Walue Source

[ew) [ca1) |

OPSW reprovizsion_device_aftributes_to_preserve  kernel_arguments reboot_c... Operating Systems ! Red Hat Enterprize Linus A% 3 7 Mot
Azsigned (Opersting Systems)

Managing Custom Attributes

Do not edit or remove custom attributes without verifying that the change you are making
A does not impact other users or critical Opsware operations.

To set custom attributes that affect a specific server, use the Manage Servers list. After
locating the server and displaying the server properties, select the Custom Attributes tab.
The SAS Web Client displays the currently defined custom attributes for the selected
server.

When you add or edit server custom attributes using the SAS Web Client, Opsware SAS
removes leading and trailing whitespace characters from custom attribute values.
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See “Adding Server Custom Attributes” on page 261 in this chapter for more information.

You can also set custom attributes to a software policy. See the Opsware® SAS Policy
Setter’s Guide for more information.

Additionally, you can set custom attributes that affect every server associated with a
specific customer or for every server in a facility. Navigate to the customer or facility where
you want to set attributes. Select Environment » Customers or Facilities in the navigation
panel, and click the correct name in the list. Select the Custom Attributes tab, and add
attributes for all the servers associated with the customer or located in the facility. When
you use this option, you define custom attributes at a customer-specific or facility-specific
level. The procedure to add custom attributes to a customer or facility is the same as
adding custom attributes to individual servers.

Additionally, you can add custom attributes for a server group by viewing a server group,
and then selecting the Custom Attributes tab for that group. The procedure to add custom
attributes to a server group is the same as adding custom attributes to individual servers.

Adding Server Custom Attributes

For information about how to set custom attributes required by the software running on a
specific server, contact the group responsible for packaging your applications.

Perform the following steps to add a custom attribute for a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server for which you want to add custom
attributes.

Or
Search for the server for which you want to add custom attributes.

H Click the display name of the server. The Manage Servers: Server Properties page
appears.

E Select the Custom Attributes tab. The Manage Servers: Custom Attributes page
appears.

Click New.

Enter the name and value for the custom attribute that you want to add.

Click Save.
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See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information

Editing Server Custom Attributes

If you want to change the name of a custom attribute entry, you need to create a new
AS
custom attribute and delete the old custom attribute.

Perform the following steps to edit custom attributes for a server:

E From the navigation panel, click Servers » Manage Servers or Server Pool. The
Manage Servers page appears. Browse the list to find the server for which you want
to edit custom attributes.

Or
Search for the server for which you want to edit custom attributes.

H Click the display name of the server. The Manage Servers: Server Properties page
appears.

E Select the Custom Attributes tab to change the custom attributes of the server. The
Manage Servers: Custom Attributes page appears.

Click the attribute name link for the custom attribute that you want to change.
B Update the value of the custom attribute.

A Click Save to save your changes. The Manage Servers: Custom Attributes page
reappears with the updated value.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.
Deleting Server Custom Attributes

Perform the following steps to delete custom attributes for a server:

E From the navigation panel, click Servers » Manage Servers or Server Pool. The
Manage Servers page appears. Browse the list to find the server from which you
want to remove custom attributes.

Or

Search for the server from which you want to remove custom attributes.
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See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

H Click the display name of the server. The Manage Servers: Server Properties page
appears.

E Select the Custom Attributes tab. The Manage Servers: Custom Attributes page
appears.

Bl Select the check box for the custom attribute that you want to delete.
H Click Delete. The SAS Web Client displays a confirmation page.
@ Click OK to delete the custom attribute.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

Service Levels

This section provides information about service levels within Opsware SAS and contains
the following topics:

+ Overview of Service Levels

« Adding a Service Level to the

» Editing a Service Level

+ Ways to View the Service Level for Servers
+ Assigning a Server to a Service Level

» Removing a Server from a Service Level

Overview of Service Levels

Service levels are user-defined categories that enable you to group servers in an arbitrary
way and design your own organizational schemes. For example, you can organize your
servers by functionality (finance, engineering, and so forth) or tier (Web, application, and
database) or by ontogeny (development, staging, and production).

You can also create service levels to indicate the Service Level Agreement (SLA) for the
servers that your IT organization manages. For example, you might create service levels to
denote Silver, Gold, and Platinum services.
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Please note that assigning servers to service levels does not cause Opsware SAS to
operate any differently with respect to those servers. When you first use service levels, the
categories will be fairly empty and by default, when an Opsware Agent is installed on a
server in the operational environment, the server will be added to the UNKNOWN Service
Level.

Adding a Service Level to the
Perform the following steps to add a service level to the SAS Web Client:

E From the navigation panel, click Environment » Service Levels. The Service Levels
page appears.

H Navigate the hierarchy of service levels until you reach the point in the hierarchy
where you want to add a new service level, as Figure 7-19 shows.

Figure 7-19: Service Level Hierarchy

Semvice Levels = OTHER

2
(¢ U OTHER

Mo Sub-Modes

Cannot edit or delete this Made. This Maode is reserved.

Name: OTHER
Description: Other service level
Customer: Customer Independent

Operating ©5 Independent
System:

Locked: Mo
Allow Servers: “Yes

ID: 50003

E Click Add. The Service Levels page refreshes and the ADD SUB-NODE TO Service
Levels form appears in the page.

Bl Enter a name for the service level (required), and (optionally) enter notes and a
description for the service level.
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B Click Save. The service level is added to the hierarchy of service levels. The Edit
Service Level page appears, where you can change the properties of the service
level, such as the customer association.

Editing a Service Level
Perform the following steps to edit a service level:

E From the navigation panel, click Environment » Service Levels. The Service Levels
page appears.

H Navigate the hierarchy of service levels until you reach the point in the hierarchy
where you want to edit an existing service level.

HE Click Edit in the Properties tab. The page refreshes and an editable form appears for
the service level properties.

Bl Make changes to the service level name, description, notes, whether servers are
allowed to be assigned to the service level, the associated customers and operating
systems.

B Click Save.

Ways to View the Service Level for Servers

Find the server whose service levels you want to view by searching or browsing the
Manage Servers list.

+ If you are browsing the Manage Server list, you can find the service level for a server by
locating the value in the Environment column, as Figure 7-20 shows.

Figure 7-20: Service Level Node Appearing in the Software Tab of the Server List
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«+ If you searched for the server, click the server name and then select the Attached
Nodes tab. You can find the service levels, as Figure 7-21 shows.

Figure 7-21: Nodes Tab That Shows the Service Level to Which a Server is Assigned
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» To view all the servers assigned to a particular service level, click Environment »
Service Levels in the navigation panel. Navigate the hierarchy of service levels until you
reach the one for which you want to see which servers are assigned. Select the
Members tab, as Figure 7-22 shows.

Figure 7-22: Manage Server Assigned to a Service Level

Serice Levels & Cpsware * adh & windows = Details
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Assigning a Server to a Service Level
Perform the following steps to assign a server to a service level:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server you want to assign to a service level.
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Or
Search for the server that you want to assign to a service level.
H Select the servers that you want to assign to a service level.

Choose Tasks » Assign Node from the menu above the Manage Servers list. A
window displays the categories of nodes, as Figure 7-23 shows.

Figure 7-23: Assign Nodes Popup Window
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Bl Click the Service Levels link. The window refreshes to show the service levels
created for your operational environment.

B Navigate to the service level to which you want to assign the server.

@ Click Assign. The window closes and you are returned to the Manage Servers list.
See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.
Removing a Server from a Service Level

Perform the following steps to remove a server from a service level:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to remove from a
service level.

Or
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Search for the server that you want to remove from a service level.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

H Select the server that you want to remove from a service level.

Choose Tasks » Remove Node from the menu above the Manage Servers list. A
window displays the nodes to which the server is assigned, as Figure 7-24 shows.

Figure 7-24: Remove Nodes Popup Window
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Bl Select the service level node from which you want to remove the server and click
Remove. You are prompted to confirm that you want to remove the server from the
service level.

Click Confirm Remove. The window closes and you are returned to the Manage Servers
list.

Network Configuration

This section provides information about network configuration within Opsware SAS and
contains the following topics:

» Overview of the Server Network Configuration

« Configuring Networking for an Opsware Managed Server
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Overview of the Server Network Configuration

You can use Opsware SAS to automatically configure network settings for a server after
you install the OS.

The OS Provisioning feature provisions servers with an OS by using DHCP addresses.
Because DHCP servers often assign temporary IP addresses to servers that boot over a
network, system administrators typically need to assign static IP addresses (and other
network properties) before the servers can be put into service. Opsware SAS enables
system administrators to do this through the SAS Web Client rather than logging onto the
server manually after OS provisioning is complete.

Opsware SAS does not support managed servers that have IPv6 addresses.

The Server Network Configuration feature allows you to configure the following settings
on a server that are related to its network configuration:

* Host Name
+ Domain Name System (DNS) servers

+ Management interface (the interface that Opsware SAS should use when managing
the server)

See “Locating the Management IP Address of a Managed Server” on page 202 in
Chapter 7 for more information.

« Gateway (the IP address of the default router)
* DNS search domains
« WINS (Windows Internet Naming Service) Servers

+ Configuration for each network interface, including whether the interface is configured
statically or with a Dynamic Host Configuration Protocol (DHCP) IP address, host name,
and subnet mask

You can alter any of these options and then apply the settings to the managed server.
Opsware SAS updates the server and reboots it to cause the new settings to take effect.
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Configuring Networking for an Opsware Managed Server

You can only use the Network Configuration feature for servers running Sun Solaris, Red
Hat Linux, and Microsoft Windows operating systems.

Perform the following steps to configure networking for an Opsware managed server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to configure
networking on.

Or
Search for the server that you want to configure networking on.

See “Using the Search Feature” on page 169 in Chapter 6 for more information. See
“Server Searching by IP Address” on page 184 in Chapter 6 for more information.

H Click the name of the server that you want to configure networking for. The Manage
Servers: Properties page appears for that server.

E Select the Network tab. The network information for the server displays.

Modify any of the following settings to configure the server networking.
For all fields, the default value is the one currently configured on the server.

+ Host Name: The host name configured on the managed server. This field only sets
the name by which the server knows itself and does not update DNS records for
the server.

+ Management Interface: Instructs Opsware SAS to use a particular network
interface when contacting the server. This is useful, for example, when a server has
multiple network interfaces, but not all of them are reachable by the Opsware core.
Designating a particular interface as the management interface allows Opsware
SAS to know which interface to use for managing the server.

+ Gateway: The |IP address of the default router
* DNS Servers: A list of DNS nameserver IP addresses

« Search Domains: A list of DNS domains to search when attempting to resolve
host names

+ WINS Servers: Set for Windows only; a list of WINS server IP addresses

+ Interface Configuration (for each network interface in the system):
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« DHCP: If DHCP is enabled for an interface, the system uses DHCP to configure
this network interface. In this case, static configuration settings (IP address, host
name, and subnet mask) are not relevant for this interface, and the SAS Web
Client makes those fields not editable. If DHCP is not enabled, then static
settings are required.

« IP Address: The IP address for this interface (unless DHCP is enabled).

+ Host Name: The local host name for the server. This item is only required for
servers running Solaris. Like the Computer Name field, this setting only affects
the name by which the managed server knows itself, and does not update DNS
records.

« Subnet Mask: The IP network mask to use for this interface.

In addition, Opsware SAS displays the management IP address and MAC address
for the server; however, you cannot change these values reported by the Opsware
Agent.

Click Update Server at the bottom of the page.

(If you click Revert, it causes any changes that you made to the fields to be
discarded.)

A confirmation dialog box appears that shows the changes that will be made to the
server. The confirmation dialog box includes a check box that allows you to indicate
that the server should revert to its old network configuration when it cannot contact
the Opsware core after you save the new network configuration. By default, the
Revert check box is selected.

The SAS Web Client does not validate the network configuration changes that you
make in the Network tab. Therefore, it is possible to provide a malformed IP address
in the IP address field for an interface.

To have the server revert to its previous network configuration if an error occurs,
ensure that the check box is selected in the confirmation dialog box.

Click OK to proceed with the configuration changes.

A progress dialog box appears that shows the progress of the operation. The process
of setting a new network configuration involves rebooting the managed server. The
operation might take several minutes.
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You can walit for the operation to complete or close the progress dialog box and perform
other work in the SAS Web Client. The status of the task is available in the My Jobs user
interface if you want to check the status of the network configuration update.

Details About Changing the Domain for Windows Servers
You cannot use the DNS Domain field to change the domain name for a Windows server.
Opsware SAS does not change the domain name of a Windows server because

changing the domain name of a server requires password authentication. Changing the
domain name of a Windows server is a manual operation. See Figure 7-25.

Figure 7-25: DNS Domain Field Displays in the Network Tab for a Server

Return to Manage Servers

NETWORK INFORMATION
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This section discusses the following topics:
« Overview of NAS Integration

« Setting Up NAS Integration

+ Device Information in SAS

+ Device Groups

+ Duplex Mismatch

* Network Device Information in NAS

* Network Reports

Overview of NAS Integration

Implementing changes in an IT environment often requires a coordinated effort between
network administrators, system administrators, and application architects. Together, these
members of the IT staff must manage an application environment spanning servers
running different operating systems and network devices that include firewalls, load
balancers, switches, servers, Web applications, and so on. For example, in some
environments, you are required to make changes to network devices in front of an
application, such as load balancers, firewalls, switches, and so on.

The NAS Integration feature makes this process easier. It enables IT staff members to see
how servers are connected to network devices and enables them to closely examine
managed servers. With this information, they can determine how all devices are related
and coordinate and implement required changes.
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Figure 8-1 shows the types of coordinated tasks you can perform by using the NAS
Integration feature.

Figure 8-1: Overview of Coordinating Tasks Using NAS Integration
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This section contains information about how to set up NAS Integration, view device
details, examine connections between network devices and servers, identify duplex
mismatches, and view combined device history information. It also contains information
about implementing changes across the environment and generating network reports.

To support an integrated approach to making changes in your environment, such as
server reallocation, ensuring compliance across servers and network devices, and
detecting and resolving duplex mismatches, the NAS Integration feature provides the
following Opsware interface points:

Opsware Server Automation System (SAS)
Opsware Network Automation System (NAS)
Opsware Global Shell (in SAS)

Opsware Visual Application Manager (in SAS)

Opsware Reports (in SAS)
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NAS Integration Features

In the NAS Integration feature, you will use several Opsware SAS and Opsware NAS
features to perform the following tasks:

Use SAS and NAS to view summarized and detailed hardware information about
managed servers and network devices, and their connections (interfaces and ports).

Use the Opsware Global File System (OGFS) to navigate between managed servers
and connected network devices by tracing their associated physical connections,
finding network device configurations, and running scripts across servers and network
devices.

Call NAS scripts from SAS scripts to automate operations across servers and network
devices.

Use features in SAS and NAS to create diagrams that illustrate managed servers,
network devices, and layer 1 connections in your environment.

Use SAS to identify, troubleshoot, and remediate configuration duplex mismatches
between managed servers and network devices.

Use SAS to perform actions on device groups that contain both servers and network
devices.

Use SAS to review a combined event history log of servers and network devices that
records changes made to an application in your environment.

Use SAS to export a combined event history log to a .csv file and an .html file.
Use NAS to directly access additional network device details and event history.

Use SAS to run network reports that identify layer 1 connections and configuration
mismatches (duplex compliance).

Reference to connections in this documentation refer to physical connections, except

where noted.

How NAS Data is Collected

The NAS Integration feature uses the NAS Topology Data Gathering and NAS Duplex Data
Gathering diagnostic tools to collect information about network devices.
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NAS Topology Data Gathering

The NAS Topology Data Gathering diagnostic instructs NAS to collect MAC addresses for
all switches. MAC addresses are required to discover and add physical connections to the
Opsware data model. For example, when you add another server to a switch, that
information will be collected the next time the NAS Topology Data Gathering diagnostic
runs. You can also run the NAS Topology Data Gathering diagnostic or the NAS Duplex
Data Gathering on demand for specific network devices. See the Opsware® NAS User’s
Guide.

To avoid impairing performance in Opsware NAS, you cannot run this diagnostic any more
frequently than weekly. If you cannot wait a week to refresh the NAS data, contact
Opsware Support.

NAS Duplex Data Gathering

For network devices, speed and duplex is gathered by the NAS Duplex Data Gathering
diagnostic, which runs after a device is initially added to NAS and then according to a
schedule that you define. To ensure that you have the latest speed and duplex
information about network devices, Opsware, Inc. recommends that you set up a recurring
schedule that runs the diagnostic. See “Duplex Mismatch” on page 295 and the
Opsware® NAS User’s Guide.

Troubleshooting Tips
To test whether SAS is communicating with NAS, verify the following setup:

» Make sure you can log in to NAS with your SAS credentials. This ensures that NAS can
communicate with SAS.

» Make sure the SAS credentials specified in the NAS Administrative Settings under
External Authentication Type are set to Opsware Server Automation System. This
ensures that NAS can look up server MAC addresses.

+ Make sure the NAS Topology Gathering Diagnostic has run successfully by searching
for tasks and check their results. This ensures that NAS has gathered MAC addresses
and tried to look them up in SAS.

SAS Client Communication

Some NAS Integration features require that the SAS Client (Java) opens the NAS Web
interface (directly from SAS) so that you can access additional details about certain NAS
events. If you have completed the required setup tasks and the SAS Client is unable to
communicate directly with the server running the NAS host (server) Web interface, you
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might need to change the Opsware NAS option in the SAS Client. For example, if a firewall
is preventing the SAS Client from reaching the NAS host, you need to specify the name of
a server that is acting as a proxy for the NAS host. This will override the default setting.

This option enables you to specify the name of the NAS host that you log in to, restore the
previously saved (default) host name, and launch the NAS login window to verify the host
name.

To reset the Opsware NAS option, perform the following steps:

E From the Tools menu in the Opsware Server Automation System window, select
Options.

H nthe Views pane, select Opsware NAS.

In the Host field, enter the name of a server that is acting as a proxy for the NAS host,
such as m208, which is the proxy for the m208.opsware.com NAS host.

(Optional) Click Restore Default to restore the previously saved NAS host name.

(Optional) Click Test to open the Opsware NAS login window.

@ Click Save to save your changes or click Cancel to close the window without saving
your changes.

Prerequisites

The NAS Integration feature requires that both Opsware NAS 6.1 and Opsware SAS 6.0
are installed and configured to enable you to share data across servers and network
devices in your environment.

The Opsware Agent 6.0 is also required. If an Agent older than 6.0 is installed on a server,
it cannot return the duplex and speed settings for the network interfaces. Therefore,
duplex compliance cannot be calculated for that server.

Setting Up NAS Integration

To set up the NAS Integration feature, you must change configuration settings in NAS and
in SAS, run diagnostics for NAS topology data, and set up user permissions. Optionally,
you can reset the NAS host name if the SAS Client is cannot find the NAS server as it is
currently defined.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

277



Opswar«e'® SAS 6.0.1 User’s Guide: Application Automation

278

Configuration Changes

To set up the NAS Integration feature, you must change the following two configuration
settings, one in NAS and then one in SAS:

+ A configuration setting in NAS (which you must make first)

« A configuration setting in a SAS .conf file (after you made the NAS change)
NAS Configuration

To change the configuration setting in NAS, perform the following steps:

Log in to Opsware NAS.

H Select Admin » Administrative Settings » User Authentication to display the
Administrative Settings - User Authentication page.

Figure 8-2: External Authentication Type in NAS

@ Administrative Settings - User Authentication Add to Favorites & Help @)
Notes:
Leaving this page or clicking any hyperlinks without clicking the Sawve button will result in the loss of any unsaved changes to the admin settings. T
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In the External Authentication Type section, select Opsware Server Automation
System.

Figure 8-3: Opsware Server Automation System Authentication

Twist Server
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OCC Server |occ.c43.dev.0psware_com Cpsware Comrand Center host name for linking to connected servers,
Dt Ws2r SreE | Limited Access User “ | User Group for new Server Automation Syster use

Bl Complete all fields in the Opsware Server Automation System Authentication section.

NAS uses the Twist Username and Twist Password when it gathers layer 2 data. NAS
looks for the server interface information by MAC address, using that user's
permissions. The user must have read access to server information.

B Click Save to save your configuration change.
See the Opsware® NAS User’s Guide.

SAS Configuration

If the NAS server name was not entered during SAS installation, you must add the
twist.nasdata.host=<hostname> setting in the twist.conf file in /etc/opt/
opsware/twist/twist.conf. See the Opsware® SAS Planning and Installation
Guide.

After you make these configuration changes, you must restart NAS and the Twist.

Topology Data

To continue setting up the NAS Integration feature, you must also run the NAS Topology
Data Gathering and NAS Duplex Data Gathering diagnostics in NAS. See “How NAS Data
is Collected” on page 275 and the Opsware® NAS User’s Guide.
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User Permissions

Access permissions for the NAS Integration feature are based on two separate databases:
a NAS database and a SAS database. NAS uses its own database for authorization. SAS
uses a different security mechanism for authorization. However, all authentication (for both
NAS and SAS) is processed by SAS.

When NAS is configured to use SAS authentication, it tries to authenticate against SAS
first. If NAS fails to authenticate against SAS, it falls back to the NAS database. If there is
an account in the NAS database, the fallback is only allowed if that user is configured to
allow fallback authentication. See the Opsware® NAS User’s Guide.

When a new user is authenticated through SAS, an account is created in NAS and placed
in the Default User Group. This is the user group that was specified when SAS
authentication was enabled in the Administrative Settings in NAS. This user group is
configurable—the specified user group and its assigned permissions control the actions
that will be allowed in NAS.

You must have a set of permissions to view servers and network devices, and make
IZ configuration changes. To obtain these permissions, contact your Opsware administrator.
See the Opsware® SAS Administration Guide.

Device Information in SAS
In addition to basic hardware details about managed servers and network devices, the

NAS Integration feature also reports the following information about network interfaces
and network ports:

+ On the server side, network interfaces have the following properties: MAC address,
subnet mask, interface type, IP address, DHCP setting, connected switch port, speed,
and duplex (excluding Windows).

« On the network device side, network ports have the following properties: port name,
speed and duplex settings, devices connected, and interface type.

For most devices, auto-negotiation works best when both sides of the connection (server
Q and network device) are set to auto-negotiate mode. For example, a duplex policy could
specify that a port should be set to full, half, or auto, and not to full (auto). A full (auto)
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duplex setting indicates that the port was set to auto-negotiate and it negotiated to full
duplex. See the Opsware® NAS User’s Guide.

The following tasks describe how you can access detailed hardware information for

servers and network devices directly in Opsware SAS. See “Network Device Information in
NAS” on page 293 for instructions on how to access hardware information about network

devices directly in Opsware NAS.

Viewing Network Interfaces

To view hardware information about a server, including network interfaces, perform the

following steps:

E From the Navigation pane, select Devices » All Managed Servers.

H From the View drop-down list, select Hardware.

E Double-click on a server in the Content pane to display hardware details in the

Server Explorer.

Figure 8-4: Hardware View in the Server Explorer
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Viewing Network Ports

To view hardware information about a network device, including network ports, perform
the following steps:

E Fom the Navigation pane, select Devices » Device Groups » Public and then
select a group.

H Double-click on a network device in the Content pane to display the Network Device
Explorer.

In the Views pane, select Hardware to display information about the selected network
device.

Figure 8-5: Hardware View in the Network Device Explorer
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Connections Between Network Devices and Servers

The NAS Integration features are based on layer 2 connections and inferred layer 1
connections. See Figure 8-6 for definitions of the OSI Model layers.

Figure 8-6: OSI Seven Layer Model

Application

Presentation

Session

Network

Data Link

| |
| |
| |
| Transport ‘
| |
| |
| |

Physical

Data Link Connections

The NAS Integration feature includes functionality that detects data link (layer 2)
connections and reports on physical (layer 1) and data link connections. These data link
connections include switches that are directly connected to a managed server and
switches that are indirectly connected through other switches. These connections are
discovered by correlating the MAC addresses reported by the device with the known MAC
addresses for servers and switches.

Physical Connections

The physical connections are inferred from the data link connections. See “Inferred
Physical Connections” on page 285. Physical connections represent direct connections
(cables) between server and switches.

In the SAS Client, you can see physical connections in the Server Explorer, the Network
Device Explorer and in detailed layout diagrams in the Visual Application Manager. In the
NAS diagramming feature, you can see physical, data link or network (layer 3)
connections.
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Network Diagrams

You can use the Visual Application Manager feature in Opsware SAS and the
Diagramming feature in Opsware NAS to create detailed diagrams that illustrate managed
servers, network devices, and layer 2 and layer 1 connections in your environment. You
can also export these network diagrams to .gif, .jpg, and .svg files, and then subsequently
annotate and use them in other applications.

See the Opsware® SAS User’s Guide: Application Automation and the Opsware® NAS
User’s Guide for more information about the Visual Application Manager and the
Diagramming tool.

Launching Visual Application Manager

To access the Visual Application Manager, perform the following steps:
E From the Navigation pane, select Devices » All Managed Servers.
H In the Content pane, select one or more servers.

H From the Tools menu, select Visual Application Manager and then select one of
the following options:

« Select New to open the Opsware Visual Application Manager window.
+ Select Open to open a previously saved topology.

Bl To create and export topology diagrams, see the procedures for using Visual
Application Manager in the Opsware® SAS User’s Guide: Application Automation.

Launching NAS Diagramming

See the Opsware® NAS User’s Guide for instructions on launching and using the
Opsware NAS Diagramming feature.

Network Directories

You can use the Global Shell feature to navigate between servers and connected network
devices by tracing their physical connections in the /opsw/Servers/@ and /opsw/
Network/@ directories in the OGFS.

You can also run three types of NAS scripts in the OGFS: command, advanced, and
diagnostic. These scripts correspond to the three directories in the OGFS under /opsw/
Scripts/Network. See “Network Directories” on page 501.

In the OGFS, you can also write scripts in languages, such as Bourne shell and Python, to
perform the following tasks:
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+ Find servers and network devices.

+ Find all servers that are connected to a certain switch.

» Find servers with a duplex mismatch.

« Display the network interfaces of a certain server.

+ Get the IP addresses of all devices.

« Compare two files to identify changes in a network device's configuration.

+ Change device details, such as the snmp-location.

Launching Global Shell

Within the Global Shell feature you can see all of the ports on a switch, view duplex
settings in the info file, see all device configurations, compare configuration files, and so

on. Every time a network device configuration is changed, a snapshot of it is also created.
All actions that you perform on a device are audited.

To access the OGFS in the Global Shell feature, perform the following steps:

E From the Tools menu, select Global Shell to launch a terminal window. See
“Opening a Global Shell Session” on page 310.

H To navigate between servers and connected network devices, use the guidelines
described in “Global Shell” on page 299 and “OGFS Directories” on page 489.

Remote Terminal

The Remote Opsware Shell (rosh) utility enables you to log in to devices (servers and
network devices) and run native commands. You invoke rosh from within a Global Shell
session. You can run rosh and enter native commands interactively, or you can specify
the native commands as an option of rosh. For example, you can log in to a switch with
rosh and run the show vlan command to view all VLAN details.

See “Remote Terminal” on page 321 and “Logging on to a Managed Server With rosh” on
page 314 for more information about using the rosh utility.
Inferred Physical Connections

The NAS Integration feature also includes functionality that detects and reports on inferred
physical (layer 1) connections. These connections are inferred from data (such MAC
addresses that are seen by switches), captured, and then added to the Opsware data
model.
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These physical connections (inferred layer 1 data) are based on heuristics. In the OSI
model, each layer is an abstraction designed to hide the layer below. Therefore, the layer
2 data gathered from devices cannot generate 100% accurate layer 1 data. In particular,
layer 1 data may be incorrect if any of the following conditions exist:

» The device does not return the port number where MAC addresses are seen.

« There was no traffic between the devices within a few minutes of when NAS gathered
the topology data (where MAC addresses are seen).

» There is an unmanaged device between two managed devices.
» There is a hub between two managed devices.

In the SAS Client, you can see inferred layer 1 connections by navigating network device
directories in Opsware Global Shell.

Device Groups

A device group helps you categorize your devices (servers and network devices) in ways
that make sense for your organization. For example, you can group devices by customer,
facility, usage, application, and so on, and then perform actions on all of the devices in the

group.

In SAS, a device group can contain managed servers and network devices, or only
managed servers. In Opsware NAS, a device group contains only network devices. You
create and edit network device groups only in NAS. See the Opsware® NAS User’s Guide
for more information about using the rosh utility.

The NAS Integration feature allows you to associate a public device group (that exists in
Opsware SAS) with a device group (that exists in Opsware NAS). The device group
names must be identical and you must enable the corresponding option. To monitor an
application that is running on multiple servers and relies on multiple network devices in
your environment, Opsware, Inc. recommends that you model it as a device group that
contains all servers and network devices the application runs on. This enables you to
troubleshoot the application by using SAS.

Associating a NAS Device Group

When you associate a public device group in SAS with a device group in NAS, you will be
able to monitor information about all servers and network devices that you are interested
in. You associate device groups by using identical group names.
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To associate device groups in SAS and NAS, perform the following steps:
E From the Navigation pane, select Devices » Device Groups » Public.
H In the Content pane, select a device group.

HE Right-click on the device group and then select Open to display the Device Group
Explorer.

Bl From the View drop-down list, select Properties.

Check the “Associate with a NAS device group of the same name” check box to
enable this functionality.

@ From the File menu, select Save.

Combined Device History Log

The combined device history log records events performed on servers and network
devices in your environment. These events are recorded in detail as actions performed on
a certain date, by a certain user, on a certain server, or on a certain network device.

In many troubleshooting tasks, this type of information is critical because some of these
actions (changes) might be the root cause of problems. This log provides detailed
information, such as the date the action occurred, the name and type of the device that
the action was performed on, and a description of the action, that can help you perform
root cause analysis, capacity planning, and compliance remediation tasks. For example, if
an application in your environment has suddenly stopped running and you know exactly
when it was previously running, you need to examine a combined event history log for the
affected servers and network devices, for that time period. This information can help you
determine why the application stopped working.

Viewing a Combined Device Event History Log

You can view a detailed list of events that occurred on a server or network device, such as
all changes made to an application. You can narrow the time frame of the log display to
see changes that occurred daily, weekly, monthly, quarterly, or in a custom range of dates.
You can also dynamically filter the display of events by a certain date, device name,
device type, event type, or by user name.

You can view a combined device history log for one or more managed servers or for a
device group that contains managed servers and network devices.

To view a combined device history log for a device group, perform the following steps:
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E From the Navigation pane, select Devices » Device Group, and then select a device
group.

In the Content pane, select one or more devices in the group.

Right-click and then select View History to list events that occurred on the selected
devices.

Figure 8-7: Combined Device Event History
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Ilon Jun 26 04: . im106 pra.opsw .. Server opened "tmplstemap-doT Ge3f0c0006e5131 9e0c51 Schbdbbas... cstarkey

Mor Jun 26 0d: . i 05 prS opsw.. Server created "tmplstemap-doTBe9f0c0006:8191 9elcs1 ScEbdbba. .. cstarkey

:Mon Jun 26 04 i 01 proopsw... Server created "trmplstemap-dc? 6e9f0c0006e5191 9elcs1 Schbdbba. .. cstarkey

don Jun 26 04: ... it O prSopsw... Server created "tmplstemap-doTEe9f0c 000628191 9e0ca1 Schbdbba. .. cstarkey
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Wlon Jun 26 01: ... swl.prs Swvitch Task Started admin

Mon Jun 26 01:... =wl.prs Swvitch Last Used Device Password Changed -

Non Jun 26 01: ... =wl.prs Swvitch Device Diagnostic Completed Successfully admin

:Mon Jun 2601 sl prs Swvitch Task Cornpleted aclrnin

\Sun Jun 25 220, 2wl s Swvitch Device Snapshot admin

Sun Jun 25 2220, 3wl prs Swvitch Task Completed admin

Sun Jun 25 2200, s s Swvitch Last Used Device Password Changed -

|SUN Jun 25 22:0.. 5wl prs Swvitch Task Started admin
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Viewing an Event History Log for Servers
To view a combined device history log for one or more managed servers, perform the
following steps:

E From the Navigation pane, select Devices » All Managed Servers.
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In the Content pane, select one or more servers.

SErvers.

Figure 8-8: View History of Servers
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(Optional) In the View History window, select an option in the View drop-down list to

list events by a time period, such as Last Day, Last Week, Last Month, or Custom

Range.

5
(Optional) In the View History window, use the search tool -~ to dynamically filter
the display of events by a certain date, device name, device type, event type, or by

user name.
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@ (Optional) To identify the device name and type for a certain event, double-click on
the event listed in the View History window to display the Event Details window.

Figure 8-9: Event Details for a Selected Server

B Event Details

Date: Mon Jun 19 14:47:52 20,
Device MName: m208 dev opsware.com
Device Type: Server

Uzer: hoty

Upgrade Opsyware &gent to wersion 32.0.1.59; SUCCESS

Closg

To view the combined device history log for a device group, perform the following steps:
El From the Navigation pane, select Devices » Public.

H In the Content pane, select one or more devices in the group.
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B Right-click and then select View History to list events that occurred on the selected

network devices.

Figure 8-10: View History of Network Devices
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(Optional) In the View History window, select an option in the View drop-down list to

list events by a time period, such as Last Day, Last Week, Last Month, or Custom

Range.

I:"
(Optional) In the View History window, use the search tool -'"J to dynamically filter
the display of events by a certain date, device name, device type, event type, or by

user name.
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@ (Optional) To display details for a certain event, double-click on the event listed in the
View History window to display the Event Details window.

Figure 8-11: Event Details for a Selected Network Device

B Event Details E |§ |@

Date: Tue Jun 20 01:23:01 2006
Device Mame: aw-ee-1-1a

Device Type: Swyitch

Uzer: haEs

Summary: Tazk Completed

The following task completed:

86493901: Task Mame: Run Diagnostics
Device: sw-ee-1-1a (192168195253
Added by: nas (Donny Kawan)
Start Date: 2005-06-19 18:00:00.0
Repest type: Mon-recurring
Status: Skipped
Comments: System task to regularly detect device hoots.

Open in Opsyare NAS

Exporting a Combined Device History Log
If you need to use the log file in different applications, you can export the list of combined
device history events to a .csv or an .html file.

To export the combined device history log, perform the following steps:
EH From the View History window, click Export to display the Export Dashboard window.
H Inthe Look in field, enter the location of where you want to save the file.

H (Optional) From the Encoding drop-down list, select a character encoding option. The
default is Unicode (UTF-8).

In the File name field, enter a name for the file.

B Inthe Files of type field, select .csv or .html.

Click Export to save the file in the selected format or click Cancel to close this
window without saving.
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Network Device Information in NAS

To help you with troubleshooting tasks that involve network devices in your environment,

you can examine additional network device details and network device event history by

logging directly in to Opsware NAS. The NAS Integration feature provides a login option to
access detailed information about network devices and their event history as recorded in

Opsware NAS.

Viewing a Network Device Directly in Opsware NAS

If you want to view detailed information about a network device directly in Opsware NAS,

perform the following steps:

E From the Navigation pane, select Devices » Device Group » Public.

H In the Content pane, select a network device.

Right-click and select Open in Opsware NAS to display the Opsware NAS login

window.

Bl Enter your user name and login, and then click Login to display device details in

Figure 8-12: Network Device Details in NAS
SWARE Support Docs The Opsware Network Logout
NETWORKAUTOMATION | @ Devices | jTasks | M Policies | 4 Reports | @) Admin nas Jun-20-06 09:22:46
=
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Last Snapshot Result  Configuration unchanged Watch Device
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Default Customer
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test ca
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¢ My Favorites Sunnvvale
test ca
sw-se-1-2b Update Comments| B
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test ca Vendor: Cisco
2 My Settings Model: 2610 (C2600 series)
N Software Version: 12.0(4)T
My Profile . .
My Workspace Driver Name: Cisco routers, 800, 1700, 2500, 2600 & 4700 series,
My Py P I0S version 12.x R .
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Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

293



Opsware® SAS 6.0.1 User’s Guide: Application Automation

_ — mr—//é‘ —— -
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Change Password
Serial Number: JADD42Z09WA
Asset Tag:
System Memory: 24.0 MB
Location:
Device Origin: Manually added by nas on Mar-22-06 18:15:40
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Snapshot:
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~

H Click Logout to exit NAS.

Viewing Event History Directly in Opsware NAS
If you want to view event details directly in Opsware NAS, perform the following steps:

H In the Event Details window, click Open in Opsware NAS to display the Opsware
NAS login window. See Figure 8-10 on page 291.

H Enter your user name and login, and then click Login to display event details in NAS.

Figure 8-13: Event Details for a Network Device in NAS

~
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Or... Description NAS Detect Device Boot
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— ——— .
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HE Click on the Device link to view additional information, such as timestamps for when
the device was added, the last snapshot, and the last configuration change. See
Figure 8-11 on page 292.

Bl Click Logout to exit NAS.

Duplex Mismatch

The NAS Integration feature provides automatic detection of duplex mismatches. A duplex
mismatch is a configuration mismatch between the speed and duplex of a managed
server and a connected network device.

For servers’ network interfaces, speed and duplex information is gathered during every
hardware registration, which occurs every 24 hours. See “Opsware Agent Management”
on page 91 for information about hardware registration.

Due to the lack of a device independent method of determining duplex for servers
running a Windows operating system, the Opsware Agent for Windows does not report
duplex settings out-of-the-box. A custom script can be added to the Opsware Agent to
collect and report the speed and duplex setting for a certain network interface. For
instructions on how to create and integrate the script with the Agent, contact Opsware
Support.

Speed and duplex information for servers is not updated when you select View »
Refresh or press F5 in the SAS Client. This data gets updated when the NAS Duplex Data
Gathering diagnostic runs. See “NAS Duplex Data Gathering” on page 276.

For network devices, speed and duplex is gathered by the NAS Duplex Data Gathering
diagnostic, which runs according to a schedule that you define. To ensure that you have
the latest speed and duplex information about network devices, Opsware, Inc.
recommends that you set up a recurring schedule that runs the diagnostic. See the
Opsware® NAS User's Guide.

If the network interface information (speed and duplex) for a server does not match the
network port information (speed and duplex) for a connected network device, it is
considered to be non-compliant.

In the NAS Integration feature, you can see duplex mismatches identified at a top level by
using the Dashboard. You can also see duplex mismatches identified by server and
network device by using the Server Explorer and Network Device Explorer, respectively.
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Viewing Duplex Mismatches in the Dashboard

See the Opsware® SAS User’s Guide: Application Automation for information about
duplex compliance levels and how they are displayed in the Dashboard.

Viewing Duplex Mismatches by Server

To view duplex mismatches using the Server Explorer, perform the following steps:
E From the Navigation pane, select Devices » All Managed Servers.

In the Content pane, select a server.

Double-click on the server to display the Server Explorer.

In the Views pane, select Hardware.

In the Network Interfaces section, review the Duplex column for detected
mismatches. Mismatches are identified by an & icon that precedes the duplex
setting (Full, Half, Auto), in the Duplex column.

Viewing Duplex Mismatches by Network Device

To view duplex mismatches using the Network Device Explorer, perform the following
steps:

El From the Navigation pane, select Devices » Device Groups » Public.
In the Content pane, select a network device.
Double-click on the network device to display the Network Device Explorer.

In the Views pane, select Hardware.

In the Network Ports section, review the Duplex column for detected mismatches.
Mismatches are identified by an & icon that precedes the duplex setting (Full, Half,
Auto), in the Duplex column. See Figure 8-4 on page 281.

Network Reports

To help troubleshoot problems that involve physical connections and duplex compliance,
you can run and examine several network reports. By using the Reports feature in the SAS
Client, you can produce the following network reports that identify layer 1 connections
and configuration mismatches (duplex compliance) between managed servers and
network devices in your environment:
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Connections by Network Device
This report lists all physical connections to a selected network device.

Connections by Server
This report lists all physical connections to a selected managed server.

Duplex Compliance (All Servers)

This report groups all managed servers by duplex compliance level to show configuration
mismatches between servers and network devices. Click on a section of the chart to
display a list of servers in a certain compliance level. Double-click on a server for more
details or to perform an action.

Duplex Compliance by Customer

This report lists all managed servers by customer and then by duplex compliance level to
show configuration mismatches between servers and network devices. Double-click on a
server for more details or to perform an action.

Duplex Compliance by Facility

This report lists all managed servers by facility and then by duplex compliance level to
show configuration mismatches between servers and network devices. Click on a section
of the chart to display a list of servers in a facility with a certain compliance level.
Double-click on a server for more details or to perform an action.

See “Reports” in the Opsware® SAS User’s Guide: Application Automation for information
about how to run, export, and print these reports.
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This section discusses the following topics:
+ Overview of the Global Shell

+ Global Shell Tutorial

+ Global Shell Examples

« Character Encoding for the OGFS

+ Global Shell Error Messages

* Remote Terminal

Overview of the Global Shell

The Global Shell is a command-line interface to the Opsware Global File System (OGFS).
The command-line interface is a Unix shell such as bash that runs in a terminal window.
The OGFS unifies the Opsware data model and the contents of managed servers,
including files, into a single, virtual file system. You open a Global Shell session from
within the SAS Client or from a direct ssh connection in a terminal client on your desktop.
With the Global Shell, you can automate repetitive system administration tasks by running
scripts across multiple servers in a secure environment.

Opsware Global File System (OGFS)

The OGFS represents the Opsware data model as a hierarchical structure of file
directories and text files. For example, in the OGFS, the /opsw/Customer directory
contains details about Opsware customers and the /opsw/Server directory has
information about managed servers. The /opsw/Server directory also contains
subdirectories that reflect the contents (such as file systems and registries) of the
managed servers. If you have the required permissions, in the Global Shell, you can view
and even modify the file systems of managed servers.
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Remote Opsware Shell (rosh) Utility

The Remote Opsware Shell (rosh) utility enables you to log on to managed servers and
run native commands. You invoke rosh from within a Global Shell session. You can run
rosh and enter native commands interactively, or you can specify the native commands
as an option of rosh.

Benefits of the Global Shell
The Global Shell, OGFS, and rosh utility, offer the following benefits:

« Security: Logging on to managed servers is controlled by the Opsware SAS security
framework.

« Auditing: Logins and commands on managed servers are recorded in audit log files.

* Re-use of existing scripts: Existing native scripts can run on managed servers with
the rosh utility. For example, you can run .BAT, .vbs, and .sh scripts on managed
servers. Scripts written in Unix shells will run within the Global Shell, which supports
bash, csh, and other common shells.

* Routine maintenance tasks on multiple servers: By accessing the global view of the
OGFS, system administration scripts can run iteratively on groups of servers.

+ Access to the Opsware SAS data model: Global shell scripts can access information
about managed servers, including custom attributes.

Commands Available in the Global Shell
The Global Shell offers the following types of Unix shells:

bash (default)

csh

ksh

sh

tcsh
Many common Unix commands (too numerous to list here) are available within the Global
Shell. To display these commands, in a Global Shell session, list (1s) the contents of the

following directories:

/bin /usr/bin
/opsw/bin

The /opsw/bin directory contains utilities (such as rosh) which are specific to Opsware
SAS. For more information, see “Global Shell Utilities Syntax” on page 477.
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Differences Between the Global Shell and Unix Shells
The Global Shell is different from native Unix shells in the following ways:

* Restricted command set: Some Unix commands (such as cron) are unavailable in
the Global Shell. To find out if a command is available, use the which command.

+ Limited recursion: Commands cannot use recursion with the file systems of managed
servers. Examples of recursive commands are find, 1s -r,and rm -r.

+ Opsware user: You log on to the Global Shell as an Opsware user, not as a Unix user.

+ Opsware permissions: The operations that you can perform and the servers that you
can access are limited by the Opsware permissions of your Opsware user group.

+ Private directories: The following directories are accessible only by your Opsware
user:
/tmp
/var/tmp
/usr/tmp
For example, the /tmp directory seen by the jdoe Opsware user is different than the
/tmp seen by tjones.

+ Opsware data model in the OGFS: Stored in the Opsware Model Repository, the data
model consists of objects such as customers, facilities, and servers. End users
manipulate these objects with the SAS Client. The OGFS represents the data model in
a file system that resembles a Unix file system. Changes to the data model appear as
changes in the OGFS, and vice versa.

+ Axis (@) symbol in directory names: In the OGFS, for example, this symbol appears
in the following directories:

/opsw/Server/@
/opsw/Server/@Group
/opsw/Group/Public/group-name/@

The axis (@) symbol represents the end of the filtering criteria for managed servers.

Server Filtering in the OGFS

As you navigate down the OGFS tree, the path grows longer and more specific as fewer
servers are visible in the Server directory. In the OGFS, the /opsw directory contains
subdirectories for several types of objects in the Opsware model space, such as Server,
Group, Facility, 0S, Application, Customer, and SO on

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved. 301



Opswezre® SAS 6.0.1 User’s Guide: Application Automation

302

In the Global Shell interface, you can filter your view of these object types in the Server
directory by specifying an axis (@) in the path. A path in the Opsware model space can be
a list of filtering criteria that selects objects of a given type. This path begins with the
desired object type, such as /Server, and each filtering criteria begins with an @, such as
@Customer. An ending @ denotes the end of the filtering criteria.

Figure 9-1 is graphical representation of related objects (customers and facilities) in a
hierarchical server directory. The small boxes represent managed servers. Examples of
ways that you can filter this directory immediately follow the diagram.

Figure 9-1: Filtering in the Server Directory
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Based on Figure 9-1, the following examples illustrate ways to narrow your search for

servers:
» To find all 16 servers, specify the following path:

ls /opsw/Server/@

« To find servers in the Atlanta facility, specify the following path:

ls /opsw/Server/@Facility/Atlanta/@

+ To find servers that belong to customer Alpha, specify the following path:
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$ 1ls /opsw/Server/@Customer/Alpha/@

« To find servers in the Atlanta facility that belong to customer Alpha, specify either of the

following paths:

ls /opsw/Server/@Facility/Atlanta/@Customer/Alpha/@

ls /opsw/Server/@Customer/Alpha/@Facility/Atlanta/@
The following paths are filtered away by the OGFS, because they would yield a dead-end.
There are no servers belonging to customer Gamma in the Atlanta facility.

ls /opsw/Server/@Facility/Atlanta/@Customer/Gamma/@
ls /opsw/Server/@Customer/Gamma/@Facility/Atlanta/@

This same filtering logic can be applied to @Realm, @Group, and @Application.

Global Shell Tutorial

This tutorial covers just a few of the highlights of the OGFS and the Global Shell. After
completing this tutorial, you will know how to navigate the directories of the OGFS and
how to run commands on managed servers from within the Global Shell. Although the
tutorial is organized into steps, after performing step 1, you can perform the remaining
steps in any order.

Before starting the tutorial, you need the following capabilities:

» You can log on to the SAS Client. As you work through this tutorial, you might find it
helpful to compare the stdout of the Global Shell with information displayed by the SAS
Client.

* Your Opsware user has Read & Write permissions on at least one managed server.
Typically assigned by a security administrator, permissions are discussed in the
Opsware® SAS Administration Guide.

» Your Opsware user has all Global Shell permissions on the same managed server. For
information on these permissions, see “aaa Utility” on page 477.

The example commands in this tutorial operate on a Windows server named
abc.opsware. com. This server belongs to a device group named All Windows Servers.
When trying out these commands, substitute abc . opsware . com with the host name of
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the managed server you have permission to access. Also, replace jdoe with your
Opsware user name. If you wish to run the commands on a Unix managed server, replace
ipconfig with ifconfig; and replace Administrator with root.

Now, let's get started with the tutorial:
E Open a Global Shell session.

You can open a Global Shell session from within the SAS Client. From the Actions
menu, select Global Shell. You can also open a Global Shell session from a terminal
client running on your desk top. For instructions, see “Opening a Global Shell
Session” on page 310.

H Check your session.

First, enter the whoami command, which displays the Opsware user name for this
session:

S whoami

jdoe

You can enter the ps command to view the process status of your Global Shell
session. The following ps command shows the session is running the default bash

shell:

$ ps

PID TTY TIME CMD
7033 ? 00:00:00 bash
13712 ? 00:00:00 ps

Enter the uname command, which displays information about the server running the
OGFS component of Opsware SAS:

$ uname -a

Linux ml71.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15
21:17:59 EDT 20 05 1686 GNU/Linux

If you log on to a Unix managed server with rosh, uname displays information about
that managed server, not the server running the OGFS component. Run the uname
command when you are not sure if you are interacting with the Global Shell or with

the shell of a managed server accessed with rosh.

E Confirm your home directory.
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Every Opsware user has a home directory in the OGFS. The home directory has a
public/bin subdirectory where you can store scripts to be executed by other
users running Global Shell sessions. Each Opsware user also has a personal /tmp
directory for temporary files. You cannot view or modify the /tmp directories of other
users.

The following commands show some information about the directories of the jdoe
user:

S cd

$ pwd

/home/jdoe

$ 1ls -1d /home/jdoe/public/bin

drwxr-xr-x 2 jdoe jdoe 4096 2006-05-17 17:12 /home/jdoe/
public/bin

$ 1s -1d /tmp

drwxrwxrwx 3 root root 4096 2006-06-09 23:37 /tmp

List all managed servers.

The /opsw/Server directory of the OGFS contains information about the servers
managed by Opsware SAS. This directory is an example of how the OGFS represents
objects (in this case servers) of the Opsware SAS data model. Behind the scenes,
Opsware SAS stores this information in a database referred to as the Model
Repository.

To view the names of the servers managed by Opsware SAS, enter the following
command:

S 1ls /opsw/Server/@
abc.ospware.com m33.opsware.com gist.opsware.com
pal.opsware.com hare.opsware.com gv55.opsware.com

Examine server information.

Each managed server has a directory structure containing information about that
server. The attr subdirectory contains text files that describe the server’s attributes.
The attribute name matches the file name and the attribute value is the file contents.
The following cat command lists the OS version of the managed server named
abc.opsware.com:

S cd /opsw/Server/@/abc.opsware.com

$ cat attr/osVersion

Microsoft Windows 2000 Advanced Server Service Pack 4 Build
2195 (05-02-2006
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The Interface subdirectory has information about the server's network interfaces.
Here's an example:

$ cat “Interface/Local Area Connection/info”
AdminEnabledFlg: no

CardIndex:

CardSerialNum:

CircuitId:

Collisions:

ConfiguredDuplex: AUTO

ConfiguredSpeed: AUTO

@ List the files of a managed server.

In addition to information about managed servers, /opsw/Server contains
directories that correspond to the file systems of those servers. If you have the
necessary permissions, in a Global Shell session you can access multiple servers
from a single virtual file system, the OGFS.

The following command navigates to file system of the abc . opsware. com server:

$ cd /opsw/Server/@/abc.opsware.com/files

The next 1s command displays OGFS subdirectories that correspond to native users
of the managed server. Your security administrator specified these users with the -1
option of the aaa command. These are not Opsware users.

S 1s

Administrator LocalSystem

Native users might have different views of the managed server’s file system.
Therefore, under each user, the OGFS presents different file systems for each user.
The following ¢d command drills down to the Program Files directory as seen
by the Administrator user on the Windows server.

S cd "Administrator/C/Program Files"

$ pwd
/opsw/Server/@/abc.opsware.com/files/Administrator/C/Program
Files

Next, list the files in the Program Files directory:
$ 1s -1

Accessories

Common Files

ComPlus Applications

Internet Explorer

Messenger
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Although these files reside in a directory on the managed server’s file system, you
are in the OGFS, as shown by the preceding pwd command. To verify that you are in
a Global Shell session (and not in a session running on the managed server), enter
the following commands:

S whoami jdoe

$ uname -a

Linux ml71.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15
21:17:59 EDT 2005 1686 GNU/Linux

Copy a file from the OGFS to a managed server.

By entering the cd command, go to your home directory in the OGFS, for example:

S cd

$ pwd

/home/jdoe

Next, create a simple text file in your home directory:

$ echo “this is text” > myfile.txt

S cat myfile. txt

this is text

Copy the file that you just created to a directory in the file system of a managed
server. The following command copies myfile.txt tothe C:\temp directory of
the abc.opsware. com server:

S cp myfile.txt \

/opsw/Server/@/abc.opsware.com\
/files/Administrator/C/temp/afile.txt

Do not copy large files between the OGFS and managed servers. Copy only small
files, such as configuration files.

Log on to a managed server with rosh.

In the preceding steps, you accessed the file system of a managed server from
within a Global Shell session. In this step, from the Global Shell you log on to a

managed server with rosh. After you log in, you interact with the command-line
environment (MSDOS or Unix shell) of the managed server.

The following rosh command logs in as Administrator to a Windows managed
server named abc . opwsare . com:

S cd /opsw/Server/@/abc.opsware.com

$ rosh -1 Administrator

Microsoft Windows 2000 [Version 5.00.2195]
(C) Copyright 1985-2000 Microsoft Corp.
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The prompt indicates that you are now in the command-line environment of the
managed server. Enter the ipconfig and hostname commands:

C:\WINNT\system32>ipconfig
ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . : opsware.com
IP Address. . . . . . . . . . . . : 192.168.8.217
Subnet Mask . . . . . . . . . . . : 255.255.254.0
Default Gateway . . . . . . . . . : 192.168.8.1

C:\WINNT\system32>hostname

hostname

abc

Terminate the remote login with the exit command:
C:\WINNT\system32>exit

Enter the uname command to verify that you have returned to the Global Shell
session:

$ uname -a
Linux ml71.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15
21:17:59 EDT 2005 1686 GNU/Linux

El Create a script that runs across servers.

A Global Shell script can iterate within the OGFS and run the rosh command to
execute native commands on multiple servers. The example script shown in this step
iterates through the servers of the public device group named All Windows Servers.
On each server, the script runs the ipconfig command with the rosh command.
In this example, substitute your Opsware user name for jdoe.

First, return to your home directory in the OGFS:
S ed

$ cd public/bin

$ pwd

/home/jdoe/public/bin

Next, run the v1i editor:

S vi

In vi, insert the following lines to create a bash script:

#!/bin/bash
# This is simple iterate.sh.
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# Change jdoe to your user name.

OUTFILE="/home/jdoe/public/bin/ipconfig all.txt"
rm -f SOUTFILE

cd "/opsw/Group/Public/All Windows Servers/@/Server"

for SERVER NAME in *

do
echo ---- $SERVER NAME
echo ---- $SERVER NAME >> $OUTFILE
rosh -n $SERVER NAME -1 Administrator \
"ipconfig" >> $OUTFILE
done

# Last line in simple iterate.sh.

Save the file in vi, naming it simple iterate.sh. Quit vi.

Change the permissions of simple iterate.sh with chmod, and then run it:

$ chmod 755 simple iterate.sh
$ ./simple iterate.sh
---- abc.ospware.com
---- gist.opsware.com
---- hare.opsware.com
---- m33.opsware.com

As the script runs, it echos the name of each server to stdout, and redirects the
output of the ipconfig command to the ipconfig all.txt file. Enter the
more command to view the contents of ipconfig all.txt:

$ more ipconfig all.txt

---- abc.ospware.com

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

KK Learn more.

Here are a few suggested tasks for learning more about the OGFS and the Global
Shell:

— Explore the folders and contents under /opsw/Library, comparing them with
the Library windows of the SAS Client.

— If you have Opsware NAS installed, navigate to the /opsw/Net* (network)
directories. For descriptions of these directories, see “Network Directories” on page
501.

— On Windows servers, examine the registry and complus directories under
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/opsw/Server/@/server-name.

- List the files in the method directory, also under /opsw/Server/@/server-
name. These files are the executables of the Opsware Command-Line Interface
(OCLI), which enables you to perform Opsware SAS functions from within the
Global Shell. To learn how to run the CLI methods, see the Opsware® Platform
Developer’s Guide.

Global Shell Examples

The examples in this section use bash, the default shell of a Global Shell session. These
are relatively simple examples. For more complex examples, including those with method
invocations and search filters, see the Opsware® Platform Developer’s Guide.

Opening a Global Shell Session

You can open a Global Shell session with an ssh client or from within the SAS Client.
When you open a session, the working directory is /home/user-name.

To open a Global Shell session with an ssh client, perform the following steps:

E On a host that is not an Opsware core server or a managed server, open a terminal
window.

H In the terminal window, enter an ssh command with the following syntax:
ssh -p 2222 user-name@ogfs-host

To use this command, port 2222 must be open on the firewall that protects the OGFS
server. The user-name is your Opsware user (login) and the ogfs-host is the host
name (or IP address) of the core server running the OGFS. The Opsware user name
is not case sensitive. After you enter the ssh command, the OGFS prompts for the
password of the Opsware user.

To open a Global Shell session from within the SAS Client, from the Actions menu, select
Global Shell.

Finding Servers in the OGFS

List the names of all servers that you can manage with Opsware SAS:

ls /opsw/Server/@

List the IDs of the servers:

ls -a /opsw/.Server.ID
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Find all servers in the . opsware.com domain by specifying the wildcard character (*):

ls -d /opsw/Server/@/*.opsware.com

List all servers in the Atlanta facility:

ls /opsw/Server/@Facility/Atlanta/@

List the servers in the public device group named Alpha:

ls /opsw/Group/Public/Alpha/@/Server
List the servers in the All Windows Servers group, first with backlashes to escape the

spaces in the group name, then by enclosing the option in single quotes:

ls /opsw/Group/Public/All\ Windows\ Servers/@/Server
ls '/opsw/Group/Public/All Windows Servers/@/Server'

List the servers of the Widget customer:

ls /opsw/Customer/Widget@/Server
The following two commands display the same output, the servers in the Atlanta facility
that belong to the Green customer:

ls /opsw/Server/@Facility/Atlanta/@Customer/Green/@
ls /opsw/Server/@Customer/Green/@Facility/Atlanta/@

Getting Server Information from the OGFS
List the Opsware ID and of the server named m256 . opsware . com:

cd /opsw/Server/@/m256.opsware.com

cat self:i ; echo
(The preceding echo command is optional. It generates a new line character, which
makes the output easier to read. The semicolon separates bash statements entered on
the same line.)

List the name of the server with an Opsware ID of 340039:

cat /opsw/.Server.ID/340039/self

By iterating through the server names with a for loop in bash, display the platform
(operating system) name for each server:

cd /opsw/Server/@
for SERVER_ NAME in *
do
cat $SERVER NAME/attr/platform
done
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Display the amount of RAM in the server named abc . opsware. com:

cd /opsw/Server/@/abc.opsware.com
grep Quantity Memory/RAM/info

Display the network interfaces of a the server named blizzard.opsware.com:

cd /opsw/Server/@/glengarriff.snvl.dev.opsware.com/Interface
for INTERFACE NAME in *

do
echo ............. $INTERFACE_NAME ............
grep Interface "$INTERFACE_NAME/info"
echo nn

done

Browsing a Server’s File System or Registry

List all of the files the C:\ Program Files directory of the Windows server named

abc.opsware.com:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
ls C/Program\ Files

List the registry keys of the abc . opsware. com server:

cd /opsw/Server/@/abc.opsware.com/registry/\ Administrator/
1s *

List the contents of the /var directory on the Unix server named m256 . opsware . com:

/opsw/Server/@/m256 .opsware.com/files/root
ls var

Managing Custom Attributes

On the server abc . opsware. com, create a custom attribute named MyGreeting with
the value hello there

cd /opsw/Server/@/abc.opsware.com/CustAttr

echo -n "hello there" > MyGreeting
cat MyGreeting

Execute runit.bat on the abc.opsware. com server, passing the value of the My

Test custom attribute as a command-line parameter for runit .bat:

cd /opsw/Server/@/abc.opsware.com
TESTPARAM="cat CustAttr/"My Test"’
rosh -1 Administrator "C:\temp\runit.bat $TESTPARAM"

When you create or edit custom attributes within the OGFS, Opsware SAS preserves
leading and trailing whitespace characters in custom attribute values.
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Copying Files Within the OGFS

Do not use the techniques in this section to copy large files. The OGFS is not designed
distribute large amounts of data. However, you can use these techniques for copying
small files (such as configuration files) to and from managed servers.

Copy myfile.txt from the home directory in the OGFS of the jdoe user to the
C:\temp directory of the Windows server named abc . opsware. com:

cp /home/jdoe/myfile.txt \

/opsw/Server/@/abc.opsware.com/files/Administrator/C/temp
Copy myfile.txt from the home directory in the OGFS of the jdoe user to the /tmp
directory of the Unix server named m25 . opsware . comé:

cp /home/jdoe/myfile.txt \
/opsw/Server/@/m256 .opsware.com/files/root/tmp
Copy the C:\temp\myfile.txt file from the abc.opsware.com server to the

m344 .opsware.com Server:

cp /opsw/Server/@/abc.opsware.com/files/\
Administrator/C/temp/myfile.txt \
/opsw/Server/@/m344 .opsware.com/files/\
Administrator/C/temp/myfile.txt

Copying Files Between the OGFS and a Development Server

You can securely copy files between the OGFS and a server that is not part of Opsware
SAS. To copy the files, perform the following steps:

E On a host that is not an Opsware core server or a managed server, open a terminal
window.

H In the terminal window, enter either the scp, sftp, or rsync command and specify
port 2222, your Opsware user name, and the host running the OGFS.

The following three scp examples perform the same operation: They copy the file
myscript.sh from the local machine to the file /home/jdoe/myscript.shinthe
OGFS. The Opsware user is jdoe and the host running the OGFS is 192.168.166.178.

scp -P 2222 myscript.sh jdoe@192.168.166.178:myscript.sh
scp -P 2222 myscript.sh jdoe@192.168.166.178:/home/jdoe
scp -P 2222 myscript.sh jdoe@192.168.166.178:

The following example copies myscript . sh from the home directory of jdoe in the
OGFS to the local machine:
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scp -P 2222 jdoe@192.168.166.178:myscript.sh myscript.sh

The following sftp example copies myscript . sh from the local machine to the OGFS:

sftp -oPort=2222 jdoe@192.168.166.178
Connecting to 192.168.166.178...

Opsware Global Shell

jdoe@opsware's password:
sftp> put myscript.sh

The following rsync example transfers files from /path on the local machine to
/other/path in the OGFS:

rsync -av -e "ssh -p 2222" /path \
jdoe@192.168.166.178:/other/path

Logging on to a Managed Server With rosh

The next three rosh commands perform the same operation: logging on to the Windows
server named abc.opsware.com as the Administrator user. After logging on, the
current working directory on the remote shell is the default working directory of the
Administrator Windows user. These rosh commands require different options, depending
on the current working directory in the OGFS. For example, the first rosh command does
not require the -n (server name) and -1 (user) options because the option values can be
inferred from the current working directory of OGFS. The options of the following three
rosh commands differ because of the current working directory:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
rosh

exit
cd /opsw/Server/@/abc.opsware.com
rosh -1 Administrator
exit
cd /home/jdoe
rosh -n abc.opsware.com -1 Administrator
exit
The next rosh command logs into the Unix server named m256 . opsware . com as the

root user with the current working directory of /tmp:
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rosh -n m256.opsware.com -1 root -d /tmp

Running OGFS Scripts on Managed Servers With rosh

The next sequence of commands create a .BAT script in the OGFS and then run the script
on a Windows managed server. Created with echo statements, the myfile.bat script
resides in the OGFS under /home/jdoe/public/bin. (Note that myfile.bat does
not reside in the file system of the managed server.) The myfile.bat script contains
three commands: ipconfig, cd, and dir. The rosh command runs myfile.bat on
the server named abc . opsware. com as the Administrator Windows user. The
following commands create a local .BAT script and run it remotely with rosh:

cd /home/jdoe/public/bin

echo ipconfig > myfile.bat
echo "cd c:\temp" >> myfile.bat
echo dir >> myfile.bat

rosh -n abc.opsware.com -1 Administrator -s ./myfile.bat
Create a script named who. sh inthe /home/jdoe/public/bin directory of the

OGFS and then run who. sh on the server named m256 . opsware . com:

cd /home/jdoe/public/bin

echo \#\!\/bin\/sh > who.sh
echo "uname -n" >> who.sh
echo id >> who.sh

echo pwd >> who.sh

rosh -n m256.opsware.com -1 root -s ./who.sh

Running Native Programs on Managed Servers With rosh

The next two rosh commands run the dir and ipconfig MSDOS commands on the
Windows server named abc . opsware . com. Note that the native MSDOS commands
are enclosed in quotes. Because the server name and user (login) can be inferred from
the current working directory, the first rosh command omits the -n and -1 options, as
shown in the following code:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
rosh "dir & ipconfig"

cd /home/jdoe
rosh -n abc.opsware.com -1 Administrator "dir & ipconfig"
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Run the ipconfig command on abc.opsware . com and redirect the output to a file in
home directory of jdoe in the OGFS:

rosh -n abc.opsware.com -1 Administrator "ipconfig" \
> /home/jdoe/ipconfig ouptput.txt

On the Unix server named m256 . opsware . com, run the uname and 1s commands as

root:

rosh -n m256.opsware.com -1 root "uname -a; ls /tmp"

Within a for loop in bash, run the MSDOS ipconfig command on each server in the
All Windows device group:

cd /opsw/Group/Public/All\ Windows\ Servers/@/Server

for SERVER NAME in *

do
echo ............. SSERVER NAME ............
rosh -n $SERVER NAME -1 Administrator "ipconfig"
echo nn

done

Character Encoding for the OGFS

To support international environments, the OGFS can display information in different
character encodings such as Shift-JIS (Japanese) and EUC-KR (Korean). You can control
the encoding of Global Sessions in the following ways:

» To specify the encoding of your Global Shell sessions, in the Terminal and Shell
Preferences of the SAS Client, select an item from the Encoding drop-down list.

« To change the encoding of an active Global Shell session, run the swenc command
with the -e option.

If you change the encoding of an active session, you must also change the encoding of
the terminal application for that session. This procedure varies according to the terminal
application.

Terminal Application Configuration

The terminal application that is hosting a Global Shell or Remote Terminal session must
be configured to use the same encoding expected by the session. If the encodings do
not match, the data might be displayed incorrectly.
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When the SAS Client launches the terminal application, it composes the command
specified by the Terminal Client field in the Terminal and Shell Preferences. If the Terminal
Client field includes the %e substitution variable, the SAS Client replaces %e with an
encoding name. For Global Shell sessions, this encoding name is specified by the
Encoding field of the Terminal and Shell Preferences. For Remote Terminal sessions, this
encoding name is the value of the Encoding field in the Properties section of the Server
Explorer. If the terminal application does not support the encoding that replaces the %e
variable, or if the %e variable is not specified, you must change the encoding manually in
the terminal application after it starts.

Data that Cannot Be Displayed

Data that cannot be displayed might be from a managed server (such as the contents of
files) or it might be the name of an object in the Opsware model. If the session’s
encoding does not support the data to be displayed, the data often appears as question
marks. (However, it might appear as other characters such as exclamation points.) The
session attempts to display this data with the current encoding. Usually, this data cannot
be accessed. To access this data, select a compatible encoding for the session.

Objects in the Opsware model, such as Facility and Server, appear as file names in the
OGFS. If these file names contain characters that cannot be represented by the encoding
of the session, they are displayed as question marks, appended by the Opsware ID of the
object. In the following example, the IDs are 10002 and 11002:

New York

Paris

Montr?al~10002

??7~11002

If the model object does not have an ID, such as a custom attribute, then the session
attempts to display the name with the current encoding.

LANG and LC_CTYPE Environment Variables

Many Unix commands (such as 1s) rely on the character encoding, which is determined
by the LANG or LC_CTYPE environment variables. In a Global Session, if the encoding is
changed with the swenc command, the system attempts to reset these variables.

Opsware SAS determines the new value of the LANG variable with the following process:

El The value of LANG is generated by combining the language of the user's profile in
the SAS Web Client with the current session encoding. For example, if the language
is English and the session encoding is UTF-8, LANG is set to en_US.utf8.
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H The value determined by the preceding step is compared with the set of valid locales
on the OGFS server (according to the output of locale -a). If the value is a valid
locale, LANG is set to this value.

HE If the value is not a valid locale, the system attempts to find a valid locale that
specifies the user's language without the encoding. For example, if the user’s
language is English and the session encoding is EUC-JP, and this combination does
not form a valid locale, LANG is set to en_US. If no matching locale is found, LANG is
left unspecified.

The new value of the LC_CTYPE variable is determined in the following order:

El Opsware SAS attempts to find a valid locale that matches the session encoding,
regardless of the language.

B If a valid locale is found, LC_CTYPE is set to this locale. For example, if the session
encoding is EUC-JP, the LC_CTYPE variable is set to ja_JP.eucjp.

El If no matching locale is found, LC_CTYPE is left unspecified.

Bl If Opsware SAS cannot set the LANG or LC_CTYPE variables with the preceding
process, you should set them manually.

Transcoded Data in a Managed Server

Transcoding is the conversion of data from one character encoding to another. Opsware
SAS automatically transcodes some of the data between Global Shell sessions and other
sources of data. For example, the file names of managed servers are transcoded, but the
contents of the files are not. To see which data is transcoded, see Table 9-1. To display
the transcoding mode of the current Global Shell session, enter the swenc command
with no options.

Table 9-1: Data Transcoded for Global Shell Sessions

Objects in the Opsware model space, such | Between UTF-8 and the session encoding.
as Facility, Customer, and Server.

These objects are stored in the Opsware

Model Repository (database) in UTF-8.

File and directory names of managed Between the managed server encoding
servers. and the session encoding.
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Table 9-1: Data Transcoded for Global Shell Sessions

Meta-data of managed servers, such as Between the managed server encoding
user names and registry key names. and the session encoding.

File contents of managed servers. None

Contents of Windows registries, services, | None
COM objects, and IS metabases.

rosh: Contents of saved scripts executed | None
on managed servers (a rosh push
operation).

rosh: Ad-hoc scripts executed on man- None
aged servers.

rosh: Command-line arguments to pro- None
grams executed on managed servers.

rosh: Data streams (such as stdin and None
stdout) of programs executed on managed

servers.

rosh: Data streams of rosh jump None
operations.

OGFS home, tmp, and var/tmp None
directories.

Disabling the Transcoding of Managed Server Data

On Unix servers, file and directory names can contain characters in arbitrary encodings.
When accessed through the OGFS, file and directory names are transcoded by Opsware
SAS. If the encoding of the names does not match the default encoding of the managed
server, the transcoded data might be unusable.

You can disable transcoding with the swenc command. To turn transcoding on or off, use
the -T option:
swenc -T {on | off}

If transcoding is disabled, file and directory names are passed unmodified from the
managed servers. Therefore, you must manually configure the encoding of the terminal
application to display the names correctly.
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Windows servers store their file system data internally in the UTF-16 encoding. Because
the encoding is known, transcoding is performed correctly and does not need to be
disabled. Therefore, the -T option of the swenc command has no effect on Windows
servers. For more information, see “swenc Syntax” on page 486.

Global Shell Error Messages

The Global Shell feature provides the file system error messages that are described in

Table 9-2

Table 9-2: Global Shell Errors

Input/output error

Operation not permitted.

Permission denied.

RFS Specific error

Your session has exceeded the
time-out limit or the Agent is not
running.

No password was found.

You are not allowed to view a
directory. This does not mean that
the directory does not exist on a
given server. See the Opsware®
SAS Administration Guide for more
information.

You do not have permissions on
the managed server. For example,
this error will occur if you are trying
to perform an operation on a
managed server and you do not
belong to the Administrators group
that has the required permissions
assigned to it.

Start a new session or check the
status of the Agent.

Verify that you have a valid
password.

Verify that you have
readFileSystem permissions.

You must have a set of
permissions to perform
operations on managed servers.
To obtain these permissions,
contact your Opsware
administrator. See the Opsware
SAS Administration Guide for
more information.

®
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Remote Terminal

With Opsware SAS, you can log on to a managed server in a terminal window in two
ways:

» The Remote Terminal feature, as described in this section.
* The rosh command, entered in a Global Shell session.

The Remote Terminal feature opens a terminal window for Unix servers or an RDP client
window for Windows servers. Unlike a Global Shell session, a Remote Terminal session
does not provide access to the OGFS.

This feature requires login permissions on the managed server. See the Opsware® SAS
Administration Guide for more information. You cannot login to a remote terminal with a
user name or password that contains multi-byte characters.

In order to open a Remote Terminal session on a Windows managed server running
Windows Firewall, you must set an exception that is not enabled by default. On the
managed server, run Windows Security Center, then select Windows Firewall »
Exceptions » Remote Desktop.

You can specify your terminal and RDP client preferences for Remote Terminal and Global
Shell sessions in the Set Preferences window. See “Terminal and Shell” on page 88 in
Chapter 3 for more information.

Opening a Remote Terminal

In the Server Explorer of the SAS Client, perform the following steps:

E Select a managed server.

H Open the managed server.

E From the Actions menu, select Remote Terminal.
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This section discusses the following topics:
« Distributed Script Execution

+ Ways to Initiate Script Operations

+ Script Management Tasks

+ Script Execution

+ Script Execution Results

« Error Resolution for Script Execution

« Opsware SAS Custom Extensions

Distributed Script Execution

This section provides information about the Distributed Script Execution feature within
Opsware SAS and contains the following topics:

« Overview of Distributed Script Execution
+ Scripts Types — My Scripts, Shared Scripts, and Ad-Hoc Scripts
« Script Execution Functionality

* Run Distributed Script Link

Overview of Distributed Script Execution

The Script Execution feature provides tools for automating the management and
execution of server scripts. Previously, a user created a script and then manually executed
the script on individual servers, one server after another. With the Script Execution feature,
a user performs all script tasks from one location — the SAS Web Client.
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From the SAS Web Client, you can create or upload a script, set it up to run
simultaneously across multiple Unix or Windows servers, and monitor it as it executes on
each server. After a script runs, job- and server-specific execution results are available for
review. You can modify, delete, or rerun the script again at a later date. See Figure 10-1

Figure 10-1: Script Execution Process
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You need a specific set of feature permissions to manage and execute scripts. You'll also

IZ need permissions to access the servers associated with customers, facilities, or server
groups. To obtain these permissions, contact your Opsware administrator. For more
information, see the Permissions Reference Appendix in the O/osware® SAS
Administration Guide.

Scripts Types — My Scripts, Shared Scripts, and Ad-Hoc Scripts

The Script Execution Subsystem supports the three major types of scripts for Unix and
Windows operating systems: Unix/Linux shell, Windows batch (.BAT), and Windows
Visual Basic (VBScript).
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After you create or upload Unix or Windows scripts in Opsware SAS, the scripts are stored
in Opsware SAS in one of two ways:

+ As private scripts, accessible only to the user who created them. In Opsware SAS,
private scripts are called My Scripts.

My Scripts can only be edited, deleted, or executed by the user who created the script.
My Scripts are intended for personal use.

» As public scripts, accessible to all Script Execution users. In Opsware SAS, public
scripts are called Shared Scripts.

A third type of Opsware SAS script is created (or uploaded) and then immediately
executed by a user. The script is intended for one-time use and is not stored in Opsware
SAS. In Opsware SAS, this type of script is referred to as an Ad-Hoc Script. During the Ad-
Hoc Script creation and execution process, only one user has access to the script.

After you create a script and store it as a specific type of script in Opsware SAS, you
cannot convert the script to the other type of script. My Scripts cannot be converted to
Shared Scripts (and vice versa).

Script Execution Functionality

The Script Execution feature provides three basic functions:

 Script management

+ Script execution

» Viewing script execution results

Script Management Tasks

Script Management tasks include:

» Viewing contents of stored My Scripts or Shared Scripts

+ Creating (or uploading) My Scripts or Shared Scripts for storage in Opsware SAS
«+ Editing or deleting stored My Scripts or Shared Scripts

+ Viewing version history of stored My Scripts or Shared Scripts

Script management functionality is handled by two Opsware SAS components — the

Command Engine and the SAS Web Client. The Command Engine handles the entry of
scripts into the Opsware Model Repository (the script storage location in Opsware SAS)
and the versioning of stored scripts. The SAS Web Client provides the user interface for
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script management activities. It provides tools that allow users to create or upload scripts
for storage. It also allows users to create Ad-Hoc (one-time-use, not stored) scripts for
immediate execution.

Script Execution Tasks
Script execution tasks include:
» Executing a My Script or Shared Script, stored in Opsware SAS, on one or more servers

+ Creating (or uploading) an Ad-Hoc Script and then immediately executing it on one or
more servers

Script Execution Functionality

Script execution functionality is handled by three Opsware SAS components — the SAS
Web Client, the Command Engine, and the Opsware Agent. The SAS Web Client provides
the user interface for script execution activities. Script execution tasks are automated by a
wizard that leads users through the following script execution steps:

Select scripts.
Select servers.
Specify execution options.

Confirm settings.

Execute scripts across one or more servers.

During script execution on the servers, the Command Engine runs a script that issues an
execution command to the Opsware Agent on each server. Each Opsware Agent handles
script execution and sends execution results to the Command Engine.

Execution of a script on the managed servers cannot be rolled back.

Script Execution Results Functionality

Execution results display immediately after a script runs and can be viewed any time after
a script is executed. The functionality that displays execution results is handled by two
Opsware SAS components — the Command Engine and the SAS Web Client. The
Command Engine enters the execution results data into the Model Repository. The SAS
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Web Client retrieves and displays execution results data from the Model Repository and
provides tools for the user to download execution results data (output and error files) as a
zip file.

Ways to Initiate Script Operations

In the SAS Web Client, you can initiate a Script Execution operation in the following three
ways:

+ Scripts link

« Run Distributed Script link

+ By selecting Server » Run Script from these initiating scripts from the Scripts link and
from the Run Distributed Script Wizard on the Home page.

Scripts Link

The Scripts link displays tools for managing scripts. Select this link to create or upload
scripts that you want to save or run, and to view, edit, or delete scripts that have already
been stored in Opsware SAS. The Scripts link is located on the navigation panel under
Software. See Figure 10-2.

Figure 10-2: The Scripts Link Is Used to Create, Run, Upload, Edit, Delete, or View Scripts
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Run Distributed Script Link

The quickest way to execute a script that is stored in Opsware SAS, or to create and
immediately execute an Ad-Hoc Script, is to select the Run Distributed Script link in the
Tasks panel of the SAS Web Client. See Figure 10-3.

Figure 10-3: Click the Run Distributed Scripts Link to Launch the Script Execution Wizard

Tasks
Q5 Prowisioning Software Provisioning Powver Tools
Frepare 05 Clapioy Codg Launch Opsware SAS Client

Run Distributed Script
Run Custarmn Extensions

You can view the status of scripts in the My Jobs area of the SAS Web Client Home page,
which displays information about jobs that have run, are currently running, or are
scheduled to run, including script execution jobs. Through My Jobs, you can display script
execution results. The name of the job is also a hyperlink to a pop-up window that allows
you to change scheduling information for that job. In addition to the name, start time, and
status, the number of servers affected by the job also appears.

The hyperlink to script execution jobs is called Run Script. A particular execution event
can be identified by the start time of the execution event. Click any Run Script name to
view the results of that particular script execution if it has completed. Otherwise,
information about when the job is scheduled to run appears instead.

You can display a complete list of My Jobs by clicking the See All link in the My Jobs area
of the home page, or by clicking the My Jobs link from the navigation panel.

Script Management Tasks

Supported script management tasks include:
« Script Creation Guidelines

+ Viewing the Scripts List

« Editing, Deleting, and Downloading a Script

« Script Version History
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Script Creation Guidelines

Opsware SAS supports the three major types of scripts for Unix and Windows operating
systems: Unix/Linux shell, Windows batch (.BAT), and Windows Visual Basic (VBScript).

When creating scripts, adhere to the following guidelines:

4 MB is the maximum size allowable for a script.

When you create a Unix shell script with a language other than the Bourne (sh) shell,
use the sh-bang (#!) format at the top of the script to specify the correct command
interpreter. The command interpreter needs to be present on the Opsware-managed
server.

For example, if you are using Perl, the beginning of the script would contain the
following line:

#!/usr/bin/perl
The following example shows a short Perl script (it displays “hello world”):

#!/usr/bin/perl
print “hello world\n”

VBScripts are executed by the VBScript interpreter on the Windows server.

To access command line parameters with Unix shell commands, use the following
convention: $1 $2...

To access command line parameters with Windows .BAT, use: $1 %2. ..

Script lines do not need to be terminated in a specific way. But with Windows scripts,
Opsware SAS converts all \n to \r\n. With Unix scripts, all \r\n are converted to \n.

Scripts should be written to send error output to standard error (file descriptor #2).

Scripts should use the standard convention of returning a zero code to indicate
success. For other return codes, there is no standard code system to follow. Create
unigue non-zero return codes to handle each type of error.

Creating or Uploading a Script
You can create scripts in the SAS Web Client or by uploading a script into Opsware SAS.
To create or upload a My Script or a Shared Script, perform the following steps:

E From the navigation panel, select Software » Scripts.

H The Scripts page has two tabs: My Scripts and Shared Scripts.
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+ To create or upload My Scripts, select the My Scripts tab, and then New Script. The
New Script page appears.

» To create or upload a Shared Script, select the Shared Scripts tab, and then New
Script. The New Script page appears, as Figure 10-4 shows.

Figure 10-4: Scripts: New Script Page
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330 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 10: Distributed Script Execution

E On the Scripts: New Script page, enter the following data under Properties:

» Enter the name of the script. The name must be a unique shared-use or personal-
use name.

+ Select the script type: Unix shell, Windows .BAT, or Windows VBScript.

« If you are creating a Shared Script, select Yes next to Shared. If you are creating a My
Script, select No.

+ In the Changes Server field, select No if the script does not modify the server, and
Yes if it does. If you select Yes, locked servers cannot be selected to run that script.

Bl Under Script Contents, enter or upload a script by performing one of the following
tasks:

» To upload a script, click Upload Script. In the Local Path to Script box, either
manually enter the path to the script, or click Browse to locate the script.

When you upload a script, you must select the character encoding of the script’s contents
from the list. (Before storing the script, Opsware SAS converts the script contents from the
encoding that you select to the UTF-8 encoding.)

+ To create a script, click Enter Script Contents and manually enter the script in the
text box.

The script editor does not recognize tabs and its functionality is browser-dependent.

B Inthe Usage Notes section of the page, enter script details or other descriptive
information.

@ Click Save to store the script. The script is saved in the Model Repository.

The Scripts page appears and confirms that the script is now stored. The script is
included in the list of available Shared Scripts or My Scripts.
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Viewing the Scripts List

After you save a script in Opsware SAS, you can view it on the list of stored My Scripts or
Shared Scripts. My Scripts can be viewed only by the user who created them, while
Shared Scripts can be viewed by all users.

To view the list of stored My Scripts or Shared Scripts, perform the following steps:
El From the navigation panel, select Software » Scripts.
H The Scripts page has two tabs: My Scripts and Shared Scripts.

» To view the list of My Scripts, select the My Scripts tab.

» To view the list of Shared Scripts, select the Shared Scripts tab.

A list of My Scripts or Shared Scripts displays. Each script name is also a link.

E To view a script, click its name.

Editing, Deleting, and Downloading a Script

After you save a script in Opsware SAS, you can edit, delete, or download the script.
Before you edit or delete a script, you might want to view the script properties, contents,
usage notes, and change log.

My Scripts are accessible only to the user who created them and can only be edited or

AS
deleted by this user.

Editing a Script
To edit a stored script, perform the following steps:

El From the navigation panel, select Software » Scripts.

H The Scripts page has two tabs: My Scripts and Shared Scripts.
» To locate a My Script, select the My Scripts tab.
» To locate a Shared Script, select the Shared Scripts tab.

A list of scripts displays. Each script name is also a link.
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To view the script, click the name. The View Script page appears, displaying script
properties, contents, and usage notes, as Figure 10-5 shows.

Figure 10-5: The View Script Page
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with the results of the test.

Bl Click Edit in the Properties panel for details about script properties.

B On the Scripts: Edit Script page, Change Log information is now available. Select the
Change Log tab to view the current script’s version history.
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@ Use the tabs on the Scripts: View Script page to edit script contents or the script

name, and enter usage notes. See Figure 10-6.

Figure 10-6: View Scripts Page That Shows Properties, Contents, Usage Notes, and Change Log Tabs
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Wied Sug 27 15.26:18 2003 alfred Initial wploacd Wiewy

+ To edit script contents, select the Contents tab. In the Edit Contents panel, select

the Edit Script Contents radio button and edit the contents of the script.

Instead of manually editing script contents, you can also upload new script
contents. The uploaded script overwrites current script contents. To upload, select
the Upload & Overwrite Script radio button and enter the location of the script you
want to upload.

After you edit script contents or upload new content, enter change log comments
in the text box below the Edit Contents panel. Change log comments are required
when you edit a script. When you are finished, click Save.

To edit the name of the script, select the Properties tab. Edit the name that
currently displays in the Name box and click Save.

To enter usage notes, select the Usage Notes tab and enter information on the Edit
Usage Notes panel. When finished, click Save.

Deleting a Script

To delete a stored script, perform the following steps:

From the navigation panel, select Software » Scripts.

The Scripts page has two tabs: My Scripts and Shared Scripts.
» To locate a My Script, select the My Scripts tab.

» To locate a Shared Script, select the Shared Scripts tab.

A list of scripts displays. Each script name is also a link.
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To review a script before you delete it, click the name. To return to the list of scripts,
click the Scripts link in Return to Scripts (located at the top of the Scripts: View Script
page).

On the Scripts page, select the scripts that you want to delete by clicking the box
located to the left of the script name. You can delete more than one script at a time.

Click Delete.

The Delete Scripts confirmation window appears.

» To review the list of scripts you selected for deletion, click View Details.
» To cancel the entire operation, click Cancel.

» To delete the selected scripts, click Delete.

After you delete a script, you can still view the results of executions performed with that

script.

Downloading a Script

To download a stored script, perform the following steps:

From the navigation panel, select Software » Scripts.

The Scripts page has two tabs: My Scripts and Shared Scripts.
« To locate a My Script, select the My Scripts tab.

+ To locate a Shared Script, select the Shared Scripts tab.

A list of scripts displays. Each script name is also a link.

Click the name of the script to download.

On the Scripts page, click Download.

Select the character encoding of the target server from the list. Opsware SAS
converts the script contents from the UTF-8 encoding to the encoding that you
select. Internally, Opsware SAS stores the script in the UTF-8 encoding.

in the pop-up window for the encoding, click Download.
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Script Version History

Version history for a script is maintained in a change log, which is stored with other My
Script or Shared Script management information. Each time a script is modified, new
script version information is created and stored.

Viewing Script Version History

To view script version history, perform the following steps:

E From the navigation panel, select Software » Scripts.

H The Scripts page has two tabs: My Scripts and Shared Scripts.
« To locate a My Script, select the My Scripts tab.
+ To locate a Shared Script, select the Shared Scripts tab.
A list of scripts displays. Each script name is also a link.

K To view the script, click the name. The Scripts: View Script page appears and
displays script properties, content, and usage notes.

Click Edit in the Properties panel.

H On the Scripts: Edit Script page, select the Change Log tab to access the change log
and view version history for the current script.

The change log provides the following script version information:
« Date and time the script is modified

» Users who modified the script

« Comments associated with each script modification

 Script contents for that modification

Script Execution
This section provides information about script execution tasks, tips, and procedures and
contains the following topics:

» Overview of Distributed Script Execution
+ Script Execution Guidelines

» Executing My Script or Shared Scripts

» Creating and Executing an Ad-Hoc Script
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Overview of Script Execution

A Script Execution Wizard automates script set up and execution processes and steps the
user through the following execution stages (in the order shown):

Select Script: You can select only one My Script or Shared Script for each execution
run. You can select scripts in the Wizard or from the Scripts page by selecting
Software » Scripts in the navigation panel.

Select Servers: You can select one or more servers or groups from the displayed list
of available servers. Only servers running an operating system applicable to the
selected script are shown (for example, only servers running Unix are shown for a
Unix shell script).

Specify Options: Runtime data, information, and execution options are entered at
this stage.

Confirm Settings: This stage allows the user to review settings prior to execution.
Click Next.

On the Schedule and Notify page, you have the following options:

» Notify: Choose the Condition option and set the parameters to send an email
when the operation is completed. You can choose to have an email sent on any
result, if the operation fails, or if the operation is successful. To add another email
recipient, click the plus (+) button next to the Recipients field.

» Schedule: Choose either Run Now to execute the operation immediately, or
choose Specify Time to schedule the operation for a later time.

When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

+ Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of
the servers that the job will run on.

+ Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.
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The time used for the scheduled job is specified in your preferred time zone which can be
AN
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

[ Run Script: While the script executes, progress information displays about the total
run and each server. When execution ends, summary information displays. After
execution, script contents, output data, and error data can be immediately reviewed
and downloaded.

The default amount of output data that Opsware SAS stores is 10 KB. This amount can be

AS
modified by the Opsware administrator.

Script Execution Guidelines
When executing a script, adhere to the following guidelines:

* No specific assumptions should be made about the execution environment. No
particular environment variables are set.

* When executing processes on Unix servers, make sure long running processes (Web
servers, databases, and so forth) are started as daemons. Also, make sure server
processes properly daemonize themselves.

« For Windows servers, do not start anything that causes a window to open and wait for
input.

Executing My Script or Shared Scripts

To execute My Script or Shared Scripts, perform the following steps:

H Click the Run Distributed Script link in the Tasks area of the SAS Web Client home
page to launch the Run Distributed Script Wizard.

H On the Overview page, make sure that you select Saved Script.

Click Start.

Alternatively, you can initiate the script execution process by clicking Software »
Scripts on the navigation panel, and then selecting a script and clicking Run.

Bl To list Shared Scripts, select the Shared Script tab. Or, to list My Scripts, select the
My Scripts tab.
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From the script list, locate the script and select the script’s radio button located to the
left of the script name.

Click Next to continue (or click Previous to return to the previous step).
At the Select Servers page, browse or search for a server or servers to use.

« To browse, select the Browse tab to obtain a list of servers available to you. At the
top of the page, use the Customers and Server Status to narrow your selection.

« To search, select the Search tab. On the Search page, indicate search criteria by
selecting the appropriate check box.

Only servers are listed that use the operating system appropriate for the type of script
that you want to run. For information about a server, click the name of the server. To
sort the server list by server name, IP address, OS version, facility, or customer, click
the heading of the column that you want to sort. For example, to sort by customer,
click the heading titled Customer.

From the server list, specify the servers that you want to use. Select one or more
servers or groups for script execution.

Click Next to continue (or click Previous to return to the previous step).
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K On the Specify Options page, enter the runtime information, as Figure 10-7 shows.
Figure 10-7: The Specify Options Page

Specify Options

Specify the runtime user and command line parameters for the script,

Runtime User:
¢ Run as "root”
& Run As Specified User:

Username: I

Password: I

Confirm Password: I

Script Output;  Keep ¢ Discard
Only the fast 10 KE of script output can be shown,

Script Timeout: |2 minutes
How many minutes to walt before timing out scrint,

Ccommand Line Parameters:

Usage MNotes (Reference for Cornmand Line pararmeters )
Print Working Directory

» Specify the runtime user. If you have the appropriate permission, you are able to
execute the script as root or local system without entering a password. Otherwise,
enter a user name and password for the servers you intend to execute on. The user
name and password you use must be the same across all servers.

+ Specify if you want to keep or discard script output. Only a portion of script output
is saved (the amount of script output that is saved is configurable by the Opsware
administrator, but the default is 10 KB).

» Enter a script time-out value in minutes.

This value is the amount of time a script has to complete execution activities on a
server. If the script is not finished when the time-out value is reached, the script is
stopped by Opsware SAS and a script error occurs.

Select a time-out value that is greater than the time required for execution to
complete.
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» Enter command line parameters.

Use the same syntax as when entering a script on a command line. For Unix

scripts, use Bourne (sh) shell syntax. For Windows scripts, use cmd . exe

parameter syntax.

+ Add usage notes.

EEl Click Next to continue (or click Previous to return to the previous step).

EH On the Confirm Settings page, review your script execution settings before you
proceed. The Script to be run panel provides information about your script and the

Servers panel displays the servers selected for script execution. The Confirm
Settings page displays execution settings, as Figure 10-8 shows.

Figure 10-8: The Confirm Settings Page

Confirm Settings

Review the following script execution settings. Click 'Run Script’ to run the script.

Script to be run:

Marne: Listimp Files Long Format
Type: Unix Shall
Run-Time User: root
Command Line Parameters:
Schpt Quiput. Keep
Script Timeoul 2 minules
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If you discover that script or server changes are needed, click Previous as many
times as you need to return to the Script or Select Servers page.

EEl On the Schedule and Notify page, you have the following options:

» Notify: Choose the Condition option and set the parameters to send an email
when the operation is completed. You can choose to have an email sent on any
result, if the operation fails, or if the operation is successful. To add another email
recipient, click the plus (+) button next to the Recipients field.

» Schedule: Choose either Run Now to execute the operation immediately, or
choose Specify Time to schedule the operation for a later time.

When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

+ Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of
the servers that the job will run on.

» Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

The time used for the scheduled job is specified in your preferred time zone which can be

A
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

K Click Run Script to execute the script. While the script executes, progress
information displays about the total run and each server. When execution ends,
summary information displays. After execution, script contents, output data, and error
data can be immediately reviewed and downloaded.

If you select to run the job at that time, a progress bar appears that shows the
progress of the script execution.
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EH After script execution, summary details on each server and the total job display. An ID
number at the top of the page identifies the job.

+ To see script output, summary details and information about errors that might have
occurred, click View Details.

+ For each server, you can click Download to obtain a zip file (results.zip) that
contains script execution output and error data.

The data is in two files called stdout (output data) and stderr (error data), in a
directory named <servername>. For example, for a server named m0043, the
output and error files would be located as follows: m0043/stdout (output file for
server named m0043) and m0043/stderx (error file for server named m0043).

EI3 Click Close to exit the wizard.

Creating and Executing an Ad-Hoc Script

An Ad-Hoc script is written (or uploaded) and then executed without being stored in
Opsware SAS.

Ad-Hoc script setup and execution are handled by the same wizard that steps the user
through the processes used for stored scripts. However, the initial steps differ because
Ad-Hoc script creation is integrated with execution activities.

Perform the following steps to create or upload an Ad-Hoc script, and then execute the
script:

H Click the Run Distributed Script link in the Tasks area of the SAS Web Client home
page to launch the Run Distributed Script Wizard.
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H On the Overview page, click Define Ad-Hoc Script » Start. The Define Script page
appears, as Figure 10-9 shows.

Figure 10-9: The Define Script Page

Define Script

Specify the type and enter or upload the contents of the script vou would like o run,

Type: |[NRERERET

Script Contents;
" Enter Script Contents:

" Upload Seripts:

Local Path to Scripk: | Browse. ..

E Select the type of script that you are creating (Unix shell, Windows VBScript, or
Windows .BAT).

Bl For Script Contents, indicate if you are entering script contents or uploading the
script:

» To upload a script, click Upload Script. In the Local Path to Script box, either
manually enter the path to the script or click Browse to locate the path.

» To create a script, click Enter Script Contents and enter the script in the text box.

The Scripts editor does not recognize tabs and its functionality is browser-dependent.

B Click Next to continue (or click Previous to return to the previous step).

A On the Select Servers page, browse or search for the server or servers to use.
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« To browse, select the Browse tab to obtain a listing of servers available to you. At
the top of the page, use the Customers and Server Status filters to narrow your
selection.

» To search, select the Search tab. At the Search page, indicate search criteria by
selecting the appropriate check box.

Only servers are listed that use the operating system appropriate for the type of script
that you want to run. For information about a server, click the name of the server.

From the list of servers, select one or more servers or groups for script execution.

Click Next to continue (or click Previous to return to the previous step).

On the Specify Options page, enter the following runtime information:

« Specify the runtime user. If you have the appropriate permission, you can execute
the script as root or local system without entering a password. Otherwise, enter an
appropriate user name and password.

» Specify if you want to keep or discard script output. Only a portion of script output
is saved (the amount of saved script is configured by the Opsware administrator).

 Enter a script time-out value in minutes.

This is the amount of time a script has to complete execution activities on a server.
If the script is not finished when the time-out value is reached, the script is stopped
by Opsware SAS and a script error occurs.

Select a time-out value that is greater than the time required for execution to
complete.

» Enter command line parameters.

Use the same syntax as when you enter a script on a command line. For Unix
scripts, use Bourne (sh) shell syntax. For Windows scripts, use cmd . exe
parameter syntax.

E Click Next to continue (or click Previous to return to the previous step).

EEl On the Confirm Settings page, review your script execution settings before you
proceed to run the script. The Script to be run panel provides information about your
script and the Servers panel displays the servers selected for script execution.

If you discover that script or server changes are needed, click Previous as many
times as you need to return to the Script or Select Servers page.

EH On the Schedule and Notify page, you have the following options:
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* Notify: Choose the Condition option and set the parameters to send an email
when the operation is completed. You can choose to have an email sent on any
result, if the operation fails, or if the operation is successful. To add another email
recipient, click the plus (+) button next to the Recipients field.

+ Schedule: Choose either Run Now to execute the operation immediately, or
choose Specify Time to schedule the operation for a later time.

When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

» Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of
the servers that the job will run on.

« Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

The time used for the scheduled job is specified in your preferred time zone which can be

AS
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

EEl Click Run Script to execute the script. While the script executes, progress
information displays about the total run and each server. When execution ends,
summary information displays. After execution, script contents, output data, and error
data can be immediately reviewed and downloaded.

If you select to run the job at that time, a progress bar appears that shows the
progress of the script execution.

EEd After script execution, summary details display for the total job and each server. An ID
number at the top of the page identifies the job.

» To see script output, summary details and information about errors that might have
occurred, click View Details.
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» For each server, you can click Download to obtain a zip file (results.zip) that
contains script execution output and error data.

The data is in two files called stdout (output data) and stderr (error data), in a
directory named <servername>. For example, for a server named m0043, the
output and error files would be located as follows: m0043/stdout (output file for
server named m0043) and m0043/stderx (error file for server named m0043).

EH Click Close to exit the wizard.

Script Execution Results

This section provides information about script execution results and contains the following
topics:

+ Viewing Execution Results Immediately After Script Execution

+ Viewing Execution Results Stored in Opsware SAS
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During execution, the current status of script execution events at each server displays on
the Run Script page. When script execution activities finish, the page immediately
displays a summary of execution results for each server and for the entire run. See
Figure 10-10.

Figure 10-10: Script Execution Progress Page

Run Script - ID: 67490007

Please wait while the script is being run on the specfied servers,

ﬁ Funning Script Complete

Status: 2 of 2 servers completed. Download..

5 dhep--126.corp loudcloud.com

Wi Detalls...

Statug: Running Script Complete

5 dhep-8-130.corp loudcloud.com

Wi Datalls..

| Stabtus: Running Script Complete i

Script execution data and information are stored in the Model Repository and are later
accessible through the My Jobs feature for the user who performed the execution.
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Viewing Execution Results Immediately After Script Execution

After a script runs, execution data and information for a specific server are available by
clicking View Details for that server. Information that is displayed includes script
execution output, errors (if there are any) and summary data (such as the script name and

contents, and the date of the run). See Figure 10-11.

Figure 10-11: Execution Results After Script Execution
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A zip file (results. zip) is available that contains standard script execution output and
error data in two files (stdout and stderr), which are located inside a directory name

Download Results,..

| ciose |

<servername>. You can download the zip file by clicking Download.
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Viewing Execution Results Stored in Opsware SAS
After script execution, script data results are available through the My Jobs feature.

The My Jobs list is available either at the My Jobs panel (SAS Web Client home page) or
the My Jobs page (opened by clicking the My Jobs link at SAS Web Client’s navigation
panel). In the list, executed scripts are identified from other types of Opsware SAS jobs by
the name Run Script.

You can view Information about a specific executed script (started on a particular day and
time) by clicking the Run Script link for the specified day and time. See Figure 10-12.

Figure 10-12: Execution Results for a Particular Script Execution Event

Run Script - Job ID: 67490007

Please wait for the job information to load,

ﬁ Running Script Complete
Status: 2 of 2 servers completed,

ﬁl dhop-5-126.corp . Joudcloud.com

| Yiew [etails...

Status: Running Script Complete

ﬁl dhcp-8-130.corp.loudcloud.com

| View Details...

Status: Running Script Complete

Dowenload Results... | Zlose |

Script results data are held in the Model Repository for a limited amount of time (30 days,
for example). The Opsware administrator can configure this time period.
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Error Resolution for Script Execution

The following section describes the events that might occur during Script Execution
feature activities and provide suggestions for resolving the problems. This section
contains the following topics:

» Resolving Script Uploading Errors

» Resolving Script Time-out Events

« Investigating Script Non-Zero Return Codes
« Investigating Server Authentication Errors

« Investigating Partial Executions

Resolving Script Uploading Errors

If errors occur when a user uploads a script, the SAS Web Client error pages display
information about the event.

If errors occur, perform the following steps:

« The maximum size for a script is 4 MB. Verify that the script being uploaded does not
exceed this size.

+ If communication with the SAS Web Client is lost during the script upload process,
upload the script again.

Resolving Script Time-out Events

When a script runs on an Opsware-managed server, if the script hangs or is not finished
before the script time-out value is reached, an Opsware SAS error occurs and the script is
stopped on the server.

The script time-out value is entered on the Specify Options page of the Run Distributed
Script Wizard. The time-out value is the amount of time before a script times out.

Check that the length of time it takes for script execution does not exceed the current
time-out value. Creation of debug output can also be added into the script for
troubleshooting purposes. If the time-out event is due to the script hanging, then further
examination of the script and server should occur.
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Investigating Script Non-Zero Return Codes

If execution of a script on an Opsware-managed server returns a non-zero code, an error
is reported. (A zero return code indicates successful — for example, normal — operation.)
Information about the error is available to the user immediately following the error event
and script execution. Information is also available after execution through the My Jobs
feature.

Depending on how a script is written, a non-zero return code might indicate a fatal error.

Investigating Server Authentication Errors

If an authentication error occurs at an Opsware-managed server, verify that the user
correctly enters the password. Also, verify that the correct user name and password are
being used.

If authentication fails during execution of a script, an Opsware SAS error is raised for the
server running the script. Information about the error is displayed in the SAS Web Client
for that server during and immediately following script execution. Script execution
information is also available through the My Jobs feature.

Investigating Partial Executions

If a script runs on only some of the selected servers, this might be due to an Opsware
Command Engine failure or because someone else has locked the managed servers by,
for example, running another Opsware SAS task that uses the servers. Or, the servers
might be unreachable.

Opsware SAS Custom Extensions

Opsware, Inc. Professional Services can extend functionality for customers by creating
custom extensions to Opsware SAS. Opsware Custom Extensions (which are custom
Command Engine scripts) extend Opsware SAS functionality to cover specific customer
needs.

In Opsware SAS, the Command Engine is a system for running distributed programs
across many servers (utilizing the Opsware Agents running on the servers). Opsware SAS
features, such as the Code Deployment feature, use Command Engine scripts to
implement part of their functionality
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The Custom Extension feature is accessed through the Run Custom Extension Wizard.
This Wizard allows a user to choose a custom extension to run, specify necessary input
data for the extension, validate the data required to run the extension, run the extension,
and view or download the results from the job. When a user runs a custom extension, the
job shows up in My Jobs.

When a custom extension is added to one facility, it is automatically propagated to the
other facilities in the multimaster mesh of Opsware SAS facilities.

To access the Run Custom Extension Wizard, users must be assigned to a user group
that has the permission Wizard: Opsware Extension. When users have this permission,
they can run any custom extensions on the servers they have access to in the SAS Web
Client.
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Running a Custom Extension
To run a custom extension, perform the following steps:

E From the SAS Web Client home page, click the Run Custom Extensions link in the
Tasks panel.

Or

From the navigation panel, click Servers » Manage Servers. The Manage Servers
list appears. Select the servers on which you want to run a custom extension and
choose Run Extension from the Tasks menu.

The Run Custom Extension Wizard appears.
H Select the custom extension that you want to run and click Next.

If you have already selected servers from the Manage Servers list, you must ensure
that the custom extension that you select can run on the operating systems of the
selected servers. Otherwise, an error message appears in this page and you cannot
proceed.

Some custom extensions do not require that you select servers from the Server list.
For example, the extension might prompt you in the Specify Settings step to enter
server host names in a text box. If you already selected servers from the Servers list,
an error message appears in the page.

If you have not already selected servers from the Manage Servers list, the Select
Servers page appears.

B If prompted, select the servers or groups on which you want to run the custom
extension and click Next. You can find the servers that you want to run a custom
extension on by browsing the list or by searching.
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The Specify Settings page appears. See Figure 10-13.

Figure 10-13: The Specify Settings Page of the Run Custom Extension Wizard
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Bl Specify the settings for the custom extension and click Next.

The settings that appear in the page are unique to the custom extension that is being
run. For information about what data to enter in a field, move your mouse pointer over
a Note icon.
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The Confirm Settings page appears. See Figure 10-14.

Figure 10-14: The Confirm Settings Page of the Run Custom Extension Wizard
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B Review the values that you entered and the servers that you selected on which to run
the custom extension. (You can remove servers from the list by deselecting their
check boxes. The list displays the first nine servers on which the custom extension
will run. Click the “Show remaining servers” link to display the complete list of
selected servers.)

@ Click Next.
On the Schedule and Notify page, you have the following options:

» Notify: Choose the Condition option and set the parameters to send an email
when the operation is completed. You can choose to have an email sent on any
result, if the operation fails, or if the operation is successful. To add another email
recipient, click the plus (+) button next to the Recipients field.

» Schedule: Choose either Run Now to execute the operation immediately, or
choose Specify Time to schedule the operation for a later time.
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When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

+ Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of
the servers that the job will run on.

» Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

The time used for the scheduled job is specified in your preferred time zone which can be
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

El Click Run to start the Custom Extension Wizard.

If you selected to run the job at that time, a progress bar appears for the servers on
which the extension is running that shows the progress of the job. Depending upon
how the custom extension was written, you will see the progress displayed in one of
two ways:

« If the custom extension was written to show progress and status for individual
servers, you will see individual progress bars for each server. When the custom
extension has finished running, you will see the View Details button. You can
click View Details to display detailed error information.

+ If the custom extension was written to show progress for all servers, then you will
see a single progress bars for all servers. When the custom extension has
finished running for all servers, you will see View Details. You can click View
Details to display detailed error information.

If an error occurs while the custom extension is running on servers, the progress bar
moves to 100% and an error message appears below the bar.
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For any servers where the custom extension has failed to run, you will have to either
re-launch “Run Custom Extension” from the home page and pick the servers you
want to try again or choose those servers from a Manage Server » My Servers »
Server Search list and choose the menu item Run Custom Extension.

(Optional) When the custom extension finishes running, you can click View Details
to see the results.

The Custom Extension Results window appears. The tabs in the window can vary
depending on how the custom extension was implemented. To download the results
to a file, click the download link. When you are done viewing the results, click Close
to close the window.

EK Click Close to end the wizard.

Closing the wizard does not stop the custom extension if it is still running. After you
close the wizard, you can view the progress of the running custom extension by
viewing My Jobs (accessible from the Home page or the navigation panel). Each
custom extension job is identified with the name Run Custom Extension. Click the
name link to identify which extension was run.

See “Server Management Scheduling and Notification” on page 253 in Chapter 7 for
information about the My Jobs feature.
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This section discusses the following topics:
» Opsware Code Deployment Process

+ Services, Synchronizations, and Sequences

You must have specific permissions to deploy code and content by using the SAS Web
Client. Contact your Opsware administrator to obtain the necessary access rights. For
more information, see the Permissions Reference appendix in the Opsware® SAS
Administration Guide.

Opsware Code Deployment Process

This section provides information on the code deployment process within Opsware SAS
and contains the following topics:

» Deploying Code

Uploading Code and Content to Staging

» CDR Operations and Directories

CDR Features

* CDR Permissions

Accessing CDR

Deploying Code

The Code Deployment & Rollback (CDR) feature in the SAS Web Client provides tools for
deploying new and updated code and content to your operational environment.
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The following figure shows the architecture and process for updating a typical server
hosted in an Opsware managed environment.

Figure 11-1: Typical Code and Content Update in the Opsware Managed Environment
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The deployment process involves performing the following high-level tasks:

Determining your application code and content deployment requirements and
defining the CDR services, synchronizations, and sequences that you need to
support them.

+ Services are defined for each different type of web server or application server
applications (for example, WeblLogic Server) that is installed on the staging and
production hosts in your environment.

+ Synchronizations are defined for each service so that you can update files
between the source location and one or more destination production hosts that are
running the same service.

» Sequences are optional but can simplify deployment by grouping a collection of
service operations and synchronizations that can be performed as a single task.

Uploading new or updated code and content to your Opsware staging environment.

After performing any necessary testing, cutting over to the changed code and
content on the staging environment.
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Bl As necessary, performing CDR service operations, such as backing up code and
content from your live site.

B Performing CDR operations available to synchronize the updated code and content to
your production hosts in the Opsware managed environment.

@ To simplify subsequent deployments of new code and content, defining sequences
that specify a series of service operations and synchronizations you want to perform
as a single action.

The code and content deployment process that you follow might be different depending
on the architecture of your operational environment and your deployment requirements.

Uploading Code and Content to Staging

Before you use CDR to push code and content, you must upload new or updated files to
your Opsware staging environment. You can use content management tools, such as
OpenDeploy, scp, or rsync over SSH, to do that.
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The following figure shows an example of a typical development environment and how
your uploaded code and content move to the staging environment.

Figure 11-2: How Code and Content Move to the Staging Environment
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After you upload the files and test your changes, you can synchronize updates to the
production hosts running your managed environment. You can run specific
synchronizations and perform other service deployment operations by selecting CDR
menu options available from the SAS Web Client navigation panel.

CDR Operations and Directories

After you upload updated code and content to your Opsware-managed staging
environment, you can use the CDR operations to cutover to new code and content,
perform host synchronizations, and perform other service operations.

CDR uses the following directories to synchronize and cutover code and content for
specified hosts:

+ Live directory: The directory that stores the actual code and content required to run a
live site.
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Update directory: The directory written to by CDR synchronizations. Stores only the
files that changed between the source host Live directory and the Live directories of
the destination hosts.

Site Previous directory: This directory holds all the changes necessary to revert the
Live directory back to the state it was in before the last cutover. Like the Update
directory, the Site Previous directory only stores the files that changed between the
current Live directory contents and its previous state.

Site Backup directory: This directory stores a complete backup of the site. The
directory is populated when the user issues a Backup service operation.

When you cutover to new code and content, CDR determines the differences between
the new code and content in the current Update directory and the Live directory for your
site. The files that are different are synchronized to the Live directory. When you
synchronize source and destination hosts, CDR moves modified files from the Live
directory on a source host to a directory on a destination host.

You cannot use CDR to automate database pushes. However, you can configure CDR so

that you can synchronize modified database script files on different hosts.

CDR Features

CDR offers the following features:

Provides a single tool for deploying code (such as ASP, JSP, and JAR files) and site
content (such as HTML, JPEG, GIF, and PDF files). Using a single tool is helpful when
the code and content for your site are intermingled.

Provides direct control over code and content pushes by making it possible to decide
what information to update and determine when and how to perform updates.

Provides flexibility to accommodate frequent updates to staging and production hosts
by enabling more frequent pushes in a shorter period of time.

Allows verification of file changes between staging and production host directories by
creating a manifest of updated files. You can verify changes before cutting over to new
code and content.

Provides administrative service operations, including starting and stopping services,
and backing up, restoring, and rolling back code and content to return your site to the
previous version.
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+ Lets you push incremental updates to your site so that only files that have changed are
pushed to specified locations on staging or production hosts.

+ CDR uses the same authentication and navigation that you use in accessing other
information and performing other site operations from the SAS Web Client.

CDR Permissions

As with all other features in Opsware SAS, the links that you see on the SAS Web Client
Home page and the links that you see in the navigation panel are based on the
permissions that you have in combination with the customer you are associated with.

If you do not have permissions for CDR, you cannot see the Code Deployment links on
the navigation panel, the link called Deploy Code in the Tasks panel of the SAS Web
Client home page appears in italics, and it is not an active link.

If you have CDR permissions to no more than one customer, when you expand the Code
Deployment section in the navigation panel, you can see a link called Set Customer. Click
that link to view the links to the specific Code Deployment functions that you have
permissions for in combination with that single customer.

If you have CDR permissions to more than one customer, you can see a link called Select
Customer. Click that link to display a page that shows the customers you are associated
with. Select the customer you want to work with. The CDR Home Page appears, with links
to the specific Code Deployment functions that you have permissions for. These links are
the same functions that you can find in the navigation panel under Code Deployment.

The navigation instructions and screen captures in this chapter show what a user with

permissions to all code deployment functions and access to only one customer can see.
Consequently, because your permissions and customers might be different, the available
menu selections and features that you see might likewise differ.
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Perform the following steps to access CDR:

H If necessary, click the Code Deployment link in the navigation panel to expand the

list of CDR options.

H Click the CDR Home link. The CDR Home Page for [customer name] appears, as the

following figure shows.

Figure 11-3: Code Deployment Home Page
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Depending on your access permissions, the following CDR options appear:

+ Service Management: Create, modify, or delete service definitions that define the

location and commands to manipulate an application on hosts associated with
each application instance running in your operational environment.
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* Run Service: Perform a service operation or request that one be performed.

+ Sync Management: Create, modify, or delete synchronization definitions
associated with code pushes.

+ Synchronize: Perform a synchronization or request that one be performed.
+ Sequence Management: Create, modify, or delete sequences of operations.
* Run Sequences: Perform a selected sequence or request that one be performed.

» View History: View information stored in an operations log to determine the status
of particular deployment operations, and whether they completed successfully.

Choose the CDR operations that you want to perform, selecting options from the
navigation panel or from the CDR home page.

Services, Synchronizations, and Sequences

This section provides information on performing services, synchronizations, and
sequences within Opsware SAS and contains the following topics:

Overview of Performing Services, Synchronizations, and Sequences
Synchronization of Site Code and Content

Performing Synchronizations

CDR Cutover Operation

CDR Service Operations

Starting and Stopping Host Services

Backing Up Code and Content

Restoring Code and Content from a Previous Version
Rolling Back Code and Content to the Previous Version
Accessing Service Operations in CDR

Performing Service Operations by Service Name
Performing Service Operations by Host Name
Performing Sequences

Processing Code Deployment Requests from Users
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« Status View of Previous Operations

Overview of Performing Services, Synchronizations, and Sequences

After you upload updated code and content to your Opsware SAS staging environment,
you use CDR to cutover to new code and content, perform host synchronizations, and
perform other service operations.

When you cutover to new code and content, CDR determines the differences between
the new code and content in the current Update directory and the Live directory. The files
that are different are synchronized to the Live directory. When you synchronize source and
destination hosts, CDR moves modified files from the Live directory on a source host to a
directory on a destination host.

The code and content footprint that CDR maintains on a host is larger than the storage
space for the code and content files of the live site. The amount of storage used beyond
the actual size of your site increases with the number of files that you modify and back up.

Synchronization of Site Code and Content

CDR uses the following directories to synchronize and cutover code and content for
specified hosts:

+ Live directory: The directory that stores the actual code and content required to run a
live site.

+ Update directory: The directory written to by CDR synchronizations. Stores only the
files that changed between the source host Live directory and the Live directories of
the destination hosts.

- Site Previous directory: This directory holds all the changes necessary to revert the
Live directory back to the state it was in before the last cutover. Like the Update
directory, the Previous directory only stores the files that changed between the current
Live directory contents and its previous state.

- Site Backup directory: This directory stores a complete backup of the site. The
directory is populated when the user issues a Backup service operation.

CDR can synchronize updates from the Live directory of a source host to either the
Update or Live directories on destination hosts. Decide whether you want to synchronize
changed files on the source host to Update or Live directories on the destination hosts:
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+ Synchronize to Update directories: CDR determines files that have changed by
comparing files in the destination host Live directory and the source host Live directory.
Updated files are stored in the Update directories of destination hosts.

+ Synchronize to Live directories: CDR updates changed files to the Live directory on
destination hosts bypassing the Update directory.

If you choose to synchronize directly to Live directories, the Rollback operation does not
A function properly. Therefore, choose this option only for synchronizations that are not likely
to impact site stability.

When you choose to synchronize to Live directories, back up the Live directories first and
run the Restore operation to return your site to the previous version. See “Rolling Back
Code and Content to the Previous Version” on page 375 in this chapter for more
information.
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Figure 11-4 shows an example of synchronization between hosts and how you
synchronize updates for each service.

Figure 11-4: Service Synchronization of Hosts Using CDR
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Contact your Opsware administrator for a description of services and synchronizations set
up for your site and the specific operations that you need to run when updating code or
content for a particular host service.

Performing Synchronizations

Perform the following steps to synchronize updated code and content from one source
host to one or more destination hosts:

H Click the Code Deployment link in the navigation panel to expand the list of CDR
options and select a customer, if necessary.

H Click the Synchronize link.

A page appears that displays the synchronizations that you can perform.
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B Select the synchronization that you want to perform by clicking the link. The CDR
Synchronize for [customer name] page appears, as Figure 11-5 shows.

Figure 11-5: The CDR Synchronize Page
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Bl Select one or more of the displayed host names on which you want to perform
synchronization. The hosts that you select are the destination hosts.

Choose the Select/Deselect All option to select all or clear all host names.

W

H (Optional) To view a list of files that will be created, modified, and deleted on the
destination hosts, click Preview.

Or
(Optional) To view a list of all the files on the destination hosts, click List.

@ Select the Perform Operation option to directly perform a selected synchronization.
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Or

Select the Submit Request To option to send a request to users specified to receive
email notification for service and synchronization requests. When you submit a

request, specify any additional instructions that you want to include for the requested
synchronization. For example, these might be instructions such as the time that you
want the synchronization performed, verification, or other related services to perform.

The Perform Operation option is only visible when you are a member of an SAS Web
Client user group allowed to directly perform a synchronization.

Choose the type of synchronization that you want performed from the drop-down list:
+ Synchronize To Update
+ Synchronize To Live

See “Synchronization of Site Code and Content” on page 367 in this chapter for
information about these options.

B To initiate the synchronization or send the request, click Run.

CDR Cutover Operation

Perform the cutover operation to make the Update directory and the current live site
identical.

When you cutover, CDR performs the following actions:

« Updates the Site Previous directory with files from the Live directory. CDR saves
modified files and files-to-be-deleted to the Site Previous directory. The Site Previous
directory contains the files necessary to restore the live site to the previous version.
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« Determines the differences between the Update directory and the current Live directory.
The files that are different are synchronized from the Update directory to the Live
directory. See Figure 11-6.

Figure 11-6: Directory and File Updates for Cutover Operations Using CDR
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CDR determines file differences between source and destination directories based on file
size, modification date and time, ownership, group attributes, and permissions attributes.

By using the cutover process, CDR ensures your ability to rollback to the previous version
of your code and content if you experience a problem.

Your Opsware administrator can configure a CDR service to run scripts before and after
cutting over to updated code and content. For example, before and after cutting over, you
might distribute content on geographically disperse servers.

See “Synchronization of Site Code and Content” on page 367 in this chapter for
information about a description of these directories. See “CDR Service Operations” on
page 373 in this chapter for information about how to rollback code and content to the
previous version.
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CDR Service Operations

In addition to the Cutover operation, CDR provides a number of service operations:
 Starting and stopping host services

» Backing up code and content

» Restoring code and content from a previous version

» Rolling back code and content to the previous version

Performing these operations might be required depending on the type of code and
content changes made or the host services that are affected.

The operations that you need to perform are specific to the service (for example, Web
server or application server instance) for which you are updating code or content and the
particular host.

Starting and Stopping Host Services

Stopping and starting services might be required depending on the type of code and
content changes made or the host services that are affected. Discuss your requirements
with your Opsware administrator.

Typically, you only stop and start host services for the hosts in your staging environment.
Select members of your staff, or other individuals in your operations center, can stop and
start host services for the hosts in your production environment.

Start: Launch a defined service; for example, starting a web or application server
instance that is running on a specific host.

Stop: Shut down a defined service; for example, shutting down a web or application
server instance before cutting over to new or changed code and content on a specific
host.

Backing Up Code and Content

When you use CDR to back up your site, CDR saves the entire contents of the current
Live directory for a specific service in the Backup directory. CDR saves the backup copy to
the local disk for the host on which you ran the Backup operation. See Figure 11-7.
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You can use CDR to keep only one backup copy at a time for a service.

Figure 11-7: Update Directory to Site Backup Directory for Backup Using CDR
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When you run the Restore operation, CDR replaces the Live directory contents with files
stored in the Backup directory.

When you reach a high level of site stability, backing up your site is recommended,
Q especially if you plan to make changes to site code and content.
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Restoring Code and Content from a Previous Version

The Restore operation restores the previous Live directory by copying the contents of the
Backup directory to the Live directory. Restoring code and content from the Backup
directory does not change files that are stored in the Update directory. See Figure 11-8.

Figure 11-8: Site Backup Directory to Update Directory for Restoring Using CDR

Site Backup Directory to Update Directory for Restoring Using CDR

RESTORE PROCESS

S I

Live Directory
Update Directory .
Site Previous Directory ’

Site Backup Directory %

Before you restore code and content, you must have backed up the contents in the Live
directory to the Backup directory by performing a Backup operation.

Rolling Back Code and Content to the Previous Version

If you experience a problem after cutting over updated code and content to your
production site, you can rollback to the previous version.
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Rolling back returns the site to the state it was in prior to the last cutover that you
performed. See Figure 11-9.

Figure 11-9: Directory and File Updates for Rollback Operations Using CDR

Directory and File Updates for RollIBack Operations Using CDR

ROLLBACK PROCESS

Updated Directory
Live Directory -

A' ~
Site Previous Directory R R

During cutover, CDR updates the Site Previous directory with files from the Live directory.
CDR saves modified files and files-to-be-deleted to the Site Previous directory. The Site
Previous directory contains the files necessary to restore the live site to the previous
version.

During rollback, CDR restores the set of different files (modified files and files that were
deleted during cutover) to the Live directory.

If you upload files directly to the Live directory or choose to synchronize directly to Live

directories, the rollback operation does not function properly. Under these conditions,
back up your Live directory and run the Restore operation to return your site to the
previous version.

Accessing Service Operations in CDR

The Service Management option provides a number of service or administrative
operations, including starting and stopping host services, backing up, restoring, or rolling
back code and content, and cutting over to new site code and content.
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To access CDR, your Opsware administrator must add you as a member of a user group
authorized to use CDR.

You have the option of initiating a service either by selecting a service name or by
selecting host names. You must select both a service to perform and the hosts on which
to perform the service. See Figure 11-10.

Figure 11-10: Run Service Page

Update

Parfarm service operations by service name
Perform service operations by hostname

« Initiate a service by selecting the “Perform service operations by service name” option
first when you want to perform a service on multiple hosts at the same time. Selecting
the service name first shows you all the hosts for which that service is defined.

+ Initiate a service by selecting the “Perform service operations by host name” option first
when you want to perform a service on a single host or on a specific host where you
know the host name. Selecting the host name first shows you all the services that are
defined for that host.

Performing Service Operations by Service Name

Perform the following steps to perform service operations by service name:

H Click the Code Deployment link in the navigation panel to expand the list of CDR
options and select a customer, if necessary.

H Select the Service Management option.

E From the Service Management page, select the “Perform service operations by
service name” link.
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Bl Select a service from a list of services defined for your site. A page that prompts you
to select the hosts and the operation that you want to perform appears, as Figure 11-
11 shows.

Figure 11-11: Perform Service Operations by Service Name Page

Update
Hosts to Perform Operations On
r 2v.0pSwWare.com
M BV 0P SWare. corm
[T SelectDeselect All
Cperation ta Perfarm
" perform Operation m
" Submit Request To
Additional Infarmation
Extra Instructions ﬂ

Run Cancel

B Select one or more of the displayed host names. You can choose the Select/
Deselect All option to select all or clear all host names for the operation that you want
to perform.

@ Select the Perform Operation option to directly perform a selected operation.

The Perform Operation option is visible only when you are a member of the CDR user
N
group that allows users to directly perform a service operation.

Or
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Select the Submit Request To option to send a request for authorized individuals to
perform the operation for you. When you submit a request, specify any additional
instructions that might be required to perform the requested operation.

Choose the type of operation that you want performed from the drop-down list:
« Start
» Stop

» Cutover

Rollback
» Backup
* Restore

See “CDR Service Operations” on page 373 in this chapter for information about
these operations.

To initiate the operation or send the request, click Run.

Performing Service Operations by Host Name

Perform the following steps to perform service operations by host name:

Click the Code Deployment link in the navigation panel to expand the list of CDR
options and select a customer, if necessary.

Select the Service Management option.

From the Service Management page, select the “Perform service operations by
hostname” link.

Select a host name from the list of staging and production hosts available for your
site. A page that prompts you to select the service and the operation that you want to
perform appears, as Figure 11-12 shows.
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Figure 11-12: Perform Service Operations by Host Name Page

Update
Services to Perform Operation On
WiehlLogic Custapp (Application)

COperation to Perform

" Perform Operation m

" Submit Request To
Additional Information

Extra Instructions ﬂ

Run Cancel

Select the service for which you want to perform an operation.

Select the Perform Operation option to directly perform a selected operation or select
the Submit Request To option to send a request to have authorized individuals
perform the operation for you. When you submit a request, specify any additional
instructions that might be required to perform the requested operation.

The Perform Operation option is visible only when you are a member of the user group
S
that allows users to directly perform a service operation.

Choose the type of operation that you want performed from the drop-down list:
+ Start
« Stop
+ Cutover
 Rollback
« Backup
+ Restore
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See “CDR Service Operations” on page 373 in this chapter for information about
these operations.

B To initiate the operation or send the request, click Run.

Performing Sequences

CDR also allows you to perform service operations and synchronizations that have been
set up as a sequence of operations.

Perform the following steps to perform CDR sequences set up for your site:

H Click the Code Deployment link in the navigation panel to expand the list of CDR
options and select a customer, if necessary.

H Click the Run Sequence link.

The CDR Run Sequence for [customer name] page appears that shows the
sequences that you can run. See Figure 11-13.

Figure 11-13: CDR Run Sequence Page

Backup Prod Site
Push WebSite and app Code
Restore Production Site from Backup

Rollback Wweb 2 App Code
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Select the sequence that you want to perform by clicking the link. The Run Sequence
page appears, as Figure 11-14 shows.

Figure 11-14: Run Sequence Page That Shows Details of a Specific Sequence

Update
Step Fun  ServicefSynchronization Cperation Hosts
1 ¥ Apache Front End Service Backup . ORSWArR.COMm
2 v Wiehlogic App Server Senice Backup 2y OpsWware. com

" Paerform Operation © Submit Regquest To Perfarm

Additional Infarmation

Extra Instructions ﬂ

Run Cancel

Bl Select the Perform Operation radio button to directly perform the selected sequence.
Or

Select the Submit Request To Perform radio button to send a request to the users
specified to receive email notification for service, synchronization, and sequence
requests. When you submit a request, specify any additional instructions that you
want to include for the requested sequence. For example, you might want to include
instructions such as the time that you want the sequence to run, verification, or other
related services to perform.

The Perform Operation option is visible only when you are a member of a user group

S
allowed to directly perform a sequence.

B Toinitiate the sequence or send the request, click Run.
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Processing Code Deployment Requests from Users

When CDR users request that a service operation or synchronization be performed on
their behalf, an email notification is sent to the individuals assigned to perform the
requested service operation or synchronization.

The following message is a typical example of an email notification request.

From: CDR-tool@opsware.com
To: opscenter@opsware.com
Date: Tue, 10 Jul 2001 11:25:13 -0700

Subject: Request To Perform Start operation for opsware.com
Please perform the following request

Requestor: jhancock/opsware.com

Request Time: Jul 10, 2001 11:25:13 AM PDT
Requested Service: Demo Apache

Requested action: Start

Perform on the following hosts:
hostl.opsware.com

host2.opsware.com

Extra Instructions:

In this case, the email message specifies a request from a user, jhancock, to perform a
Start operation on two hosts running the Demo Apache service. The subject line provides
a summary of the request. In addition, the email indicates the time that the request was
sent.

Perform the following steps to process the request:

H Identify any special instructions that might need to be carried out for the specific
request.

H Log into the SAS Web Client, choose the CDR option, and then select the particular
option within CDR to perform the requested operation.

B When you successfully complete the CDR request, you might want to notify the
individual user making the request, and all other involved parties, that the requested
operation was completed.

If you encounter problems in completing a request and cannot resolve them, contact your
Opsware administrator for any specific remedies and follow normal escalation procedures
defined for your operational environment.
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See the Opsware® SAS Policy Setter’s Guide for more information about troubleshooting
tips.

Status View of Previous Operations

CDR maintains a log of operations (service operations, synchronizations and sequences)
that were executed. You can view this information to determine the status of particular
deployment operations, and whether they have completed successfully. You can also use
the My Jobs task area of the SAS Web Client Home page, or the My Jobs link to view this
information.

Accessing the Log
Perform the following steps to access the log:

H Click the Code Deployment link in the navigation panel to expand the list of CDR
options and select a customer, if necessary.

H Select the View History option.

CDR displays a page providing a list, most recent to oldest, of operations that are either in
progress or those that have been completed. This information displays only for the past
60 days. Each page is limited to a list of 10 operations. A Next link displays at the end of
the page if there are more than 10 operations to view. Click the Next link to view
subsequent operations. A Previous link is available to return to previous pages.

You need to refresh the page to view the status of any operations initiated after you

AS
selected the View History link.

A similar page displays after you select the View History link. See Figure 11-15.

Figure 11-15: CDR View History Page

Most Recent Session History ( Page 1 of 1)

Seszsion D Operation Matme Lsername Status Initisted Date

70340007  RollbackWeh & App Code cdsonly  SUCCESS Thu Cct 16 18:29:03 UTC 2003
0310007 Push'WehSite and App Code  cdsonly SLICCESS Thu Oct1617:49:24 LUTC 2003
70300007  Push'WehSite and App Code  cdsonly  INCOMPLETE  Thu Oct 16 17:46:450 UTC 2003
BY810007  Mew Sequence edwardc  INCOMPLETE  Wed Oct 15 20:34:11 UTC 2003
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The individual headings of column information included in the table are:

+ Session ID: A session is created each time a CDR operation is performed. Click the
Session ID to view detailed results of the operation.

+ Operation Name: The name of the service, synchronization or sequence as specified
when they were first defined.

» User Name: The user ID of the user that initiated the operation.

« Status: This describes the state of the operation at the end of the sequence. The
status message varies depending on the type of operation. Single step operations
always result in Success/Failure messages while multiple step operations (Sequence
operations) could result in Complete with Error, Incomplete, or Success messages.
Table 11-3 describes the possible status messages.

Table 11-3: CDR History Status Messages

Abort This message displays only if a CDR specific script that is executed in
order to complete service, synchronization or sequences fails. Such
issues should be escalated to your Opsware Support Representative.

Active This message displays if an operation is still in progress.

Complete with
error

The sequence completed successfully but there were errors reported
while the operation was in progress and the user opted to continue
rather than cancel the operation.

Failure The operation (service, sequence or synchronization) did not
complete successfully.

Incomplete The sequence resulted in an error and the user opted to cancel the
sequence rather than continue.

Success The operation (service, synchronization or sequence) was completed

successfully and no errors were reported. In the case of a sequence,
this message means that all the steps were completed successfully.

Initiated Date

The date on which the operation was initiated.
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This section discusses the following topics:

« Overview of Configuration Tracking

« Configuration Tracking Operations

« Customized Configuration Tracking Policies
+ Manual Backups

* Backup History

+ Restoration of Backed Up Files

Overview of Configuration Tracking

The Configuration Tracking feature of Opsware SAS allows you to monitor critical
configuration files and configuration databases. When Opsware SAS detects a change in
a tracked configuration file or configuration database, the system can perform a number
of actions, including backing up the configuration file or sending an email to a designated
individual or group. You use configuration tracking policies to identify the files to be
tracked and actions to be taken when change is detected. A configuration tracking policy
consists of one or more configuration tracking policy entries that specifies the
configuration file, the directory of configuration files, or the configuration database that
you want to track.

The Configuration Tracking feature is designed for flexibility. For example, you can set
configuration tracking defaults for a particular software application, and all attached
servers automatically get those defaults. You can also quickly deploy the common
configuration tracking defaults to a large number of servers in your Opsware managed
environment or create a specific policy for a single server.
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Configuration Tracking allows you to recover from many problems caused by changes to
configuration files. Using Automated Configuration Tracking, you can identify which
tracked configuration files have changed, thus helping you identify the potential source of
a problem. If you back up your configuration files with the Configuration Tracking feature,
you can quickly restore the changed configuration files to a previous version.

You can also view a detailed history of all backup activity. This history includes a list of all
tracked files that have been backed up and what types of backups occurred. If the
backed up configuration files are text-based, you can download the files from the backup
history and compare them to determine what specific changes have been made.

The Configuration Tracking feature is not a general-purpose backup solution.

Configuration Tracking is designed to monitor text-based configuration files and specific
types of configuration databases. The number and size of files that can be monitored on
any managed server is limited.

File Types Supported

You can use the Configuration Tracking feature with the following types of files:
« Text-based configuration files

+ The COM + Registration Database (Windows 2000)

+ The lIS Metabase

+ Windows Registry keys

Configuration Tracking Operations

This section discusses the following topics:
+ Change Detection

+ Types of Actions Performed

Types of Backups Performed

Email Automated Configuration Tracking and Logging Actions

« Creating the Email Notification List
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Change Detection

All servers that Opsware SAS manages have an Opsware Agent installed on them. On
servers that use Configuration Tracking, every four hours the Opsware Agent inspects the
configuration files and databases that you select to track.

The Opsware Agent computes an MD5 checksum to determine if the contents of a
tracked file have changed. (Any change to the contents of the file results in a change to
the MD5 checksum.) If the contents of the file have changed, the action that you specify
in the tracking policy is performed. For example, if you create an entry in your tracking
policy for the /etc/passwad file and select backup as the action to be taken, the file is
backed up when the Opsware Agent discovers a change in the /etc/passwd file.

The creation or deletion of a tracked file (or files inside a tracked directory) also counts as
change and triggers a policy’s action. (There are some exceptions; see the Opsware®
SAS Policy Setter’s Guide for more information.)

Changes to the properties of a tracked file or directory (such as changes to permissions
or time stamps) do not count as a change. When a file or directory is backed up, however,
its properties are backed up as well.

The first time that a tracking policy is deployed, all targets are considered changed. The
Opsware Agent is encountering the files for the first time, and all of the policy's actions
are triggered.

Types of Actions Performed

Opsware SAS can perform the following actions when change is detected in a tracked
configuration file or configuration database:

* Back up

+ Send email to addresses specified in the policy entry

+ Send email to a designated natification group specified by a custom attribute

» Create an entry in the server’s standard system log, (the syslog on Unix servers and the
event log on Windows servers)

Types of Backups Performed

If you selected backup as the action for a tracked configuration file, the two general types
of backups that can occur are incremental backups and full backups.
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Incremental Backups

During an incremental backup, only targets that have changed since the last backup (and
that have been selected to be backed up) are backed up.

An incremental backup occurs automatically when the Opsware Agent detects change in
a tracked file that is selected to be backed up. (The Opsware Agent checks for change
every four hours.)

Incremental backups also occur before and after you restore a previous version of a
backed up configuration file to a server. These backups allow you to rollback the restored
files.

Full Backups
During a full backup, all tracked configuration files that were selected to be backed up are
backed up, not just the files that have changed.

Once a week, the Opsware Agent on a server checks to see if any files have changed
since the last full backup. If any files have changed, Opsware SAS performs a new full
backup. If no files have changed, the full backup does not take place.

You can also force Opsware SAS to perform a full backup on a server by selecting the
Perform Manual Backup option. (See “Manual Backups” on page 401 in this chapter for
more information.)

See “Backup History” on page 401 in this chapter for information about Backup types.

Backups are stored in the Software Repository until you delete them. You should delete

old backups periodically, especially if you are backing up a large number of files that
change frequently. See “Deleting Backups” on page 408 in this chapter for information
about the procedure for deleting backups.

Email Automated Configuration Tracking and Logging Actions

You can choose to have email sent when a monitored target changes. The following
example shows the text of an email generated when a tracked file changed.

From: <configurationtracking@yourcompany.com>

Date: Thu Jan 16, 2003 5:40:11 PM US/Pacific

To: <joe@yourcompany.coms>

Subject: athena.cust.com: Configuration Tracking CHANGE
notification
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Configuration Tracking has detected a CHANGE event

Host: athena.cust.com

Object: /db/filelll
The email specifies the name of the server and the name of the object that changed. The
object can be a file, a directory, or a configuration database.

If you are monitoring a directory target, you receive email about the directory itself and
about changes to the files in the directory (except when a file is deleted.) For example, if
three new files are created in a directory, you would receive four emails, one for the
directory and three for the new files.

If you selected the logging action, an entry is made to the server's standard system log
when a change is detected. You select the type of log entry that you want to have written.
Opsware SAS uses the following three standard entry types:

* Info
+ Warning
« Error

How the entry types are identified is system-dependent. For example, on most systems,
Warning entries are identified by the word warning. In some systems, however, a number
is used to identify the log entry type.

The following example shows a warning log entry written on a Solaris Server:

Jan 8 00:05:25 athena.cust.com Configuration Tracking:
[ID702911

local0.warning] Configuration Tracking: /other/otherfilel
Event CHANGE occurred

Jan 8 00:05:25 athena.cust.com Configuration Tracking: [ID
702911

local0.warning] Configuration Tracking: /other/otherfilel
Event CHANGE occurred

Creating the Email Notification List

Sending email to a server's backup notification list is one of the actions that you can
select in a tracking policy entry. The email notification list is a list of email addresses that
you define for the following custom attribute:

backup notification email
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This attribute can be set on the server itself or on the customer to which the server is
attached. Setting the attribute at the customer level allows you to use the same email
notification list for all servers that belong to the same customer (assuming that these
servers have all been attached to the same customer and do not have the backup
notification list seton the servers themselves). See the Opsware® SAS Policy
Setter’s Guide for more information about setting custom attributes for customers.

Search Order for Email Notification List Attribute

On a server that has a policy that includes the Email Notification List for Server action
selected, the server searches for the backup_notification_email attribute in the following
order:

» Server
+ Customer

After the custom attribute is found, its value is used (for example, the email address of the
notification list) and the search is concluded. If, for example, the backup_natification
email attribute is set on a server, the server's email notification list is used, even if the
server is assigned to a customer that has a different backup_notification_email attribute.

Format of Email Notification List
The natification list can contain multiple email addresses. The email address must be
formatted as a comma-separated list.

Customized Configuration Tracking Policies

This section provides information on customizing configuration tracking policies within
Opsware SAS and contains the following topics:

+ Server-Based Entries

+ Policies for Customizing Multiple Servers

+ Adding or Editing Customized Tracking Policy Entries
+ Disabling Customized Tracking Policy Entries

» Enabling Customized Tracking Policy Entries

» Viewing a Server's Tracking Policy

+ Reconciling Customized Tracking Policies
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» Enabling and Disabling Configuration Tracking on Servers

You can customize the tracking policy for a server or selected group of servers. Ordinarily,
a server gets its tracking policy from the policy to which it is attached. In some cases,
however, you might need to customize the tracking policy for a particular server or set of
servers. If, for example, an application on one server is using an optional configuration file,
you can customize the tracking policy for that server so that the optional configuration file
is monitored.

Server-Based Entries

A tracking policy entry created for a specific server or selected group of servers is called a
server-based tracking policy entry.

Table 12-1 shows the actions that you can perform on server-based tracking policy

entries.

Table 12-1: Entry Types

Server-based Yes Yes No

To determine if a tracking policy entry server-based, check the Source column in the
Track Configurations: Customize Tracking Policies page. Figure 12-1 shows the policy
entries for a single selected server.

Figure 12-1: Viewing Configuration Tracking Policy

Return to Managed Servers
vigwy: | Enabled Enties |+ | Update

Add Entry 1 itermis)

Comman Ta

arcet ™
)| Target Total 1 Servers

Tyke Action=) Source

[] chweonfigfiesiconfiy  File Okject  Backup, Email Backup Notification List for Server, Log Info  Node 1 Server

Disable Delete
Policies for Customizing Multiple Servers

When you customize a tracking policy, you can select one or multiple servers. Here are
some considerations when you customize the policies of multiple servers.
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+ When you select a group of servers that contain both Unix-based (for example, Solaris,
HP-UX, Linux, and so forth) and Windows-based servers, you cannot add tracking
policy entries. (You can always add entries when you select a single server.)

* When you select a group of servers made up entirely of either Unix-based servers or
entirely of Windows-based servers, you have the option of making new tracking policy
entries. The policy entries are added to all servers that you select.

+ When you select a group of servers made up entirely of either Unix-based servers or of
Windows-based servers, you have the option of editing a tracking policy entry. Any
policy entry that can be edited can also be added to all selected servers (if it is not

already common to all of them).

It can take 20 seconds or longer to customize polices when you select six or more

AS
% servers.

Adding or Editing Customized Tracking Policy Entries

Use the following procedure to add or edit tracking policy entries for a server or set of
servers running the same general type of operating system. If you select a set of servers
running both Windows and Unix operating systems, you cannot add tracking policy

entries.

E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the server whose policy you want to edit.
(Alternatively, you can click Manage Servers and then select the server from the

server list))

B Select the server or set of servers that you want to add server-based tracking policy

entries to, as Figure 12-2 shows.

Figure 12-2: Selecting Servers

Al Statuses || All Opersting Systems || Al Stages || Al Uzes w || Al Customers
All Manufacturers || Al Models || Managed & Deactivated
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Public Groups
&)

[ Eﬂ| core fr3.opsware.com core fr3.opsware.com Red Hat Erterprize Linux A5 3 Mot Specified
~ 172163615

O Eﬂ| m201 tr3 opsware.com mhi3 Windowes 2000 Mot Specified
~ 17216.36.54
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Bl From the Configuration Tracking drop-down menu, select Edit Tracking Policies. The
Configuration Tracking: Edit Tracking Policies page appears, as Figure 12-3 shows.

Figure 12-3: Configuration Tracking: Edit Tracking Policies Page
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B Click Add Entry to create a new policy entry. To edit an existing entry, click the link

for the entry in the Target field.

@ Define the target, select the type, and select the actions to be performed on the

target.

Table 12-2 describes each of the selections that you must make.

Table 12-2: Editing Configuration Tracking Policies

Type File: Monitor the file specified in the target field.

Directory: Monitor all the files in the directory specified in the target

field.

The following types are available only for Windows servers:

Windows Registry: Specify key in target field.

IS Metabase: Entire Metabase is monitored; do not specify target.

COM + Registration Database: Entire Registry is monitored; do not

specify target.
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Table 12-2: Editing Configuration Tracking Policies (continued)

Target If you selected the file type, specify the full path (including the drive
letter on Windows servers) of the file that you want to monitor.

If you selected the directory type, specify the full path of the directory
(including the drive letter on Windows machines) that you want to
monitor. You also have the option of monitoring subdirectories. (Select
the include subdirectories check box.)

If you select the file or directory type, you can use wildcards in the
target. (See the Opsware® SAS Policy Setter’s Guide for more
information about Configuration Tracking Policy Targets and
Wildcards.)

If you selected the Windows Registry type, specify the Windows
registry key. This key and all its subkeys are backed up. Use standard
syntax for Windows Registry keys (For example, HKEY_LOCAL_
MACHINE\SOFTWARE)

If you selected the IS Metabase or COM + Registration Database
type, you do not specify the target.
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Table 12-2: Editing Configuration Tracking Policies (continued)

Actions (you
can select
multiple
options)

Backup: Back up the specified file, directory, COM + Registration
Database, Windows Registry keys, or IIS Metabase.

Email Backup Notification List for Server: Send an email to the
backup notification list for the selected server. (Not available for
Windows Registry.) See “Creating the Email Notification List” on
page 391 in this chapter for more information.

Email: Send an email to the address or addresses specified in this
field when a change is detected. Use a comma-separated list for
multiple email addresses. (Not available for Windows Registry.)

Log: Add an entry to the server's system log when a change is
detected. (Not available for Windows Registry.)

You can choose to write the following types of log entries to the
server's system log:

Info
Warning

Error

Click Save to add the entry to the tracking policy.

B If you want continue to add entries to the tracking policy, click Add Entry and repeat

this procedure.

Changes do not take effect until you perform a Configuration Tracking policy reconcile.

Disabling Customized Tracking Policy Entries

Perform the following steps to disable customized tracking policy entries:

EH From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

HE From the Configuration Tracking drop-down menu, select Edit Tracking Policies.
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The Configuration Tracking: Edit Tracking Policies page appears.
Bl Select the tracking policy entry or entries that you want to disable.

B Click Disable to disable the tracking policy entries that you selected.

Changes do not take effect until you perform a Configuration Tracking policy reconcile.

Enabling Customized Tracking Policy Entries
Perform the following steps to re-enable tracking policies:
E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

From the Configuration Tracking drop-down menu, select Edit Tracking Policies.

The Configuration Tracking: Edit Tracking Policies page appears.

From the View menu, select Disabled Entries and then click Update.

B Select the tracking policy entry or entries that you want to disable.

Click Enable to disable the tracking policy entries that you select.

Changes do not take effect until you perform a Configuration Tracking policy reconcile.

Viewing a Server’s Tracking Policy
Perform the following steps to view a server’s tracking policy:
E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

E From the Configuration Tracking drop-down menu, select Edit Tracking Policies. The
tracking policy entries display.

Bl Click the Tracking Policy link to display the server’s tracking policy.
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Reconciling Customized Tracking Policies

When you create or edit any customized tracking policy entries, the entries are not
deployed to your servers until you perform a configuration tracking reconcile.

A configuration tracking reconcile is not the same as a standard Opsware SAS remediate.
Performing a standard remediate does not deploy your tracking policies to your servers.

A configuration tracking reconcile deploys all configuration polices, not just the
customized policies.

Perform the following steps to reconcile the tracking policy to the servers whose policies
you customized:

E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

HE From the Configuration Tracking drop-down menu, select Reconcile Tracking Policies.

The Track Configurations: Preview Reconcile page appears and displays the
progress of the test reconcile.

Bl After the test reconcile completes successfully, click Reconcile to perform the actual
reconcile operation.

The Track Configurations: Reconcile page appears.

B If you want to see more information about the changes made during the reconcile
operation, click View Details. Otherwise, click Done.

Enabling and Disabling Configuration Tracking on Servers

You can enable or disable Configuration Tracking on any server or set of servers in your
Opsware-managed environment.

Disabling Configuration Tracking is not the same as disabling an individual tracking policy
entry (See “Disabling Customized Tracking Policy Entries” on page 397 in this chapter for
more information”). Disabling Configuration Tracking stops all configuration tracking
activity on the selected server.
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Disabling configuration tracking, however, does not change a server’s tracking policy in
any way. If you later re-enabled configuration tracking on the server, the server still has
the same tracking policy that it did before you disabled it.

By default, Configuration Tracking is disabled on all managed servers. It is not necessary,
however, to manually enable configuration tracking in order to turn on the Configuration
Tracking feature. Configuration Tracking is automatically enabled on a server when you
reconcile its configuration tracking policies, and you must perform a reconcile in order to

deploy tracking policies.

If you want configuration tracking to remain disabled on a server, be careful not to perform

S
a configuration tracking reconcile on the server. (You can, however, still perform a regular

reconcile.)

Perform the following steps to enable or disable configuration tracking:

E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

B Under the Configuration Tracking drop-down menu, select Enable/Disable. A list that
displays the state (Enabled/Disabled) of the servers that you selected, as Figure 12-4

shows.

Figure 12-4: Enable/Disable Configuration Tracking Page

Return to Managed Servers

Enable/Disable Configuration Tracking

Set a zenerto Enabled or Disabled and click Save.

ﬁ! MO030.corel custgas.com MOO30.corel custgas.com

F asendoc ¢I360d0c

ﬁ! mid94.cust.custasd.com mid94 cust.custgad.com
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Save Cancel
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Bl Under the Tracking field, select Enabled or Disabled to enable or disable
configuration tracking on the selected server.

B Click Save to commit the changes.

Manual Backups

On a server or set of servers, you can perform a manual backup of all tracked
configuration files and databases for which you have selected the backup action. Manual
backups can be useful as a precaution before making changes to configuration files. If a
problem arises, you can then immediately restore a backed-up configuration file or
database to its previous state.

Manual backups are full backups. All tracked configuration files and databases for which
the backup action has been selected are backed up, not just the files that have changed.
Performing Manual Backups

Perform the following steps to perform a manual backup:

E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

From the Configuration Tracking drop-down menu, select Perform Backup Now.

If you do not want to use the default backup name (Manual Backup), type a new
name in the backup name field. If you provide a backup name, you can later perform
a search for backup names to find this backup point. Backup names do not have to
be unique.

Click Start Backup. The backup progress displays.

When the backup is completed, you can click View Details to review the list of
configuration files or configuration databases that have been backed up.

Backup History

Opsware SAS provides a detailed history of backup activity as well as search capabilities
to find backup points by backup name and to find backed up files by file name. This
section contains the following topics:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

401



Opswezre® SAS 6.0.1 User’s Guide: Application Automation

+ Viewing the Backup History

» Viewing the List of Backup Events
+ Types of Backup Events

« Backup History Search Options

» Backup Info and Backup Manifest
+ File Info and File Versions

» Deleting Backups

Viewing the Backup History
Perform the following steps to view the backup history:
E From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

EH From the Configuration Tracking drop-down menu, select View Backup History.

The Track Configurations: View Group Backup History page displays. This page
displays the backup activity for the servers that you select. Figure 12-5 shows a
sample backup history.

Figure 12-5: Backup History

Configuration Tracking: View Backup History

Return to Server Search

view Backup History for a | Month % | staring from | 10/18/2003 (UTC) matching Backup Mame
4 10/M85£2003 10/25/2003 11401 /2003 11/05£2003 11M 542003
reports . cust custgsl 0.com
diZE0doc: 2 Backupsz
0030 coreld custgasS.com 1 Backup

md94 cust.custyad.com 21 Backups

The number of backups that occurred on a particular date displays as a link in the server's
date column.

The number of backups refers to the number of backup events (or backup points) when a
particular type of backup took place. It does not refer to the number of files backed up.
For example, if a server displays 3 backups in a date column, it could refer to the following
three backup events:
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» A scheduled incremental backup that backed up four files
» A second scheduled incremental backup that backed up 10 files

* A manual backup that backed up 30 files

Viewing the List of Backup Events

To view the list of individual backup events, click the link that displays the number of
backups in the desired date column. Figure 12-6 shows a page with a list of backup
events.

Figure 12-6: Backup Events

Return to View Backup History

l::nnﬂg Tracking

Tracking Policy

Wiew by | Backup v | fora | Week v starting from |'I 0182003 |(UTC) matching | | Update

[] Backup Name User Type Files Size
[0 Manual Backup - 14 servers 1042303 UTC joeacdy flanual Full 14 2392 KB
[0 Post-RESTORE Backup 1042303 UTC joesdmin Manual Incremental g 21.05 KB
[ Pre-RESTCRE Backup 1042303 UTC joesdmin Manuzl Incremerntal G 43.37 KB
[0 Triggered Backup 1042303 UTC Opsweare Agent Triggered Incremental ) 235KB
[0 Manual Backup 1042303 UTC joeadmin tdanusl Full 14 5392KB
[0 Post-RESTORE Backup 102303 UTC joeacdmin Manual Incremental 10 51.39 KB
[ Pre-RESTCRE Backup 10523003 UTC joeadmin Manual Incremental 1 .37 KB
O Trigoered Backup 1002303 UTC Opsware Agent Triggered Incremerntal a 369 KB
[0 Manual Backup 1042303 UTC joesdmin flanual Full 13 23.35 KB
[0 Manual Backup 1042303 UTC joesdmin flanual Full 11 2231 KB

Showing 1-10 of 21 | Show Al [1 23] »
Delete Restore selected backups

Types of Backup Events

In addition to information such as the date and time the backup occurred, the list of
backup events indicates the type of backup. Table 12-3 describes the type of backup
events that can occur.

Table 12-3: Types of Backup Events

Triggered Full The automatic weekly backup of all tracked files for which the
backup option was selected. This takes places only if any
relevant files have changed since the last full backup.
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Table 12-3: Types of Backup Events (continued)

Manual Incremental A backup of all changed files (for which the backup option was
selected) that occurs before and after a restoration or a
rollback.

Triggered Incremental | An automatic backup that occurs when the Opsware Agent
detects a change to a tracked file for which the backup option
was selected. Only changed files are backed up.

Manual Full A full backup initiated by the user of all tracked files for which
the backup option was selected.

Backup History Search Options
By default, you see the backup history for the past week for the servers that you selected.
If you want to display a different date range, you have the following options:

« Display the backup history for different date range by selecting a different option in the
“View Backup History for a” box.

« Use the “starting from” field to search for backup history from a past date until the
current date.

You can use the matching field to search for a backup name within the selected date
range. Wildcards are allowed (the * and ? characters). If you do not type the full name of
the backup, you must use a wildcard for any missing parts of the name.

The results of this search show the date and number of backup names on that date that
match the * pattern. When you click the link for the number of backups, a list of the
matching backup names displays.

Backup Info and Backup Manifest
When you click a backup name (such as Scheduled Backup) anywhere in the backup

history, the Backup Info and Backup Manifest tabs display.

Backup Info Tab

The Backup Info tab displays general information about a backup event. This information
includes the name of the backup, the date and time of the backup, and the policies that
triggered the backup event.
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All customized policies are identified as Server Policy, as Figure 12-7 shows.
Figure 12-7: Track Configurations: View Backup Triggered Backup Page

Track Configurations: View Backup | Triggered Backup

Return to Config Tracking

Backup Info

Name Triggered Backup

Date 10/23/0318:09:18

User Cpsware Adent

Type Triggered Incremental
Server mo0%94.custeustgad.com

Policies Server Palicy
Files 4
Size 2.35KB

Restore

From the Backup Info tab, you can also place the files that were backed up into the
Restore Queue. See “Restoring Backups” on page 412 in this chapter for information
about how to use this feature.

Backup Manifest Tab

The Backup Manifest tab displays the list of files that were backed up during the selected
backup event, as Figure 12-8 shows.

Figure 12-8: Backup Manifest Tab

Return to Config Tracking

Backup Manifest

Wiew Files for; | A Policies % [ rratehing | Update
] File Type Size  Modified Date  Palicy Ertry Type Ertry Target
O ccurieadir] 022 Directory Cortents 0 bytes 1002303 UTC  Server Policy Directory Conterts  clcurieadiv 022
| cicurieadiv] D022ewe Text Document txt File Chject 11 bytes 1062303 UTS  Server Policy  Directory Conterts  ccuriesdiv 022
O o wvonotree Directory Cortents Obytes 100230353 UTC  Server Policy  Directory Tree c:wyongtreet
O o wvongtreewvongsubtres Directory Cortents Obytes 1002303 UTC  Server Palicy  Directory Tree c:wvongtreet
| cwvonotreswvongsubtresiilewy Text Documert txt File Ohject 11 bytes 1002303 UTS Server Policy  Directary Tree o iwvongtreet
Showing 1-5 of 5

Restore

Two types of objects are backed up, as seen in the File Type field.
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+ File Object in the File Type field indicates that a file has been backed up. You can use
the entry to restore the file.

« Directory Contents in the File Type field indicates that a directory object has been
backed up. The directory object is the directory itself, and not the contents of the
directory. You can use this entry to restore the directory, but you must select the files
inside the directory to restore the contents of the directory.

The Entry Type field can have three possible values. The Entry Type identifies the target
type in the policy entry that caused the file or directory object to be backed up.

+ File Object in the Entry Type field indicates that the file was backed up as the result of a
file target type.

« Directory Contents in the Entry Type field indicates that the file or directory object was
backed up as result of a directory target type.

« Directory Tree in the Entry Type field indicates that the file or directory object was
backed up as a result of a directory target type with the include subdirectories option
selected.
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When you click a file or directory name anywhere in the backup history (such as in the
Backup Info tab), the File Info and File Versions tabs display, as Figure 12-9 shows.

Figure 12-9: File Info

Track Configurations: View File | c:icurieadirl 0224Mew Text Document.txt

Return to View Backup

File Name:
File Type:
Size:
Checksum:
Modified Date:
Backup Date:
Backup Name:
Backup Type:
Policy Name:
Entry Type:
Entry Target:

Server:

cicurieadir] 022N ewy Text Docurment. b
File Ohject

11 bytes

0324743057 hadi645a438937897hEde
10023003 18:07:58

10023003 18:09:18

Triggered Backup

Triggered Incremental

Server Policy

Directary Contents

cicurieadir] 022

m094 cust.custgal.com

Restore Download

The File Info tab displays information about the specific file that you selected. The Policy
Name refers to the policy that caused the file to be backed up. The Policy Name is the
Server Policy if the server's customized tracking policy caused the file to be backed up.

You can place the file that you selected in the Restore Queue by clicking Restore. See
“Restoration of Backed Up Files” on page 409 in this chapter for more information.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

407



Opsware® SAS 6.0.1 User’s Guide: Application Automation

The File Versions tab displays a list of the backed up versions of the file, as Figure 12-10
shows.

Figure 12-10: File Versions

Track Configurations: View File | c\curieadirt 022%New Text Docurment. txt

Return to View Backup

File Mame Size  Checksum Modified Date

-1 Backup Mame Backup Type

cihcurigadic] 022
\Mewy Text 11 bytes 05247249087 bad9648ada5957897bEde 1002303 UTC 1002303 UTC hanual Backup - 14 servers  Manual Full
Documert txt

cihcurigadic] 022
\Mewy Text 11 bytes 05247249087 bad9648ada5957897bEde 1002303 UTC 1002303 UTC Triggered Backup Triggered Incrementsl
Documert txt

ciicurigadiv] 022
\Mewy Text 11 bytes 05247249087 bad9648ada5957897bEde 1002303 UTC 1002303 UTC hanual Backup Manual Full
Documert txt

Showing 1-3 of 3

It displays the backup name and backup type of the file. If you click any of the files, the
File Info for the file is displayed. You can therefore use the File Versions tab to select a
different version of the file, and then restore it or download it from the File History.
Deleting Backups

Backups remain in the backup history until you delete them or the server is deactivated.
Backups are stored in the Software Repository. You should delete old backup events
periodically to reclaim disk storage from the Software Repository.

You can delete entire backup events (identified by a backup name); you cannot delete
individual files from the backup history.

See the Opsware® SAS Administration Guide for more information about mass deletion of
backup files.

Perform the following steps to delete backup points from your backup history:
EH From the navigation panel in the SAS Web Client, click Servers.

H Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

E Select the server or set of servers that have backup points that you want to delete.

Search for a date that contains the backup points that you want to delete. Click the
link with the number of backup events that occurred on that date.
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B Select the check boxes for the backup events that you want to delete from the
backup history.

[@ Click Delete.
The Delete Backup Confirmation page appears.

Click Delete Backups. The backups are now deleted.

Restoration of Backed Up Files

You can use the Configuration Tracking feature to restore configuration files or databases
that have been backed up. You can restore all files that were backed up during a backup
point, or you can select and restore individual files from a backup point. Opsware SAS
allows you to rollback a restoration (for example, return your server's tracked files to the
state immediately before the restoration).

Overview of Procedures Used to Restore Backed Up Files

This section presents an overview of the procedures you use to restore backed-up
configuration files and databases. See “Restoring Backups” on page 412 in this chapter
for information about the step-by-step procedure.

To restore backed-up configuration files and databases, view the backup history for a
server or set of servers. The backup history displays entries for each date when a backup
occurred. As Figure 12-11 shows, the entry for the date displays how many backup points
occurred on that date.

Figure 12-11: Backup Points

Configuration Tracking: View Backup History

Return to Server Search

View Backup History for a | Wesk % | starting from | 10/23/2003 (UTC) matching Backup Mame
4 1082003 10/ 92003 1062002003 10424 /2003 102212003 10/23/2003

reports . cust custgal 0.com

dli360doc 1 Backup
MOD30 . corel.custoas com 1 Backup
mi8d cust custgad.com 3 Backups 16 Backups
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You select the desired backup date, and you can then select one or more backup points
that occurred on that date. Before you restore the backups, you can review all files that
were backed up at your selected backup points. You can either choose to restore all
backed up files from your selected backup points, or you can select the files individually.

To select the backup, click on the link in the date field that displays the number of
backups that were performed on that date.
Restore Queue

This section provides information on the restore queue within Opsware SAS and contains
the following topics:

+ Storing files in the Restore Queue

» Incremental Backups for Restoration and Rollbacks
» Entries for Directories in the Backup History

+ File Not Found Entries

» Restoring Backups

» Rolling Back Restored Files

Storing files in the Restore Queue

When you click Restore, the files that you selected are placed in the Restore Queue and
the View Restore Queue and Perform Restore page appears. You can then review and
select files from all the backup points that you selected.

If you do not want to restore the files at this time, you can perform other actions and the
files will remain in the Restore Queue as long as your session is active (even if you leave
this page). You can also return to the backup history and select other files to put in the
Restore Queue.

When you are ready to restore the backups, return to the Track Configurations: Select a
Task page and click the View Restore Queue and the Perform Restore link.
Incremental Backups for Restoration and Rollbacks

To make rollbacks possible, Opsware SAS performs two automatic incremental backups.
The first backup occurs immediately before the restoration, and the second occurs
immediately after the restoration. Similarly, in order to undo a rollback, Opsware SAS
performs two automatic incremental backups, one before and one after a rollback.
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These backups do not occur if all the files you have selected to restore are identical to the
files already on the server. In such a case, the restoration does not in fact change any files
on the server, and the rollback option is not available (there are no changes to rollback).

Entries for Directories in the Backup History

As discussed in the “Special Considerations for Directory and Wildcard Targets” in the
Opsware® SAS Policy Setter’s Guide, if you are tracking a directory and the contents of
the directory change, the action that you selected is triggered for the directory object itself
and for the files that changed. The only exception occurs when a file is deleted from the
directory. In that case, the action is triggered for the directory object alone.

If you selected the backup action for the directory target, when the directory contents
change, the directory object is backed up as well as the changed files. When a file is
deleted, however, only the directory object is backed up.

If you restore files contained in a directory without selecting the entry for the directory
object, the directory is re-created on the server if it does not already exist. If you do select
the entry for the directory object, however, you can ensure that the directory object is
restored with the same properties (such as permissions and time stamp) it had at the
selected backup event.

File Not Found Entries

If you are monitoring specific files (as opposed to files monitored in tracked directories
and files monitored as the result of wildcard targets), the backup history can contain
entries noting “file not found” if the file does not exist on the server, or if the file is later
deleted on the server. Similarly, if you are monitoring specific directories (opposed to
monitoring directories through wildcard targets), the backup directory can contain “file not
found” entries if the directory does not exist on the server, or if the directory is later
deleted.

If you select and restore “file not found” entry and the file exists on the server, the file is
deleted (it is reverted to the state of the backup event that you selected.)

Exercise caution in restoring entries for deleted directories. If the directory exists on your
server and the directory contains files, both the directory and its contents will be deleted.
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Restoring Backups

Perform the following steps to restore backed-up configuration files:

From the navigation panel in the SAS Web Client, click Servers.

Click Server Search to search for the desired servers. (Alternatively, you can click
Manage Servers and then select the server from the server list.)

Under the Configuration Tracking drop-down menu, select View Backup History.

Find the date and server that has the backup points that contain the files that you
want to restore. See “Backup History” on page 401 in this chapter for information
about finding backup points, viewing backup point details, and viewing lists of
backed up files.

Select the check box for the backup points that have files that you want to restore.
Click Restore.

The files or collection of files from the backup points you selected are placed in the
Restore Queue. If you do not want to perform a restore now, you can click the Return
to Select a Task link to leave this page. While your session is active, the files remain
in the Restore Queue. You can also continue to add more files to the Restore Queue.
To return later to the Restore Queue, click the View Restore Queue and Perform
Restore from the Track Configurations: Select a Task page.

If you are ready to restore files, first review the files in the Restore Queue. If you want
to restore all the files in the queue, you can select the check box at the top of the list.
If you do not want to restore all of the files in the queue, select the checkboxes for
the files that you want to restore.

Click Restore (or Restore All if you want to restore all of the files in the queue).

After the restoration is complete, you can click View Details for more information
about the restored files.

Rolling Back Restored Files

You can rollback any files that you selected to restore. By rolling back the files, you revert
the file to the version that was on the server before you performed the restoration. (In
other words, you undo the restoration.)

The rollback option is not available if you restored any files that are no longer being
monitored by the Configuration Tracking feature. You can choose to restore all changed
files or select the files individually.
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Perform the following steps to rollback restored files:
E After you restore the backups, click Rollback.

The Track Configurations: Restore Queue page appears, which contains the list of
files that you need to revert in order to rollback the tracked configuration files to their
previous state.

This list might not contain all the files that you selected for your original restore. If any
of the files that you selected during your original restore are identical to the files
already on the server, they do not need to be rolled back. Only the files that changed
display.

A If you want to rollback all the changed files, click Restore All. Otherwise, you can
select the individual files that you want to rollback and click Restore.

The Track Configurations: Restore Progress page appears.

Exercise caution in restoring entries for deleted directories. If the directory exists on your
A
server and the directory contains files, both the directory and its contents will be deleted.
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Appendix A: Communication Test
Troubleshooting

This section discusses the following topics:
« Overview of Agent Communication Tests
+ Command Engine to Agent (AGT)

+ Crypto Match (CRP)

+ Agent to Command Engine (CE)

« Agent to Data Access Engine (DAE)

+ Agent to Software Repository (SWR)

* Machine ID Match (MID)

+ Common Troubleshooting Tasks

Overview of Agent Communication Tests

The Communication Test performs the following diagnostic tests to determine if an Agent
is reachable:

+ Command Engine to Agent (AGT): Determines if the Command Engine can
communicate with the Agent. The Command Engine is the Opsware SAS component
that enables distributed programs to run across many servers. The Command Engine
handles the entry of scripts into the Opsware Model Repository (the script storage
location in Opsware SAS) and the versioning of stored scripts.

+ Crypto Match (CRP): Checks that the SSL cryptographic files that the Agent uses are
valid.

+ Agent to Command Engine (CE): Verifies that the Agent can connect to the
Command Engine and retrieve a command for execution.
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+ Agent to Data Access Engine (DAE). Checks whether or not the Agent can connect
to the Data Access Engine and retrieve its device record. The Data Access Engine
provides an XML-RPC interface to the Model Repository that simplifies interaction with
various clients such as the SAS Web Client, system data collection, and monitoring
agents on servers.

+ Agent to Software Repository (SWR): Determines if the Agent can establish an SSL
connection to the Software Repository. The Software Repository is the central repository
for all software that the Opsware system technology manages. It contains software
packages for operating systems, applications, databases, customer code, and software
configuration information.

* Machine ID Match (MID): Checks that the Machine ID (MID) on the server matches
the MID registered in the Model Repository for the Agent.

When the test run finishes, it returns results that show either success or failure for each
test run on each server. For each failed test, the nature of failure is listed by error type in
the error details column of the Communication Test window. In some cases, the failure of
one test might prevent other tests from being executed.

See “Agent Reachability Communication Tests” on page 114 in Chapter 4 for information
about how to run Communication Test.

Command Engine to Agent (AGT)

The Command Engine to Agent (AGT) communications test system checks that the
Command Engine can initiate an SSL connection to the Agent and execute an XML/RPC
request.

The thirteen possible results are:
« AGT - OK
+ AGT - Untested
* AGT - Unexpected error
+ AGT - Connection refused
+ AGT - Connection time-out
+ AGT - Request time-out

« AGT - Server never registered
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AGT - Realm is unreachable

AGT — Tunnel setup error

AGT — Gateway denied access

« AGT — Internal Gateway error

.

AGT — Gateway could not connect to server

AGT — Gateway time-out

AGT - OK

No troubleshooting necessary.

AGT - Untested

This result is returned when a functional area cannot be tested because of a previous
failure that prevents further testing. For example, if the Command Engine cannot contact
the Agent, then no other tests are possible.

What Can I Do If a Test Is Not Run During an AGT Test?
First resolve all tests that failed, and then run the Communication Test again.

AGT - Unexpected error

This result indicates that the test encountered an unexpected error.

What Can I Do If | Get an Unexpected Error?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Support.

AGT - Connection refused

This result indicates that the Command Engine is receiving a TCP reset packet when it
attempts to connect to the Agent on port 1002. The likely cause is that the Agent is not
running. A firewall might also be blocking the connection.

What Can I Do If the Connection is Refused During an AGT Test?

H Log into the server and confirm that the Agent is running. See “Verifying that an
Agent is Running” on page 440 in this appendix for more information.
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B If the Agent is not running, restart the Agent. See “Restarting an Opsware Agent” on
page 442 in this appendix for more information.

H From the managed server, use netstat to confirm that a socket is in listen mode on
port 1002. If not, stop and restart the Agent.

Bl From the server itself, use Telnet to connect to the IP address of the server where the
Agent is installed and port (1002) that the Agent is listening on. If this does not
succeed, stop and restart the Agent.

B Verify that the Management IP address that Opsware SAS is using to reach the
server is the correct address. See “Checking Management IP of a Managed Server”
on page 442 in this appendix for more information. If the IP addresses do not match,
stop and restart the Agent, then rerun the test.

[ If the previous steps are performed and the test still fails, the problem is likely caused
by either a software-based firewall on the server itself or an external firewall blocking
the connection.

AGT - Connection time-out

This result indicates that the Command Engine is not receiving any reply packets when it
attempts to initiate a TCP connection to the Agent on port 1002. The likely cause is that
the server is not running, or that the IP address that Opsware SAS is using to reach the
Agent is incorrect. (A firewall might also be blocking the connection.) To check the IP
address that Opsware SAS is using to reach the Agent, see “Checking Management IP of
a Managed Server” on page 442.

What Can I Do If the Connection Times Out During an AGT Test?

Follow the same steps used to resolve this issue specified in “What Can | Do If the
Connection is Refused During an AGT Test?” on page 417.

AGT - Request time-out

This result indicates that the Command Engine is able to successfully complete a TCP
connection to the Agent on port 1002, but no response is received from the Agent in
response to the XML-RPC request. The likely cause is that the Agent is hung.

What Can I Do If the Request Times Out During an AGT Test?

E Log into the server and restart the Agent. See “Restarting an Opsware Agent” on
page 442 in this appendix for more information.
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H Check to see whether or not some other process is consistently utilizing an
excessive amount of the CPU on the server where the Agent is installed. Also check
to see if the system is performing slowly due to a lack of available memory and/or
excessive file 10. In any of these cases, the system might be performing too slowly to
permit the Agent to respond to the test in a timely manner.

AGT - Server never registered

This test indicates that the server being tested has neither been registered with the
Command Engine, nor can it communicate with the Command Engine. The cause of this
could be any number of reasons similar to those in the Agent to Command Engine (CE)
test. It is also possible (but unlikely) that the Agent was installed but never started.

What Can I Do If the Server Has Not Been Registered with the Command
Engine During an AGT Test?

To troubleshoot this error, use the following procedures:

E Ensure that the Agent is running. For these instructions, See “Verifying that an Agent
is Running” on page 440 in this appendix for more information.

H Ensure that the Agent can contact the Command Engine.

If the Agent is in a Satellite facility, ensure that its Gateways are properly configured
and that it is properly configured to use those Gateways. See “Checking Network
Gateway Configuration” on page 442 in this appendix for more information.

B If the Agent is not in a Satellite:

+ Ensure the host name “way” (no quotes) resolves to its valid IP address. See
“Resolving Host Name” on page 443 in this appendix for more information.

 Verify that a connection can be established to port 1018 of way. Use the command
“telnet way 1018" (or equivalent).

One (or more) of the above checks will fail. To solve that failure, refer to the corresponding
error code for the Agent to Command Engine (CE) test on page 423, or to the realm
connectivity and configuration test.

AGT - Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This means that
a path of tunnels between the Gateways in the Opsware core and the realm of the
managed server cannot be established.
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What Can I Do If the Realm Is Unreachable During an AGT Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a
Gateway misconfiguration. Contact Opsware, Inc. Customer Support for assistance in
troubleshooting the Gateway network.

AGT - Tunnel setup error

The Command Engine could not establish a connection through any of its defined
Gateways. This could be due to a network problem, a malfunctioning or failed Gateway, or
a Gateway misconfiguration.

What Can I Do If | Get a Tunnel Setup Error During an AGT Test?
Contact your Opsware administrator.

AGT - Gateway denied access

The Gateway is working but refused to proxy the connection on behalf of the Agent. This
error most likely means that the Gateway is misconfigured such that the Gateway will not
allow the Command Engine access to the Agent.

What Can I Do If the Gateway is Denied Access During an AGT Test?
Contact your Opsware administrator.

AGT - Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically
occurs when the Gateway is overloaded.

What Can I Do If There is an Internal Gateway Error During an AGT Test?
Contact your Opsware administrator.

AGT - Gateway could not connect to server

The Gateway could not establish a connection to the Agent. This might be because the
Agent is not running, or because a firewall might be blocking the connection.

What Can I Do If the Gateway Couldn’t Connect to the Server During an AGT
Test?

If you suspect the Agent is not running, see “Verifying that an Agent is Running” on page
440. To make sure that the Gateway can establish a connection to the IP address of the
server where the Agent is installed, try to ping the IP address of the server where the
Agent is installed.

420 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix A: Communication Test Troubleshooting

AGT - Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most
likely due to a network connectivity problem.

What Can I Do If the Gateway Times Out During an AGT Test
Ensure that network connectivity is available between the Gateways in the path between
the realm of the managed server and the Opsware core.

Crypto Match (CRP)
This test checks that the SSL cryptographic files that the Agent uses are valid.

The five possible results are:
« CRP-0OK

* CRP - Untested

CRP - Unexpected error

+ CRP - Agent certificate mismatch

CRP - SSL negotiation failure

CRP - OK

No troubleshooting necessary.

CRP - Untested

This result is returned when a functional area cannot be tested because of a previous
failure that prevents further testing. For example, if the Agent cannot be reached, then no
other tests are possible.

What Can I Do If a Test Is Not Run During a CRP Test?
First resolve all tests that failed, and then run the Communication Test again.

CRP - Unexpected error

This result indicates that the test encountered an unexpected error.
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What Can I Do If | Get an Unexpected Error During a CRP Test?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Support.

CRP - Agent certificate mismatch

This result indicates that the SSL certificate that the Agent is using (cogbot.srv) does not
match the SSL certificate that is registered with Opsware SAS for that Agent.

What Can I Do If | Get a Certificate CN Mismatch During a CRP Test?

Use the Recert Agent Custom Extension to issue a new certificate to the Agent. See
“Opsware SAS Custom Extensions” on page 352 in Chapter 10 for more information.

CRP - SSL negotiation failure

This result indicates that the Agent is not accepting SSL connections for the Opsware
core. (The Opsware core is the entire collection of servers and services that provide
Opsware SAS services.) The likely cause of this error is that one or more files in the Agent
crypto directory are missing or are invalid.

What Can I Do If | Get an SSL Negotiation Failure During an CRP Test?
Run the Server Recert custom extension in the “set allow recert flag only” mode on the

server, and then Run the Opsware Agent Installer with the “-c” switch.

Reinstalling the Agent with the “-c” option (“c” stands for “clean”) removes all certs on the
server and also removes the MID file, which forces the Agent to retrieve a new MID from
the Data Access Engine.

+ See “Opsware SAS Custom Extensions” on page 352 in Chapter 10 for more
information how to run the Recert Agent Custom Extension to issue a new certificate to
the Agent.

+ See “Agent Reachability Communication Tests” on page 114 in Chapter 4 for
information abouthow to install an Opsware Agent using the “-c” switch.

After you reinstall the Agent, run the test again to check if the Agent is now reachable.
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Agent to Command Engine (CE)

This test checks that the Agent can connect to the Command Engine and retrieve a
command for execution.

The sixteen possible results are:

CE - OK

CE — Untested

CE - Unexpected error

CE - Connection refused

CE - Connection time-out

CE - DNS does not resolve

CE — Old Agent version

CE - Realm is unreachable

CE - No Gateway defined

CE - Tunnel setup error

CE - Gateway denied access

CE - Gateway name resolution error
CE - Internal Gateway error

CE - Gateway could not connect to server
CE - Gateway time-out

CE — No callback from Agent

CE - OK

No troubleshooting necessary.

CE - Untested

This result is returned when a functional area cannot be tested because of a previous
failure that prevents further testing. For example, if the Agent cannot reach the Command
Engine, then no other tests are possible.
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What Can I Do If a Test Is Not Run During a CE Test?
First resolve all tests that failed, and then run the Communication Test again.

CE - Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If | Get an Unexpected Error During a CE Test?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Support.

CE - Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to
connect to the Command Engine on port 1018. The likely cause is that the Agent is
connecting to the wrong IP address. In other words, the Agent does not know the correct
IP address of the Command Engine. It is also possible that a firewall might be blocking
the connection.

What Can I Do If the Connection is Refused During a CE Test?
Bl Check that the name “way” resolves to its correct IP address. For instructions on how
to do this, see “Resolving Host Name” on page 443.

H Check to make sure there isn't a firewall refusing the connection to this IP address.

CE - Connection time-out

This result indicates that the Agent is not receiving any reply packets when it attempts to
initiate a TCP connection to the Command Engine on port 1018. The likely cause is that
the Agent is connecting to the “wrong” IP address. In other words, the Agent doesn’t know
the correct IP address of the Command Engine. A firewall might also be blocking the
connection.

What Can I Do If the Connection Times Out During a CE Test?

Follow the same steps specified in What Can | Do If the Connection is Refused During a
CE Test?.
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CE - DNS does not resolve

This result indicates that the Agent cannot resolve the host name “way” to a valid IP
address. In other words, the Agent does not know the correct IP address of the Command
Engine.

What Can I Do If the Command Engine Name Does Not Resolve During a CE
Test?

Log into the server and use a command such as Telnet to confirm that the host name
“way” can resolve (for example: “telnet way 1018”). If not, check the DNS configuration of
the server to make sure that the host name “way” is configured to its correct IP address.
See “Resolving Host Name” on page 443 in this appendix for more information.

CE - Old Agent version

This result indicates that the Agent was unable to contact the Command Engine, but the
test was unable to determine the exact cause because the Agent is out of date.

What Can I Do If the Agent is Out of Date During a CE Test?
If this error occurs, it will likely be for one of two reasons: either the host name of the
Command Engine (“way”) did not resolve, or the connection was refused.

+ If you believe that the host name of the Command Engine (“way”) did not resolve, then
See “CE — DNS does not resolve” on page 425 in this appendix for more information.

« If you determine that the connection was refused, See “CE - Connection refused” on
page 424 in this appendix for more information.

Alternatively, you can upgrade the Agent to the latest version (contact Opsware, Inc.
Customer Support) and re-run the test. See “Agent Reachability Communication Tests” on
page 114 in Chapter 4 for information about how to install an Agent.

CE - Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This error means
that a path of tunnels between the Gateways in the Opsware core and the realm of the
managed server cannot be established.

What Can I Do if the Realm is Unreachable During a CE Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a
Gateway misconfiguration. Contact your Opsware administrator for assistance in
troubleshooting the Gateway network.
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CE - No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use
a Gateway. Agents located in satellites must use a Gateway to contact the core.

What Can I Do If No Gateway is Defined During a CE Test?
To troubleshoot this error, try the following:

El Create or open the opswgw.args file on the managed server. The opswgw.args file is
located on the managed server at:

« Unix/Linux: /var/lc/cogbot/etc

+ Windows: %SystemDrive%\Program Files\Common Files\Loudcloud\cogbot\etc
H Make sure that this file contains a single line as shown:

opswgw.gw_list: <gw_ip address>:<gw_port>,<gw_up

address>:<gw_port>

CE - Tunnel setup error

The Command Engine could not establish a connection through any of its defined
Gateways. This could be due to a network problem, a malfunctioning or failed Gateway, or
a Gateway misconfiguration.

What Can I Do If A Tunnel Setup Occurs Error During a CE Test?
Contact your Opsware administrator.

CE - Gateway denied access

The Gateway is working, but refused to proxy the connection on behalf of the Agent. This
error most likely means that the Gateway is misconfigured such that the Gateway will not
allow the Agent to access the Command Engine.

What Can I Do if the Gateway is Denied Access During a CE Test?
Contact your Opsware administrator.
CE - Gateway name resolution error

The server running the Gateway in the Opsware core was unable to resolve the host
name “way”. It must be able to do this in order to proxy connections on behalf of
managed servers in Satellite realms.
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What Can I Do if a Name Resolution Error Occurs on the Gateway During a
CE Test?

Log into the server where the core Gateway is located and use a command such as ping

or host to confirm that the host name “way” can be resolved (for example: “host way”).

If you cannot connect, contact your Opsware administrator so that you can check the
DNS configuration of the core Gateway server.

CE - Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically
occurs when the Gateway is overloaded.

What Can I Do if an Internal Gateway Error Occurs During a CE Test?

Contact your Opsware administrator.

CE - Gateway could not connect to server

The Gateway could not establish a connection to the Command Engine. The situation
might be because the Command Engine is not running, or because the Gateway is
resolving the Command Engine host name (“way”) to the wrong IP address. It is also
possible that a firewall might be blocking the connection.

What Can I Do if the Gateway Can’t Connect to Server During a CE Test?

Check that the name “way” resolves to the correct IP address and that the Gateway can
establish a connection to port 1018 at that IP. See “Resolving Host Name” on page 443
and “Verifying that a Port is Open on a Managed Server” on page 441 in this appendix.

CE - Gateway time-out
The Gateways on the two ends of a tunnel could not communicate with each other, most

likely due to a network connectivity problem.

What Can I Do if the Gateway Times Out During a CE Test?

Ensure that network connectivity is available between the Gateways in the path between
the realm of the managed server and the Opsware core.
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CE - No callback from Agent

The Command Engine was able to contact the Agent, but the Agent did not call back to
retrieve its command. However, the Agent reports that it can connect to a Command
Engine. This most likely means that the managed server's name resolution mechanism
(such as DNS) is not configured to point the server to a different Opsware core facility
than is currently stored for the server by Opsware SAS.

What Can I Do if There is No Callback from Agent?

It is possible that the MID file is missing. If the MID file is missing, it can be recreated
easily by creating a file called 'mid' in the correct location which contains the value of the
“Server ID” from the Server's Properties page in the SAS Web Client.

If the MID file is not missing, then ensure that the server's name resolution mechanism
(DNS, NIS, and so on) is properly configured so that the host names “spin” and “way”
resolve to the appropriate IP addresses or Opsware core services in the same core, and
that those hosts can be reached from the server on ports 1004 and 1018, respectively. If
this is the case, it is likely that the server has been redirected to a different core recently,
and the Agent has not yet registered, which will cause Opsware SAS to update its records.
It this issue remains unresolved for more than 12 hours, contact Opsware, Inc. Customer
Support.

Agent to Data Access Engine (DAE)

This test checks that the Agent can retrieve its device record from Data Access Engine.
The fifteen possible results are:

« DAE - OK

* DAE - Untested

» DAE - Unexpected error

+ DAE - Connection refused

» DAE - Connection time-out
+ DAE - DNS does not resolve
« DAE - Old Agent version

* DAE - Realm is unreachable
+ DAE - No Gateway defined

* DAE - Tunnel setup error
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DAE - Gateway denied access

DAE - Gateway name resolution error

+ DAE - Internal Gateway error

DAE - Gateway could not connect to server

.

DAE - Gateway time-out

DAE - OK

No troubleshooting necessary.

DAE - Untested

This result is returned when a functional area cannot be tested, because of a previous
failure that prevents further testing. For example, if the Agent cannot reach the Data
Access Engine then no other tests are possible.

What Can I Do If a Test Is Not Run During a DAE Test?
First resolve all tests that failed, and then run the Communication Test again.

DAE - Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If | Get an Unexpected Error During a DAE Test?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Support.

DAE - Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to
connect to the Data Access Engine on port 1004. The likely cause is that the Agent is
connecting to the wrong IP address. A firewall might also be blocking the connection.

What Can I Do If the Connection is Refused During a DAE Test?

El Check that the name “spin” resolves to its correct IP address. See “Resolving Host
Name” on page 443 in this appendix for more information.

H Check to make sure that a firewall is not refusing the connection to this IP address.
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DAE - Connection time-out

This result indicates that the Agent is not receiving any reply packets when it attempts to
initiate a TCP connection to the Data Access Engine on port 1004. The likely cause is that
the Agent is connecting to the wrong IP address. In other words, the Agent does not know
the correct IP address of the Command Engine. A firewall might also be blocking the
connection.

What Can I Do If the Connection Times Out During a DAE Test?
Follow the same steps specified in “What Can | Do If the Connection is Refused During a
DAE Test?” on page 429.

DAE - DNS does not resolve

This result indicates that the Agent cannot resolve the host name “spin” to a valid IP
address. In other words, the Agent does not know the correct IP address of the Data
Access Engine.

What Can I Do If the Data Access Engine Name Does Not Resolve During a
DAE Test?

Log into the server and use a command such as Telnet to confirm that the host name
“spin” can be resolved (for example: telnet spin 1004”). If not, check the DNS
configuration of the server to make sure that the host name “spin” is configured to its
correct IP address. See “Resolving Host Name” on page 443 in this appendix for more
information.

DAE - Old Agent version

This result indicates that the Agent was unable to contact the Data Access Engine, and
the test is unable to determine the exact cause, because the Agent is out of date.

What Can I Do If the Agent is Out of Date During an DAE Test?
If this error occurs, it will likely be for one of two reasons: either the host name of the Data
Access Engine (“spin”) did not resolve, or the connection was refused.

« If you believe that the host name of the Data Access Engine (“way”) did not resolve,
then see “DAE - DNS does not resolve” on page 430.

« If you determine that the connection was refused, see “DAE - Connection refused” on
page 429.

430 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix A: Communication Test Troubleshooting

Alternatively, you can upgrade the Agent to the latest version (contact Opsware, Inc.
Customer Support) and re-run the test. See “Agent Reachability Communication Tests” on
page 114 in Chapter 4 for information about how to install an Agent.

DAE - Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This error means
that a path of tunnels between the gateways in the Opsware core and the realm of the
managed server cannot be established.

What Can I Do if the Realm is Unreachable During a DAE Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a
Gateway misconfiguration. Contact your Opsware administrator for assistance in
troubleshooting the Gateway network

DAE - No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use
a Gateway. Agents located in satellites must use a Gateway to contact the core.

What Can I Do If No Gateway is Defined During a DAE Test?
To troubleshoot this error, try the following:

H Create or open the opswgw.args file on the managed server. The opswgw.args file is
located on the managed server at:

« Unix/Linux: /var/lc/cogbot/etc
+ Windows: %SystemDrive%\Program Files\Common Files\Loudcloud\cogbot\etc
H Make sure this file contains a single line as shown:
opswgw.gw_list: <gw_ip address>:<gw_port>,<gw _up
address>:<gw_port>
DAE - Tunnel setup error

The Data Access Engine could not establish a connection through any of its defined
Gateways. This could be due to a network problem, a malfunctioning or failed Gateway, or
a Gateway misconfiguration.

What Can I Do if a Tunnel Setup Error Occurs During a DAE Test?
Contact your Opsware administrator.
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DAE - Gateway denied access

The Gateway is working, but refused to proxy the connection on behalf of the Agent. This
error most likely means that the Gateway is misconfigured such that the Gateway will not
allow the Agent to access the Data Access Engine.

What Can I Do if the Gateway is Denied Access During a DAE Test?
Contact your Opsware administrator.

DAE - Gateway name resolution error

The server running the Gateway in the Opsware core was unable to resolve the host
name “spin”. It must be able to do this in order to proxy connections on behalf of
managed servers in Satellite realms.

What Can I Do if There is a Name Resolution Error on the Gateway During a
DAE Test?

Log into the server where the core Gateway is located and use a command such as ping
or host to confirm that the host name “spin” can be resolved (for example: “host spin”).

If you cannot connect, contact your Opsware administrator so that you can check the
DNS configuration of the core Gateway server.

DAE - Internal Gateway error
Due to an internal error, the Gateway was unable to proxy the connection. This typically

occurs when the Gateway is overloaded.

What Can I Do if an Internal Gateway Error Occurs During a DAE Test?
Contact your Opsware administrator.

DAE - Gateway could not connect to server

The Gateway could not establish a connection to the Data Access Engine. This might be
because the Data Access Engine is not running, or because the Gateway is resolving the
Data Access Engine host name (“spin”) to the wrong IP address. It is also possible that a
firewall might be blocking the connection.
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What Can I Do if the Gateway Can’t Connect to Server During a DAE Test?
Check that the name “spin” resolves to the correct IP address and that the Gateway can

establish a connection to port 1018 at that IP. See “Resolving Host Name” on page 443 in
this appendix for more information and See “Verifying that a Port is Open on a Managed
Server” on page 441 in this appendix for more information.

DAE - Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most
likely due to a network connectivity problem.

What Can I Do if the Gateway Times Out During a DAE Test?

Ensure that network connectivity is available between the Gateways in the path between
the managed server's realm and the Opsware core.

Agent to Software Repository (SWR)

This test checks that the Agent can establish an SSL connection to the Software
Repository.

There 16 possible results are:
« SWR - OK
* SWR - Untested
+ SWR - Unexpected error
* SWR - Connection refused
+ SWR - Connection time-out
* SWR - DNS does not resolve
+ SWR - Old Agent version
* SWR - Server identification error
* SWR - Realm is unreachable
+ SWR - No Gateway defined
* SWR - Tunnel setup error

+ SWR - Gateway denied access
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SWR - Gateway name resolution error

SWR - Internal Gateway error

SWR - Gateway Could not connect to server

SWR - Gateway time-out

SWR - OK

No troubleshooting necessary.

SWR - Untested

This result is returned when a functional area cannot be tested because of a previous
failure that prevents further testing. For example, if the Agent cannot reach the Software
Repository, then no other tests are possible.

What Can I Do If a Test Is Not Run During a SWR Test?
First resolve all tests that failed, and then run the Communication Test again.

SWR - Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If | Get an Unexpected Error During a SWR Test?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Customer Support.

SWR - Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to
connect to the Software Repository on port 1003. The likely cause is that the Agent is
trying to connect to the wrong IP address. A firewall might also be blocking the
connection.

What Can I Do If the Connection is Refused During an SWR Test?

El Check that the name “theword” resolves to the correct IP address. For this
information, see “Resolving Host Name” on page 443.

H Check to make sure that a firewall isn't refusing the connection to this IP address.
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SWR - Connection time-out

This result indicates that the Agent is receiving a TCP reset packet when attempting to
connect to the Software Repository on port 1003. The likely cause is that the Agent is
connecting to the wrong IP address. In other words, the Agent does not know the correct
IP address of the Software Repository. A firewall might also be blocking the connection.

What Can I Do If the Connection Times Out During an SWR Test?

Follow the same steps specified in “What Can | Do If the Connection is Refused During
an SWR Test?” on page 434.

SWR - DNS does not resolve

This result indicates that the Agent cannot resolve the host name “theword” to a valid IP
address. In other words, the Agent does not know the correct IP address of the Software
Repository.

What Can I Do If the Software Repository Name (“theword”) Does Not
Resolve During an SWR Test?

Log into the server and use a command such as Telnet to confirm that the host name
“theword” can be resolved (for example: “telnet theword 1003"). If not, contact your
Opsware administrator so that you can check the DNS configuration of the server.

SWR - Old Agent version

This result indicates that the Agent was unable to contact the Software Repository, and
the test is unable to determine the exact cause because the Agent is out of date.

What Can I Do If the Agent is Out of Date During an SWR Test?
If this error occurs, it will likely be for one of two reasons: either the host name of the

Software Repository (“theword”) did not resolve, or the connection was refused.

« If you think that the host name of the Software Repository (“theword”) did not resolve,
then see “SWR - DNS does not resolve” on page 435.

+ If you determine that the connection was refused, see “SWR - Connection refused” on
page 434.

Alternatively, you can upgrade the Agent to the latest version (contact Opsware, Inc.
Customer Support) and re-run the test. See “Opsware Agent Installation Using ODAD” on
page 106 in Chapter 4 for information about how to install an Opsware Agent.
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SWR - Server identification error

Whenever an Agent makes a request of the Software Repository, the identity of the server
is validated to confirm that the server should be allowed access to the information
requested. This error indicates that the Software Repository was unable to identify the
server being tested, or incorrectly identified that server.

What Can I Do If | Get a Server Identification Error?

The Software Repository identifies servers based on the incoming IP address of the
request. To troubleshoot this error, try the following:

E Check the Device Properties tab for the server in the SAS Web Client to see if
Network Address Translation (NAT) is in use. If it is, make sure that NAT is statically
configured, and that only one server is using the NAT address. If multiple servers are
using the same IP address, you will need to reconfigure the NAT device. See
“Network Address Translation (NAT) for Managed Servers” on page 201 in Chapter 7
for more information.

B If the Agent is installed on a cluster, check that each node in the cluster has a unique
IP address at which it can be reached. You might have to add static routes to the
server to ensure that connections made from that server to the Opsware core use the
unique IP. If NAT is not in use, you can alternately mark the correct interface as the
“primary” interface through the Network Configuration tab for the server in the SAS
Web Client. See “Network Address Translation (NAT) for Managed Servers” on
page 201 in Chapter 7 for more information.

E The server's IP address might have changed recently. If this is the case, stop and
restart the Agent. For instructions on how to stop and start an Agent, see “Restarting
an Opsware Agent” on page 442.

SWR - Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This error means
that a path of tunnels between the gateways in the Opsware core and the realm of the
managed server cannot be established.

What Can I Do if the Realm is Unreachable During a SWR Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a
Gateway misconfiguration. Contact your Opsware administrator for assistance in
troubleshooting the Gateway network.
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SWR - No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use
a Gateway. Agents located in satellites must use a Gateway to contact the core.

What Can I Do If No Gateway is Defined During a SWR Test?
To troubleshoot this error, try the following:

El Create or open the opswgw.args file on the managed server. The opswgw.args file is
located on the managed server at:

« Unix/Linux: /var/lc/cogbot/etc
+ Windows: %SystemDrive%\Program Files\Common Files\Loudcloud\cogbot\etc
H Make sure that this file contains a single line as shown:
opswgw.gw_list: <gw_ip address>:<gw_port>,<gw_up
address>:<gw_port>
SWR - Tunnel setup error

The Data Access Engine could not establish a connection through any of its defined
Gateways. This could be due to a network problem, a malfunctioning or failed Gateway, or
a Gateway misconfiguration.

What Can I Do If a Tunnel Setup Error Occurs During a SWR Test?
Contact your Opsware administrator.

SWR - Gateway denied access

The Gateway is working but refused to proxy the connection on behalf of the Agent. This
error most likely means that the Gateway is misconfigured such that the Gateway will not
allow the Agent to access the Software Repository.

What Can I Do if the Gateway is Denied Access During a SWR Test?
Contact your Opsware administrator.

SWR - Gateway name resolution error

The server running the Gateway in the Opsware core was unable to resolve the host
name “theword”. It must be able to do this in order to proxy connections on behalf of
managed servers in Satellite realms.
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What Can I Do if a Name Resolution Error Occurs on the Gateway During a
SWR Test?

Log into the server where the core Gateway is located and use a command such as ping
or host to confirm that the host name “theword” can be resolved (for example: “host
theword”).

If you cannot connect, contact your Opsware administrator so that you can check the
DNS configuration of the core Gateway server.

SWR - Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically
occurs when the Gateway is overloaded.

What Can I Do if an Internal Gateway Error Occurs During a SWR Test?
Contact your Opsware administrator.

SWR - Gateway Could not connect to server

The Gateway couldn't establish a connection to the Software Repository. This error might
be because the Software Repository is not running, or because the Gateway is resolving
the Software Repository host name (“theword”) to the wrong IP address. It is also possible
that a firewall might be blocking the connection.

What Can I Do if the Gateway Can’t Connect to Server During a SWR Test?
Check that the name “theword” resolves to the correct IP address and that the Gateway
can establish a connection to port 1018 at that IP address. For more information, see
“Resolving Host Name” on page 443 and “Verifying that a Port is Open on a Managed
Server” on page 441.

SWR - Gateway time-out
The Gateways on the two ends of a tunnel could not communicate with each other, most

likely due to a network connectivity problem.

What Can I Do if the Gateway Times Out During a SWR Test?
Ensure that network connectivity is available between the Gateways in the path between
the realm of the managed server and the Opsware core.
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Machine ID Match (MID)

This test checks whether the MID that the Agent reported matches that recorded in the
Model Repository (Opsware data repository).

You can receive four possible errors from the Machine ID (MID) Communication Test:
« MID - OK
* MID - Untested
* MID - Unexpected error

* MID - MID mismatch

MID - OK

No troubleshooting necessary.

MID - Untested

This result is returned when a functional area cannot be tested, because of a previous
failure that prevents further testing. For example, if the Agent cannot reach the Model
Repository, then no other tests are possible.

What Can I Do If a Test Is Not Run During an MID Test?
First resolve all tests that failed, and then run the Communication Test again.

MID - Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If | Get an Unexpected Error During an MID Test?

First resolve all tests that failed, and then run the Communication Test again. If the
unexpected error recurs, check to see if any additional details in the error message
indicate the problem. If the error cannot be resolved, contact Opsware, Inc. Customer
Support.

MID - MID mismatch

This result indicates that the MID that the Agent reported does not match the recorded
MID in the Model Repository for that Agent. The likely cause is that the Command Engine
is running the test against the wrong Agent.
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What Can I Do If the MID is Mismatched During an MID Test?

To
(1]
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troubleshoot this error, try the following:

Check the Device Properties tab for the server in the SAS Web Client to see if NAT is
in use for this server. If it is, make sure that static, 1-to-1 NAT is being used. Opsware
SAS requires that all managed servers be reachable on a distinct, consistent IP
address, so configurations that assign addresses dynamically or use port-based
translation are not supported.

If the Agent is installed on a cluster, check that each node in the cluster has a unique
I[P address at which it can be reached. You might have to add static routes to the
server to ensure that connections made from that server to the Opsware core use the
unigue IP. If NAT is not in use, you can alternately mark the correct interface as the
“primary” interface via the Network Configuration tab for the server in the SAS Web
Client.

The IP address might have changed recently. If this is the case, stop and restart the
Agent. For these instructions, see “Restarting an Opsware Agent” on page 442.

ommon Troubleshooting Tasks

e following list of troubleshooting tasks are common to more than one Communication
st error:

Verifying that an Agent is Running

Verifying that a Port is Open on a Managed Server
Restarting an Opsware Agent

Checking Management IP of a Managed Server
Checking Network Gateway Configuration

Resolving Host Name

Verifying that an Agent is Running

To

verify that an Agent is running on a server, perform the following steps:

E On Solaris, HP-UX, or AlX, enter this argument at the command line:

440 Opsware Inc. Confi

/usr/ucb/ps auxwww | grep cog

dential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix A: Communication Test Troubleshooting

You should get this result if the Agent is running:

/opt/OPSW/bin/python /opt/OPSW/blackshadow/shadowbot/
daemonbot .pyc --conf /var/lc/cogbot/etc/cogbot.args

H On Linux, enter this argument at the command line:
pPsS auxwww | grep cog
You should get this result if the Agent is running:

/opt/OPSW/bin/python /opt/OPSW/blackshadow/shadowbot/
daemonbot .pyc --conf /var/lc/cogbot/etc/cogbot.args

E On windows, from the Administrative Tools | Services, check to make sure that the
‘shadowbot' service is running.

Verifying that a Port is Open on a Managed Server

For some errors, you will need to verify that the port is open on the server where the
Agent is installed. To do this, perform the following steps:

El Check if the port is open.
H On Solaris, HP-UX, AIX, or Linux enter:
'netstat -an | grep 1002 | grep LISTEN'
If the port is open on the box, you should get back the following:
*.1002 * Kk 0 0 24576 0 LISTEN
EH On Windows, at the command prompt enter:
'netstat -an | f£ind "1002" | find "LISTEN"':\
If the port is open on the box, you should get back the following result:
TCP0.0.0.0:10020.0.0.0:0LISTENING

Bl Confirm that the port is actually open. To do this, from the computer where the Agent
is installed, Telnet to port 1002 by using both localhost and the external IP address of
the server. Performing the Telnet will help you confirm that a connection refused
message is being caused by the lack of an open port on the managed server rather
than a problem with networking hardware between the core and the managed
server.
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Restarting an Opsware Agent

For Solaris, Linux, or AlIX, perform the following steps:

To stop an Opsware Agent on Solaris, Linux, or AlX, execute the following command:
/etc/init.d/cogbot stop

To restart the Opsware Agent on Solaris, Linux, or AlX, execute the following
command:

/etc/init.d/cogbot start

For HP-UX, perform the following steps:

To stop an Opsware Agent on HP-UX, execute the following command:
/sbin/init.d/cogbot stop
To restart an Opsware Agent on HP-UX, execute the following command:

/sbin/init.d/cogbot start

For Windows, execute the following command to stop and start an Opsware Agent:

net stop shadowbot

net start shadowbot

Checking Management IP of a Managed Server

To check the Management IP of a managed server, perform the following steps:

To view the management IP of the managed server, log into the SAS Web Client.
From the Navigation panel, click Servers » Manage Servers.

From the Manage Servers list, click the display name of the server for which you
want to check the Management IP.

Select the Network tab of the server's properties.

Check to make sure that the Management IP address matches the IP address of the
managed server.

Checking Network Gateway Configuration

To check the network Gateway configuration, perform the following steps:

On Solaris, enter this command to check routing table:

netstat -rn
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Your results should look like this:
default 192.168.8.1

where 192.168.8.1 is the IP of the Gateway.

On Linux, enter this command to check routing table:

route -n
Your results should look like this:

0.0.0.0 192.168.8.1 0.0.0.0
0 etho

where 192.168.8.1 is the IP of the Gateway.

On Windows, enter this command to check routing table:

route print

Your results should look something like this:

0.0.0.00.0.0.0192.168.8.1192.168.8.12020

where 192.168.8.1 is the IP of the Gateway.

UG 1 5904

UG 0 0

In each case, you should also ping 192.168.8.1 (IP) to confirm that you can actually

reach the Gateway.

Resolving Host Name

All managed servers (those with agents) must be able to resolve unqualified Opsware
SAS service names for the following components:

» spin (Data Access Engine)

+ way (Command Engine)

+ theword (Software Repository)

If you need to ensure that one of these host names resolves correctly, contact your
Opsware administrator to find out what qualified host name or IP address these service
names should resolve to.

H Try to ping the host. For example, execute the following command if you wanted to

resolve the host name, way:

ping way
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H If the host name cannot resolve, you will get the following errors:
Linux/Solaris/AIX/HP-UX:
ping: unknown host way
Windows:

Ping request could not find host way. Please check the name

and try again.

HE If the host name can resolve, you might get back various permutations of these types
of messages (OS independent):

way 1is alive
or

pinging way (ip) with 32 bytes of data
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This section discusses the following topics:
+ Agent Installation Using the CLI
+ Opsware Agent Upgrade Tool

+ Opsware Agent Upgrade Custom Extension

Agent Installation Using the CLI

This section provides information on Opsware Agent installation using the Agent Installer
CLI and contains the following topics:

Overview of Agent Installation Using the CLI

Preparation for Opsware Agent Installation

Preassimilation Checklist

Installing an Opsware Agent by using the Agent Installer CLI
Opsware Agent Installer Options

Example: Opsware Agent Installer Command and Options
Starting an Opsware Agent on a Server

Verifying Opsware Agent Functionality

Augmenting the Information for a Managed Server
Uninstalling an Opsware Agent on Unix and Windows
Uninstalling Earlier Versions of Opsware Agents on Unix

Uninstalling Earlier Versions of Opsware Agents on Windows
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Overview of Agent Installation Using the CLI

When you install Opsware Agents on existing operational servers, you should synchronize
Iz the local time on the servers with an external time-server that uses a network time
protocol (NTP).

Installing Opsware Agents on servers makes existing operational servers known to
Opsware SAS so that they can be managed. Assimilating servers into Opsware SAS is
appropriate when many servers are already functioning in the operational environment
and need to be managed (for example, when Opsware technology is initially deployed in
a facility).

Installing an Opsware Agent on a server with a pre-built OS into Opsware SAS enables:
» Baseline discovery of the operating system on the server.

+ Managing the baseline operating system, including patch management, when the
operating system is defined in Opsware SAS with the Prepare Operating System
Wizard.

« Full provisioning and management capabilities for any new applications deployed on
the server.

When installed, the Opsware Agent registers the server with the Opsware Model
Repository. Opsware SAS assigns the server to a generic operating system that
corresponds to the operating system that the Opsware Agent discovered during the
installation. The server is assigned to a placeholder OS node. For each operating system,
the SAS Web Client contains a node <operating_system_version>/Not Assigned.

The Opsware Agent Installer can install Agents when an Opsware core is not available to
a server. If a newly-installed Agent cannot contact a core, the Agent runs in a dormant
mode. While dormant, it periodically attempts to contact the core. When the core
becomes available, the Agent performs the initialization tasks, such as hardware and
software registration, that usually take place when the Agent is first installed.
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The server is tracked in the SAS Web Client. However, the server operating system cannot
be managed while the server is assigned to the generic operating system node. You must
reassign the server to the operating system that was defined with the OS Provisioning
feature.

The server is associated with the default facility for the local instance of Opsware SAS.

If the managed server's IP address does not fall within a specified IP range, the server is
associated with the default IP range group (Default). The default group is associated with
the customer Not Assigned.

See the Opsware® SAS Policy Setter’s Guide for information about how servers are
associated with customers.

Users install an Opsware Agent on each server. Running an Opsware Agent on a server
allows Opsware SAS to manage the server. To install an Opsware Agent, run the Opsware
Agent Installer.

The Opsware Agent Installer is an application that has the following features:

» Can be invoked from the command line or within a script.

+ Installs an Opsware Agent.

» Logs its decisions and actions.

» Can be operated unattended because user interaction is not required.

The Opsware Agent Installer installs the Opsware Agent, retrieves cryptographic material,
retrieves configuration information, and writes a configuration file.

Preparation for Opsware Agent Installation

Opsware Inc. recommends that you set up a Windows file share to make the Opsware
Agent Installer for various operating systems available from one place. Setting up a file
share allows you to install Opsware Agents on servers quickly and easily. If this is not
possible, the Opsware Agent Installer needs to be moved by using an alternate file
transfer mechanism, such as SFTP.

At the completion of the Opsware Agent installation process, a managed server is
assimilated and the hardware and software data that the Opsware Agent discovered is
stored in the Model Repository.
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To use the Patch Management features on Windows NT 4.0 and Windows 2000 servers,

Iz you must install Internet Explorer (IE) 6.0 or later on the server first because a patch utility
depends on it. If you do not install IE 6.0 on the server first, the Opsware Agent Installer
warns you that the Patch Management feature does not work as expected because it
checks for |E 6.0 on all Window servers. This prerequisite is not required for Windows
2003, because IE 6.0 is pre-installed for this operating system.

Preassimilation Checklist

Prior to installation, you should perform the following tasks on the server where the
Opsware Agent is to be installed. Performing these tasks is vital to installing the Opsware
Agent quickly within maintenance windows.

H For the Code Deployment & Rollback feature, verify that the following port is
accessible between the server you will push code from and the server where you will
push code to:

- telnet <staging server> 1002

- telnet <production_server>1002

H Because the Opsware Agent runs on port 1002, verify that no other applications are
using this port.

— On a Unix server, enter this command from a terminal window:
netstat -an | grep 1002 | grep LISTEN
— On a Windows server, enter this command from a terminal window:
netstat -an | f£ind "1002" | find "LISTEN"
E Check for sufficient disk space for Opsware Agent installation on the server.

The Opsware Installer checks for the following amounts of free disk space in these
directories:

- 30MBin /opt/0OPSW/installdir (Unix)
- 100MB in /var/lc/vardir (Unix)

- 30MBin $SystemDrive%\\Program Files\\Loudcloud\\installdir
(Windows)

- 100MB in $SystemDrive%\\Program Files\\Common
Files\\Loudcloud\\vardir (Windows)
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(These default directories can be overridden with parameters at installation time.)

These space requirements might not be enough. The vardir directory is used for
dynamic content like logs and downloaded packages. If there is not enough disk
space for the packages during remediation, it will fail.

On the Solaris operating system, check for legacy sun4m architecture. Currently, the

Opsware Agent works only for sun4u architecture.

For Windows, check the following items:

- At a minimum, NT 4.0 Service Pack 6a must be installed on the server.

- Verify that the Windows Registry has the correct settings:

1. Start regedit and locate the following registry key:
HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control
\FileSystem

2. Select the NtfsDisable8dot3NameCreation entry.

3. On the Edit menu, click DWORD and verify that the value is set to 0. The value
must be set to 0. If necessary (because the value is set to 1), change the value by
following your organization’s IT policies and reboot the server.

To install an Opsware Agent on a server running Solaris, you must also install the
following Solaris packages:

For Python:
SUNWtoo
SUNWtoox
For showrev:

SUNCadm
SUNW1ibC
SUNW1ibCx
SUNWadmfw
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Before you install an Agent on a server, the server must meet certain package and
patch requirements that vary by operating system, as Table B-1 shows.

Table B-1: Required Patches and Packages for Opsware Agent Installation

AIX 4.3 APAR 1Y39444
AIX 5.1 APAR 1Y39429
NOTE:

If AIX 4.3.3.388, 4.4.4.89, or 5.1.0.3 is installed, the
Opsware Agent Installer displays an error message that
indicates the correct APAR to install on the server.

HP-UX (10.20, 11.00, 11.11/11i) For HP-UX 10.20, PHCO_21018

Additionally, SW-DIST should be upgraded to the HP
recommended patch level. You should continue to
upgrade this package when HP recommends new
versions.

Linux AS 3.0 openssl096b

NOTE:
This package must be included in the $packages
section of the Kickstart configuration.

Solaris 9, 8, 7, and 6 SUNWadmc
SUNWesl
SUNWcsu
SUNWesu
SUNWIibms
SUNWswmt

Windows 2000 Service Pack 4
Windows NT 4.0 Service Pack 6a
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Installing an Opsware Agent by using the Agent Installer CLI

The Opsware Agent needs administrator-level privileges (root on Unix servers and Local
System on Windows servers) to manage a server. Therefore, Opsware Agent installation
needs to be performed as root on Unix operating systems and as administrator on
Windows operating systems.

You can install an Opsware Agent on any server listed in “Supported Operating Systems
for Managed Servers” in Opsware® SAS User’'s Guide: Server Automation.

Perform the following steps to install an Opsware Agent on a server:
E Log into the server that you want to assimilate by using a remote shell.

H For Unix operating systems, change the user login to root (su - root) and for
Windows operating systems, log in as administrator.

H From the SAS Web Client, download the package that contains the Opsware Agent
Installer to a directory on the server you want to assimilate:

1. Search for the package opsware-agent. From the navigation panel, enter
opsware-agent in the Search box, select the Packages option, and click Go.
The Manage Packages: Search Packages page appears.

Each operating system and operating system version has different packages for
the Opsware Agent Installer.

Unix
opsware-agent-<versions>-<system name>-<system version>
Windows:

opsware-agent-<versions>-<system name>-<system

versions>.exe

2. Click the package name for the Opsware Agent Installer that you want to
download. The Packages: Edit Properties page appears.

3. Click Download to save the package locally.

Bl From the directory where the Opsware Agent Installer was copied, run the Installer by
entering the correct executable and options for the installation environment.

See “Example: Opsware Agent Installer Command and Options” on page 456 in this
appendix for more information.
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Opsware Agent Installer Options

When you use the Opsware Agent Installer CLI, you can include the options that the
following table shows to control the way that the Opsware Agent is installed on a server.

Table B-2: Agent Installer Options

--logfile

--loglevel <level>

Removes any machine-specific identifying material from the
server. Specifically, removes the machine ID file (MID), and all
machine-specific cryptographic material. Use this option when
a server is deactivated and deleted from the SAS Web Client
and needs to be returned to service at a later time.

Forces Opsware Agent installation and removes the target
installation directory if it exists.

REQUIREMENT:

When using the - £ option, you must run the Opsware Agent
Installer as root on Unix operating systems and as the
administrator on Windows operating systems.

Specifies the path to the Opsware Agent Installer log file. By
default, the current directory is set as the path.

By default, the log file has the following filename:
opsware-agent-installer-<date>.log
Sets the log level for log messages.

With this option, specify one of the following levels: error,

warn, info, trace, Or none.

The level error logs the least detail. The level trace logs all
messages. By default, the log level is set to the log level info.

Logs all output to stdout instead of a log file. This option is
invoked automatically if the default log file or the log file
passed with the --1ogfile option cannot be created, for
example, when running the Opsware Agent Installer from non-
writeable media, such as a DVD.
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Table B-2: Agent Installer Options (continued)

--reconcile <type>

--rpmbin <path>

--template <I/D>

Reconciles the server against any nodes assigned to the
server. The <type> can be full or addonly.

full - All nodes in a category are selected and reconcile
removes software that Opsware SAS did not install.

addonly — Software installed outside of Opsware SAS is not
removed.

WARNING:

When assimilating a server that is already functioning in the
operational environment, use caution when specifying the
option --reconcile. If you specify this option, you might
inadvertently uninstall software from the server.

Specifies the path to the RPM binary to use for RPM
operations. Use this option, when RPM is already installed on
the server, to point the Opsware Agent at the RPM binary.

Use the - -withrpm option to install RPM if a usable instance
of RPM is not already installed.

NOTE:
It is unnecessary to use this option with the
- -withrpm option.

Starts the Opsware Agent after installing it. By default, the
Opsware Agent Installer does not start the Opsware Agent.

Assigns the nodes contained in the template to the server.
<ID> can be an ID or a full name of a template.

If this option is specified with the - -reconcile option,
Opsware SAS assigns the nodes in the template to the server
before reconciling the server.

WARNING:

When assimilating a server that is already functioning in the
operational environment, use caution when you specify the
option --template. If you specify this option, you might
inadvertently uninstall software from the server.
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Table B-2: Agent Installer Options (continued)

--withmsi Installs MSI 2.0 along with the Opsware Agent. If MSI 2.0 is
already installed, this option has no effect. Works with
Windows NT 4.0 Service Pack 6a, Windows 2000, and
Windows 2003.

--withwmi Installs WMI 1.5 along with the Opsware Agent. If WMI 1.5 is
already installed, this option has no effect. Works with
Windows NT 4.0 Service Pack 6a.

--withrpm Installs the RPM handler with the Opsware Agent. By default,
an Opsware Agent is not installed with this option. Opsware
Inc. recommends that you always include the - -withrpm
option when you install Opsware Agents on Solaris servers.

NOTE:

Use the - -withrpm option only with the Opsware Agent
Installers for these operating systems: Solaris 5.6, 5.7, 5.8, and
5.9, and AIX 4.3 and AIX 5.1.

On Solaris, RPM 3.0.6 is installed in the directory /opt/
OPsSWrpm and the RPM database is installed in the directory /
var/opt/OPSWrpm/lib/rpm.

On AIX, RPM 3.0.5 is installed in the directory /opt/
freeware and the RPM database is installed in the directory
/var/opt/freeware/lib/rpm

--workdir <path> Specifies the path to the Opsware Agent Installer temporary
working directory. Use this option if the default working
directory causes problems with installation.
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Table B-2: Agent Installer Options (continued)

--reboot

--resetconf (-r)

--no_anonymous__
ssl (-A)

--opsw_gw-addr-
list

--remediate

--software policy

<id>

--installdir

<path>
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During Opsware Agent Installation on a Windows server, the
Agent Installer copies the ogshcap.dll file to the following
location:

$SystemRoot%\system32\ogshcap.dll

If the file is open or is in use, the Agent Installer is unable to
copy the ogshcap.dll file. The Agent Installer then informs the
user whether to restart the machine and copies the file after
restart.

You can specify the - -reboot Installer option in the Opsware
Command Line to initiate the reboot at the end of the Agent
installation.

Resets Opsware Agent configuration file to default the
settings.

Disables anonymous SSL. This option applies to dormant
Opsware Agents only. This option configures the Opsware
Agent so that browsers cannot connect without a valid
certificate.

Specifies the Opsware Gateways used during Opsware Agent
installation.

Remediates the server against any software policies attached
to the server.

Attaches server to the software policy <ID>.

Allows you to specify the directory where the Opsware
Agent will be installed. By default, the Agent is installed in /
opt/opsware/agent on UNIX, and
$ProgramFiles%\Opsware\agent on Windows.
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Table B-2: Agent Installer Options (continued)

--no_open_fw By default, the Opsware Agent Installer will modify the
Windows Firewall configuration on Windows XP and Windows
2003 (r2) servers to allow the Opsware core to contact the
managed server on port 1002. If you specify this option, the
firewall configuration will not be modified. The server may not
be manageable by Opsware in this case.

--settime (-t) Synchronizes the time on the server on which the Opsware
Agent is installed with that of the Opsware core.

NOTE:

If the server on which the Opsware Agent is being installed is
significantly ahead of the clock on the Opsware core, then the
clock on the managed server is set back in time. Since this
can cause problems, do not use the --settime option unless
you are sure that this scenario is not a problem in your
environment.

If a managed server's clock is significantly behind of the clock
on the Opsware core, the Opsware Agent installation might
fail. To install an Opsware Agent successfully, use the

- -settime option or manually set the time and date on the
managed server before retrying the Opsware Agent
installation.

Example: Opsware Agent Installer Command and Options

Enter the following command and options to install the Opsware Agent for Solaris 5.7 in
the default directories and log the results of the installation in the log file:

[}

% opsware-agent-14.2.12.5-solaris-5.7 --logfile opsware-agent-

installer.log --loglevel info

Enter the following command and options to install the Opsware Agent for Windows NT
4.0 in the default directories and log the results of the installation in the log file:

[}

% opsware-agent-14.2.12.5-win32-4.0.exe --logfile opsware-

agent-installer.log --loglevel info

456 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix B: Opsware Agent Utilities

Starting an Opsware Agent on a Server

If you do not include the -s option on the command line when you install an Opsware
Agent, you have to start the Opsware Agent on the server manually.

Enter the following command, which varies with the operating system:
Solaris:

/etc/init.d/cogbot start

Linux:

/etc/rc.d/init.d/cogbot start
AIX:

/etc/rc.d/init.d/cogbot start
HP-UX:

/sbin/init.d/cogbot start

Windows:

net start shadowbot

Verifying Opsware Agent Functionality

Perform the following steps to verify Opsware Agent functionality:

E From the navigation panel in the SAS Web Client, click Servers » Manage Servers.

The Manage Servers page appears. Browse the list to find the server whose
Opsware Agent installation you want to verify. If necessary, select the correct
customer and facility for the server and click Update.

Or
Search for the server whose Opsware Agent installation you want to verify.
Or

B Verify that the server appears in the Manage Servers list and has the correct
properties.

See “Using the Search Feature” and “Server Searching by IP Address” in Opsware

SAS User’s Guide: Server Automation for more information.

B If you want to discover reasons why a server is unreachable, you can run a

Communication Test. See “Agent Reachability Communication Tests” on page 114 in

Chapter 4 for more information.
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Augmenting the Information for a Managed Server

Use caution when you augment the discovery process for an Opsware-managed server
A that is functioning in the operational environment. You might inadvertently install or

uninstall software from the server. During the test remediate, verify what software will be

uninstalled from the server before you perform the actual remediate operation.

Perform the following steps to augment the information for an Opsware-managed server:

E Model the OS and other applications running on the server in Opsware SAS by
defining the OS with the Prepare Operating System Wizard and by creating nodes
and templates for applications running on the assimilated server.

See the Opsware® SAS Policy Setter’'s Guide for more information about Operating
System Definitions.

H Move the server to the appropriate nodes for the OS and installed applications.

The server is tracked in the SAS Web Client; however, the server operating system
cannot be managed while the server is assigned to the generic operating system
node. You must reassign the server to the operating system that was defined with
the OS Provisioning feature.

Remediate the server.

If an IP range group was set up, servers are automatically associated with customers
when users install an Opsware Agent on the servers. Otherwise, the servers are
associated with the Not Assigned customer. To change the customer associated with
a server, See “Editing the Properties of a Server” on page 244 in Chapter 7 for more
information.

B To specify the server's use, stage, and state, edit the server's properties. See “Editing
the Properties of a Server” on page 244 in Chapter 7 for more information.

Discovery is complete. Opsware SAS assumes that the server should always be running
the specific OS build it has been associated with. Any changes to the OS outside of
Opsware SAS are not captured in the model.

Users can deploy and manage new applications on the server, just as if Opsware SAS
initially provisioned the server. Users can also deploy OS level patches on the server, or
rebuild the OS by using the OS build with which the server was associated.

458 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix B: Opsware Agent Utilities

Uninstalling an Opsware Agent on Unix and Windows

To uninstall Opsware Agents on Windows NT, Windows Scripting Host 5.1 or Internet

Explorer 5.5 must be installed on Windows NT.

Perform the following steps to uninstall an Opsware Agent on Unix or Windows:

Log into Unix as root user. Log into Windows as Administrator.

Change directories to any directory other than the Opsware Agent's installation
directory.

On Unix, enter the following command:
<installation directorys/bin/agent uninstall.sh

By default, for Solaris and AlX, the Opsware Agent Uninstaller will not remove the
Opsware RPM package. For command line options for the agent uninstaller,
including how to activate removal of the Opsware RPM package, See “Opsware
Agent Uninstaller Options” on page 459 in this appendix for more information.

On Windows, enter the following command:
msiexec /x <installation directorys>\bin\agent uninstall.msi

As the uninstall proceeds, the Unix platform stdout shows the uninstallation
progress. The Windows uninstall does not show uninstallation progress.

Opsware Agent Uninstaller Options
When you use the Opsware Agent Uninstaller, you can include the options that Table B-3
and Table B-4 show.

Table B-3: Opsware Agent Uninstallation Unix Options

--uninstallerVersion @ Show the uninstaller version.

--help Show this help.
--no_deactivate Do not deactivate the server; by default, the server is
deactivated.
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Table B-3: Opsware Agent Uninstallation Unix Options (continued)

--force Do not prompt for confirmation before deactivating the
server.
--delete opsw_rpm Remove the OPSW RPM package (AlX, Solaris only). Use

the following commands to remove the RPM package:
Solaris: pkgrm -n OPSWrpm

AlX: installp -u rpm.rte

Table B-4: Opsware Agent Uninstallation Windows Options

NO DEACTIVATE="1" Do not deactivate the server; by default the server is
deactivated.

FORCE="1" Do not prompt for confirmation before deactivating the
server.

During Opsware Agent Uninstallation on a Windows server, the Agent Installer removes
the ogshcap.dll file from the following location:

$SystemRoot%\system32\ogshcap.dll
If the file is open or is in use, the Agent Installer is unable to remove the ogshcap.dll file.
The Agent Installer then prompts the user to restart the machine and removes the file
after restart.
Uninstalling Earlier Versions of Opsware Agents on Unix
Perform the following steps to uninstall Opsware Agents versions 5.1 and earlier:
H Stop the Opsware Agent on the server by running the following command as root:
Linux:

/etc/rc.d/init.d/cogbot stop
Solaris:

/etc/init.d/cogbot stop

HP-UX:
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/sbin/init.d/cogbot stop
AIX:
/etc/rc.d/init.d/cogbot stop

H Deactivate or delete the server by using the SAS Web Client Server menu.

For Linux servers only, run chkconfig to de-register the Opsware Agent
initialization script:

% /sbin/chkconfig -del cogbot

Bl As root, delete the following files and directories to remove the Opsware Agent files
from the server:

Linux:
/etc/rc.d/init.d/cogbot
Solaris:
/etc/init.d/cogbot
/etc/rc2.d/S79cogbot
/etc/rc0.d/K44cogbot
HP-UX:
/sbin/init.d/cogbot
/sbin/rc2.d/cogbot
AlX:
/etc/rc2.d/init.d/cogbot
/etc/rc.d/S79cogbot
All Unix:
/opt/OPSW

/var/lc

Uninstalling Earlier Versions of Opsware Agents on Windows
Perform the following steps to uninstall earlier versions of Opsware Agents on Windows:

H Stop the Opsware Agent by running the following command as administrator:
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C:\> net stop shadowbot
H Deactivate or delete the server by using the SAS Web Client Server menu.

E Deregister the Opsware Agent service by running the following command as
administrator:

C:\> "%SystemDrive%\Program
Files\Loudcloud\blackshadow\watchdog\watchdog.exe" -x

Bl As administrator, delete the following directories to remove the Opsware Agent:
"$SystemDrive%\Program Files\Loudcloud"

"$SystemDrive%$\Program Files\Common Files\Loudcloud"

Opsware Agent Upgrade Tool

This section contains the following topics:

+ Ways to Upgrade Opsware Agents

» Prerequisites for Using the Opsware Agent Upgrade Tool
« Upgrading the Opsware Agent on Managed Servers

+ Commands for the Opsware Agent Upgrade Tool

« Options for the Opsware Agent Upgrade Tool

« Example: Options for the Opsware Agent Upgrade Tool

+ Example: Commands and Output for Agent Upgrade Tool

Ways to Upgrade Opsware Agents

After you upgrade Opsware SAS running in a facility, you should upgrade the Opsware
Agents on every managed server to the new version, so that you can utilize the new
features in the newly-upgraded core.

Opsware SAS features continue to work on a managed server even when it is running an
older Opsware Agent. However, new features in the new versions might not be available
for that server.

Refer to the Release Notes for the new version for information about the compatibility of
new features with older agents.

You can upgrade the Opsware Agents on managed servers in the following ways:
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Use the Opsware Agent Installer (a command line interface) to install a new Opsware
Agent on one server at a time.

See “Agent Installation Using the CLI" on page 445 in this appendix for information
about how to use the Opsware Agent Installer.

Use the Opsware Agent Upgrade Tool to upgrade Opsware Agents on groups of
servers. Running the tool upgrades deployed Opsware Agents on managed servers.
You can run the script simultaneously on many servers to upgrade large groups of
Opsware Agents.

The Opsware Agent Upgrade Tool has the following characteristics:

It is a command line interface that provides a flexible mechanism for selecting servers
to upgrade, and for monitoring and reviewing upgrade operations.

You can use it to upgrade many Opsware Agents on managed servers simultaneously.

It runs within your preferred Unix shell, allowing it to leverage the power of standard
Unix shells and text processing tools.

You can use it to upgrade a server in any facility running Opsware SAS. You can run it
from an Opsware shell attached to any Opsware SAS in any facility.

The Opsware shell is a program that authenticates users in Opsware SAS, starts the
user's normal Unix shell (as specified in the standard password database). Using the
Opsware shell allows the user to run the Opsware Agent Upgrade Tool in this facility.

Prerequisites for Using the Opsware Agent Upgrade Tool

+ On a core server of the facility being upgraded, install the Opsware Shell RPM by

downloading the opsh package from the SAS Web Client. See the Opsware® SAS
Content Migration Guide for instructions on downloading a package.

Installing the opsh RPM places the Opsware shell and the Opsware Agent Upgrade
Tool in the directory /opt/OPSWopsh/bin.

You need the correct permissions to upgrade Opsware Agents. Run the Opsware shell
by specifying the Opsware admin user and password to ensure that you have the
appropriate permissions. (Contact your Opsware administrator to obtain the password.)

When you start an Opsware shell to run the Opsware Agent Upgrade Tool, the user
name and password are authenticated by Opsware SAS.

The server where you install the opsh RPM must be able to resolve the name
way.<facility-domain> to the host running the Command Engine in the facility’s
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core. For example, if the Command Engine runs on a host in the prod. opsware.com
domain, the servers must resolve the name way .prod.opsware. com. You specified
the facility-domain when you installed the core.

Upgrading the Opsware Agent on Managed Servers

To upgrade the Opsware Agent, perform the following steps:

H After you install the opsh RPM on a core server, enter the following command as root
to start the Opsware shell:

opsh [username@] facility-domain
For example:
opsh admineprod.opsware.com

See the preceding section for the name resolution requirement for facility-
domain. See “Commands for the Opsware Agent Upgrade Tool” on page 465 for
more information on opsh.

B (Optional) To obtain information about the current Opsware Agents running on the
managed servers before you upgrade them, enter any of the following commands
and options:

opsh_agent query server-options

(Enter this command if you want to view a report of the Opsware Agent versions
running on the servers before you upgrade them.)

opsh agent verify server-options schedule-options \
agent-version

(Enter this command if you want to verify the versions of the Opsware Agents
running on the managed servers before you upgrade them.)

HE To upgrade Agents on specified servers, enter the following Opsware Agent Upgrade
Tool commands and options:

opsh _agent stage server-options schedule-options \
[--always] agent-version

(Enter this command if you want to download the package for the Opsware Agent to
the managed server before you run the upgrade.)

opsh _agent upgrade Server-options schedule-options \
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[--always] agent-version

Bl (Optional) To review the status of the Opsware Agent upgrade, enter the following
command and option:

opsh _agent review session-id

Commands for the Opsware Agent Upgrade Tool
* opsh [usernamee] facility-domain

This command starts an Opsware shell and authenticates the user name against the
Opsware facility running at the specified domain.

If you do not specify a user name, the currently logged in user name is used. The
Opsware shell prompts for a password.

A new Unix shell (which is attached to the specified Opsware core-domain) is started.
(The password database for the user specifies which Unix shell to use.)

* opsh_agent query server-options
This command must be run from an Opsware shell started with the opsh command.

This command queries the reported version of Opsware Agents and any staging status
for the specified servers by examining data in the Model Repository.

One line is printed to stdout for each server that shows device ID, IP address, current
Opsware Agent version, and any staging status.

You can specify the servers by using the --device, --customer, --facility,
and --os options.

* opsh _agent stage server-options schedule-options \
[--always] agent-version
You must run this command from an Opsware shell started with the opsh command.

This command contacts the Opsware Agent on each specified server and instructs it to
download the package for the specified version of the Opsware Agent from the
Software Repository.

If the download is successful, the staging status is written to the Model Repository for
the server.

To download the package to the server even when this command was entered
previously (recorded in the Model Repository), specify the --always option.
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One line is printed to stdout for each server that shows the device ID, IP address, and a
success or failure indicator.

You can specify the servers by using the --server, --customer, --facility
and --os options.

A session is started and the session ID displays for later review. After the session ID
displays, you can type CTRL-C and review the session later using the opsh_agent
review command.

* opsh_agent upgrade server-options schedule-options \
[--always] agent-version
You must run this command from an Opsware shell started with the opsh command.

This command contacts the Opsware Agent on each specified server and instructs it to
upgrade to the specified version. If the necessary package has not been downloaded
on the server already (the opsh_agent stage command was entered), the package
is downloaded from the Software Repository.

If the upgrade is successful, the package is removed from the server and the staging
status is deleted from the Model Repository.

To upgrade the Opsware Agent even when the specified version of the Opsware Agent
was already installed on the managed servers, enter the - -always option. (The Model
Repository records when Opsware Agents are upgraded on servers.)

One line is printed to stdout for each server that shows the device ID, IP address, and a
success or failure indicator.

You can specify the servers by using the - -server, --customer, --facility,
and - -os options.

A session is started and the session ID displays for later review. After the session ID
displays, you can type CTRL-C and review the session later by using the opsh_agent
review command.

* opsh_agent verify server-options schedule-options \
agent-version
You must run this command from an Opsware shell started with the opsh command.

This command contacts the Opsware Agent on each specified server to verify that it is
running the specified version.
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One line is printed to stdout for each server that shows the device ID, IP address, the
word OLD, NEW, or CURRENT and the actual Opsware Agent version running on the
server.

You can specify the servers by using the --server, --customer, --facility,
and - -os options.

A session is started and the session ID displays for later review. After the session ID
displays, you can enter CTRL-C and review the session later by using the opsh_agent
review command.

* opsh agent review session-id

You must run this command from an Opsware shell started with the opsh command;
although, not necessarily the same Opsware shell from which the original command
was started.

This command attaches to a running opsh_agent stage, opsh_agent
upgrade Or opsh agent verify session running on the Command Engine. It
prints the same output to stdout that the original command would have printed if the
user had not typed CTRL-C and terminated the command. If the session is complete, it
shows the same results that were shown when the session completed.

Options for the Opsware Agent Upgrade Tool
Server-options: --server|-S <svr-specs> --customer|-C <cust-spec>
--facility|-F <fac-spec> --o0s|-0 <os-spec>

If more than one of the - -customer, --facility, or --os options is specified, only
servers that match all options are selected. Any servers specified by using the - -server
option are added to (or subtracted from) the list specified by combining the

--customer, --facility, and --os options.

Table B-5: Options for the Opsware Agent Upgrade Tool

--server -S <svr-spec> | Server by device ID, IP address, or system name

--customer | -C <cust-specs> | All servers associated with the customer
specified by the customer ID or name
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Table B-5: Options for the Opsware Agent Upgrade Tool (continued)

LONG OPTION

SHORT

OPTION

VALUE

MEANING

--facility | -F <fac-spec> | All servers in the facility specified by the facility ID
or name
--os -0 <0os-specs> All servers running the operating system

specified by the OS name

Schedule-options: - -when | -W when-time --until|-U until-time

Table B-6: Schedule Options

LONG OPTION

--when

SHORT
OPTION

-W

VALUE

<when-time>

MEANING

Start time for a stage, upgrade, verify, or test
operation in the format:

MM/DD/YYY-HH:MM

If the - -when option is used, the operation starts
at the specified time, but the command displays
a session ID and returns immediately.

When you schedule an operation, you use the
review command to review the results after the
operation has run.

If the - -when option is not specified, the
operation starts immediately and the command
displays the output of the command.

--until

<until-time>  End time for a stage, upgrade, verify or test

operation in the format:
MM/DD/YYY-HH:MM

If the - -until option is specified, the operation
stops processing servers at the specified time.
Any servers that are not complete are left in a
consistent state; this might require that the
session run past the specified time.
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Miscellaneous options:
--ip|-I --always|-A --parallel|-P --theword|-T

Table B-7: Miscellaneous Options

SHORT

LONG OPTION OPTION VALUE MEANING

--ip -1 (N/A) Display IP addresses instead of host names.

--always -A (N/A) Always stage or upgrade servers even if the
current version is staged or upgraded.

--parallel | -P <Concurrency> The maximum of concurrent commands.
(Recommended default = 10)

--theword -T <hostname> The host name or IP address to use when
contacting the Software Repository from a
server.
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Example: Options for the Opsware Agent Upgrade Tool

The following table provides examples for running the Opsware Agent Upgrade Tool.

Table B-8: Examples of Options for the Opsware Agent Upgrade Option

--server 1,2 Selects servers 1 and 2.

--facility Y, 2 Selects all servers (for all customers) in
facilities Y and Z.

--customer -A,-B --facility Z | Selects all servers in facility Z except those
owned by customers A and B.

--server 1,2,-3,-4 --customer Select servers 1 and 2 as well as all

A,B --facility Y, 2 servers owned by customers A or B which
are in facilities Y or Z except servers 3 and
4.

--gserver 1,-2 --customer A,B --| Select server 1 and all servers owned by

facility -Y,-Z --os SunOS 5.8 | cystomers A or B, except those in facilities
Y or Z and which are Solaris 5.8 machines
excluding server 2.

Example: Commands and Output for Agent Upgrade Tool

# cd /opt/OPSWopsh/bin

# ./opsh admineprod.opsware.com

admin@prod.opsware.com's password:

#

# ./opsh agent verify --os "SunOS*" 14a.2.12.18

Session 37802500101L

Device ID Name/IP address Version Result Status Reason
410101L core2-1l.prod.opsware.com 14a.2.12.18 CURRENT SUCCESS
e

Interrupted review of running session 37802500101L
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Use review 37802500101L command anytime to review session status
#

# ./opsh _agent review 37802500101L

Session 37802500101L

Device ID Name/IP address Version Result Status Reason

410101L dO33.prod.opsware.com 14a.2.12.18 CURRENT SUCCESS
670101L dhcp-174.prod.opsware.com 1l4a.2.12.16 OLDER SUCCESS
1460100L emb218-37.manu.opsware.com l4a.2.12.18 CURRENT SUCCESS
20100L fO00l.manu.opsware.com 14a.2.12.18 CURRENT SUCCESS

10100L £f002.manu.opsware.com l4a.2.12.21 NEWER SUCCESS

210100L mO22.manu.opsware.com 14a.2.12.18 CURRENT SUCCESS

Session 37802500101L completed.

Opsware Agent Upgrade Custom Extension

Opsware SAS includes a custom extension ("AgentUpgrade") that you can use to
upgrade Opsware Agents from the previous three versions.

The Custom Extension feature is accessed through the Run Custom Extension Wizard.
This Wizard allows a user to choose a custom extension to run, specify necessary input
data for the extension, validate the data required to run the extension, run the extension,
and view or download the results from the job. When a user runs a custom extension, the
job shows up in My Jobs.

To access the Run Custom Extension Wizard, users must be assigned to a user group
that has the permission Wizard: Opsware Extension. When users have this permission,
they can run any custom extensions on the servers they have access to in the SAS Web
Client.

See Chapter 10, “Opsware SAS Custom Extensions” on page 352 of this guide for more
information.

Any user who has the ability to run custom extensions can run the Agent Upgrade
Custom Extension.
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The Agent Upgrade custom extension only upgrades agents that are not up-to-date.
Therefore, rerunning the custom extension on a group of servers will not affect servers
that are already running the most recent version of the Opsware Agent.

Upgrading Agents with the Agent Upgrade Custom Extension

To run the Agent Upgrade custom extension, perform the following steps:

E From the SAS Web Client home page, click the Run Custom Extensions link in the
Tasks panel.

Or

From the navigation panel, click Servers » Manage Servers. The Manage Servers
list appears. Select the servers on which you want to run a custom extension and
choose Run Extension from the Tasks menu.

The Run Custom Extension Wizard appears.
B Select the "AgentUpgrade" custom extension and click Next.

If you have not already selected servers from the Manage Servers list, the Select
Servers page appears.

HE If prompted, select the servers or groups on which you want to run the custom
extension and click Next. You can find the servers that you want to run a custom
extension on by browsing the list or by searching.
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The Agent Upgrade Settings page appears as shown in Figure B-12:

Figure B-12: Specify Settings Page for the Agent Upgrade Custom Extension

Specify Settings

Enter values for each field (bold items are required) to run this extension.
Mouse over the note icon (52 for directions on setting the values correctly.

:j AgentUpgrade

Operation Mode: | Stage Package v | &
Agent Version: | 3250175 + | &

Flags to pass to the agent @},
installer:

Perform stage/upgrade even Oives ® Mo ﬁ;}
if not needed:

Bl Specify the settings for the custom extension and click Next.
« Select the Agent Upgrade action you want to perform:

» Stage Package: Downloads the Opsware Agent Installer package (the binaries)
but does not upgrade the Opsware Agent.

» Perform Upgrade: Upgrades the servers to the specified Opsware Agent
version by downloading the Agent Installer package (binaries) if not previously
staged. If the Agent Installer package was already staged, upgrades the
Opsware Agent version by using the staged version of package on the server.

» Verify Upgrade: Check whether all the servers are running the selected
Opsware Agent version.

« Select the Opsware Agent version to upgrade to. All agent versions available in the
Software Repository are displayed in the list. By default, the latest version available
in the Software Repository is selected.

+ Enter additional parameters to pass to the Opsware Agent Installer. The Agent
Upgrade custom extension does not validate the parameters you enter. See
“Opsware Agent Installer Options” on page 452 in this chapter for information
about the parameters you can enter in this field.
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« Specify whether the custom extension should upgrade Opsware Agents even if the
version of the currently running agent is equal to or greater than the version being
upgraded to.

The Confirm Settings Screen appears and displays the selected options.

B Review the values that you entered and the servers that you selected on which to run
the Agent Upgrade custom extension. (You can remove servers from the list by
deselecting their check boxes. Click the “Show remaining servers” link to display the
complete list of selected servers.)

Click Next.
On the Schedule and Notify page, you have the following options:

* Notify: Choose the Condition option and set the parameters to send an email
when the operation is completed. You can choose to have an email sent on any
result, if the operation fails, or if the operation is successful. To add another email
recipient, click the plus (+) button next to the Recipients field.

+ Schedule: Choose either Run Now to execute the operation immediately, or
choose Specify Time to schedule the operation for a later time.

When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

« Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of
the servers that the job will run on.

» Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

The time used for the scheduled job is specified in your preferred time zone which can be
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).
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El Click Run to start the Custom Extension Wizard.

If you selected to run the job at that time, a progress bar appears for the servers on
which the extension is running that shows the progress of the job.

El When the custom extension finishes running, you can click View Details to see the
results. The Custom Extension Results window appears. The results window contains
a tab for the operation summary and a tab for the operation details.

By default, the Summary tab is displayed.

Figure B-13: Summary Tab in the Details Window of the Agent Upgrade Custom Extension

https:ffocc.c39. dev.opsware.com - Opsware Server Automation System Web Client - Mozilla Firefox [Z|

Custom Extension Results

iz AgentlUpagrade

" Summary \||{ Details ~]

Operation Mode
Ferform Upgrade

Agent Version
32a.0.1.78

Result
1 succeeded, O failed, 0 were skipped

Daone occ.c39.dev. opsware.com (7

The Details tab contains a table with one row for each server selected. The table in
each tab includes the following columns:

+ Name: The name of the server

« Agent Version: The agent version running on the server after the custom
extension completes

» Reason: If an operation failed, a text description of the reason the operation failed
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* Result: (Only shown for Verify operations) Shows the result of the verification:
» OLDER: The agent on the server is older than the selected version
« UP TO DATE: The agent on the server is up to date

+ Status: The exit status of the command SUCCESS or FAILURE

Figure B-14. Details tab in Results Window for the Agent Upgrade Custom Extension

https:ffocc.c39.dev.opsware.com - Opsware Server Automation System Web Client - Mozilla Firefox

Custom Extension Results

@ AgentUpgrade

| Summary || Details W

w Agent Yersion Reason Result Status

EH mi09 dev opsware com | 32a.01 78 SUCCESS
Done oce, 039, dev. opsware. com ﬂ

K When you are done viewing the results, click Close to close the window.

After you close the wizard, you can view the progress of the custom extension by
viewing My Jobs (accessible from the Home page or the navigation panel). Each

custom extension job is identified with the name Run Custom Extension. Click the
name link to identify which extension was run.

See “Server Management Scheduling and Notification” on page 253 in Chapter 7 for
information about the My Jobs feature.
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This section discusses the following topics:
+ aaa Utility
+ rosh Utility

« swenc Utility

aaa Utility

The aaa utility grants and revokes permissions for operations on managed servers. These
permissions are stored in the /opsw/Permissions directory of the OGFS. For details
on the contents of the directory, see “/opsw/Permissions Directory” on page 499.

aaa Syntax

The aaa utility has the following syntax:

aaa shell-perm (grant | revoke) -o operation [-u user-group]
[-f facility | -c¢ customer | -g device-group [-s | -1 login]]

Table C-1 describes the command options and Table C-2 lists the operations that can be
granted or revoked the aaa utility.

Table C-1: aaa Options

-0 operation The operation on which to grant or revoke
the permission. For a list of allowed values,
see the Operation column in Table C-2.
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Table C-1: aaa Options

-u user-group

-f facility

-Cc customer

-g device-group

-1 login

aaa Usage Rules

The Opsware user group that is assigned
the permission. This value is inferred from
the current working directory if it
corresponds to a user group. If it cannot be
inferred, specify a user group.

The name, ID, or path to a facility, such as:
/opsw/Facility/Chicago
Permission will be granted to all servers in
this facility.

The name, ID, or path to a customer, such
as:

/opsw/Customer/Alpha

Permission will be granted to all servers
that belong to this customer.

The name, ID, or path to a public device
group, such as:
/opsw/Group/Public/Unix Servers
Permission will be granted to all servers
that belong to this group. To specify the
device group by name, omit the following:
/opsw/Group/

A login account on the servers that are
specified by the - £, -c, or -g option. On a
Unix server, for example, the login is the
Unix user name. Login accounts with multi-
byte characters are not supported.

The login account on the servers (specified
by -f, -c, or -g) is the same as the
Opsware user name.

The following usage rules and recommendations apply to the aaa utility:
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« For operations that are performed on a server, one of the - £, -c, or -g options is
required.

+ As a best practice, when you are granting permissions, use care when you select
servers so that you do not capture more servers than you intend. This is particularly
important when using the -c or - £ option. For example, if you want to grant permission
to the loginToServer operation for all servers in the Chicago facility as root, you
could use the - £ option to select all servers in a particular facility. However, this may
also select Windows servers, which is probably not desired since the root user does
not typically exist on Windows servers. In this case, you should define a public device
group that only includes servers in the Chicago facility which are running a Unix
operating system.

« If you specify the - £, -¢, or -g option, you must also specify either the -s or -1 option.
The choice of the -s or -1 option depends on the policies of your organization. If users
log into managed servers with generic user names (such as root), then you should
specify the -I option. If users log into managed servers with individual user names,
which are the same as their Opsware user names, they should specify the -s option.

+ The - £ and -c options are provided as a convenience; however, in general, it is
recommended that you define permissions based on device groups instead.

+ The revoke command can only remove a permission that was previously granted. If
the permission was not previously granted, the revoke command has no effect.

+ The revoke command only removes a permission for a specific user group. If a user
has overlapping permissions, revoking permissions from a single user group will not
prevent the user from performing that operation. For example, suppose a user belongs
to two user groups that both have the 1aunchGlobalShell permission. If this
permission is revoked from only one of those user groups, the user still has the
launchGlobalShell permission.

aaa Examples

The following example gives all members of the Advanced Users group permission to
open a Global Shell session:

aaa shell-perm grant -o launchGlobalShell \
-u ‘Advanced Users’

The next example gives all members of the Unix Admin user group permission to log in
as root to all servers inthe Public/Unix Servers device group:

aaa shell-perm grant -o loginToServer -u ‘Unix Admin’\
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-g ‘Public/Unix Servers’ -1 root

The following example removes the permission for the Unix Admin user group to log
into servers that belong to the device group named Public/Unix Servers. The
command applies to any login, because the -1 option is not specified.

aaa shell-perm revoke -o loginToServer -u ‘Unix Admin’\
-g ‘Public/Unix Servers’

Global Shell Operations (Permissions)

The actions that an Opsware user can perform within the Global Shell are determined by
the operations specified by the aaa utility. Most of these operations, such as
readServerFilesystem, can be granted on both managed servers and on a login
basis. The login is the user name on the managed server, such as the Administrator user
on Windows or root on Unix.

A login is not specific to a particular platform (operating system). For example, if the
permissions specify that a user can read the file system as root, then root will appear
under the files subdirectory, regardless of the platform. The Server Explorer of the SAS
Client displays the login names that you have been authorized to access that server's file
system.

The operations are listed in the /opsw/Permissions directory of the OGFS.

Table C-2 identifies and describes the server operations in Global Shell. In the table, the
On Server column identifies which operations can be granted for a set of managed
servers, and the On Login column identifies the operations that can be granted for
specific logins (users).

Table C-2: Global Shell Operations

launchGlobalShell Launches the Global Shell. No No

loginToServer Opens a shell session on a Unix server. In | No No
the SAS Client, this is the Remote Terminal
feature that opens a terminal window for a
Unix server.

readServerComplus Reads COM Plus objects as a specific login. | Yes Yes
In the SAS Client, use the Server Explorer to
browse these objects on a Windows server.
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Table C-2: Global Shell Operations (continued)

readServerFilesystem

readServerMetabase

readServerRegistry

relayRdpToServer

runCommandOnServer

runTrustedOnServer

writeServerFilesystem
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Reads a managed server as a specific login.
In the SAS Client, use the Server Explorer to

browse the file system of a managed server.

Reads IS Metabase objects as a specific
login. In the SAS Client, use the Server
Explorer to browse these objects on a Win-
dows server.

Reads registry files as a specific login. In the
SAS Client, use the Server Explorer to view
the Windows Registry.

Opens an RDP session on a Windows
server. In the SAS Client, this is the Remote
Terminal feature that opens an RDP client
window for a Windows server.

Runs a command or script on a

managed server using a rosh

operation, where that command or script
already exist. In the SAS Client, this is used
for Windows Services when you use the
Server Explorer.

Runs a shared saved script (which is stored
in /opsw/Script/Shared) on a man-
aged server.

Modifies files on a managed server as a
specific login. In the SAS Client, use the
Server Explorer to modify the file system of a
managed server.

Yes

Yes

Yes

No

Yes

Yes

Yes

Yes

Yes

Yes

No

Yes

Yes

Yes
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rosh Utility

The Remote Opsware Shell (rosh) command makes a client connection that enables
you to remotely run programs on managed servers. You invoke the rosh command from
within a Global Shell session.

rosh Syntax
For servers, the rosh command has the following syntax:

rosh (-n server-name | -i server-id) [-d dir] [-1 login-name]
[-s] [-t | -T] [command [arg ...]]

For network devices, the rosh command has the following syntax:

rosh (-n device-name | -i device-id) [-N] [-C comment]
[-L] [-P parameters] [-s] -[-V variables] [command [arg ...]]

Table C-3 describes the rosh options of the preceding syntax statements.

Table C-3: rosh Options and Commands

-C comment A comment for the log of a network script invocation.

-d dir Sets the working directory (path) on the remote server. The
default is the remote user's home directory.

-1 server-id Specifies the server by its ID, which must already exist in the
/opsw/ .Server. ID directory.

-1 login-name | Specifies the login name of the remote user who performs
operations on a remote server, which must already exist in the
/opsw/Server directory.

-L The network script should be run line-by-line.
-m Network device mode.

-n server-name Specifies the server by its name, which must already exist in
the /opsw/Server directory.

-N The -i or -n option refers to a network device instead of a
server.

-P parameters | Parameters for a network advanced script.

-r Relays RDP data to a managed server (on Windows).
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Table C-3: rosh Options and Commands (continued)

-s script-name Treats a command as the name of a saved script that will be
sent to and run on the remote server.

-t Forces the remote session to run in a pseudo terminal (for
Unix servers only).

-T Forces the remote session to run without a pseudo terminal
(for Unix servers only).

-V variables Variables for a network command or advanced script.

-w seconds Inactivity timeout.

-W seconds Overall timeout.

command Runs a program or saved script.
[args . . .]

rosh Usage Rules
The following usage rules apply to the rosh program:

« Specify either the -n or -1 option to log into or run programs on a managed server.
These options are mutually exclusive, but if both are specified the -1 option has
precedence.

« If neither the -n, -1, and id options are specified, the managed server can be
inferred if your working directory is at or below:

/opsw/Server/.../server-name/

Or
/opsw/ .Server.ID/server-id/
« If -r is specified, no other option (excluding -n or -1i) can be specified.

« If -1 is not specified, the login-name can be inferred if your working directory is at or
below:

/opsw/Server/.../server-name/files/login-name/

Or

/opsw/ .Server.ID/server-id/files/login-name/
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« If -s is specified and command is a saved shared script with a setuid policy, the
login-name specified by the -1 option will be overridden. In this case, the -1 option
may be omitted. These scripts are stored in /opsw/Script/Shared.

« If your working directory is not below server/files/login-name and -d is not
specified, the cwdpath defaults to the home directory for login-name. To default to
the home directory, you must specify -1.

« For network scripts, if your current working directory is below a network device directory
in the OFGS, you do not need to specify the device with -N, -n or -i. The network
device is implied by the current working directory.

« For network scripts, if the full path of the script is not specified, rosh uses the search
path indicated by the NETWORK SCRIPT_ PATH environment variable. If this variable
is not set, rosh searches for the script in these directories:

/opsw/Script/Network/Command/
/opsw/Script/Network/Diagnostic/
/opsw/Script/Network/Advanced/

rosh Operations

The rosh command establishes a client connection which enables you to remotely run
programs on managed servers. The Opsware Global Shell feature provides the following
modes of operation for rosh:

« jump: This operation starts a shell session in a pseudo-terminal on a managed server.
This mode operates when you do not use the -s option and when you do not specify a
command or a script. You must have the loginToServer permission on the
managed server to jump.

» reach: This is a remote execution of commands that are native to the platform
(operating system) of the managed server. This mode operates when you specify a
command. You must have the runCommandOnServer permission on the managed
server to reach.

» push: This is a remote execution of a script on a managed server. The script is stored in
the OGFS and is sent to the managed server by rosh. Depending on the type of script,
the following permissions may be required:

« For shared saved scripts, which are stored in /opsw/Script/Shared, you can
require the runTrustedOnServer permission on the managed server or other
permissions that are specified by the policy of the script.
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+ For any other script file, you must have the runCommandoOnServer permission on
the managed server.

rosh Examples

The following examples illustrate what these operations look like for an Opsware user
named psi at this path:

/opsw/Server/@/salish.snvl.corp.opsware.com/files/root/etc

[psi@ml68 etc] (538) $ uname -n; id; pwd
mlé68.dev.opsware.com

uid=59796 (psi) gid=59796 (psi) groups=59796 (psi)
/opsw/Server/@/salish.snvl.corp.opsware.com/files/root/etc

The rosh jump command would display the following information about the managed
server:

[psi@mle8 etc] (539) $ rosh

[root@salish etcl# uname -n; id; pwd
salish.snvl.corp.opsware.com

uid=0 (root) gid=0 (root)

groups=0 (root) ,1(bin), 2 (daemon) , 3 (sys),4 (adm),6 (disk),10 (wheel)
,12(mail), 7(1lp), 4 (adm), 9 (kmem) , 6 (disk),5(tty),3(sys), 2 (daemon),
8 (mem)

/etc

[root@salish etcl# logout

The rosh reach command displays the following information about the managed server:

[psi@mlée8 etc] (541) $ rosh "uname -n; id; pwd"
salish.snvl.corp.opsware.com

uid=0(root) gid=0 (root)

groups=0 (root) ,1(bin), 2 (daemon) , 3 (sys) ,4 (adm),6 (disk),10 (wheel)
,12(mail), 7(1lp), 4 (adm), 9 (kmem) , 6 (disk) ,5(tty),3(sys), 2 (daemon) ,
8 (mem)

/etc

The rosh push command displays the following information about the managed server:

[psieml168 etc] (544) $ cat /tmp/who.sh

#!/bin/sh
uname -n
id
pwd

[psieml168 etc] (543) $ rosh -s /tmp/who.sh
salisgh.snvl.corp.opsware.com
uid=0(root) gid=0 (root)
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groups=0 (root) ,1(bin), 2 (daemon) , 3 (sys) ,4 (adm),6 (disk),10 (wheel)
,12(mail), 7(1lp), 4 (adm), 9 (kmem) , 6 (disk) ,5(tty),3(sys), 2 (daemon) ,
8 (mem)

/etc

The following example runs a script on a network device:

$ cd /opsw/Network/@/sw-ee-1-2b
$ rosh -s -C 'Updating device location' \

-V 'Location=Opsware - Sunnyvale' 'Set Location'
run script task 8725081 completed successfully.
Results:

Script 'Set Location for Cisco IOS configuration (for drivers:
Cisco switcheg, Catalyst 2950, 3550, 3750 & 8500 series, IOS
version 12.x)' completed.

swenc Utility

The swwenc command enables you to switch the character encoding within a Global
Shell session.

swenc Syntax
The swenc command has the following syntax:

swenc [-e encoding] [-T {on | off}] [-E] [-x] [-c command]

Table C-4 describes the swenc options.

Table C-4: swenc Options

-¢ command Executes command and exits, reverting
the session encoding to its previous state.

-E Lists the valid character encodings.

-e encoding Changes the character encoding of the
current session.

-T {on | off} Turns on or off the transcoding of data from
the Unix managed server. (Data from Win-
dows servers does not need to be
transcoded.) See “Transcoded Data in a
Managed Server” on page 318.
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Table C-4: swenc Options

-x Prevents the launching of a sub-shell.

swenc Usage Rules

The following usage rules apply to the swenc utility:

.

If you specify no options, swenc displays the character encoding and transcoding
mode of the current session.

Unless you specify the -x option, swenc starts a new sub-shell, which uses the
encoding specified with the -e option. To leave the sub-shell and revert to the previous
encoding, enter exit.

Changing the encoding with swenc affects all processes in the current session,
including background processes. If you change the encoding while background
processes are running, the background processes might encounter errors.

The swenc command affects only the current Global Shell session. For example, if you
run the rosh command after the swenc -e command, the rosh command does not
inherit the encoding that you changed with the swenc command.

The swenc command does not change the working directory of the session, unless the
working directory contains path names that cannot be represented in the new
encoding. In this case, the working directory is the user's home directory.

If you change the character encoding, make sure that the encoding of the terminal
application that hosts the Global Shell and Remote Terminal sessions is set properly. To
view or change the terminal client, go to the Terminal and Shell Preferences of the
Opsware SAS Client.
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This section discusses the following topics:
+ Directories in the OGFS

« root (/) Directory

« /opsw Directory

« /opsw/Server Directory

« Other Directories Under /opsw

* Network Directories

Directories in the OGFS

The Opsware Global File System (OGFS) is accessible from within a Global Shell session.

Many directories contain similar files. The id file contains the Opsware SAS unique
identifier (primary key) for the object represented by the directory. The .info file contains
text describing the properties of the object. The attr directory contains text files that
describe the attributes of the managed server. The self file represents this specific
server object (instance). The method directory contains executables that invoke the
methods in the Opsware SAS API. For more information see the TBD unified api guide.

In the directory listings that follow, the italicized text represents variable paths (specific
instances of objects in the data model). For example, server-1 is the name of a specific
managed server. The italicized text in parentheses contains comments.

root (/) Directory

At the root level of the OGFS is a directory for each Opsware user. Each user directory
and all files and directories under it are visible only to processes in an authenticated
session.
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Each Opsware user has the following private directories:
* A home directory which is at /home/user-name (Opsware user name)
« Temporary directories located at /tmp, /var/tmp and /usr/tmp

Each user's home directory contains a public directory (/home/user-name/public)
which is readable by all other Opsware users and can be used to share files with other
Opsware users.

The root directory has the following structure:

/. (root)
bin/
dev/
etc/
home/
lc/
lib/
opsw/
opt/
proc/
sys/
tmp/
usr/
var/

/opsw Directory

The opsw directory represents the data model of Opsware SAS. For example, the
/opsw/Customer directory represents customer objects in the data model. Global Shell
scripts and other client applications can navigate within the data model in the OGFS.
Except for the api and bin directories, all of the directories under the opsw directory
represent objects. The api directory contains executables that invoke methods on the
Opsware SAS API. The bin directory contains Global Shell utilities such as rosh and

aaa.
For Opsware SAS, the top level of the opsw directory has the following structure:

/opsw/
api/
Application/
.Application.ID/
bin/
Customer/
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.Customer.ID/
Facility/
.Facility.ID/
Group/
.Group.ID/
Hardware/
.Hardware.ID/
Library/
.Library.ID/
NetModel/
NetOS/
NetType/
Network/
.Network.ID/
0os/

.0S.1ID/
Realm/
.Realm.ID/
Script/
Server/
.Server.ID/
ServiceLevel/
.ServiceLevel.ID/

The ID directories organize objects by their unique Opsware identifier. These directories
are equivalent to those organized by name. For example, if a server with an ID 10043 is
named m44 . opsware . com, then the following directories contain the same information:

/opsw/ .Server.ID/10043
/opsw/Server/@/m44 .opsware.com

If the Opsware NAS is installed, the /opsw directory also contains several network
directories. See “Network Directories” on page 501.

/opsw/Server Directory

The Server directory not only contains information about managed servers, but also
organizes the servers by their associated objects. For example, the /opsw/Server/
@Group directory organizes servers by device group.

At the top level, the /opsw/Server directory has the following structure:

/opsw/Server/
e/
server-1/
server-2/

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved. 491



Opswezre® SAS 6.0.1 User’s Guide: Application Automation

@Application/
Application Servers/
Database Servers/

@Customer/
customer-1/
customer-2/

@Facility/
facility-1/
facility-2/

@Group/
Private/

private-group-1/
private-group-2/

Public/
public-group-1/
public-group-2/

@Hardware/
@0s/

@ServicelLevel/

The sections that follow list some of the directory structures under /opsw/Server.

/opsw/Server/@ Directory

This directory contains all managed servers. The £iles directory reflects the file system
of the managed server. When you modify the file system beneath the £iles directory,
you do so as a specific user (such as login-1) of the managed server.

The Interface directory contains information about the network interface of the server.
This directory might contain symbolic links to a network device. See “/opsw/Network
Directory” on page 502 for more information on these links.

The paths in the following directory structure are under /opsw/Server/@. For example,
the full path name of server-1 in the following structure is

/opsw/Server/@/server-1/.

server-1/
attr
ChangeLog
complus
CPU/

492 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



0
1

CustAttr/

custom-attribute-1
custom-attribute-2/

files/
login-1/

(file system as seen by login-1)

login-2/

(file system as seen by login-2)

info
Interface/

network-interface-1/

Memory/
RAM
SWAP
metabase/
login-1/
(metabase as
login-2/
(metabase as
method/
registry/
login-1/
(registry as
login-2/
(registry as

self
Storage/

seen

seen

seen

seen

storage-device-1/

server-2/

server-3/

by login-1)

by login-2)

by login-1)

by login-2)

/opsw/Server/ @Facility Directory

This directory filters servers according to their facility:

facility-1/

Appendix D: OGFS Directories
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@ /(all servers in facility-1)
server-1/
server-2/

@Group/
group-1/

@/ (all servers in both facility-1 and group-1)
server-1/

group-2/

facility-2/

/opsw/Server/ @Group Directory

This directory does not contain network devices. This directory filters servers according to
their device groups:
group-1/

@/ (all servers in group-1)
server-1/

child-group-1/
@ (all servers in child-group-1)
server-1/

child-group-2/

@Facility/
facility-1/
@ (all servers in both group-1 and facility-1)
server-1/

group-2/
@/ (all servers in group-2)

/opsw/Library Directory

The Library directory contains information about folders and the objects within folders:
application policies, OS sequences, and packages. This directory has the following
structure:

/opsw/folder-path-1/@/

AppPolicy/
app-policy-1/
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attr/
method/
self

app-policy-2/

attr/
method/
0OSSequence/
os-sequence-1/
attr/
method/
self
os-sequence-2/
Package/
package-1/
attr/
method/
self
package-2/
self

/opsw/folder-path-2/

Other Directories Under /opsw

This section lists, in alphabetical order, the object directories under /opsw other than the
Server, Library, and Net* (network) directories.

/opsw/Application Directory
This directory is deprecated in Opsware SAS 6.0.

This directory represents the Opsware Software Tree, a hierachical structure for organizing
applications:

/opsw/RApplication/
Application Servers/
application-1/
@/
CustAttr/
custom-attribute-1
custom-attribute-2

.id
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info
child-application-1/
@/

grandchild-application-1/
@/

grandchild-application-2/
child-application-2/
application-2/

Database Servers/
application-1/

Operating System Extras/
application-1/

Other Applications/
application-1/

System Utilities/
application-1/

Web Servers/
application-1/

/opsw/Facility Directory

Typically, a facility identifies the geographical location of a data center, such as a city or
building. This directory contains information about facilities and the servers they manage:

/opsw/Facility/
facility-1/
e/
attr
CustAttr/
custom-attribute-1
custom-attribute-2

info

method

self

Server/
server-1/
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server-2/

facility-2/

/opsw/Group Directory

This directory represents device groups. This directory also contains groups for network
devices under the following conditions:

+ Opsware NAS is installed.
» The Opsware SAS group has the NAS-associated attribute set.
+ The SAS and NAS group names are the same.

In the following structure, the child-group and grandcdhild-group reflect nested
device groups:

/opsw/Group/
Public/
group-1/
e/
CustAttr/
custom-attribute-1
custom-attribute-2

info
Server
server-1/

server-2/

child-group-1/
@/

grandchild-group-1/
@/

grandchild-group-2/
child-group-2/
group-2/

Private/
group-1/

group-2/
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/opsw/Library

This directory corresponds to the Library of folders displayed by the SAS Client.

/opsw/Library/ct
folder-1/

@/
attr
method
OSSequence
self
Software
SoftwarePolicy

subfolder-1/

@/
subfolder-2/

folder-2/
@/

/opsw/0OS Directory

This directory contains information about the operating systems defined in Opsware SAS.
It does not contain the actual bits for the operating systems, which are stored in the OS
Provisioning Media Server. The /opsw/0S directory has the following structure:

/opsw/0S/
os-name-1/
Not Assigned/
@/
CustAttr/
custom-attribute-1
custom-attribute-2

info
Serv-1l/er

server-1/
server-2/

os-name-2/
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/opsw/Permissions Directory

This directory contains information about the Global Shell permissions. The info
directory contains a file for each operation (permission) that can be granted with the aaa
utility. For each user group, the operations subdirectory contains a text file
corresponding to an operation (such as 1aunchGlobalShell) that have been granted
to the group by aaa. The contents of these text files summarize the parameters of the
permissions for that operation and user group.

For example, the readServerFilesystem text file is in the operations directory of
the Advanced Users group:

/opsw/Permissions/UserGroups/Advanced Users/operations/
readServerFilegsystem

The readServerFilesystem text file contains the following information:

Facility: C40(40) Login: sysadmin
Group: Unix Servers (2880040) Login: root

In this example, all members of the Advanced Users group can read the file system as
user sysadmin on servers that belong to Facility €40 (with ID 40), and as user
root on servers that belong to the device group Unix Servers (with ID 2880040).

If a user group directory does not contain a text file for an operation, then the group does
not have permission to perform that operation. If the text file is empty, the user group has
permission to perform the operation, but the operation has no parameters. The
launchGlobalShell operation, for example, has no parameters.

The /opsw/Permissions directory has the following structure:

/opsw/Permissions/
info/
launchGlobalShell
loginToServer
readServerComplus
readServerFilesystem
readServerMetabase
readServerRegistry
relayRdpToServer
runCommandOnServer
runTrustedOnServer
writeServerFilesystem
UserGroups/
user-group-1/
description
operations/
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launchGlobalShell
loginToServer

user-group-2/

/opsw/Realm Directory

A realm is a logical name for a group of IP addresses that can be contacted by a particular
set of Opsware Gateways. Typically, each Satellite and Facility has one or more distinct
realms. To find out which managed servers belong to a realm, note the server names
below the realm/@/Server subdirectory.

The Realm directory has the following structure:

/opsw/Realm/
realm-1/
@/
info
Server/
server-1/
server-2/

realm-2/

/opsw/Script/Shared Directory

This directory contains utility scripts that are included with Opsware SAS. These scripts are
not the same as the DSE shared scripts that are accessible with the SAS Web Client. The
contents of this directory cannot be changed by end users.

/opsw/Script/
Shared/

script-1/
description
policy
source
version

script-2/

/opsw/ServiceLevel Directory

This directory is deprecated in Opsware SAS 6.0.
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Service levels are user-defined categories such as Silver, Gold, and Platinum. The
/opsw/ServiceLevel directory has the following structure:

/opsw/ServiceLevel/
service-level-1/
@/
CustAttr/
custom-attribute-1
custom-attribute-2

.id
inf-1/0

child-service-level-1/

@/

grandchild-service-level-1/

@/
child-service-level-2/
Server/
@/

service-level-2/

Network Directories

For Opsware NAS, the top level of the opsw directory includes the following
subdirectories:
/opsw/

NetModel/

NetOS/

NetType/

Network/
.Network.ID/

Script/Network
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/opsw/Network Directory

This directory organizes the devices by their model, OS, type, and group. All network
devices are in the /opsw/Network/@ directory. The Changelog directory contains
time-stamped events for the device. The Config directory contains time-stamped
configuration files.

At the top level, the /opsw/Network directory has the following structure:

/opsw/Network/
@/
device-1/
attr/
ChangeLog/
Config/
info
method/
Module/
Port/
port-1/
.id
info
Link/
port-2/

self
Vlan/
device-2/

@Group/

@NetModel/

@Net0OS/

@NetType/
The pPort and VLAN directories contain Layer 2 information. Within each subdirectory of
the Port directory, an info file contains duplex information and other data for a specific
network port. The Link directory contains a symbolic link to a server interface or a port
on another network device (if the MAC address to the interface or port is available). In the
following example, the etho0 under Network is a symbolic link to eth0 under Server:

/opsw/Network/@/sw-ee-1-2b/Port/FastEthernet0_ 1/Link/etho
symbolic link to -->
/opsw/Server/@/m180.mycomp.com/Interface/etho0

Similarly, the server directory can have a symbolic link to the correpsonding entry under
Network:
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/opsw/Server/@/x.mycomp.com/Interface/eth0/Link/FastEthernet0 7
symbolic link to -->
/opsw/Network/@/sw-ee-2-4a/Port/FastEthernet0_ 7/ethoO

/opsw/Network/@Group Directory

This directory does not contain groups for managed servers. This directory filters network
devices according to their groups:

group-1/
@/ (all devices in group-1)
device-1/

@NetModel/
@NetOS/
@NetType/
child-group-1/
@ (all devices in child-group-1)
device-1/

child-group-2/

group-2/
@/ (all devices in group-2)

/opsw/NetModel Directory

This directory contains subdirectories for vendors, for example,
/opsw/NetModel /Cisco. The /opsw/NetModel directory has the following
structure:

vendor-1/
model-1/
e/
@Group/
@Net0S/
@NetType/
model-2/

vendor-2/

/opsw/NetOS Directory

This directory organizes devices by their operating system. The /opsw/NetModel
directory has the following structure:
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family-1/
os-1/
@/
@Group/
@Net0S/
@NetType/
os-2/
family-2/

/opsw/NetType Directory
This directory organizes network devices by the following types:

Firewall

L3Switch

L4to78witch

Proxy

Router

Switch

unknown

VPN

Wireless Access Point
WirelessAP

The /opsw/NetType directory has the following structure:
type-1/

e/
@Group/
@Net0OS/
@NetType/

type-2/

/opsw/Script/Network Directory

This directory contains utility scripts for network devices. For information about these
scripts, see the Opsware NAS documentation.

/opsw/Script/Network/
Advanced/
Command/
Diagnostic/
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This appendix describes terminology and acronyms used in Opsware SAS.

ACM See Application Configuration Management.

Ad-Hoc scripts A script that is created (or uploaded) and then immediately executed by
a user. The script is intended for one-time use and is not stored in Opsware SAS.

administrator See Opsware administrator.

Agent See Opsware Agent.

Agent Installer An application that installs the Opsware Agent on a server.

Agent Uninstaller An application that uninstalls the Opsware Agent on a server.
application A set of tiers and sub-tiers, such as a Web tier running Apache on Linux, an
application tier running Weblogic on Windows, and a database tier running Oracle on

Solaris.

application component An object that represents a process of running software, such
as Apache, Oracle, BEA WeblLogic, Microsoft® SQL Server, and so on.

application configuration Contains application configuration templates associated with
an application.

Application Configuration Management (ACM) An Opsware feature that enables you
to manage and modify configuration files for applications on managed servers.

application definition Specifies an application's logical construction in terms of tiers,
subtiers and the application components contained in those tiers. Allows you to transform
a data display that contains extraneous and hard-to-understand information into a
focused and easy-to-understand view of the data that is relevant to the application of
interest.

application tier A set of process families that you create to organize the Application View

so that you can see a compelling diagram of multiple servers, the connections among
them, clients connecting to them, and dependencies to which they connect.
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audit A set of rules that express desired state of a managed server's configuration
objects — for example, a server's file system directory structure or files, a server’s
Windows Registry, application configuration, and so on.

audit job The process that performs an audit.
audit policy A collection of rules that define a desired state of configuration for a server.

audit result The results of running an audit, which will show how a target server or
groups of servers’s configuration object values match or mismatch the values as defined
in the audit.

Automated Configuration Tracking An Opsware feature that allows users to monitor
critical configuration files and configuration databases. When Opsware SAS detects a
change in a tracked configuration file or configuration database, the system can perform a
number of actions, including backing up the configuration file or sending an email to a
designated individual or group.

available patch A patch that the patch administrator has tested and marked as available.
Only patches that have been marked as available can be installed by anyone other than a
patch administrator. (The patch administrator can install an unavailable patch in order to
test it.)

available server A reserve of new, unconfigured Opsware-enabled servers ready for
quick deployment. The provisioned server can be moved into the Live environment to
replace existing servers, add capacity, or support new applications. While optional, this
provides faster recovery options in cases of hardware failure.

backup A feature in Automated Configuration Tracking that performs a backup of a file or
database when it detects a change to a tracked configuration file or database. This action
is performed only if the backup action is selected in the configuration tracking policy for
the file or database.

backup (CDR) Process of saving the entire contents of the current Live directory for a

specific service to the Backup directory. Code Deployment & Rollback (CDR) saves the
backup copy to the local disk for the host on which the Backup operation was run. Only
one backup copy is maintained at any time for a service.

backup event An event that causes configuration files or configuration databases to be
backed up. Types of backup events include manual, full, and triggered.

Boot Server A part of the OS Provisioning feature that supports network booting of Sun
and x86 systems with inetboot and PXE respectively. The processes used to provide this
support include the Internet Software Consortium DHCP server, and Sun Solaris TFTP and
NFS.
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Build Manager A part of the OS Provisioning feature that facilitates communication
between the OS Boot Agent and the Command Engine for OS provisioning.

CDR See Code Deployment & Rollback (CDR).

change log An audit trail of changes made to a node (read-only). Tracks changes made
to a node. Identifies who has recently modified the node to add or remove software
packages, add or remove operating systems, add or move servers, and create or remove
subordinate nodes.

Code Deployment & Rollback (CDR) An Opsware feature used to push updated code
and content to staging host servers.

Code Deployment Role A specific role that authorizes access to capabilities and
functions with the Opsware Code Deployment & Rollback feature.

combined event history log A record of events performed on servers and network
devices in your environment. These events are recorded in detail as actions performed on
a certain date, by a certain user, on a certain server, or on a certain network device.

Command Engine The Opsware SAS component that enables distributed programs to
run across many servers. The Command Engine handles the entry of scripts into the
Opsware Model Repository (the script storage location in Opsware SAS) and the
versioning of stored scripts. Command Engine scripts are written in Python and run on the
Command Engine server.

Communication Test A feature that helps in identifying managed servers with
unreachable Opsware Agents. A Communication Test lists all servers with unreachable
agents, returns specific errors associated with each unreachable agent, and provides
troubleshooting information to resolve the error. The Communication Test runs various
tests like Command Engine to Agent Communication, Crypto Match, Agent to Command
Engine Communication, Agent to Data Access Engine, Agent to Software Repository
Communication, and Machine ID mismatch to determine if an Opsware Agent is
reachable.

compliance The degree to which a server object conforms to a test.

configuration template A set of values that represent the configuration file of an
application.

configuration tracking policy The configuration tracking policy defines the set of files or
configuration databases to be monitored, and the actions to be taken when change is
detected to a tracked file.

configuration tracking reconcile Process by which new configuration tracking polices
or changes to existing configuration tracking polices are deployed on servers.
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core See Opsware core.

custom attributes Attributes such as miscellaneous parameters and named data values
that users can set for servers in the . Used when performing a variety of Opsware
functions, including network and server configuration, naotifications, and CRON script
configurations.

custom extension Custom Command Engine scripts that extend Opsware SAS
functionality to customers to cover their specific needs.

customer An account within Opsware SAS that has access to designated resources,
such as servers and software.

cutover A feature in CDR, that causes the Update directory and current Live directory to
be identical. Performed automatically by determining the differences between the Update
directory and current the Live directory. The files that are different are synchronized from
the Update directory to the current Live directory.

Data Access Engine The XML-RPC interface to the Model Repository that simplifies
interaction with various clients such as the SAS Web Client, system data collection, and
monitoring agents on servers.

data center Legacy term. See facility.

data link connection A layer 2 connection that includes switches that are directly
connected to a managed server and switches that are indirectly connected through other
switches.

deactivated server Server removed from Opsware management even though its history
still exists.

deployment Within CDR, automatically pushes code and content from a staging server
to a live network server.

deprecated A possible state of a package or patch in Opsware SAS. A deprecated
package or patch can no longer be installed on a managed server, but might still be
installed on a server before the patch or package was deprecated.

device A managed server or network device.

device group In SAS, a device group can contain managed servers and network
devices, or only managed servers. In NAS, a device group contains only network devices.
A device group helps you categorize your devices (servers and network devices) in ways

that make sense for your organization.

Distributed Scripts An Opsware feature that allows you to manage scripts in your
managed environment.
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Dormant Opsware Agent An Opsware Agent that runs in the dormant mode after its
installation when Opsware SAS core is not available on the network. The dormant agent
periodically attempts to contact the core and when the core is available, it performs the
initialization tasks to complete its installation.

duplex mismatch A configuration mismatch between the speed and duplex of a
managed server and a connected network device.

dynamic group A server group that contains servers added to or removed from the
group based on a set of user-defined rules.

email notification list In the Automated Configuration Tracking feature, an email can be
sent to the email addresses in the email naotification list whenever a change to a tracked
file or configuration database is detected.

Environment Tree The Environment Tree manages characteristics about a customer’s
unigue data center environment, including hardware, location of servers, network
infrastructure, application names, business units, and service levels assigned to servers
and applications. The information contained in the Environment Tree, combined with the
information contained in the software policy, is utilized by the Opsware Automation
Platform to model and simulate operational changes before they are executed in the
production environment.

facility The collection of servers that a single Opsware core manages. A facility can be all
or part of a data center, server room, or computer lab.

folder A hierarchal file-system type organization structure that allows you to organize
and manage your software resources and allows you to define security boundaries to
control access to its content across user groups.

full backup During a full backup, all tracked configuration files that were selected to be
backed up are backed up (and not just the files that have changed). Full backup is
performed if you select backup as the action for a tracked configuration file.

gateway See Opsware Gateway.

Global Shell A terminal window for the Opsware Global File System (OGFS) in your
Opsware SAS.

group See device group.

IDK Intelligent Software Module (ISM) Development Kit. The tools from Opsware Inc.
used to build and upload ISMs.

Import Media tool A utility script included with Opsware SAS that is used to import OS
media from the Media Server to Opsware SAS.
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inclusions/exclusions criteria Specifies how to include and exclude directories and
files during the snapshot or audit process.

incremental backup During an incremental backup, only targets that have changed
since the last backup (and that have been selected to be backed up) are backed up.
Incremental backup is performed if you select backup as the action for a tracked
configuration file.

initialization Legacy term. See OS Provisioning.

IP Range Groups A designated set of servers assigned to a customer account, grouped
by either a physical or a logical list.

IP Ranges A designated grouping of servers.

ISM Intelligent Software Module. A set of file and directories that include application bits,
installation scripts, and control scripts. When an ISM is uploaded into an Opsware core, a
node created for the application and installable packages are attached to the node.

ISM control A script within an ISM package that can be run on a managed server.

job Any major process run by the SAS Web Client or the SAS Client such as
Communication Test or Install Software.

layer 2 connection See data link connection.
Library In the SAS Client, the Library provides a way to display features such as
application configurations, software policies, patches, patch policies, packages, OS

sequences, and OS profiles managed by Opsware.

Live directory In CDR, the directory that stores the actual code and content required to
run a live site.

MAC See Media Access Control Address (MAC).
Machine ID (MID) A unigue identifier that Opsware SAS uses to identify the server.
Opsware SAS assigns a unique number to the server when it first registers and stores the

Machine ID and uses it to identify each server.

managed server A Server that has an Opsware Agent installed on it and is under the
control of a particular Opsware core.

management IP The IP address that Opsware SAS uses to communicate with the
Opsware Agent on the server.
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manifest Within CDR, a list of files that indicate the results or preview of an update to be
performed. Each entry in the list specifies the file size, last-modified date and timestamp,
and the full directory path to the listed file.

Media Access Control Address (MAC) The network interface card’s unique hardware
number. The MAC is used as the server's physical address on the network.

Media Resource Locator (MRL) A network path in URL format that is registered with
Opsware SAS. The path defines the installation media for an OS.

Media Server Contains the vendor-supplied OS media used during OS provisioning over
the network. The OS media on the Media Server is accessed over the network by using
NFS for Linux and Solaris OS provisioning, and by using SMB for Windows OS
provisioning.

MID See Machine ID.

Model Repository The Opsware database that stores information about managed server
configurations within Opsware SAS. It contains all information necessary to build, operate,
and maintain an Opsware-managed site, including a list of all servers under
management, the hardware associated with these servers, including memory, CPUs,
storage capacity, and the configuration of these servers, including IP addresses, DNS
configuration, and so on.

Model Repository Multimaster Component The application that propagates and
synchronizes changes from each Model Repository database to all other Model
Repository databases.

Modeling and Change Simulation Engine Opsware SAS enables users to first model
and simulate proposed operational changes to their environment before propagating
these changes to production servers and applications. Utilizing the information contained
in the Software and Environment Trees, the Modeling and Change Simulation Engine
maintains a model of the various hardware and software configurations and other
customer characteristics associated with each of the production servers under Opsware
SAS control.

MRL See Media Resource Locator (MRL).

multimaster core An Opsware core that belongs to a multimaster mesh.

multimaster infrastructure component See Model Repository Multimaster Component.

multimaster mesh A set of two or more Opsware cores that are linked by synchronizing
the data in the Model Repositories at each of the cores. The Model Repositories in each

of the cores are continually updated so that they are exact duplicates of each other. All the
Opsware cores in a multimaster mesh can be managed through a single SAS Web Client.
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My Jobs A page in the SAS Web Client that displays a list of jobs from the Model
Repository such as software installation or server provisioning.

My Scripts Private scripts that can only be executed by the user who created the script.
My Scripts are created for personal use.

name-value pairs Legacy term. See custom attributes.

NAS Integration An Opsware feature that enables you to closely examine detailed
information about managed servers and the network devices connected to them so that
you can determine how they are related and then, subsequently, coordinate and
implement those changes.

OCLI See Opsware command Line Interface (OCLI).
OGFS See Opsware Global File System.

Opsware administrator Responsible for overall administration, policy, and practices for
individuals accessing Opsware SAS. Can add users and define access to specific
Opsware SAS features that allow users to view site information and deploy new code and
content to their site.

Opsware Agent Intelligent software on Opsware-managed servers that is used to make
changes to the servers. Depending on the request, the agent might use Global Opsware
services. Some functions supported include software installation and removal, software
and hardware configuration, server status reporting, and auditing.

Opsware Automation features Opsware SAS is made up of a set of Opsware
Automation features. Opsware Automation features are the components that automate
particular IT processes. The Opsware Automation features include the following functions:
Configuration Tracking, Code Deployment and Rollback, Script Execution, and Data
Center Intelligence Reporting.

Opsware Discovery and Agent Deployment A feature that helps deploy Opsware
Agents to a large number of servers through the SAS Client.

Opsware SAS Web Client A web-based user interface for managing the Opsware
environment.

Opsware Command Line Interface (OCLI) An alternative interface to the SAS Web
Client. The OCLI allows you to perform some actions not possible though the browser-
based interface of the SAS Web Client, such as uploading multiple packages, patches,
AlX filesets, and so forth, in a batch operation.

Opsware core The server side of Opsware SAS server-agent architecture. A core
consists of the Opsware components (such as the Model Repository, the Software
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Repository, the Data Access Engine, and the Command Engine) for a particular
installation.

Opsware Gateway Provides connectivity with an Opsware core either directly or through
a network of gateways. All traffic between the servers in the Satellite and the core that
manages them is routed through Opsware Gateways.

Opsware Global File System (OGFS) The Opsware Global File System is a single,
unified file system view of all file systems for all managed servers in Opsware SAS.

Opsware installation Either a standalone core, multimaster core, or Opsware Satellite.

Opsware model space The Opsware Global File System (OGFS) file system structure
that is derived from the Model Repository.

Opsware Satellite Installed in a remote facility, an Opsware satellite provides network
connection and bandwidth management for a core that manages remote servers. A
Satellite must be linked to at least one core, which may be either standalone or
multimaster.

Opsware SAS The server management application to preserve the knowledge of
system administrators, network engineers, and database administrators in a centralized
knowledgebase. Automates previously manual tasks associated with the deployment,
support, and growth of a data center infrastructure.

OS Build Agent A part of the OS Provisioning feature that is responsible for registering
bare metal servers in Opsware SAS and guiding the installation process.

OS media Installation software for an OS from the software vendor that is distributed on
a CD-ROM, or DVD, or can be obtained by downloading the software from the vendor's
FTP site.

OS Provisioning Process of installing a basic set of software components, including an
operating system and an Opsware Agent to add a server into the Opsware managed
environment. After provisioning is complete, the server is ready to be managed by
Opsware SAS.

Package Repository Legacy term. See Software Repository.

package A collection of executables, configuration, or script files that are associated with
an Opsware-installable application or program. In Opsware SAS a package contains
software package files registered in the Software Repository. Contains software for
operating systems, applications (for example, BEA Weblogic, IBM WebSphere),
databases, customer code, and software configuration information.
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packaging server A managed server that has the IDK installed on it. Visual Packager
requires a packaging server for each type of operating system for the packages you plan
to create.

patch A piece of object code (binaries) that is inserted into (patched into) an executable
program to temporarily fix a known defect.

patch management administrator Administrator responsible for testing patches and
defining patch options, such as installation and uninstallation scripts. A patch cannot be
installed by other personnel until the patch administrator has marked the patch available
through the SAS Web Client.

Patch Management An Opsware feature that allows you to upload, test, and deploy
patches in a safer and uniform way.

permission A setting within a User Group that allows or disallows access to Opsware
SAS features and resources. A resource is usually a set of managed servers or software
nodes. The set of managed servers corresponds to a facility, customer, or server group.

physical connection Inferred from data link connections and represents direct
connections (cables) between server and switches.

platform The name and version of an operating system.

post-install script A shell script invoked on a managed server immediately after a
software package is installed on a managed server.

post-uninstall script A shell script invoked on a managed server immediately after a
software package is removed from the managed server.

pre-install script A shell script invoked on a managed server immediately before a
software package is installed on a managed server.

pre-uninstall script A shell script invoked on a managed server immediately before a
software package is removed from the managed server.

preview remediate Before Opsware SAS installs software on a server, it performs a
preview remediate, and determines what will happen when the actual remediate is
performed (for example, what packages will be installed or removed, what server reboots
are required, and so forth).

primary IP A locally-configured IP address of the management interface.

private group A type of server group that can be edited, or deleted by the Opsware user
who created the server group.

privileges See Permissions and User Group.
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public group A type of server group that can be created, edited, or deleted by any
Opsware user who has Manage Public Server Groups permissions.

realm One or more Opsware Gateways that service the managed servers contained
within an Opsware realm. In Opsware SAS, a realm is a routable IP address space, which
is serviced by one or more gateways. All managed servers that connect to an Opsware
core via a gateway are identified as being in that gateway’s realm.

remediate The process of updating the actual software configuration of a server based
on the specified configuration stored in the Model Repository.

remediate output After a remediate operation completes, Opsware SAS displays the
remediate output for each server that was remediated. The remediate output aggregates
output from the various installation, uninstallation, or post-installation scripts, messages
from Opsware SAS, and messages from the system utilities that remediate uses to
perform the installation and uninstallation of packages, operating systems, and patches.

reference server A managed server that is compliant (performs as expected) and is also
referred to as a known working server or a baseline server.

remote terminal A terminal window for a Unix server or an RDP client window for a
Windows server.

Reports An Opsware feature that enables you to create reports that provide
comprehensive, real-time information about managed servers, network devices, software,
patches, customers, facilities, operating systems, compliance policies, and users and
security in your environment.

restore A function of the Automated Configuration feature that allows the user to return
the configuration file or database to a previous state, when the backup action for a
tracked file or database is selected.

restore Within CDR, the process of restoring the previous Live directory from the Backup
directory to the Live directory.

restore queue Queue in which configuration files are placed before they are restored to
a server.

rollback Within CDR, returns a site to the state prior to the last cutover. During rollback,
restores the set of modified and deleted files to the Live directory.

rosh The remote Opsware shell is a command that makes a client connection enabling
you to remotely run programs on managed servers.

Satellite See Opsware Satellite

Script Execution See Distributed Scripts.
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selection criteria Rules that instruct Opsware SAS what server objects you want to
collect information about, how to collect the server objects, and (optionally) file
comparison and inclusions/exclusions criteria. Selection criteria is required for the
snapshot and audit processes.

sequence Process within CDR that simplifies deployment by grouping a collection of
service operations and synchronizations that can be performed as a single task.

Sequence Editor In CDR, a predefined User Group to create, modify, or delete a
sequence definition.

Sequence Performer (Production) In CDR, a predefined User Group to directly perform
or request performance of a sequence action on production hosts.

Sequence Performer (Staging) In CDR, a predefined User Group to directly perform or
request performance of a sequence action on staging hosts.

Sequence Requester (Production) In CDR, a predefined User Group to request
performance of a sequence action on production hosts.

Sequence Requester (Staging) In CDR, a predefined User Group to request
performance of a sequence action on staging hosts.

servers Any specific hardware. Specific nodes are attached to servers that determine the
specific software, configuration, and other server attributes.

server assimilation Opsware SAS assimilates servers that are already functioning in the
operational environment, which allows users to deploy and manage new applications
installed on those servers. Assimilating servers installs Opsware Agents on the servers
and registers them with the Model Repository.

server baselines Process of defining and provisioning servers with standard
configurations. Opsware templates can be used to automate the building of complete
server baselines.

Server Explorer A feature of the SAS Client that allows you to browse and manage
servers and server groups in your facility.

Server ID The primary key in the Opsware Model Repository that represents a given
server. The Server ID is used internally in Opsware SAS.

server lifecycle The various server states assigned to a server by Opsware SAS. Server
states include Unprovisioned, Available, Installing OS, and Managed.

server management Process by which users can manage and track servers in an
Opsware-managed environment. Opsware SAS forces changes to the operating
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environment by first changing the centralized configuration information in the Model
Repository and then changing the actual configuration of physical servers.

Server Pool Servers that have registered their presence with Opsware SAS, but do not
have a full operating system installed.

server provisioning The process of installing a basic set of software components that
include the operating system, an Opsware Agent, and other system utilities and
debugging tools to manage the server. Configuration is defined in the Model Repository.

Server Search A feature that allows you to search for servers based on a variety of
criteria, including OS version, installed package, customer, and installed patch.

Server Status A feature that defines server availability. The three major status conditions
are USE, STAGE, and STATE.

server-based configuration tracking policy A configuration tracking policy that is
defined for a particular server or group of servers, rather than for a particular software

node (application).

service A host application (for example, BEA WebLogic, Allaire ColdFusion, Microsoft IIS,
Apache Web Server, or iPlanet Application Server).

Service Editor In CDR, a predefined User Group to define and modify or delete service
definitions.

Service Performer (Production) In CDR, a predefined User Group to directly perform or
request performance of service operations on production hosts (servers).

Service Performer (Staging) In CDR, a predefined User Group to directly perform or
request performance of service operations on staging hosts.

Service Requester (Production) In CDR, a predefined User Group to request
performance of service operations on production hosts.

Service Requester (Staging) In CDR, a predefined User Group to request performance
of service operations on staging hosts.

service-instance Multiple independent instances of a service running on a host (for
example, BEA Weblogic, which can run single or multiple instances).

Service Levels User-defined categories that are used to group servers in an arbitrary
way. For example, a user can group servers by functionality, tier, application, or ontogeny.

Shared Scripts Public scripts that every Opsware SAS user can access.
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signature A set of rules that you provide and that Visual Application Manager uses to
identify a process family.

Site Backup directory In CDR, the directory that stores a complete backup of the Live
directory when the user issues a Backup service operation.

Site Previous directory In CDR, the directory that stores the files that have changed
between the current Live directory and its previous state prior to the last cutover. It holds
all the changes necessary to revert the Live directory back to the state that it was in
before the last cutover.

snapshot A record of how an Opsware managed server is configured at a particular
point in time. Snapshots allow administrators to audit the configuration of servers and
deploy files and software to correct discrepancies. A snapshot can be based on specified
server objects. Server Compliance records one snapshot per server.

snapshot job The process that created a snapshot of a server or server group.

snapshot specification A definition of a target and selection criteria that will be
examined during the snapshot process to capture and record information about a
managed server.

software compliance Software compliance indicates whether or not the all software
policies attached to the selected server are compliant with the actual server configuration.

software policy A software policy contains packages, patches, application
configurations, and other software policies and allows you to install software and
configure applications on managed servers simultaneously.

Software Repository The central repository for all software managed by Opsware SAS. It
contains software packages for operating systems, applications, databases, customer
code, and software configuration information.

Software Repository Cache An Opsware Satellite component that contains local copies
of files. The Software Repository Cache stores files from the Software Repository of an
Opsware core or from another Software Repository Cache, and supplies the cached files
to Opsware Agents on managed servers.

Software Repository Replicator A component providing backup functionality for
Software Repositories running in a multimaster mesh.

source In the snapshot process, this is the managed server that information is recorded
about. In the audit process, this is an existing snapshot or server you are comparing
selection criteria from.

standalone core An Opsware core that manages servers in a single facility. Unlike a
multimaster core, a standalone core does not communicate with other cores.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Appendix E: Glossary

static group A server group in which the servers are added to and removed from
the group manually.

synchronization Process within CDR to move modified files from a directory on a source
host to a directory on a destination host.

Synchronization Editor In CDR, a predefined User Group to create, modify, or delete a
synchronization definition.

Synchronization Performer In CDR, a predefined User Group to directly perform or
request performance of a synchronization action.

Synchronization Requester In (CDR), a predefined User Group to request performance
of a synchronization action.

target In the snapshot process, this is the managed server or server group you are
recording information about. In the audit process, this is an existing snapshot, server, or
server group you are comparing selection criteria to.

topology A snapshot that represents the state of a set of network devices and managed
servers, the process families running on those servers, the connections among those
process families, and any external clients and dependencies.

tunnel A TCP connection between two Gateways that carries multiplexed TCP or UDP
connections.

Update directory The directory that CDR writes to when synchronizing modified files in
source and destination hosts. After synchronization, the Update directory is different from
the current Live directories. After cutover, the Update directory and current Live directory
are identical.

user An individual with access to the Opsware SAS. An Opsware user belongs to one or
more User Groups, which control the access of its members.

User Group Represents a role played an organization’s Opsware users. The permissions
specified for a user group determine what the group’s members can do with Opsware
SAS.

Value Set Editor Enables you to change the values in a configuration file by editing that
file's value set. Each entry configuration file is represented inside the value set editor as a
“value set” (a key name and a value).

Visual Application Manager An Opsware feature that is designed to help you

understand and manage the operational architecture and behavior of distributed business
applications in your IT environment.
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Web Service APl A web services interface that facilitates the integration of operations
and business support systems with Opsware SAS. The Opsware Web Services APIs allow
other IT systems, such as customers’ existing monitoring, trouble ticketing, billing, and
virtualization technology, to exchange information with Opsware SAS.

Web Services Data Access Engine A web services interface to the Model Repository
that provides increased performance to other Opsware SAS components.
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